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Get started

Welcome to the Confluence getting started documentation. In this section, you'll find tutorials and other
information that'll be useful for evaluating Confluence, and getting to know it when you're starting out.

Teams in Space

For each tutorial in this section, we'll use a fictional organization known as "Teams in Space'. Their mission is to:

"Perform flight research and technology integration to revolutionize aviation and pioneer
aerospace technology. Also, land the first humans on Mars by 2020."

You're an astronaut in the 'See Space EZ' team, which is working on the upcoming colonization of Mars.
Go ahead - dive into the tutorials, and let us show you around Confluence and some of its handy features.

® Tutorial: Navigate Confluence

® The dashboard

® The space directory

® The space sidebar

® Keyboard shortcuts

® Complete your mission
® Tutorial: Space ace

® Create a project space
Create your personal space
Create the team's PR space
Delete and archive spaces



Tutorial: Navigate Confluence

Confluence is pretty simple to use, once you get to know it. This tutorial aims to get you acquainted with the
Confluence user interface, and show you how and where to perform some common tasks.

Teams in Space

In this tutorial,you'll be working with some new Teams in Space recruits. Let's get to know them.

Alana Baczewski Emma Silvetti William Vladinov
Tech Lead Launch Specialist Aerospace Engineer

Now that you've met your team, let's take a look at your mission.

Mission brief

Your mission commander has thrown you a curveball: this week you'll be training new recruits at Teams in
Space HQ on your collaboration tool — Confluence. You just need to know the basics, so we'll go through the
main things you need to know to complete your mission.

Your mission is broken up into the following components:

Get to know the dashboard

Find your way in the space directory
Master the space sidebar

Impress everyone with keyboard shortcuts

Those new recruits will be here tomorrow; we better get started!

Let's go!



The dashboard

The dashboard

The space directory
The space sidebar
Keyboard shortcuts
Complete your
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The dashboard is the hub of your Confluence site, providing you with access to information and updates that
are important to you. It's also the first thing your new recruits will see, so you need to make a good
impression on this one.

You can get to the dashboard from anywhere in Confluence by choosing the site logo at the left of the
Confluence header.

The dashboard has a collapsible sidebar that helps you get around:

® Discover
Watch the action unfold in real time with All updates or check out pages with lots of likes and activity
in the Popular feed.

* My Work
Get lightning fast access to your recently created and edited pages in Recently worked on, get back
to that page you stumbled across yesterday in Recently viewed, and have mission critical pages on
speed dial under Saved for later.

® My Spaces
This is where you can keep links to the spaces that you hop in and out of several times a day.

If you're a Confluence admin you can give the dashboard some personality by adding useful
announcements, links, or a photo from your last mission (or office party). The whole right hand column is
ready and waiting for you to customize.

= X Confluence Spaces v People  Create -

o — O’ A.'I' . pcpular Invite Users  Create Space
7 Il upclates

= Popular £ Re: Whan shoubd we launch? 4
Emma McRas Welcome to Confluence

B When should we launch? 22 B3
Ryan Low P

D B Team playbook update: customer interviews 2 7 {
.
X Alana Grant

WY SPACES Al Mission essentials

v team B Solar powered charging stations
Emad Abdi

kK Team Space
[
Around the base

B Re: Team playbook update: customer interviews 1
Cassle Dwens Bixe

Sata

B Bike storage

argi
" 3¢

v ‘ Birthdays this week

‘; Jessie Emmerson

W-mockup.jpg 2 [: {]
Emma Mciae

Upcoming events

18 Apr 2018 Launch party!

1. Discover: see what's happening in your site.
2. Your work: get work done with recent and useful pages at your fingertips.
3. Customize: admins can add useful content to welcome people to the site.

Try clicking one of the spaces on the sidebar, then return to the dashboard by clicking the site logo. Even
when your shuttle is spinning out of control, the dashboard is there to orient you.

You'll discover more about the dashboard as you get to know Confluence, but, for now, let's move on to the
space directory.
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(® Pro tips
® You can choose to set any page as your personal home page
® You can always get to the dashboard at htt ps://yoursite.confw ki/dashboard.

action
® Your Confluence admin can customize the global dashboard that all users see

Next
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The space directory won't let you look up ET in the intergalactic phone book, but it will let you see and filter
all the spaces in your Confluence site. Spaces are places to collect pages with a common theme — you can
create as many spaces as you like — and you can find them all in the space directory.

Here are some tasks to get you comfortable using the space directory:

1. Visit the space directory — To get to the space directory, choose Spaces > Space directory in the
Confluence header.

2. Choose the spaces you'll use the most — No doubt there'll be a space or two that you'll use on a
regular basis. Click the star to the right of a space to make it appear under My Spaces on the
dashboard.

3. Choose space categories — Once you're there, you'll see a list of all the spaces in your Confluence
site. Choose the 'My Spaces' category on the left to see only the spaces you marked with a star. Then
choose all spaces again.

4. Filter the list of spaces — Type part of a space name in the Filter field at the top right. That'll quickly
narrow down the list of spaces if there are a lot of them.

= Z Confluence spaces ~ People

Create - Feedback

Space Directory

&8} Create Spaca

All Spaces Site Spaces
Site Spaces Space Description Categories
ersanal Spaces Dy e @ w
My Spaces
&i IT Knowledge Base knowiedge-bases
Archived Spaces
B social
CATEGORIES
Knowledge-bases bl TeamsinSpace @ *

Hint: Your space administrator can organise spaces into categories, Learn maore,

@. You can also categorize spaces with labels you create yourself. We're not going to cover that here,
but, if you'd like to know more, you can check out Use Labels to Categorize Spaces.

Understanding and using the space directory will make it much easier to find pages and blog posts that are
relevant to you.

You're ready to impress those new recruits with your knowledge of Confluence's space directory; now it's
time to sneak a peek at the space sidebar.

Next
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What's in the sidebar?

The sidebar is a feature of every Confluence space; it's where you'll find the page tree (a hierarchical list of
pages in the space), customizable space shortcuts, and a link to the space's blog.

The See Space EZ team will find their meeting notes, decisions, requirements, and other pages in the
sidebar. Basically any page you create in the space will appear in the sidebar by default.

(-:-*) When you use certain page templates, like meeting notes, Confluence will automatically add an
index page to your space shortcuts. The index page is just a place where you can view all pages of
the same type — meeting notes in this example — in one place.

The space's blog is great for announcements and what's new-type updates.
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4
H Teams in Space *

F Pages
99 Blog

SPACE SHORTCUTS
F Decision log

& Our Kanban board

F Media assets

PAGE TREE
v Meeting notes
2017-12-12 SeeSpaceEZ Tez
» 2018-01-18 Meeting notes

»  Decision log

> Product Planning i
> Product Requirements
> Teams in Space PR

Meet the SeeSpaceEZ Team

> Teams in Space PR

{3 Space tools v «

1. Space shortcuts: link to Confluence pages or other pages on the web
2. Page tree: hierarchical view of pages in this space.

The page tree in the sidebar shows the 200 pages closest to where you are. Hit Show all pages, if you want
to see all the pages in a space.

Configure the sidebar

You can expand or collapse the sidebar using the left square bracket ([ ) on your keyboard, or by dragging it
with your mouse.

There are lots of things you can change in the sidebar, but we'll stick to the basics — just enough to train your
new recruits.

G} You need to be a space admin to complete this task. Take a look, but feel free to skip it if you're not
an admin of any space.

Try this out:

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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1. Choose Space tools > Configure sidebar from the bottom of the sidebar (or the cog menu if your
sidebar is collapsed)

2. Add a space shortcut by clicking +Add link
Shortcuts can be to Confluence pages or spaces, or to any other content on the web. Try linking to this
blog post, which mentions Teams in Space (we're always after a plug at Teams in Space HQ!)

You can also hide things — like the space's blog — in the sidebar, if they're of no use in the space.

The sidebar is pretty easy, right? You'll be schooling those recruits in no time. Next up: Impress them with
your knowledge of keyboard shortcuts.

Next
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Give a person some space food, and they'll eat for a day; teach a person to rehydrate their own space food,
and they're set for the whole mission. Or something like that. Keyboard shortcuts fall into this basket. We
could give you a list here, but then you'd need to keep referring to this page. The best way to go is to show
you how to find the list of keyboard shortcuts within Confluence.

Your recruits also need to work fast, so you'll need to pass this wisdom on to them.

Find the keyboard shortcuts

To open the list of keyboard shortcuts in Confluence, do any of the following:

® Choose the help icon i4 at top right of the screen, then choose Keyboard Shortcuts
®* When viewing a page, press Shift+?
* While editing a page, choose the question mark icon ? in the editor toolbar

What you'll see is a dialog listing the available keyboard shortcuts, for your operating system, in Confluence.

Keyboard Shortcuts

General

Editor Block Formatting Rich Formatting

Editor Autoformatting Paragraph R |« |6 Fites and images H + M
Heading 1 ® (=1 Link ® o+ K
Heading & % + 6 nsert markup ¥ + sShit + D
Preformatted 8o x | T Macr # = Shift + A
Quote ® 0+ 8 ® o+ Shit o+ |
Bullet st # + Shift + B #® + Shift + X
Numbered list ¥ 4+ Shit + N Capy table raw ¥ + Shh + | C

Saste table row ® + Shit + WV

Editing Actions
Preview ¥ + Shit + E
Save B |« |'B

The keyboard shortcuts are broken up into 3 categories:
® General — Global, page and blog post shortcuts.

® Editor — Text editing and formatting shortcuts.
® Editor Autoformatting — Wiki markup and autoformatting shortcuts.

@ You can turn the 'General' keyboard shortcuts off when you visit the General tab in the keyboard
shortcuts dialog.

Take some time to open the dialog and take a look at the shortcuts, and maybe find some you'll use a lot.
Then, start practising!

Want a printable sheet of keyboard shortcuts? Keyboard shortcuts infographic - you're welcome.

Next, we'll wrap up this mission and give you some ideas about where to head from here.


https://atlassianblog.wpengine.com/wp-content/uploads/2018/01/keyboard-shortcuts-infographics.pdf

Confluence 7.4 Documentation

Next
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Well done, astronaut, you've acquitted yourself admirably. I'm sure those new recruits will be mightily
impressed with your knowledge of Confluence.

In this tutorial, we've:

® Explored the anatomy of the dashboard

® Navigated using the space directory and favorited a space

® Taken a look at and customized the space sidebar

® Found a handy list of keyboard shortcuts to help you work faster

Just look at your team's adoring faces...

If you'd like to take things to the next level, check out our tutorial on becoming a space ace.



Tutorial: Space ace

This tutorial will take you on a journey through Confluence to create and customize spaces, and delete them
if you want to, so you can achieve the rank of 'Space Ace'l

You'll need to have the 'Create space' and 'Create personal space' permission to complete this tutorial. If
you've just set up Confluence, you won't have any trouble; if you're using an existing instance and you're not
an admin, speak to your Confluence admin to make sure you have the right permissions.

Teams in Space

In this tutorial you're a new recruit on the Teams in Space crew, but, even though you're new, you'll be given
a lot of responsibility. You need the power to go with it.

Mission brief

You're in charge of organizing information and resources for the planned mission to Mars. There's going to
be plenty of important information, and it must be readily available to the people who need it. Some
information, though, will be sensitive, and may be ‘for your eyes only." You'll use the power and flexibility of
Confluence spaces to organize information, and make sure it's visible to the right people.

Your mission is broken up into the following components:

® Create a space to house all of the important information related to the mission
® Create your own space to keep yourself organized
® Create a public relations space, where you'll introduce your team the world

What's a space?

Well, being an astronaut, | hope you know what space is, but what's a Confluence space all about? It's really
just a place to put related things, like information pages and files. But spaces also give you a place to
collaborate with groups of people, whether that's your team, people working on a common project, or the
whole world.

Every space has its own permissions, allowing you to grant access and other privileges to the right people.
They also have a blog, so you can post important messages and updates to whoever can see the space.
You can have as many Confluence spaces as you like, and you can archive or delete spaces when you no
longer need them.

Enough about that; let's begin.

Start the mission!



Create a project space

=
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4, Delete and archive

spaces

The Mars colonization crew needs a place to put all their mission-critical information and resources, and
you're charged with setting it up. This part is going to be easy, because the information needs to be viewable
by the entire Teams in Space organization. That means we can set up the project space without any special
permissions.

If you haven't done so already, open up Confluence and log in so we can get started.

Create the space

1. Choose Spaces > Create space from the Confluence header

2. Select the Blank space option and choose Next

3. Enter a Space name — for this space, we'll call it ‘Mars Colony', as it's being used for the Mars
colonization project.

4. Change the Space key to 'MARS' — this step isn't absolutely necessary, but it helps people if they're
navigating to this space by name. The space key forms part of the URL, so making it a word or name
makes it much easier to associate with your project.

5. Click Create

You now have a space set up for the Mars colonization project. Because everyone at Teams in Space HQ
needs access to the information in this space, you don't need to do anything with the space's default
permissions. It's visible to everyone in your organization, but not to the general public.

Every space has a default home page, which you can customize to suit your needs. Add the following image
and text to your space's home page to get things started. Just click Edit (or press E on your keyboard) to
edit the home page, and copy and paste the text. For the image it's best to drag it to your desktop and save
it there, then drag it into your page. That'll make sure the image is attached directly to the page.

Hit Save when you're happy with the home page.

A human mission to Mars has
been the subject of science
fiction, engineering, and
scientific proposals throughout
the 20th century and into the
21st century. The plans
comprise proposals to land on
Mars, eventually settling on and
terraforming the planet, while
exploiting its moons, Phobos an
d Deimos.

Exploration of Mars has been a
goal of national space
programs for decades.
Preliminary work for missions
that would involve human explorers has been undertaken since the 1950s, with planned missions typically
being cited as taking place 10 to 30 years in the future when they are drafted. The list of manned Mars
mission plans in the 20th century shows the various mission proposals that have been put forth by multiple
organizations and space agencies in this field of space exploration.
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Your 'Mars colony' space is ready for your team to add pages to. If you want to find it again, choose Spaces i

n the Confluence header, and select it from the list; to add a page to it, navigate to the space and hit Create i
n the header.

Now it's on to your personal space; a place where you can work in peace, and be sure that no one's looking
over your shoulder.

Next
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As a newbie on the team, you might want to keep some work to yourself until you're ready to present it.
There's always the chance your mission commander will also send you some information that's ‘for your
eyes only,' and you'll need to keep that in a safe place.

For this part of the mission, we'll be creating a special type of space: a personal space. We'll be using your
personal space like a sandbox, at least to start with — somewhere you can play around, draft pages, try out
features, and generally see what spaces are capable of.

Create your personal space

1. Choose your profile picture at the right side of the Confluence header
2. Select Add Personal Space...
3. Hit Create

You've now got a space that you can call your own. But we still need to lock it down to make sure it's
only visible to you.

= X Confluence spaces » People  Create =

3 Page: @ # Edit 17 Save forlater @ Watching =2 Share
Cassie Owens *

Cassie Owens's Home

& Profile
[El Pages About Me (Cassie Owens)
9 Blog You may edit this page to include additional information about yourself.

SPACE SHORTCUTS E-mail: cassie@mycompany.com

cut finks to the Navigate space
o tsam or Recently Updated

project. Configure sidebar,

ur e

PADE TREE Search

Get started by adding some pages to this

space. Create page.

e Like  Be the first to ke this Mo labets B

0 Write a comment...

1} Space tools ~

4. Choose Space tools > Permissions from the bottom of the siderbar
5. Hit Edit Permissions (enter your password if prompted)

You should see the conf | uence- user s group listed under Groups. To the left of the list of
permissions is the View permission, which determines whether everyone in that group can see your
space.

6. Uncheck View and hit Save all at the bottom of the page

You're now the only one that can view this space. Feel free to try anything in this space, and store super
secret stuff here.

Next



Create the team's PR space

=

Create a project space

2. Create your personal

space

3. Create the team's PR

space

4. Delete and archive

spaces
Now it's time to go public; the world needs to know about the mission and its brave participants.

In this step, we'll create a team space and open it up to everyone. That's right — you can open Confluence

spaces up to anonymous (not logged in) users.

@ In order to allow anonymous access to your Confluence site, a site admin needs to grant
anonymous users the 'Use Confluence' permission. Don't worry if you can't do that, or if it's not
done; it's just something to note if you're opening up your Confluence site for real.

Create a Team space

arwbdE

Choose Spaces > Create space from the header
Select Team Space and hit Next

Enter a Space name (let's call it 'Mars PR")
Change the Space key to 'MarsPR'

If there are other people using Confluence with you, feel free to add them as Team members (you

can remove them later), or just stick with yourself for now

o

Paste this in as the Description: Follow the progress of the brave Teams in Space astronauts as they

embark on their mission to colonize Mars.

Great! You now have a team space, again with its own home page. This home page is a little different to the
project space and your personal space — you'll see any team members you added, listed on the home page.

Space name’
Space ke

Team members

Description

Create team space

Mars PR

y"  MPR

) Cassie Owens = ) Ryan Lee =
& Emad Abdi x @ Emma McRae x

Follow the progress of the teams in space
astronauts as they embark on their mission
to colonise Mars

About team spaces

Share knowledge and collaborate on
projects, processes and procedures with
your team. They will be notified abaut this
space and all updates. Team members will
be granted permissions and added as
waltchers of the space.

Back [ -EIEW Close

Each space you create also has its own blog, so your social media team will be able to create posts in this
space and speak directly to all those adoring fans. But none of those fans can see this space. Yet.

Allow anonymous access

It's time to let the world in by changing the permissions on this space.

1. Choose Space tools > Permissions from the bottom of the sidebar
2. Scroll down until you see Anonymous, then hit Edit Permissions

3. Tick the View permission for anonymous users and hit Save all
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That's it. You can now share the space's URL, which will be http(s)://<your_confluence_site>/display
/MarsPR. Visitors to that space don't need to log in, or have a license for Confluence.

Next
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Delete and archive spaces

1. Create a project space

2. Create your personal
space

3. Create the team's PR
space

4. Delete and archive
spaces

We hope you've had a successful mission, and learned a bit about the power and versatility of Confluence
spaces. Flash forward 18 months, and just look how well the colony is coming along!

If you need to clean up old spaces (or destroy the evidence of a failed mission!), you can either archive or delete
a space. Archiving just means it won't show up in the regular search, whereas deleting is obviously a lot more
permanent.
To archive a space:

1. Choose Space tools > Overview from the bottom of the sidebar

2. Click Edit Space Details

3. Change the Status from 'Current' to ‘Archived' and hit Save
To delete a space:

1. Choose Space tools > Overview from the bottom of the sidebar
2. Select the Delete Space tab

What next?

If you'd like to know more about spaces and the permissions that govern them, check out Spaces and Permissio
ns and restrictions in the Confluence documentation.

Teams in Space HQ, signing off.



Spaces

What is a space?

On this page:
Spaces are Confluence's way of organizing content
into meaningful categories. Think of it like having ® Whatis a space?
different folders into which you can put your work. ®* How do | use a space?

Related pages:
Spaces come in two main varieties:

¢ Create a Space
* Site spaces — These spaces are found in the ® Space Permissions Overview
Space Directory and are the areas where * Navigate Spaces
you create content and collaborate with ¢ Organize your Space
others. They are sometimes called global : ’CAZ\usg_omlzeSyour Space
spaces. rcnive a space
* Personal spaces — Every Confluence user * Export Content to Word, PDF, HTML and
can set up a personal space which they can . XML
keep private or make public so others can Delete a Space

view and edit. Personal spaces are listed in
the People Directory and found under your
personal profile.

How do | use a space?

Create as many spaces as you need to get things done:

® Team spaces — Give each team (QA, HR, Engineering, Support, ...) their own space so they can
focus and make their information easier for everyone to find.

® Project spaces — Put all the information related to your project in one place. This allows everyone to
work together in Confluence instead of emailing back and forth.

® Personal space — Store everything you're working on individually, keep your to-do lists, and polish
any content before you move it into another shared space.
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Global

Dashboard

Spaces —
°

Dev team

E.{ 'H

Pages

I 331 E»-"; lH

Homepage

Child pages

Stay up to date with spaces

® \Watch a space to stay up-to-date with any changes.
® Add important spaces to your dashboard so that they're easy to find again.

Administer spaces
If you have admin permissions for a space you can:

® Change the colors, logo, sidebar and homepage of that space.
® Control who can view and edit your space.
® Make your space public to share it with people who don't have access to Confluence.

Space Permissions
Some things we should make clear about space admin permissions:

® The person who creates a space automatically has admin permissions for that space.

® Space admins can grant admin permissions to others.

® Space admins don't have to be Confluence admins and can have special permissions for a single
space. For example, you are the admin for your personal space, no matter what kind of access you
have anywhere else.

Want more ideas for using spaces? Check out our kickass guides on how to:

Use Confluence as a Knowledge Base

Develop Technical Documentation in Confluence
Use Confluence as your Intranet

Use Confluence for Software Teams

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/
https://confluence.atlassian.com/display/CONF74/Organize+your+Space#OrganizeyourSpace-my

Confluence 7.4 Documentation

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

Create a Space

There's no limit to the number of Spaces you can create on Confluence.
You can choose to set up a space for each team, project, or a mix of both On this page:
depending on your needs.

Each space in Confluence functions autonomously, which means that each ¢ Create a personal
space: space
® Create a site space
® Has its own homepage, blog, pages, comments, files, and RSS ® Space permissions
feeds. ® Linking related

® Can be customized with different color schemes, logo and sidebar. Spaces

® Has its own set of permissions, as set by the space admin. ® Tips
For example, an IT team can create one overarching space with all their roa Related pages:

dmaps, details of sub-teams, and a list of all the people and roles within that
team. They could then create a new space for each sub-team, such as
Quality Assurance, Developers, and Documentation, with guidelines, long
term plans, and knowledge articles within them. Each project that these
teams work on could also have its own space, which could be linked to the
team spaces using labels.

® Spaces

® Space Keys

® Create a Space
From a Template

Create a personal space

Your personal space is always owned by you, and you can use it to store
your individual work, keep track of tasks, blog about what you've been
working on, or just use it to polish your pages before you move them into a
site space.

1. Choose your profile picture at top right of the screen, then choose Add Personal Space..
2. Choose Create.

You can change the permissions for your space at any time to determine who can and can't access the
content. So if you want it to be a private sanctuary, that's no problem.

@ To create a personal space you need the 'Personal Space' global permission.

Create a personal space

With a personal space, you can...

1 Stay organised 2 Share news 3 Introduce yourself
Keep your notes, task lists, files Use your blog to make Customise your personal
and other personal content announcements, capture ideas hemepage and introduce
organised. and share learnings. yourself to the team.

Back Create [E=LES

Create a site space

You can create a site space for any team or project that would benefit from having a place where people can
work together and store related files. You can create these as blank spaces, or use templates, called space
blueprints , to help you create Team spaces, Knowledge Bases spaces, or Documentation spaces quickly
and easily.

1. Hit Spaces > Create space in the header.
2. Pick a type of space.
3. Enter the required details and create your space.
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1. Choose your space key carefully as you can't change this later.

Each space you create will automatically have a home page that you can customize to display relevant
information for people viewing the space. If you use a space blueprint when creating a space, it will
customize your home page for you.

@ To create a site space you need the 'Create Space' global permission.

Create team space
Space name”  Marketing Team About team spaces
Space key'  MARKETING & Share knowledge and collaborate on
T B projects, processes and procedures with
Ttk b (D Cassic Owens x @ Emad Abdi x your team. They will be notified about this

space and all updates. Team members will

& Emma McRae »

- be granted permissions and added as
4 Harvey Jennings *

watchers of the space.

Description  This is the space for all things marketing

Back m Close

Space permissions

Each space is created with a set of default permissions. The user who created a site space is automatically
granted 'space admin' permissions for that space, which means that they can then grant permissions to
other users and groups. See Space Permissions Overview for more information.

@ System Administrators can edit the permissions of spaces in their Confluence site at any time.

Linking related spaces

You can link related spaces together using labels. This will create categories in the space directory for each
label, grouping all spaces with that label together.

Space Directory ® Create Space
Al Spaces Knowledge-bases
Site Spaces Space Deseription Categories
N s fEanal Branas " <
Personal Spaces ﬁ’ IT Knowledge Base knowledge- @
" bases
My Spaces
Archived Spaces z Marketing Knowledge base This is the space for all things ggg:‘;ﬁdge- @
marketing
CATEGORIES : o : ! .
Hint: Your space administrator can organise spaces into categories, Learn mare.
Knowledge-bases

® You can also add a space description to make it easier for visitors to find the right space within each
category.

® To help navigate between related spaces, you can use the Spaces List Macro on a page and filter by
category. This will let you insert a list of all the other spaces in a certain category into your space. You
can use this, for example, to keep a list in your team space of all the project spaces your team is
working on.

® If you want to link to only certain pages of related content, rather than whole spaces, you can use the
Content Report Table Macro. You can use this, for example, in a space that functions as a workplace
directory, to create a list of all the team pages with everyone's roles and contact details across your
organization.
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Tips

® |f your needs change, or your spaces grow too big, it's easy to copy or move content from one space
to another.

® |If the content or purpose of your space changes, you can update the space name, logo, colors and de
scription to reflect those changes.

® |f you no longer need a space, such as when a project has been completed, you can archive it, which
makes it less visible but retains the content on your site so that you can still refer back to it later.
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Create a Space From a Template

Confluence comes with a number of templates, known as space blueprints,
which have a customized homepage and sidebar, and may contain page
blueprints or sample content to help you get started. * Create a Space

Related pages:

@. This page is about space blueprints. You can also use Blueprints to
create individual pages.

@ Your Confluence administrator can customize or disable particular
blueprint templates, so they may be different to the examples shown here.

Types of space blueprints
Team space

A great building block if you are using Confluence as an intranet or to manage teams. Team spaces highlight
the members of the team, and grants permissions to those users accordingly.

Knowledge base space

This space blueprint uses search and page labels to make content easier to find, right from the space
homepage. It also contains two page blueprints for creating how-to and troubleshooting articles. The
templates used in these page blueprints are completely customizable. The Knowledge Base space blueprint
also Use Jira applications and Confluence together.

Documentation space

This space blueprint displays the full page tree in the sidebar and hides other sidebar features including
blogs and shared links. The homepage uses search and page labels to make content easy to find. Add the
‘featured' label to any page you want to highlight on the homepage. This space does not include any page
blueprints but you can create and promote templates for your documentation authors to use.

Software project space

This space is designed to help you organize your software project. The purpose-built space home page lets
you view and edit your roadmap, see team members, and Use Jira applications and Confluence
together#JIRA Software. Create pages in this space for requirements, meeting notes, decisions, retros, and
more.

@ The software project space blueprint will only appear if you have linked Confluence to your Jira Software
instance.

Filter Help
Create space :
Blank space e ; Y Personal space
Start with a blank space. ‘4 Keep your notes, task lists and other content
organised.
P Documentation space ) Knowledge base
'.Ii‘r Create and manage technical documentation L’ Capture and share best practices and
for your praducts solutions to commaon problems.

7o Team space
L';." Collaborate and share resources with your
team.

- L
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Check out our guides for some more tips on how to:

Use Confluence as a Knowledge Base

Develop Technical Documentation in Confluence
Use Confluence as your Intranet

Confluence for Software Teams
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Space Keys

Each Confluence space has a space key, which is a short, unique identifier

that forms part of the URL for that space. Related pages:
Create team space ® Create a Space
ame” | Marketng Team About team spaces ® Create a Space

" MARKETING @

From a Template

rs (P Cassie Owens * @ Emad Abdi x
& Emma McRae x
i Harvey Jennings »

watchers of the space,

Description  This is the space for all things marketing

When you create a site space, Confluence will suggest a space key or you can enter your own key to make
it more memorable.

For example, you might give your marketing team's space a key of MARKETING. You can then navigate
directly to the space using a URL like this - ht t p: / / <your si t e>/ di spl ay/ mar ket i ng

@ Personal spaces always use your username as the space key.

Choosing a space key
Each space key:
® Must be unique.
® Can contain any alphanumeric character (a-z, 0-9).

® Can be up to 255 characters long.

i. You can't change the space key after you create your space, so choose your space key carefully!



Navigate Spaces

How is content arranged in spaces?
On this page:
Think of a space as the container that holds all the important stuff a team,
group, or project needs to work. These are autonomous — that means that
each space has its own pages, blogs, files, comments and RSS feeds.

® How is content

arranged in
. . . ' . spaces?
Each space is automatically created with a homepage - the first page you'll * View all spaces in
see when you navigate to the space. You can edit your homepage and your Confluence

sidebar to help people navigate their way around your space.

- Related pages:
Spaces can't be nested — you can't have a space within a space — but you Pag

can Use Labels to Categorize Spaces. Spaces with the same label will * QOrganize your
appear together in the the space directory and in the recent activity area of Space
the dashboard. ® Watch Pages,

Spaces and Blogs
® Pages and blogs
® Search

Inside the space, you can nest your pages, and you can create as many levels of hierarchy as you need.
Each space also has its own blog, which lets you share news and make announcements. Blog posts are a
great way to keep people involved in what's going on in your team or project.

You can set different levels of access for each space, and the pages and blogs within it, using Space
Permissions Overview.

project

D_
2
D__
IIIII |

] — [ -
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0
®

JEaEE

g
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0

View all spaces in Confluence
There are two main ways to view spaces in Confluence:

® The space directory — choose Spaces > Space directory in the Confluence header for a list of all
the site and personal spaces you have permission to see. Filter the list of spaces by selecting from
the categories on the left of the space directory.

® The dashboard — you can make your most useful spaces appear under My spaces on the
dashboard. Choose the star icon in the space sidebar or space directory to add a space to My spaces.
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Spaces v  People Create ---

RECENT SPACES

' Dev team

& Marketing Knowledge base
& Teams in Space

@@ Social

® |T Knowledge Base

Space directory

Create space

The spaces menu in the header also displays a list of your recently viewed spaces, allowing you to quickly
navigate to the things you view most often.

The Spaces List Macro allows you to display a list of spaces on a Confluence page, and lets you filter them
by category.

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

Space Permissions Overview

Every Confluence space has its own set of permissions which determine
what people can do in the space.

Related pages:

® Confluence Groups

Space permissions are set by the space administrator. The user who * Assign Space
created the space is automatically a space administrator, and other users Permissions
can also be granted Space Admin permission. * Page Restrictions

® Global Permissions
Overview

(¥) This page is about Space Permissions. Confluence also lets you set Page Restrictions.

Edit space permissions

To change permissions for a space, choose Space tools > Permissions from the bottom of the sidebar,
then choose Edit Permissions to change permission settings.

See Assign Space Permissions for more details.

Permissions Summary
The following permissions can be assigned in a space:

Category

All

Pages

Blog

Attachmen
ts

Permission

View gives you permission to access the content in this space, and see it in the space
directory and other places like the dashboard.

Delete own gives you permission to delete any pages, blogs, attachments and comments
you've created in this space (regardless of whether other users have subsequently edited the
content).

Add page gives you permission to create new pages and edit existing pages in this space
(assuming the page is not restricted for editing).

Delete page gives you permission to delete any page in the space.

Add blog gives you permission to create new blog posts and edit existing blog posts in this
space (assuming the blog post is not restricted for editing).

Delete page gives you permission to delete any blog post in the space. Delete permission is
also required to move a page or blog to a different space.

Add attachment gives you permission to upload (attach) files to pages and blog posts in this
space.

Delete attachment gives you permission to remove attached files from pages or blog posts
in the space.

People with only Add page or blog permissions can still insert existing attached files in the
editor, and remove files from the editor, so they're not displayed on the page or blog post.
They can't however upload a new file, a new version of the file, or delete the attached file

itself.
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Comments = Add comments gives you permission to add comments to a page, blog post or attached
file.

Delete comments gives you permission to delete any comment on a page, blog post or
attached file.

Restrictions' Add restrictions gives you permission to apply page-level restrictions to a page or blog
post. You can restrict a page for viewing, or just for editing.

Delete restrictions gives you permission to remove restrictions from any page or blog post.

Mail Delete mail gives you permission to delete mail items that have been archived in this
space. This is not a commonly used feature.

Space Export space gives you permission to export all the contents of the space to PDF, HTML or
XML. This is different to single page exports - anyone who can view a page can also export it.

Admin gives you permission to access all space administration tools, including things like
permissions, templates, look and feel, and the ability to delete the whole space.

Here's how it looks on the Permissions screen:

All Pages Blog Attachments Comments Restrictions  Mail Space

View Delete Add Delete Add  Delete  Add  Delete  Add  Delete  Add/Delete Delate  Export  Admin
Own

atlassian-staff ] e ©®© © © © © B © o -] ] (] <]
confiuence-users [-] [ =] [-] [ =] (-] B [-] [ x | [ -] a [ x | a [-] a

How space permissions work

Space permissions are additive. If a user is granted permissions as an individual or as a member of one or
more groups, Confluence will combine these permissions together. This is sometimes known as their
effective permissions.

Sasha is a member of the conf | uence- user s group and the devel oper s group. The conf | uence-
user s group has 'export' permission, but does not have 'restrict' permission. The devel oper s group
has 'restrict' permission but does not have 'export' permission.

By being a member of these two groups, Sasha can restrict and export content. The permissions do not
conflict, they combine to determine what Sasha is allowed to do in this space.

If you have Confluence Data Center, Inspect permissions provides space admins and Confluence
administrators a great way to view someone's effective permissions.

Who is the space admin?

The user who created the space is automatically a space administrator, and other users can also be granted
Space Admin permission.

To find out who is an administrators in your space, either:
® Go to Space Tools > Overview in the space.
® Go to Spaces > Space Directory on the header, then choose theSpace Details icon beside the

space.

If you accidentally deny all admin access to a space, so that nobody has access to administer the space any
more, you can ask someone with Confluence Administrator global permission to recover Space Permissions.

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

Confluence 7.4 Documentation

Space admin superpowers
Space administrators can do a lot of things in the space such as:

grant permissions to users and groups (and themselves)

create templates

change the look and feel

delete the space

manually remove page restrictions (including on pages they can't see)
manage watchers, to change who is watching a page

inspect permissions to see what users can do in the space (Data Center only)

Confluence administrators aren't necessarily space administrators. If they don't have the Space Admin
permission (as an individual or member of a group), they can recover permissions to the space, which will
grant them space admin permission.
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Assign Space Permissions

If you are the administrator of a space, you control the permissions for it.
You can choose to assign/revoke permissions on either an individual user On this page:
basis, or using Confluence Groups.

® Grant space

(¥) Want to know the best way to set permissions for your team's permission
needs? Check out our Permissions best practices guide. ® Set default space
permission for all
. h . ¢ ) new spaces
To view the permissions for a space: * Revoke space
permissions

1. Go to the space and choose Space tools > Permissions from the
bottom of the sidebar

2. Choose Edit Permissions.

Inspect permissions
® Manage and

recover space

admin permissions
The Edit Space Permissions page is divided into the following sections:

Related pages:

® Space Permissions
Overview

® Global Permissions
Overview

®* Make a Space
Public

® Give Access to
Unlicensed Users
from Jira Service
Desk

® Licensed Users - this is where you grant permissions to groups and individual users.

® Anonymous Access - this is where you grant permissions to users who are not logged in (essentially
making the space public). Note: allowing anonymous access in a space will allow all logged in users
to see that space, even if your site is not Public.
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Permissions  Restricted Pages

Licensed Users

Groups
Grant permissions for this space to all the members of a group
All Pages Elog Attachments Comments Restrictions  Mail Space
View Delete Add Delete Add Delete Add Delete Add Delete Add/Delete Delete  Export Admin
Own
confience: @ @ © @ © @ © B © B [+ B o @
users
developers @ e 6 66 0 6 o o o o o a o [ ]

Edit Permissions

Individual Users

Grant permissions to individual users, regardless of which groups they are a mamber of.

All Pages Blog Attachments Comments Restrictions  Mail Space
View Delete Add Delete Add Delete Add Delete Add Delete Add/Delete Delete  Export  Admin
Owin
Rach L] e © © o © © © o © o @ @ o
Admin
{admin)

Edit Permissions

Anonymous Access

If your Confluence site is pu

blic, you cén grant permissions to people who are net logged in. Anonymous users can be granted almast any
permission, but we

commend you limit this to viewing and commenting

All Pages Blog Attachments Comments Restrictions  Mail Space
View Delete Add Delete Add Delete Add Delete Add Delete Add/Delete Delete Export Admin
Own
Anonymous [ 8 B 8 8 B B a @ @B a %] %] a

Edit Permissions

Grant space permission

To add a new user or group to the permissions list:

1. Search for either a group or user in their respective sections and choose Add. The group or user will

appear in the list.
2. Select the specific permissions you'd like to apply then choose Save all.

You can bulk assign or revoke permissions by selecting Select All or Deselect All.

Default Space Permissions # Edit Permissions
These are the default permissions that will be assigned to groups when someone adds a new space. The ‘confluence-administrators’ group
always has all permisslons for all spaces, and any permissions set for it here will be ignored.

All Pages Blog Attachments Comments Restrictions  Mail Space

View Delete  Add Delete Add Delete Add Delete Add Delete | Add/Delete

Delete  Export  Admin
Own

confluence-

e © @/ B © B 06 B o @8 B 8 o @

Permissions are managed on a space by space basis. Your Confluence Administrator is able to set default

space permissions, which will apply to any new spaces.

Set default space permission for all new spaces

If you regularly need to grant permissions to the same groups each time a new space is created, you should

consider updating the default space permissions.
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To set the default space permissions:

1. Goto E > General Configuration > Space Permissions.
2. Choose Edit Permissions.

Default permissions are configurable for groups only, not for individual or anonymous users.

Revoke space permissions

To remove a user or group from the space permissions list, deselect all the checkboxes for that user or
group and save the changes. The user or group won't appear in the list once you save.

Inspect permissions

If you need to troubleshoot why someone can or can't do something in your space, and you have a Data
Center license, you can inspect permissions. See Inspect permissions for more information.

Manage and recover space admin permissions

If you're a Confluence Administrator you can recover permissions to a space. This is useful when the only
person with Space Admin permissions to a space leaves your organisation, for example.

To recover Space Admin permissions:

1. Goto E > General Configuration > Space Permissions.
2. Locate the space in the list of individual spaces and choose Recover Permissions.

You can then choose Manage Permissions, and add any other appropriate permissions to the space.
Requests to recover permissions are recorded in the Confluence audit log.

People with System Administrator permissions are able to manage permissions for all spaces, they do not
need to first recover permissions.

Individual Spaces

These are the current wiki spaces.

Name Key Operations

Dev team DT Manage Permissions
IT Knowledge Base IKB Manage Permissions
Marketing Knowledge base MKE Manage Permissions
Social soc Manage Permissions
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Make a Space Public

If your site is public, and you want to share your space with people who are

not logged in to Confluence (anonymous users), you can make your space Related pages:

public. * Give Access to

) ) ) Unlicensed Users
Making a space public does not let you choose who you want to share it from Jira Service
with — a public space can be viewed by anyone inside or outside of your Desk

organization.

@. In order to make a space public, your administrator must first turn on the global permission for
anonymous access.

This permission doesn't automatically grant anonymous users permission to see any of the spaces
on your site, that is done on a space by space basis.

To make your space public:

1. Go to the space and choose Space tools > Permissions from the bottom of the sidebar.

Choose Edit Permissions.

3. Scroll down to the Anonymous Access section and select the specific permissions you'd like
anonymous users to have.

4. Save All to apply the changes.

N

Anonymous Access

f your Confluence site i o are not logged in. Anonymous users cen be granted aimost any

permission, but we r
All Pages Blog Attachments Comments Restrictions  Mail Space

View Delete Add Delete Add Delete Add Delete Add Delete Add/Delete Delete | Export  Admin
Own

Anonymous
Select Al

m Cancel

You can't grant space administration or page restriction rights to anonymous users. You can grant Delete
Own, but it will have no effect, as we have no way of knowing who an anonymous user is.

What happens when the site is not public?
If your Confluence administrator turns off anonymous access to your site, users who are not logged in will no

longer be able to see any spaces. However, all logged in users (regardless of their group membership) will
be able to see all spaces that have granted space permissions to anonymous users.

Auditing considerations

There are some additional things to be aware of if you grant the Add page permission to anonymous users.
You won't be alerted, when closing the editor or publishing a page, if the only unpublished changes on the
page were made by anonymous users. This means a logged in user may inadvertently publish changes

they were not aware had been made to the page.

The changes themselves are visible in the page, but the usual warning dialog will not appear if the only
people to have made changes were not logged in.
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If there are unpublished changes from both logged in users and anonymous users, the warning dialog will
appear, but only the logged in users will be listed in the dialog. Changes made by all users (including
anonymous) will be included if you view the changes from that dialog.

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

Give Access to Unlicensed Users from Jira Service Desk

If you're using Confluence as a knowledge base for Jira Service Desk, you

can choose to allow all active users and customers (that is, logged in users Related pages:

who do not have a Confluence license) to view specific spaces. This can

only be turned on via JIRA Service Desk. * Make a Space
Public

When a space is accessible to all active users, you'll see the following
message in the space permission screen.

Permissions = Restricted Pages

" Any active user can view this space

Any active user can view pages in this space, including users who don't have a Confluence license. This wi
enabled through JIRA Service Desk so people can view knowledge articles when raising a help request.

Edit this permission

@ This permission overrides all existing space permissions, so any logged in Confluence user will also be
able to see the space (regardless of their group membership).

You can edit this permission at any time to revoke access to a space, but it can only be re-enabled from Jira
Service Desk.

Active users who don't hold a Confluence license have very limited access to Confluence. They can view
pages, but can't like, comment, edit, view the dashboard, use the space directory, see user profiles or
search your full site.

See Use Jira applications and Confluence together for more information about Jira Service Desk integration.
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Organize your Space

Here's a few tips that'll help you organize your
space so that everyone can find what they're On this page:
looking for and stay on top of what's important to

them.
® How do | organize content within my

space?
® Pages and blogs
® Configure the sidebar

5 @ _ L
R 7 @ @ @ * Using labels
Fle L e g I ® How do | keep my space tidy?
| i {f} * Create a set of guidelines
@ _______ - i ® Use page blueprints
i B @zujﬁr_ﬁ ® Create from template macro
m _____ @ - ® Create your own page templates

® How do | help my team stay on top of
what's important?

My Spaces

Save for later

Watch a page, blog or space

@mentions

How do | organize content within my space?

Pages and blogs

Everything you create in Confluence, from meeting notes to retrospectives and everything in between, takes
the form of either pages or blogs.

® Your homepage will be the first thing that visitors to your site see, so to help them find relevant
content, start by curating your homepage with useful macros and including information about what is
in your space. See Set up a Space Home Page for more information.

® |f you're creating content that is specific mainly to the current time-frame, and isn't going to change
over time, create it as a blog post. Your blog displays as an infinite scroll, so it surfaces the latest
news and visitors just need to scroll down if they're interested in older content.

® |f you're creating content that you want to last, and possibly evolve over time, then create it as a page.
Pages nest, so every page can have its own child pages, which lets you organize your content into
categories and subcategories.

Configure the sidebar
You can Configure the Sidebar to make it easier to navigate through your space.

The space shortcuts section of the sidebar lets you link to important content. You can use this to highlight
pertinent pages within your space, related content from other spaces, or to external content that is relevant
to your space.

The navigation display lists the pages in your space in either a page tree or child pages format. If you only
want some content to be visible in the sidebar, you can hide the navigation display and put the pages you
want to remain visible under Space shortcuts instead.
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4 4 : : :
® s Beginner's guide to Confluence *

F Pages

99 Blog

SPACE SHORTCUTS

F Tag your space with labels
B Groups of users

F] Emergency contacts

PAGE TREE

* Get started in 5 steps

*» When to create a space?

v What should you put in your space?

» Make your content easy to find

The page tree in the sidebar shows the 200 pages closest to where you are. Hit Show all pages, if you want
to see all the pages in a space.

Using labels
Labels are keywords or tags that you can add to pages, blog posts, and attachments.

® Define your own labels and use them to categorize, identify, or bookmark content in Confluence. For
example, if you assign the label ‘accounting' to all accounts -related pages on your site, you'll then be

able to:
® Browse all pages with that label in a single space or across the site.

® Display a list of pages with that label.
® Search based on that label.
® Use theContent by Label Macro to create a table of contents for your space that is organized by label

categories.
® Labels aren't exclusive, so you can have as many labels as you want on a page. The page will then
appear under each of those categories. See Use Labels to Categorize Spaces for more information.

How do | keep my space tidy?

If you have lots of people creating in the same space, things can get messy fast. You can prevent this by
taking a few easy steps.

Create a set of guidelines

® | et your collaborators know about what parent pages to create their child pages under, so no content

gets lost or misplaced.
® Decide on standard labels to add to pages, blogs, and attachments so all content gets neatly

categorized.
® Add a link to this in the Space Shortcuts section of the sidebar so that it's easy to find.

Use page blueprints
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Blueprints are templates that come with formatting, macros and sample content. You can customize these
Blueprints for each space. Everything created from a Blueprint will have it's own index in the sidebar, so for
example if you use the Meeting Notes Blueprint, you can select 'Meeting Notes' in the sidebar to see a list of
all the meeting notes in your space.

Create Filter Help

Select space Beginners guide to Confluence Parent: Baginners guide to Conflu..

ﬁ' Deacision
4 Record important project decisions and
communicate them with your team.

DACI decision
Define the roles and respansibilities for
making high-impact or high-risk decisions.

&

Experiance canvas
Make sure your work is user-centered,
technically sound, and makes sense for the

Haalth monitor

Fila list
Upload, preview and share files with your
team.

How-ta article

Keep track of your project or team's health. Provide step-by-step guidance for

completing a task.

Jira raport

Fmamar imlmata

Meating notes
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Add or customise templates for the salected space

Create from template macro

Make things simpler for other contributors by using the Create from Template Macro. The Create from
Template Macro lets you put a button on a page that links to a specific template of your choice. When the
button is clicked, the macro opens the editor, ready to add a new page, and adds content to that page based
on the given template.

Create your own page templates
Create your own templates for any content that you want formatted the same way every time. For example, if
you have to create a regular report tracking the same criteria, create a template with headings, variable

dates, tables, and spaces for any graphics, so that each time all you have to do is input the new data instead
of creating the whole report from scratch.

How do | help my team stay on top of what's important?

If you've got a lot of content on Confluence, staying on top of everything may seem a little daunting — but
these features will help your team save and track all the content they care about.

My Spaces

Add any spaces that you want to be able to navigate to easily to your list of ‘My Spaces'. This list can be
found under your dashboard and in the Space Directory, and you can also use the Spaces List Macro to
display it on a page or blog.

To add a space to your list of 'My Spaces', either navigate to that space or find it under the Space Directory,
and select the star icon next to the Space Name. To remove it from the list, just select the star icon again.
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MY SPACES ALL

.‘: Beginner's guide to Confluence
# T Knowledge Base
" Dev team

k! Teams in Space

Save for later

If you only want links to certain pages or blogs rather than a whole space, you can choose Save for later and
these will appear on your dashboard and under your profile. You can use the Favorite Pages Macro to
display a list of all of everything you've saved for later.

& Edit ¥¥ Save for later ® Watch <5 Share

Watch a page, blog or space

If you want to keep track of all the changes made to a page, blog, or space, you can also watch them.
Watching any content means that you will receive email notifications for all edits, deletions, attachments or
comments made to that content.

® To watch a page, navigate to the page you want to watch, then choose Watch > Watch page, or if
you want to watch the whole space, select Watch all content in this space.

® To watch a blog, navigate to that blog and choose Watch this blog.

® To stop watching something, deselect the relevant checkbox.

You can also manage watchers for your own space. This is useful when, for example, you're creating a new
project, and want the team members on that project to stay notified of its progress. Go to any page in that
space and choose Watch > Manage Watchers, then add or delete any names under 'Watching this space'.

# Edit v¥ Save for later © Watching < Share

You are watching this page

Receiving email updates about changes to this
page.

Watch page

Watch all content in this space

Manage Watchers

@mentions
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Use @mentions for any work where you need someone else's input or want to assign someone a task.
Mentioning someone works like a tag; they'll immediately receive a notification that they've been mentioned,
and can click through to that page or blog. If you mention someone when creating a task, it'll assign that task
to them and they'll also be able to find it under their profile.

You can use this in place of emails — if you want someone to look something over, add in additional
information, or approve anything, simply put that work on Confluence and assign it to them as a task. They'll
be able to make any changes or comments within Confluence and let you know when they're done by
mentioning you back.
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Set up a Space Home Page

When you create a space, Confluence automatically

creates a home page for that space. Spaces On this page:
created with a blueprint come with a ready-made

home page populated with useful macros and

sample content specific to the blueprint's use case.

However, even if you've started with a blank space,
you can still customize your home page to make it

Create a kick-ass home page

Top macros for common types of spaces
Set up your personal space home page
Set another page as your home page

easier for everyone using that space to navigate
their way around and find useful content. Related pages:

® QOrganize your Space

Create a kick-ass home page

What is this space about?

Your home page is the first page visitors will see when they visit your space, so it helps to include
some information about what the space is about, and what you're working on. You can use the Info,
Tip, Note, and Warning Macros to create a colored box in which to put this information.

What is in this space?

You can use the Content Report Table Macro to create a table of contents for your space. You can
also set this macro to only display content with a particular label, so if you would like only some
content to display, you can do this by adding that label to only those pages and blogs you want listed
on your home page.

Organize your space with labels

You can organize content in your space with labels, so that for example, if you have a Learning and
Development space, you can create different labels for online learning resources, upcoming
workshops, and training strategy. You can then use the Labels List Macro to create a list of those
labels to make it easy for visitors to your space to find the content relating to each of those topics.

Add a search box so that it's easy to find content within your space
The Livesearch Macro allows you to add a search box to a Confluence page, and you can set it to
only find content within your space.

Keep everyone updated about the latest changes within your space

If it's important for your visitors to know about the latest changes to your space, you can use the Rece
ntly Updated Macro to display a list of the most recently updated content. You can set the space
parameter to show this for just your space, or, if you have related spaces, to show the most recently
updated content across all of those spaces as well.

Using Jira? Create and display your Jiraissues on Confluence

If your Confluence site is connected to a Jira application, you can both create and display your Jira
issues without having to leave Confluence using the Jira Issues Macro. You can connect Confluence
to any Jira application, including Jira Software and Jira Service Desk.
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Top macros for common types of spaces

Team Spaces:

® Introduce the team: The User Profile Macro displays a short summary of a given Confluence user's
profile with their role, profile photo and contact details.

® Share news and announcements with your team: The Blog Posts Macro displays a stream of your
latest blog posts so your team can easily see what's been going on.

Knowledge Base:

® Have external content that you need on your page? Embed online videos, slideshows, photo
streams, and more, directly into your page with the Widget Connector Macro.

®* Put your own multimedia content onto the page: The Multimedia Macro embeds attached video,
animation, and other multimedia files on a Confluence page.

® Create an index of all your content: The Page Index Macro creates a hyperlinked alphabetical
index of all page titles within the current space.

Planning/Project:

® Keep track of everyone's tasks: Use the Task Report Macro to display a list of tasks on a page.
Filter the tasks by space, page, user, label, created date and more.

® |s your project on track? The Status Macro displays a colored lozenge (a rounded box) that is
useful for reporting project status. You can choose the color of the lozenge and the text that appears
inside the lozenge.

® | et everyone see where you're going: The Roadmap Planner Macro creates simple, visual
timelines that are useful for planning projects, software releases and much more.
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Using Macros

1. From the editor toolbar, choose Insert T = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested
macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro
details, so you can edit the macro parameters.

Edit Remove

Set up your personal space home page

Whether you're using your personal space as a sandbox to draft and test content, a portfolio to show off
what you're working on, a home base to navigate to your content in other spaces, or something completely
different, these are some macros that should help you use your space more effectively.

® Use the Favorite Pages Macro to create a list on your home page of all the pages you've saved for
later, so you can easily navigate back to any of them.

® Use the Content by User Macro to keep track of all the current pages, comments and spaces you've
created so you can find everything you've been working on in one place.

® Use the Task Report Macro to keep track of all tasks assigned to you, and tick them off as you finish
them.

® Use the Recently Updated Dashboard Macro to keep track of all the content across your Confluence
site that you're interested in - the Dashboard lets you choose which spaces, users, blogs, pages or
files you would like to keep updated about.

Set another page as your home page

If at any point you decide that you would like another page within your space to be your home page, you can
easily change this from the Edit Space Details tab.

To edit a space's detalils:
1. Go to the space and choose Space tools > Overview from the bottom of the sidebar.

2. Choose Edit Space Details.
3. Enter the page you want use in the Home page field then choose Save.
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Space Details Delete Space

Edit Space Details

Name:  Beginner's guide to Confluence

Description: A few simple tips to help you on
your way to becaming a Confluence
expert.

Rl g

Status: Current

Home page: Beginner's guide to Confluence Homr

The page that displays when users navigate to this space.

o

i. You can change the home page, hame and description of your space, but you are not able to change the
space key.
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Use Labels to Categorize Spaces

If you've got lots of related spaces, you can use labels to group them
together into categories in the Space Directory.

For example, if you're in an IT team who work on a number of projects,
each in a different space, you could label each space 'IT-projects-open'.
Then in the Space Directory you could select IT-projects-open to see all
your current IT project spaces.

You can add as many space categories to a space as you need, so that if,
for example, two different teams are working on a project together, you can
add labels for both teams and space will appear under both categories.

Labels are easy to add or remove, so if your needs change, you can always
recategorize your spaces.

Categorize a space

You need space administrator permissions to add categories to a space.

On this page:

® Categorize a space
® View spaces in a

category
Remove a space
from a category
Search within a
space category

Related pages:

Add, Remove and
Search for Labels

1. Go to the space and choose Space tools > Overview from the bottom of the sidebar

2. Choose Edit next to Space Categories.

3. Under Space Categories, enter your category name and choose Add.

Alternatively, choose a category in the list of Suggested Space Categories.

4. Choose Done.

Add a space description

Help make it easier to find the right space within a category by adding a description to your space:

1. Go to the space and choose Space tools > Overview from the bottom of the sidebar.

2. Choose Edit Space Details.

3. Under the Description field, type a short description to tell visitors what your space is about, then

choose Save.

View spaces in a category

To see what spaces are in a category, choose Spaces > Space directory in the Confluence header, then

select one of the categories from the list.

Space Directory

marketing bas0s

CATEGORIES ) ' i :
Hint: Your space administralor can organise spaces into categories, Learn maore.

Knowledge-bases

Al Spaces Knowledge-bases

Site Spaces Space Description Categaries

S P 4

Personal Spaces é IT Knowledge Base knowledge-
. bases

My Spaces

Archived Spaces z Marketing Knowiedge base This is the space for all things knowledge-

®y Create Space
s p

You can also view spaces by category by using the Spaces List Macro and filtering by category.
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@ Head to My Spaces in the Space Directory to see all your favorite spaces. When viewing a space,
you can choose the star icon next to the space title in the sidebar to add it to My Spaces so that it's
easier to find later.

Remove a space from a category
1. Go to the space and choose Space tools > Overview from the bottom of the sidebar

2. Choose Edit next to Space Categories.
3. Under Space Categories, choose the x icon next to each category that you want to remove.

Space Details Delete Space

Categories

Space Categories will appear inside the categories tab on your dashboard and as
tabs in the space directory. They can be used to group together related spaces.

Labels
help X knowledge-bases x

Add

1. If you remove all spaces from a category, the category will no longer appear in the Space Directory.
There's no way to bulk remove a category, but you can choose the category in the Space Directory to find all
the spaces it appears on, and then remove it from each space.

Search within a space category
You can search for content within a specific space category using the search filter.
To search within a Confluence space category:
1. Click the search field in the top-right of Confluence to open the search panel.
2. Click the Space category filter on the left.

3. Start typing the category name and choose from the list of possible matches.

Learn more about searching Confluence.
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Customize your Space

Make your space stand out from the crowd by Related pages:
customizing its appearance.

o ® Changing the Look and Feel of Confluence
If you have space admin privileges, you can change
the color scheme for your space, add your own ® Styling Confluence with CSS
space logo, choose what shows up in your space's
sidebar, or use Atlassian Marketplace themes to

change the whole look of your space.

® Configure the Sidebar

® Edit a Space's Color Scheme
® Apply a Theme to a Space

® Customize Space Layouts
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Configure the Sidebar

If you have administration permissions for a space,

you can customize the space's sidebar to have its On this page:
own logo, change the way the hierarchy is

displayed, and add shortcut links to help navigate to

important content quickly. ® Change the space name and logo

® Configure the sidebar links
To start configuring the sidebar, choose Space ¢ Change the navigation display options
tools > Configure sidebar. ® Adding custom content to a sidebar

Related pages:

Change the space name and logo * Edit a Space's Color Scheme
® Organize your Space

To change the space name:

1. Choose ¢ next to the space hame.
2. Type in a new space name and Save.

<4 R
o & Beginner's guide to Confluence I.‘—-o

e—" B Pages ©

99 Blog O]

Space shortcuts @"—o

F Tag your space with labels 0

# Groups of users ]

-+ Add link

Navigation display options ©)

Child pages
© Page tree
Done

1. Logo - change the space name and logo
2. Reorder - drag to reorder shortcuts
3. Hide - hide or show pages, blogs, shortcuts or navigation display options.

To change the space logo:

Choose the # next to the space name.

Choose Upload an image.

Select an image from your computer.

Adjust the size of the image to fit within the highlighted circle.
Choose Save.

arwdppE

Things you should know:

® Space logos are 48px x 48px. Logos smaller than these dimensions will be centred with whitespace
around them.

® You can only change the space logo for a site space. For your personal space, your profile picture is
used as the space icon.

Configure the sidebar links
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® Choose the icons to show or hide pages, blogs, shortcuts or navigation options.
For example, if you want your space to be used primarily as a blog you can hide the 'Pages’ link.

® Add--ons such asTeam Calendars for Confluence Server may add other links in this section of the
sidebar and you can also show or hide these.

® Choose Add link to add a shortcut link to the sidebar. This could be a link to an important page for
your team, or to an external site.

® Drag links to reorder them within each section (you can't move a link from one section to another).

Change the navigation display options
® Choose Child pages to see the current page and its children in the sidebar.
® Choose Page tree to see the page tree for the entire space, expanded to the current page.
® You can also choose to completely hide the navigation display options and instead add the pages you

want to be visible as shortcut links. Alternatively, you can remove the sidebar navigation altogether
and use a Page Tree Macro or Children Display Macro on your homepage for navigation instead.

Adding custom content to a sidebar

You can further customize a sidebar using wiki markup to add custom content.

To add custom content to your sidebar:
1. Go to the space and choose Space tools > Look and Feel from the bottom of the sidebar.
2. Choose Sidebar, Header and Footer.

3. Enter your custom content in the Sidebar field.

The sidebar, header and footer fields all use wiki markup, check our guide to wiki markup for help, or check
out some common customizations below.

To add a search field to the sidebar add the following wiki markup for a search macro in the Sidebar field.
For the Livesearch Macro macro:

{livesearch}

For the Page Tree Search Macro macro:

{ paget r eesear ch}

To add a panel with some custom content to the sidebar add the following wiki markup for the Panel
Macro in the Sidebar field:

{panel } This is some custom content to appear in the sidebar{panel}

To hide the default page tree and add your own, with additional parameters:
1. Add the wiki markup for the Page Tree Macro in the Sidebar field.
The following example includes parameters to expand the top three levels of the page tree by
default and include an Expand All and Collapse All link above the tree.

{paget ree: r oot =Page Nane| st art Dept h=3| expandCol | apseAl | =t r ue}

2. Goto Space Tools > Configure sidebar.
3. Use the Show and Hide icons to hide the default page tree from the sidebar.
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Edit a Space's Color Scheme

Spaces inherit the global color scheme by default, but if you have admin
permissions for a space, you can jazz it up with your very own customizable

Related pages:

color scheme. ® Configure the
Sidebar
To change the color scheme for a space: * Apply a Theme to
a Space
1. Go to the space and choose Space tools > Look and Feel from the

bottom of the sidebar

Choose Color Scheme

Choose Select next to a scheme listed under Custom Color
Scheme (if not already selected)

Choose Edit -

Enter standard HTML/CSS2 color codes or use the color-picker I to
choose a new color from the palette provided

Customizable Elements

The color scheme allows you to edit the colors of Ul elements including the top bar, tabs and backgrounds.

Some Ul elements below are for specific themes, and color changes may not take effect for other themes.

Top Bar - the top navigation bar background

Top Bar Text - the text on the top navigation bar

Header Button Background - buttons on the top navigation bar (e.g. Create button)

Header Button Text - the text on buttons on the top navigation bar

Top Bar Menu Selected Background - background color of top navigation bar menu items when
selected (e.g. spaces)

Top Bar Menu Selected Text - text color of top navigation bar menu items when selected

Top Bar Menu Item Text - text on top navigation bar drop down menus (e.g. help or cog)

Menu Item Selected Background - highlight color on top navigation bar drop down menu items
Menu Item Selected Text - text color on highlighted top navigation bar drop down menu items
Search Field Background - the background color of the search field on the header

Search Field Text - the color of the text in the search field on the header

Page Menu Selected Background - the background color of the drop down page menu when
selected

Page Menu Item Text - the text of the menu items in the drop down page menu

Heading Text - all heading tags throughout the space

Links - all links throughout the space

Borders and Dividers - table borders and dividing lines
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Custom Colour Scheme
A custom colour scheme which can be edited.
H B N B BN BEBEE s
Edit
The follewing colours can be customised for this colour scheme,
7op Bar [ #004880 @
Top Bar Text #DEEBFF o]
Header Button Background . #00BSFF &
Header Button Text #FFFFFF [+ ]
Top Bar Menu Selected Background . RGBA(9, 30, 66, 0.48) &
Tap Bar Menu Selected Text #DEEBFF ]
Top Bar Menu Item Text . #172B4D EJ
Menu Item Selected Background #EBECFO 1]
Menu llem Selecied Text . #172B4D &
Search Field Backaround . RGBA(9, 30, 6&, 0.48) 4]
Search Field Text #DEEBFF &
Page Menu Selected Background #FAFSF7 &
Page Menu ltem Text . #17284D [+ ]
Heading 'm:r. #172B4D i ]
inks [ #o0s2ce ]
Borders and Dividers #FFFFFF @
Reset Cancel

(® Handy Hint

If you mess things up, just choose Reset then try again.
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Apply a Theme to a Space

Themes are used to change the appearance of your space. Your

Related pages:
Administrator can download and install themes from The Atlassian pag

Marketplace. ® Applying a Theme
to a Site

Once a theme is installed it can be applied to the whole site or to individual ¢ Customize your

spaces. Space

To apply a theme to a space: * Edita Space's

Color Scheme

1. Go to the space and choose Space tools > Look and Feel from the * g%gt')%urre the
bottom of the sidebar

You'll need Space Admin permissions to do this.

Choose Themes and select a theme option.

3. Choose Confirm.

n

What is the global look and feel?

When a new space is created, whichever theme is applied to the whole site will be applied by default to the
new space. This is the global look and feel, and any changes made globally will flow through to all spaces
that inherit the global look and feel.

If a space has its own theme applied, or if changes have been made to customize the look and feel of the
space, it will no longer inherit changes from the global look and feel.

If you want to go back to inheriting the global look and feel choose Global look and feel from the Themes p
age.
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Documentation theme migration FAQ

As previously announced, the documentation theme is not available in Confluence 6.0. We know you'll have a
lot of specific questions, so we've created this FAQ to help you prepare for upgrading to Confluence 6.0.

If you have further questions, you can ask them at the bottom of the page and we'll do our best to provide an
answer.

What does the default theme look like?

How can | check if | am using the documentation theme in my space?
How can | check if the documentation theme is being used anywhere in my site?
What will happen to my theme customizations during the upgrade?

Will my space break after the upgrade?

Can | add custom content to the sidebar, header and footer globally?
Can | still use macros in my sidebar, header or footer?

Where should | add custom content to the sidebar, header or footer?
How do I turn off the Pages and Blogs shortcuts at the top of the sidebar?
Can | edit the default theme's sidebar globally?

| want to see the page tree, not child pages. how do | do this?

Where is Space Administration and Space Operations?

Do | have to use wiki markup in the sidebar, header, and footer?

Can | hide or change the space logo appearance?

Can | hide the built in page tree and insert my own?

How can | make my page titles wrap in the sidebar?

Can | change the order in which things appear in the sidebar?

Can | still use the space jump macro?

Why don't child pages appear below the page?

Can | restrict search to just this space?

How do | view the pages in my space alphabetically?

What will happen if | import a space that uses the documentation theme?

What does the default theme look like?

Here's an example of the documentation theme, and default theme with the same custom content side by side:

= XConfluence Spaces - Pecpis Browse - | Creats

Not sure where to start? - i
Sample Space

Raead the Geliing Started guice Trst. San‘lple Space Home
3 Meskng nates B Groated Dy Rach Admin [Aaminsiaton. st mooiied 2 minas age
5 Project Romdmap

* Sumvey rests

= XConfluence Speces- Pecpls  Greate

- Fages @
Sample Space

1.
2.

Sample Space Home
& Pages & 15

reaied by Rch Adenin JAdminisinrion, lnst modified 8 minuies ago

N Blog
SPACE SHORTCUTS
1] Mesting notes

Mot sura where to start?

Read tha Gatting Stared guida first

PAGE TREE
+ Projact Rosomap
' Mesting rotes

* Survey resulls

Documentation theme: with custom sidebar content.
Default theme: with the same custom content in the sidebar.

How can | check if | am using the documentation theme in my space?
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The easiest way to check whether your space is using the documentation theme is to look for a Browse menu
in the header, near the Create button. (If you're using the default theme already, you'll see a Space Tools menu
at the bottom of the sidebar instead.)

How can | check if the documentation theme is being used anywhere in my site?

There's no simple way to see a list of spaces using the Documentation theme in Confluence itself, however if
you have a very large site, your Confluence Administrator can use the following query to get a list of spaces
directly from the database.

SELECT *

FROM BANDANA B, SPACES S

VWHERE B. BANDANAKEY=' at | assi an. conf | uence. t hene. setti ngs'
AND S. SPACEKEY=B. BANDANACONTEXT

AND B. BANDANAVALUE LI KE (' %glocunent ati on% )

ORDER BY S. SPACENAMNE;

This query will only find spaces that are explicitly using the documentation theme. It doesn't include spaces
using the global look and feel (these spaces automatically change when you change the Site Theme, you wont
need to change the theme space by space).

What will happen to my theme customizations during the upgrade?

During the upgrade we'll automatically turn on the default theme for any spaces that currently use the
documentation theme. If you've customized the documentation theme (by adding wiki markup to the sidebar,
header or footer) we'll take this wiki markup and drop it into the sidebar, header and footer in the default theme.

The default theme adds some new sections to the sidebar, such as links to pages, blogs and space

shortcuts. You can choose to hide these - head to Space Tools > Configure Sidebar and use the "= button to
hide any items you don't want to see.

Will my space break after the upgrade?

This depends on the amount of customization you have. In most cases your space sidebar may look a little
different but the changes shouldn't be dramatic.

If you've used CSS to change the appearance of your space (either in the space stylesheet or by using the
Adaptavist Content Formatting macros like {style} and {div} in the sidebar, header, or footer of the
documentation theme), you may need to make a few changes to some class names in your CSS to get your
space looking right. For example, if you specified #spl i tt er - si debar in the doc theme, you'll need to use .
acs- si de- bar for the default theme.

If you have customized default theme layouts through the Confluence Ul, you may find that your space looks
strange or broken when the default theme is re-applied to spaces previously using the documentation theme.

If you experience problems, you'll need to reset the broken layouts.

This method will only work if you have more than one theme available in your site. You'll need System
Administrator global permission to do this.

1. Switch to another theme temporarily.
If you're unable to use the space navigation, use this URL, replacing YOURSPACEKEY with the space
key for the space.

http://<yoursite>/spaces/ chooset hene. acti on?key=YOURSPACEKEY

2. In the space administration options go to Layouts (if available) or use the following link, replacing YO
URSPACEKEY with the space key for the space.

http://<yoursite>/spaces/|istdecorators. acti on?key=YOURSPACEKEY
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3. Choose Reset Default next to any template that have been customized.
4. Return to the Themes page and try applying the default theme again.

Layouts can also be customized for the entire site - head to E > General Configuration > Layouts if you
need to reset the layout for the entire site.

If you're unable to reset the layouts via the Confluence Ul, you can remove the affected layouts directly in
the database. Be sure to take a full database backup before you try this.

First, use the following query to identify customized layouts:

Sel ect *
FROM DECORATOR
ORDER BY SPACEKEY

Then, you can selectively remove records for spaces that are affected.

Can | add custom content to the sidebar, header and footer globally?

Yes. Head to E > General Configuration > Sidebar, Header and Footer. All spaces that use the global look
and feel will inherit your custom content. Any custom content added to the sidebar, header and footer in a
particular space will override any custom content added globally.

Can I still use macros in my sidebar, header or footer?
Yes! If a macro worked correctly in the documentation theme it'll work in the default theme too.
Where should | add custom content to the sidebar, header or footer?

You can add custom content to the sidebar, header and footer in each space individually (Space Tools > Look

and Feel > Sidebar, Header and Footer) or globally (E > General Configuration > Sidebar, Header and
Footer).

Confluence displays global custom content in all spaces, except where a space has its own custom content
defined (space custom content overrides global custom content). This behavior applies field by field, so a space
can display a combination of custom content. For example you could define the content of a footer globally, and
content of a header in each space individually, or only in some spaces.

How do I turn off the Pages and Blogs shortcuts at the top of the sidebar?

Go to Space Tools > Configure Sidebar and use the "= icons to hide any items you don't want to see.

Can | edit the default theme's sidebar globally?

No. You can add custom content to the sidebar globally, but showing and hiding sections of the sidebar, setting
space logos, and adding shortcut links are done on a space by space basis.

I want to see the page tree, not child pages. how do | do this?

Head to Space Tools > Configure Sidebar and select Page Tree in the navigation options. The default for all
new spaces is Page Tree.

Where is Space Administration and Space Operations?
Instead of choosing between Space Operations and Space Administration, the documentation theme has a

single Space Tools menu that lets you jump right to Permissions, Content Tools, Look and Feel, or
Integrations.

Old Space Operations location New Location in the sidebar

Browse > Pages Pages on the sidebar or Space Tools > Reorder pages
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Browse > Blogs

Browse > Labels

Browse > Space Operations >
Space Details

Browse > Space Operations >
Orphaned Pages

Browse > Space Operations >
Undefined Pages

Browse > Space Operations >
Attachments

Browse > Space Operations >
PDF, HTML, XML Export

Browse > Space Operations >
RSS Feeds

Browse > Space Operations >
Watch this space

Browse > Space Operations >
Watch this blog

Browse > Space Operations >
Remove from My Spaces

Browse > Space Admin > Space
Details

Browse > Space Admin > Space
Categories

Browse > Space Admin >
Templates

Browse > Space Admin > Delete
Space

Browse > Space Admin > Trash

Browse > Space Admin >
Permissions

Browse > Space Admin >
Restricted Pages

Browse > Space Admin >
Application links

Browse > Space Admin > Themes

Browse > Space Admin > Color
Scheme

Browse > Space Admin > PDF
Layout

Blogs on the sidebar

Click a label on any page, then use the Q- menu to see all
labels, popular labels or pages from other spaces

Space Tools > Overview

Space Tools > Content Tools > Orphaned Pages

Space Tools > Content Tools > Undefined Pages

Space Tools > Content Tools > Attachments

Space Tools > Content Tools > Export

Space Tools > Content Tools > RSS Feeds

Pages > Watch this space (or use the Watch button on any page)
Blogs > Watch this blog (or use the Watch button on any blog post)
Use the W icon in the sidebar (or in the space directory)

Space Tools > Overview

Space Tools > Overview

Space Tools > Content Tools > Templates

Space Tools > Overview > Delete Space

Space Tools > Content Tools > Trash

Space Tools > Permissions
Space Tools > Permissions > Restricted Pages
Space Tools > Integrations > Application Links

Space Tools > Look and Feel > Themes

Space Tools > Look and Feel > Color Scheme

Space Tools > Look and Feel > PDF Layout
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Browse > Space Admin > PDF Space Tools > Look and Feel > PDF Stylesheet

Stylesheet

Browse > Space Admin > Space Tools > Configure Sidebar then choose the edit icon on the
Change Space Logo space logo

Browse > Space Admin > Hipchat = Space Tools > Integrations > Hipchat
Integration

Do | have to use wiki markup in the sidebar, header, and footer?

Yes. Our main focus when adding this feature was to help people move from the documentation theme to the
default theme with a minimum of effort. Keeping these fields as wiki markup means that your existing
customizations can be pasted straight in.

Can | hide or change the space logo appearance?

You can upload any image to use as your space logo, but you can't change how it appears in the sidebar (it's
always round and always at the top).

Can | hide the built in page tree and insert my own?

Yes! If you want to have complete control over how the page tree appears in your sidebar you can hide the built
in page tree, and then add a Page Tree macro { paget r ee} in the sidebar custom content.

How can | make my page titles wrap in the sidebar?

Page titles do not wrap in the sidebar of the default theme (regardless of whether you're using the built in page
tree or have added a { { paget r ee}} macro as custom content). There's no way to change this.

Can | change the order in which things appear in the sidebar?

You can change the order of some items in the sidebar, such as the shortcuts, but the order of the sections
themselves can't be changed. Anything that has a = icon can be moved.

Custom content appears above the page tree. You have the option to hide the built in page tree, and then add it
back in the custom content area using wiki markup. This can be useful if you want more control over the order of
the page tree and your custom content.

Can | still use the space jump macro?

No, the space jump macro was provided by the documentation theme and will not be available once the
documentation theme is removed. If you've used this macro on a page or in the header or footer of a space, it
will show the following error after the upgrade unknown macro: {spacej unp}.

To find out whether the Space Jump macro is used on any pages in your site, enter macr oNane: spacej unp
into the search bar. All pages containing the macro will be returned (it won't search the sidebar, header or
footer unfortunately).

Why don't child pages appear below the page?

The default theme does not list child pages below the sidebar, but you can achieve a similar result by adding a C
hildren Display macro to the footer.

Can | restrict search to just this space?
No, that is one of the features we removed with the documentation theme.

One workaround is to add a Livesearch macro to the sidebar or space homepage. Use @el f in the spaces
parameter to restrict the search to the current space.

How do | view the pages in my space alphabetically?

The default theme does not have an option to view all pages in your space alphabetically.
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What will happen if | import a space that uses the documentation theme?

You should have no problems importing the space, but it will have the default theme applied and any wiki
markup customization in the theme will not be automatically migrated to the default theme. Before exporting the
space you should copy the wiki markup contents of the sidebar, header, and footer fields and keep it so that you
can add it back in manually after you've successfully imported your space.
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Customize Space Layouts

You can modify Confluence's look and feel by

editing the layout files. This page tells you how to Related pages:

customize the layout files for a space. You'll need

the system administrator global permission plus spa ¢ Customize your Space

ce administrator permission for that space. ¢ Apply a Theme to a Space

® Styling Confluence with CSS
People with system administrator permissions can
also customize the layout of the entire Confluence
site. For more information, see Customizing Site
and Space Layouts. Site layout customizations
modify the default layout of all spaces in the
Confluence site.

Any space layout customizations will override the
equivalent site customizations.

-

(D If you modify the look and feel of Confluence by following these instructions, you'll need to update
your customizations when you upgrade Confluence. The more dramatic the customizations are, the
harder it'll be to reapply your changes when upgrading. Please take this into account before
proceeding with any customizations.

For more information on updating your customizations, please refer to Upgrading Customized Site
and Space Layouts .

&

Confluence is built on top of the Open Source SiteMesh library, a web-page layout system that provides a
consistent look and feel across a site. SiteMesh works through 'decorators' that define a page's layout and
structure.

To edit the layout of Confluence, you will need to modify these decorator files. A decorator file is a .vmd file
and is written in a very simple programming language called Velocity. Learn more about Velocity. Once you
become familiar with Velocity, you can edit the decorator files to personalize the appearance of Confluence.

The decorator files in Confluence are grouped into the following categories:

® Site layouts: These are used to define the controls that surround each page in the site. For example,
if you want to make changes to the header and the footer, you will need to modify these layouts.

® Content layouts: These control the appearance of content such as pages and blog posts. They do
not change the way the pages themselves are displayed, but they allow you to alter the way the
surrounding comments or attachments are shown.

® Export layouts: These control the appearance of spaces and pages when they are exported to
HTML. If you are using Confluence to generate a static website, for example, you will need to modify
these layouts.

Learn more about using decorators.
To edit a decorator file:

1. Go to the space and choose Space tools > Look and Feel from the bottom of the sidebar
2. Choose Layout (Layout is displayed only if you are a Confluence system administrator.)
You'll see a list of the layouts for the space
3. Click Create Custom to edit the default vmd file
This will open up the vmd file in edit mode. If you only want to view the vmd file, click View Default.
4. Make any changes and click Update
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Content Layouts

Content layouts contraol the appearance of content such as pages and blog
posts: they don't change the way the pages themselves are displayed, but they
allow you to alter the way the surrounding comments or attachments are shown.

Decorator Operations

Space Layout < default > - Create custom -
Controls how a space is displayed. View Default

Page Layout < default > - Create custom -
Controls how a page is displayed. View Default

Blog Post Layout < default > - Create custom -
Controls how a blog post is displayed. View Default
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Archive a Space

Archiving a space is useful when you have content that is no longer

relevant, but you still want the option of accessing it at a later date. Archived On this page:
spaces are less visible, but still available on your site. Archiving a space is
easy to undo — you can make a space current again at any time. ® Archive a space
® The effect of
Archive a space archiving a space
® Spaces
1. Go to the space and choose Space tools > Overview from the ® Pages

® Change a space
from archived to
current

bottom of the sidebar
2. Choose Edit Space Details.
3. Select Archived in the Status dropdown menu.

4. Ch .
Choose Save Related pages:

® Delete a Space

® Export Content to
Word, PDF, HTML
and XML

The effect of archiving a space

Spaces
If a space is archived, that space:

Won't appear in the Recent spaces section of the search panel.

Won't appear in search results, unless you select Search archived spaces.

Won't appear in advanced search results unless you select Search archived spaces.
Won't appear on the Spaces dropdown menu.

® \Won't appear in the general spaces lists in the Space Directory, but will instead appear under the Arc
hived Spaces list. It will, however, still appear under any categories it was labeled with.

® Won't show up in activity streams when updated.

®* Won't appear on your dashboard.

Pages
Pages within an archived space will appear in a few places.
If you view a page within an archived space, that page will appear in:

® The Recently visited section of the search panel.
® The Recently viewed pages menu.

If you edit a page within an archived space, that page will appear in:

® Activity streams
® The Recently updated macro.

Pages within an archived space won't appear in search results, unless you select Search archived spaces.
These functions remain available for archived spaces:
® You can view the content as usual, by following a link or typing in a URL belonging to the archived
space.

® You can edit the content as usual, as determined by the space permissions.
® RSS feeds, watches and notifications remain active.
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@ Archiving a space has no effect on search results of external search engines. For example, a public space
will still appear in Google search results.

Change a space from archived to current
Through the space directory:

Go to Spaces > Space directory in the header.

Choose Archived Spaces on the left.

Find your space and click the @ on the right.

Choose Edit Space Details.

Change the Status from 'Archived' to 'Current' and hit Save.

O WNR

Through the archived space:

1. If you know the space key, you can navigate straight to the archived space - htt p: //yoursite
/ di spl ay/ SPACEKEY

2. Choose Space tools > Overview from the bottom of the sidebar.

3. Choose Edit Space Details.

4. Change the Status from 'Archived' to '‘Current’ and hit Save.

Space Details Delete Space

Edit Space Details

Name: Beginner's guide to Confluence

Description:

.

Status: | v Current : '

Archived

Home page: | Beginner's guide to Confluence Hom

The page that displays when users navigate to this space.

o
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Delete a Space

Deleting a space permanently removes the space and all of its contents,
including any calendars and questions linked to that space. Only someone
with space admin permissions can delete that space.

i, Deleting a space is permanent — it does not go to the trash and cannot
be undone.

If you're unsure about deleting a space, create an XML export of the space
as a backup before proceeding. You can then restore the space from the
XML export file if you need to.

To delete a space:

1. Go to the space and choose Space Tools > Overview from the
bottom of the sidebar.

2. Choose Delete Space.

3. Choose OK.

Related pages:

® Archive a Space

® Export Content to
Word, PDF, HTML
and XML

Space Details Delete Space

attachments and blogposts)

WARNING

cannot be retrieved. It will be gone forever.

Knowledge Base?

OK Cancel

Deleting a space will delete all its content (including pages, comments,

This operation cannot be undone. Once the space is deleted, it

Are you sure you want to delete this space with space key IKB and name IT

G} Members of the conf | uence-adm ni st rat or s group can also delete spaces, including personal

spaces.



Export Content to Word, PDF, HTML and XML

You can export all or part of a Confluence space to various formats,

including Microsoft Word, HTML, PDF and XML. On this page:
To use the space export functionality, you need the 'Export Space' * Export single
permission. See the guide to space permissions. pages to PDF

® Export single
Export single pages to PDF pages to Word

® Export multiple
If you need to send content to people who don't have access to Confluence, pages to HTML,
you can export a single page or blog post as a PDF. XML, or PDF

® Customizing the
If you've got permission to view the page in Confluence, you'll be able to appearance of
export it in this way; go to the page and choose *** (Tools) > Export to PDF exports
PDE. ® Migrating content

to Confluence

Only published content is exported. This means you can create PDF Cloud

exports even while people are still working on the page.

Related pages:
When you export a single page to PDF, the PDF stylesheet customizations
are applied, but any PDF layout customizations are not. To make your PDF
layout customizations apply to a single page exported to PDF, you'll need to
use the 'multiple page' method described below to export the single page.
See Customize Exports to PDF.

® Customize Exports
to PDF
® Restoring a Space

Export single pages to Word
You can also choose to export single pages to a .doc file that can be opened in Microsoft Word.

If you've got permission to view the page in Confluence, you'll be able to export it in this way; go to the page
and choose Tools > Export to Word.

Only published content is exported. This means you can create Word exports even while people are still
working on the page. Also, only the first 50 attached images will be included in the export. See the notes
below for more information.

Note that due to the format of this file, it can only be opened in Microsoft Word and is not compatible with
other applications such as Open Office, Libre Office or Google Docs.

Export multiple pages to HTML, XML, or PDF

If you want to export a space — or selected pages in a space — to HTML, XML, or PDF, Confluence can
create a zipped archive of the HTML or XML files, or a single, downloadable PDF file.

PDF export is useful you're producing a printable user manual from your documentation space for example.
The HTML export can be used to convert your site content to a static website, and finally the XML export can
be used to import your space content into another Confluence space (running the same or later version of
Confluence).

To export pages to HTML, XML, or PDF:

Go to the space and choose Space tools > Content Tools from the bottom of the sidebar
Choose Export
Select either HTML, XML, or PDF, then choose Next
Select the type of export:
® Normal Export (HTML and PDF) — to produce an HTML or PDF file containing ONLY the
pages that you have permission to view.
® Full Export (XML) —to produce an XML file containing all the pages in the space, including
those that you do not have permission to view.
® Custom Export — if you want to export selected pages only, or if you want to exclude
comments from the export.

N
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5. Choose whether to Include Page Numbers (PDF only)
6. Choose Export.

When the export process has finished, you can download the zipped archive or PDF.
What's included in the export?

The following content is included in space exports.

PDF export | XML export HTML export
Pages Yes Yes Yes
Blogs No Yes No
Comments No Optional Optional
Attachments Images only | Yes Yes
Unpublished changes No Yes No
Page numbers Optional N/A N/A
Restricted pages Only those Yes, they Only those
and blog posts you can view | remain you can view

restricted

Customizing the appearance of PDF exports

You can add a title page, table of contents, and customized headers and footers to the PDF output. For
more advanced customizations, you can apply Cascading Style Sheet (CSS) modifications. These
customizations are specific to each space, and you need the 'Space Administrator' permission to apply these
customizations. For more information, see Customize Exports to PDF.

Notes on PDF exporting

® To export a PDF containing international text, see Create a PDF in Another Language

® Confluence's PDF export feature is designed to handle a wide variety of content, but on rare
occasions the PDF Export process may fail due to an unrecognized customization. If that happens,
the PDF export screen will indicate the title of the page in which the problem occurred, to help you
diagnose the cause of the failure.

® Tables that exceed the width of a page, particularly those with images in them, might be cut off in the
PDF. See Wide tables are cut off in PDF exports for some suggested workarounds.

® |n Confluence Data Center, PDF exports are handled by the external process pool.

Notes on Word exporting

® Only the first 50 images attached to the page are exported to your Word document. This is to prevent
out of memory errors affecting your whole Confluence site. See

[J CONFSERVER-34211 - If a page with big number of images Exported to Word, some images
are invisible GATHERING IMPACT

for more information, and to find out how you can temporarily increase this limit using a system
property.
Notes on HTML exporting

® In the zip file, page attachments are placed in individual folders with names in the following format:
... \downl oad\ at t achment s\ XXxXxXXxXx
where 'xxxxxx" is the page ID of the page containing the attachments.

® To customize the HTML output, you'll need to modify the file conf | uence- x. y. z-jar/ com

[ atl assi an/ conf | uence/ pages/ Page. ht m export. vm To learn how to repackage this file,
see How to Edit Files in Confluence JAR Files
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Notes on XML exporting

® You can only import a space into the same or later Confluence version. You can't import a space

into an earlier version.
® Team Calendars aren't included in XML exports.

® |f you're doing the export for backup purposes, consider another means of backup. See Production
Backup Strategy.

® |If you are running Confluence behind Apache HTTP Server and are facing timeout errors, please

consider creating the export directly from Tomcat, instead of going through Apache. This will speed
up the process and prevent timeouts.

See Restoring a Space for notes on restrictions when importing a space into Confluence Server.

Migrating content to Confluence Cloud

If you're migrating from Confluence Server to Confluence Cloud, you can use the Confluence Cloud
Migration Assistant to migrate your content and spaces.
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Customize Exports to PDF

Confluence_prowdes a basic EDF export that you On this page:
can customize and style to suit your needs.

You need Space Admin permissions to customize
PDF exports in a space, and Confluence
Administrator global permissions to customize PDF
exports for the whole site.

How it works
Limitations
Change the PDF layout
PDF Layout examples

® Title page

® Header or footer
® Change the PDF stylesheet
® PDF Stylesheet examples
Page size
Page orientation
Page margins
Page breaks
Word wrapping
Title page
Table of contents
Tables
Page numbers
Headings
Other formatting

Related pages:

® Advanced PDF Export Customizations

How it works

When someone exports a space to PDF, Confluence will apply any layout and styling directions it finds in the
current space or set globally for the whole site.

® The PDF Layout allows you to add a title page to your PDF, and add a header and footer to all
pages.

® The PDF Stylesheet allows you to change the look of the PDF. You can change just about anything,
including the paper size, fonts and colours, spacing, and control behaviours like page breaks.

Both the PDF Layout and PDF Stylesheet can be customized on a space by space basis, or globally for the
whole site. Space customizations will always completley override any global customizations. This means
you can't mix and match and set some items globally and others at the space level.

Limitations
There are a few limitations to be aware of:

® Changes to the PDF layout only apply to space exports, not to single page exports (via *** > Export
to PDF).

® Confluence Server and Data Center process space exports slightly differently. This means that some
options, like adding page numbers via CSS, aren't available in PDFs created with Data Center. We
recommend selecting Include page numbers on the export screen if you need to number your
pages.

® We provide a humber of example customizations to get you started, however Atlassian Support can't
help you with styling your PDFs or problems introduced by your customizations. If you're new to CSS,
you might want to get help from an Atlassian Solution Partner, or check out a Marketplace app like Scr
oll PDF Exporter which has a WYSIWYG editor to help you produce beautifully styled PDFs.

Change the PDF layout
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The PDF Layout is where you add a title page, header, or footer to your PDF exports. The PDF layout fields
accept HTML. You can include inline CSS in the HTML too.

To change the PDF layout for the whole site:

® Goto E > General Configuration > PDF Layout.
You need Confluence Administrator global permissions to do this.
You need

® Choose Edit, then add your customizations in the Title, Header, or Footer fields.
To change the PDF layout for a specific space:
® Go to the space and choose Space tools > Look and Feel from the bottom of the sidebar You'll need
Space Admin permissions to do this.

® Choose PDF Layout.
® Choose Edit, then add your customizations in the Title, Header or Footer fields

PDF Layout examples

Here are some examples of things you can do in the PDF Layout. The PDF layout can accept HTML and
inline CSS.

Title page

In this example we've added the title "Documentation for Confluence", a logo, and an additional title
"Contents" above the table of contents.

<div class="fsTitl ePage">
<ing src="/downl oad/ attachment s/ 169118009/ at | assi an_| ogo. png" />
<div class="fsDocTitle">Docunentation for Confluence</div>
</ div>
<div class="tocTitle">Contents</div>

The logo image we've used is attached to a Confluence page in the same site. You can find out the
attachment ID by right clicking the image on the page, and copying its location.
Header or footer

In this example we've added plain text to the footer with some copyright information, and included a link.

Created in 2018 by Atlassian. Licensed under a <a href="http://creativecommons.org/licenses/by/2.5 aul"
>Creative Commons Attribution 2.5 Australia License</a>.

Change the PDF stylesheet

The PDF Stylesheet allows you to change the appearance of your PDF. This includes things like paper size,
fonts, colours, spacing, and other styling.

To change the PDF stylesheet for the whole site:

® Goto E > General Configuration > PDF Stylesheet.
You need Confluence Administrator global permissions to do this.
You need

® Choose Edit, then add your CSS.

To change the PDF stylesheet for a specific space:

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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® Go to the space and choose Space tools > Look and Feel from the bottom of the sidebarYou'll need
Space Admin permissions to do this.

® Choose PDF Stylesheet.

® Choose Edit, then add your CSS.

PDF Stylesheet examples
Here are some examples of common CSS overrides that you can use in your PDF Stylesheet.

The default CSS rules will apply unless you have specified an override in the PDF Stylesheet.

Page size

The default page size is US Letter (8.5 inches wide by 11 inches long). To override this behaviour and
specify a particular size, add a si ze property to the CSS @age rule.

For example to export your space in A4 size:

@age
{
/*The A4 paper size is 210 nmw de by 297 mm | ong*/

size: 210mMm 297mm
}

Page orientation

To change the page orientation of your PDF document, reverse the order of the values declared in the @age
rule's si ze property. The first and second values of this property represent the width and height of the
page, respectively.

For example, to generate an A4 PDF in landscape, your @age rule might look like this:

@age
{

/*A4-si zed pages in | andscape orientation are 297 nmw de by 210 nmm | ong*/
size: 297nm 210mm
}

Page margins

The default margins are 0.5". To set all margins to 15 mm, with a paper size of A4, edit the CSS @age rule
in the PDF Stylesheet, like this:

@age

{

size: 210nm 297mm
mar gi n: 15mm

}

To set the margins independently, edit the @age rule like this:

@age

{

mar gi n-top: 2.54cm
mar gi n-bottom 2.54cm
margin-left: 1.27cm
margin-right: 1.27cm
}

To set margins to include a gutter for binding a printed document, you can use the : | eft and: ri ght pseud
o-classes, as follows:
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@age :left

{

margin-left: 4cm
margi n-right: 3cm
}

@age :right

{

margin-left: 3cm
margi n-right: 4cm
}

@age :first

{

margi n-top: 10cm/* Top margin on first page 10cm */

}

In the example above we've also used the : fir st pseudo-class to define different margins for the title page.

Page breaks

By default, each Confluence page will start on a new page in the PDF. If you don't want each Confluence
page to start on a new page, you can override the default page breaks using the following CSS:

.pagetitle {
page- br eak- bef ore: aut o;

}

This behaviour changed in Confluence 6.13. If you're using Confluence 6.12 or earlier, page breaks are not
added before each page title.

! If you're using Confluence Data Center, you won't be able to change this behavior, as PDFs are
generated page by page in the external process pool, and then combined together once all pages
are complete.

Word wrapping

Long, unbreakable words or strings (such as a URL) will automatically wrap to fit the page width, or cell
width if in a table.

If you don't want words or long strings to break you can use the following CSS:

div {
wor d-wrap: normal !inportant;

}

This may mean that the table formatting in your PDF is problematic, and very long content may overflow,
and be cut off the page.

Title page

If you have added a title page in the PDF layout, you can use the following rules to change the appearance
of the title page and title text.

fsTitl ePage
{

margin-left: auto;

mar gi n-top: 50mMm

margi n-right: auto;
page- break-after: al ways

}

fsTitle
{

font-size: 42px;
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font-wei ght: bold;
margin: 72px 0 4px O;
text-align:center;

}

Table of contents

A table of contents is included by default when you export a space to PDF. It will appear at the start of the
document, or after the title page, if you've configured a title page in the PDF layout.

To omit the table of contents, use the following override:

div.toc

{
di spl ay: none;

}

The table of contents uses a leader character to visually connect the page title with it's page number. By
default this is a dot. Allowed values are dot t ed, sol i d and space. You can also use a string, for example
| eader(". . . ").

The example below uses solid line, instead of dots.

span. t ocl ead: before

{

content: |eader(solid);

}

Tables

When you export a page that contains a table, we'll reduce the width of the table columns as much as
possible, so that the whole table fits comfortably on the page. Individual columns are resized to fit the
contents of each column.

If you prefer table columns to always be of equal width, you can use the following CSS:

tabl e. fi xedTabl eLayout {
tabl e-1ayout: fixed !inportant;
wi dth: 98%!inportant;

Any images in a table will be exported using the size set in the editor. If your table contains large images,
part of the table may be cut off when exported to PDF. To ensure that nothing is cut off, we recommend
resizing images in the editor, so that the total width does not exceed about 600px (for an A4 page in portrait
orientation).

Alternatively you can use the following CSS to fit images to the available width:

tabl e i my. confl uence- enbedded-i nage {
-fs-fit-images-to-wi dth: 100% !inportant;
}

Page numbers
The best way to add page numbers to your document is to select Include page numbers on the export

screen. If you're using Confluence Server, and want more control over where page humbers appear, you
can use CSS to add numbers instead.
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If you're using Confluence Data Center, you can't add page numbers using these methods, as PDFs
are generated page by page in the external process pool, and then combined together once all
pages are complete. Use the Include page numbers option on the export screen instead.

To add page numbers in the format "Page x of y" to the bottom of your page, add the following CSS to the
PDF stylesheet:

@age
{

@ottom center

{
content: "Page " counter(page) " of " counter(pages);
font-famly: ConfluencelnstalledFont, Helvetica, Arial, sans-serif;
font-size: 8pt;

Alternatively you can add page numbers into the footer. This requires making a change in the PDF layout
and the stylesheet.

First, add an element in the PDF layout. In this example we'll call it pageNum

<span id="pageNuni'/>

Then, in the PDF stylesheet, style the pageNumelement as follows:

#pageNum before

{

content: counter(page);

}

Headings

Heading sizes in the PDF export roughly match the sizes used on Confluence pages. You can easily
override them as follows:

h1l {
/* Custom styling */
}

h2 {
/* Customstyling */
}

This behaviour changed in Confluence 6.13. In Confluence 6.12 and earlier, headings were demoted based
on the position of the page in the page tree. Now headings are a consistent size on every page.

Other formatting

You can use the stylesheet to customize the output of just about anything on the page, including fonts,
tables, line spacing, macros, etc. The export engine works directly from the HTML output produced by
Confluence. Therefore, the first step in customizing something is to find a selector for the HTML element
produced by Confluence or the Confluence macro. Then add a CSS rule to the PDF stylesheet.
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Advanced PDF Export Customizations

This page provides information about ‘advanced'
PDF export customizations. These expand upon the
regular customizations described in Customize
Exports to PDF.

i. The information below is for advanced users. Be
aware that the advanced customizations described
below require knowledge of certain parts of
Confluence, and of CSS and HTML. Customizations
are not supported by Atlassian, so our support
engineers won't be able to help you with these
modifications.

Header and Footer

On this page:

® Header and Footer
® Adding Headers and Footers to
Single Page Exports
¢ Adding Images to Headers and
Footers
Incorporating Other Fonts
Adding a Dynamic Title to the Title Page
Hiding Text from the PDF Output
Indexing
Notes

Related pages:

® Customize Exports to PDF
® Create a PDF in Another Language

Adding Headers and Footers to Single Page Exports

Single page exports don't support adding HTML headers and footers via the PDF Layout page, but you can
use CSS rules in the PDF Stylesheet page (Space tools > Look and Feel > PDF Stylesheet) to produce

headers and/or footers for a single page export.

For custom headers, define any of the following rules within your @age rule: @ op- | eft, @op-center, a
nd @ op-ri ght . These rules allow you to define the cont ent of the left-hand side, centre and right-hand

side of your page's header area, respectively.

For custom footers, define @ottom | eft, @ott om cent er and @ott om ri ght rules within your @age

rule.

For example, the following rules add a document title at the centre of the header and a page number at the

centre of the footer:

CSS - PDF Stylesheet

@age
{

@ op- center

{

content: "Docunent Title CGoes Here"; /* This is the content that will appear in the header */
font-famly: ConfluencelnstalledFont, Helvetica, Arial, sans-serif;

font-size: 8pt;
}

@ottom center

{

content: "Page "

counter(page); /* This is the content that will appear in the footer */

font-famly: ConfluencelnstalledFont, Helvetica, Arial, sans-serif;

font-size: 8pt;

}

/* Any other page-specific rules */

Notes:


https://confluence.atlassian.com/display/CONF74/Customize+Exports+to+PDF#CustomizeExportstoPDF-HeadersandFooters

Confluence 7.4 Documentation

® Thefont-fam |y andfont-size properties ensure that the header and footer text is rendered in
the same default font style used for the body text, based on the default CSS rules.

® |tis not possible to use this method to insert images (stored as attachments within your Confluence
instance) into the headers and footers of single page exports.

Adding Images to Headers and Footers

To insert an image into the header or footer, add HTML to the Header or Footer section of the PDF Layout
screen.

The following example uses an HTML i ng element with sr ¢ attribute to add an image to the left of the
header. The sr c attribute refers to an image attached to a Confluence page. The image element is usually
placed within a di v element container.

HTML - PDF Layout: Header Section

<div style="margin-top: 10.0mm ">
<inmg src="https://confluence. atl assi an. comf downl oad/ att achnent s/ 12346/ header - i mage. png" />
</div>

In the example above, the header includes an image called 'header-image.png'. The "12346" in the sr ¢
attribute is the ID number of the page to which the image is attached.

Follow these instructions to include an image on your page:

Attach the image to a Confluence page.

View the list of attachments on that page, then right-click the image and copy its location.

Paste the link into the appropriate src="" attribute in your PDF Stylesheet, as shown above.

Edit the image URL so that it is relative, by removing the first part of the URL before / downl oad/ . . ..

AWNR

Notes:

® This example uses an inline CSS property mar gi n-t op in the st yl e attribute to force the image
away from the top of the page by 10mm. This comes in handy when your header image is large
enough to touch or spill over the top of the page.

® |ikewise, for footers, you can use the nar gi n- bot t om XXmmproperty to force an image away from
the bottom of the page by 'XX' mm.

® Very large images can spill over into the body of a page or alter the position of text or other elements
used within a header or footer. In such situations, it is recommended that you reduce the size of the
image and then attach it to your Confluence page again. If you prefer to keep the image size and want
to move the content lower instead, you can do so by configuring the mar gi n-t op properties in the @
age CSSrule.

® By default, a header or footer image is aligned to the left-hand side of the page. However, you can
align this image to the centre or right-hand side of a page by adding either the t ext - al i gn: cent er
ortext-align:right properties to your st yl e attribute. For example, to align the header image to
the right-hand side of the page, your st yl e attribute would look similar to this: st yl e=" nar gi n-
top: 10nm text-align:right".

Incorporating Other Fonts

By default, Confluence provides Times New Roman, Helvetica or Courier fonts for use in PDF exports. You
can use your own fonts for PDF exports by declaring them in a @ ont - f ace CSS rule in your PDF
Stylesheet.

The following CSS rule example shows how to declare the Consolas font and apply it to some elements for
your PDF export:

CSS - PDF Stylesheet

@ont-face { src: url(file:///usr/share/fonts/Consolas.ttf); -fs-pdf-font-enbed: enbed; } .code pre, .
prefornatted pre, tt, kbd, code, sanp { font-famly: Consol as, nonospace; font-size: 9pt; }
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The font path specified in the CSS must be the path to the font on the Confluence server.

Adding a Dynamic Title to the Title Page

When you export an arbitrary set of pages from Confluence, you may like to have a corresponding title
added to the cover (or title) page automatically. This can be done (in a somewhat irregular way) by using the
top level item from the default table of contents as the title. This method relies on having the exported pages
structured as sub-pages of the top-level page. In other words, the pages to be exported should consist of a
page (at the top-level) and all of its child pages. The result is that the title that appears on the cover page
changes depending on the top-level page that is used for the export.

The CSS below moves, and styles, the top-level TOC item for use as the title on the cover page, and turns
off the leader and page number normally associated with this item in the TOC.

CSS - PDF Stylesheet

.fsTitlePage { position:relative; left:0px; } /* Turn off the default section nunbering for this TOC
item*/ .toclvlO:before { content: &quot; &quot;; counter-reset: chapter 0; } /* Hide the default page
nunbering for this TOC item*/ .toclvl0 .tocnum{ display: none; } /* Mve and style this TOC item?*/ .
toclvl0 { position:absolute; top:250px; font-size: 42px; font-weight: bold; margin: 72px 0 4px 0; text-
align:center; }

Hiding Text from the PDF Output

This section describes a way to hide text from your PDF export. In other words, you can have text on the
Confluence page that will not appear in the PDF export.

There are three steps:
1. Follow the instructions to define the NoPrint user macro.

2. Use the NoPrint macro to mark some text on a Confluence page.
3. Add the following CSS to your PDF stylesheet to make the PDF export recognize the NoPrint macro:

CSS - PDF Stylesheet

.noprint { display: none ; }

Indexing

To obtain an index at the end of the exported PDF file, consider using the Scroll Wiki PDF Exporter plugin tha
tis produced by K15t Software GmbH.

Notes

If styling is not working as expected, it is useful to look at the intermediary HTML source to which the CSS is
applied. This intermediary HTML is created whenever you create an HTML export that contains multiple
pages, and is stored in the t enp directory in Confluence's home directory. For example:

/tenp/ ht M export-20110308- 154047- 1/ export-internedi at e- 154047-2. ht m
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Create a PDF in Another Language

To export a Confluence page written in a language
other than English, you'll need the necessary font Related pages:
for that language.

® Export Content to Word, PDF, HTML and
XML

Upload a Font File to Confluence

1.

Find the appropriate font file:
®* Windows users:All font files in Windows are stored in a directory called:

C: \ W NDOWB\ Font s

® Unix users:All font files in Unix are stored in:

/usr/share/fonts

® Microsoft True Type core fonts such as Verdana can be downloaded from this page: http://coref
onts.sourceforge.net/
Copy the font file into a temporary folder, for example a folder on your desktop.

Choose the cog icon E then choose General Configuration then choose PDF Export Language
Support.

Upload the file you copied in step 2.

Choose Install.

Notes

The only font files supported are true type fonts and true type collections. The accepted file
extensions are *.ttf and *.ttc.

Confluence can only store one font file at any one time. Please create a collection to install more than
one *.ttf files.

We recommend that you use Unicode font Verdana for correct character encoding and exporting to
PDF.

® For symbols, if the other fonts do not work, try Seguisym
® If the font file size is bigger than your current attachment size limit, you will not be able to upload it.

Please increase the attachment size limit temporarily and re-upload again. An improvement of the
error messaging is tracked at [l CONFSERVER24706 CLOSED

To make use of an installed font in your PDF Export style sheet (CSS) refer to it by the font-family
ConfluencelnstalledFont.
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Pages and blogs

Pages and blog posts allow you to capture and share information in

Confluence. Related pages:

. . ) . . ] ® Create and Edit
Whether it's taking down some quick notes from a meeting, writing a require Pages

ments page, or letting your teammates know about the company's latest * Blog Posts
marketing push — you can create it as a Confluence page or blog post. ® The Editor

_ . * Page Templates
Pages are great for when you want the information to last and evolve over ® Delete or Restore
time. If it's a point-in-time update or one-time communication then a blog a Page
post is the way to go. These aren't hard-and-fast rules; they're just pointers * Spaces

to give you a place to start.

Each Confluence space, including your personal space, allows you to
create pages in it, and has its own blog where you can create posts. If
you're not sure what a space is, or what you can do with spaces, check out
our page on Spaces.

Take a look at the below pages to learn more about pages and blog posts in Confluence.

Create and Edit Pages

Blog Posts

The Editor

Move and Reorder Pages

Copy a Page

Delete or Restore a Page

Add, Remove and Search for Labels
Drafts

Page Restrictions

Links

Anchors

Tables

Add, Assign, and View Tasks
Autocomplete for links, files, macros and mentions
Page Layouts, Columns and Sections
Create Beautiful and Dynamic Pages
Page Templates

Blueprints

Import Content Into Confluence
Undefined Page Links

View Page Information

Page History and Page Comparison Views
Confluence Markup



Create and Edit Pages

Create a page

On this page:

You can create a page from anywhere in Confluence; just choose Create in

the header and you're ready to go. Pages are the place to capture all your
important (and unimportant) information; start with a blank page and add
rich text, tasks, images, macros and links, or use one of the useful blueprints

to capture meeting notes, decisions, and more.

* Create a page
Edit together
® Collaborate or
restrict
® Organize and move
® Other page actions
®* Notes

(-:f} If you want to quickly create a blank page, hit the Create button in the header; if you want to create
a page from a template, hit the Create from template button.

BN °

1. Create blank page
2. Create from template

Dev team -

o — Select space

Blank page
Start with a blank page.

DACI decision

ke

#
ﬁ Define the roles and responsibilities for
making high-impact or high-risk decisions.
@— e
E Experience canvas
Make sure your work is user-centered,
technically sound, and makes sense for the
" Health monitor

el banlth

Add or customise templates for the selected space

Help

Farent: Dev team HOMmMe @e— o

Blog post
Share news and announcements with your
team.

Decision
Record important project decisions and
communicate them with your team,

File list
Upload, preview and share files with your
team.

How-to article

L P L )

R A

Create elLES

1. Select space: choose the space where you'll create the content.
2. Page templates: create a page from a template or create other types of content.

3. Parent page: your page will be a child of this page.

Once you decide on a blank page or blueprint, you'll be taken straight into the Confluence editor. The editor
is where you'll name or rename your page, add the content, and format it to look great. When you've added
some content, choose > Preview to take a peek at what your finished page will look like, and Publish when
you're ready to make it appear in the space.

After you save you'll see the page in 'view' mode. You can re-enter the editor any time by choosing Edit or
pressing E on your keyboard.
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Creats

2 Confluence Spaces v

People

4 Pages & & # Edit 7 Save for later © Watching < Share

_ﬂi Teams in Spaca
Teams in Space Home

Created by Alana Gean st modified by Rach Admin on Jan 17, 2018

B Pages

3% Bilog

SPACE SHORTCUTS

© Welcome to your new spacel
Confluence spaces are great for sharing content and news with your team.
This is the home page for Teams in Space. Right now it shows recent space
activily, bul you ¢an customize this page in anyway you [ike. Sean along the
fefthand side to see important pagas in this space.

B Declsion log
& Our Kanban board
B Media assets

PAGE TREE You can customize the left navigation to fit your team.

Meeting notes

Decision log

Recent space activity Space contributors

Product Requirements Alana Grant Alana Grant (7 hours ago)

]
)
* Product Planning
3
>

-

» 8 B Where should we store
our files? updated about
& hours ago = view

Teams in Space PR

* Meet the SeeSpaceEZ Team

Rach Admin {7 hours ago)
Judd (2 days agao)
Ryan Lee (5 days ago)

+ Team Sprint Calendar Emad Abdi (b days ago)

change
Rach Admin

B Where should we store
our files? updated about
B hours ago « view

+ File lists

* Media assets

£} Space tools “t

1. Confluence header: create blank pages, pages from templates and visit spaces or your profile.
2. Space sidebar: access pages, blogs and administer the space.
3. Page tools: edit or share the page, watch it to get updates and perform more actions.

@. Another useful way to create a page is to use the Create from Template Macro. This macro allows
you to choose a page template, and adds a button to the page allowing one-click page creation. If
you want others to create pages using this template, this is a great option.

Edit together
Need input from your team members? Multiple people can edit your page at the same time.

Hit the Invite button in the editor and either grab the link, or enter some people or groups to invite by email (t
hey need the appropriate Confluence and space permissions of course).

See Collaborative editing for all the ins and outs.

Collaborate or restrict

Once you've created a page, you can decide if you want to keep it private, using restrictions, or collaborate
on it with others using @mentions, sharing, and comments.

Organize and move

You can also organize pages in a hierarchy, with child and/or parent pages for closely related content. When
you navigate to a Confluence page and choose the Create button in the header, the page you're creating will
by default be a child of the page you're viewing. Have as many child pages and levels in the hierarchy as
you need to, and move pages if you want to change their location.

If you want to view all pages in a Confluence space, choose Pages in the sidebar.

G} Each time you create a page, you're creating it in a space . Spaces are containers used to contain
pages with related content, so you can set them up for each team in your organization, for projects,
a combination of both, or for any reason you want to group pages together. See Spaces for more
information.

Other page actions
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Copy a page and its child pages

Delete a page or remove a specific version of a page

Monitor page updates and other activity through page notifications
View page history, and manage and compare versions of a page
Search page content, including attachments

Export pages to Word, PDF, HTML or XML

Like a page

i. We recommend you don't use special characters in page or attachment names, as the page or
attachment may not be found by Confluence search, and may cause some Confluence functions to behave
unexpectedly.

G} If you rename a page, Confluence will automatically update all relative links to the page, except in
some macros . Links from external sites will be broken, unless they use the permanent URL. See Lin
ks for more information.

Notes
You may experience problems saving extremely large pages. Confluence can accept approximately 5mb of

content (not including attached files) which is roughly equivalent to 800,000 words. If you do experience
errors that indicate the page is too large to save, you should break up the page into several smaller pages.
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Blog Posts

Blog posts are an easy way to share announcements, journal entries, status

reports, or any other timely information. Others can join in by commenting on On this page:
and/or liking your blog post and, if you get enough of either, your post ® Create a blog post
might make it to the popular feed on the dashboard! * Move a blog post

® Restrict a blog post
Each space in Confluence, including your personal space, has it's own blog. * Delete a blog post
To view a space's blog, go to a space and choose Blog in the sidebar. You'll ® Export a blog post

see a list of the latest blog posts, and you can click through to earlier posts
via the navigation area in the sidebar. Related pages:

® Subscribe to RSS
Feeds within
Confluence

® Blog Posts Macro

® Collaboration

® Export Content to
Word, PDF, HTML
and XML

Create a blog post

You can follow the same process to create a blog post as when you create
a Confluence page.

1. Navigate to the space where you want to create your blog post
2. Choose Create in the Confluence header and select Blog post
3. Add your content and choose Publish

You can create blog posts from the Dashboard, but you'll need to make
sure you choose the space it's going to appear in in the create dialog.

Blog posts can be attractive and engaging in the same way a page can be, so go ahead and add images,
YouTube clips (preferably of cats), and tables to your post to really grab your audience.

To create a blog post, you need the 'Add Blog' permission. See Space Permissions.

Move a blog post

If you create a blog post in the wrong space, or want to reorganize your spaces, you can move an individual
blog post to another space.

To move a blog post, go to the post and choose *** > Move and select the new destination space.

You'll need the 'Delete blog' permission in the current space, and 'Add blog' permission in the new
(destination) space to do this.

Restrict a blog post

You can restrict a blog post so that it is only available to specific users or groups. Blog post restrictions work
in the same way as page restrictions.

To restrict a blog post prior to publishing it, choose the Unrestricted button in the footer and apply your
restrictions. To restrict a blog post after publishing, choose *** > Restrictions and apply your restrictions.

Notes:
® Notifications are sent at the point a blog post is created - removing restrictions does not trigger a new

natification.
® As a blog post has no parent, restrictions aren't inherited.

Delete a blog post

To delete a blog post, choose *** > Delete. Deleting a blog post follows the same rules as deleting a page.

Export a blog post

You can export individual blog posts to PDF. This is useful, for example, if you want to email an internal blog
post to people outside your organization.
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See Export Content to Word, PDF, HTML and XML for more information on exporting blog pages to PDF.
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The Editor

The Confluence editor is what you'll use to create and edit Confluence
pages, blog posts, and comments. You can enter content as you would in a
Word document, apply formatting, and embed other content and files on the

page.

Note: To edit a page, you need the 'Add Pages' permission for the space.
See space permissions. Someone may also apply page restrictions that
prevent you from editing the page.

Edit a page or blog post

You'll be taken to the editor whenever you create a new page or blog post,
or add a comment. To edit an existing page or blog post, choose Edit at the
top of a page or press E on your keyboard.

Confluence automatically saves changes as you type. Changes are only

visible when viewing the page after you publish or update. See Collaborative
editing for more information on how this works.

The editor

On this page:

Edit a page or blog
post

® The editor
® Editor toolbar
® Restrictions,

labels, and
notifications
Things to help you
work faster

Find and replace
text

Invite people to
edit with you
Record change
comments and
notify watchers

Related pages:

®* Tables
® Page Layouts,

Columns and
Sections

Display Files and
Images

® |inks
® Symbols,

Emoticons and
Special Characters

The editor allows you to enter or change the title of your page; insert content including text, images, and

links; and format your content using the toolbar.

If you're renaming your page, there are some things you should take into account.
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& Confluence spaces v People Create

Oev tearn [ Pages [ Dev team home [ Introducing Confluence @

Introducing Confluence

TTransparency and organisation are key for modern teams. Confluence gives you a central place to keep your team's work organised and
accessible, making it easier to find the information needed to keep work moving forward.

High performing teams work together to maximise productivity. Confluence combines the speed of creating on your own with the
advantages of working together. Confluence makes it easy to create documents as a team, provide feedback in context and guickly iterate
until your work is finalised.

@ Readytogo What did you change? T Motify watchers Close i

Page content: add your page title and body text.

Page tools: add labels or restrict the page.

Insert: add files, links, images, tables and macros

Notify: notify others and leave a comment when you change a page.

Preview or revert: preview your page, view changes since last published, or revert back to last
published version (or delete the draft page, if it has never been published).

R WNR

Editor toolbar

The editor toolbar is where you format your page layout and text, and add links, tables, images, attachments
and macros. You can also perform a find and replace, or get help using the editor by choosing the help icon

?.
& Confluence Spaces v People Create = Feedback Search
EE: A B :=:=9 == =:=®8 8¢ -~ a ?
Paragraph Strikethrough B Files and images
Heading 1 evteamhom  Subscript * @ & Link ]
Heading 2 Superscript % Markup
Heading 3 Monospace — Horizontal rule
Heading 4 Clear formatting B Taskiat
Heading 5 .
© Ematicon
Heading 6 & eyl
i & User mention
Cuata T Jira Issue/Filter
9 Info
EE Status
& Gallery

Table of Contents

Other macros
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The Insert menu

The Insert menu is particularly useful. Use the Insert menu to include any of the following content types on

your page:
® Animage
® Alink to another Confluence page or external URL, or a link to an attachment or image
® An emoticon or symbol, or a horizontal line
[ ]

A macro (choose a specific macro, or Other Macros, from the Insert menu)

You can also use keyboard shortcuts to insert links, images, and macros. Try out the shortcuts listed below:
® Type [ (square bracket) to insert a link.
® Type ! (exclamation mark) to insert an image or other media.

® Type { (curly bracket) to insert a macro.

Typing any of the above shortcuts will trigger the autocomplete functionality, prompting you with a list of

v
suggestions to finish off the entry. For more shortcuts, click the helpicon °  on the editor toolbar.

Restrictions, labels, and notifications

When editing a page, you may want to set restrictions on who can view or edit the page, or add labels to the
page to make it easily searchable.

Once you're ready to save, you can enter change comments to let others know what you've changed, and, if
you like, send an email notification to anyone watching the page.

Things to help you work faster

Auto-formatting

You can type Confluence wiki markup directly into the editor to have Confluence auto-format your text as

7
you type. To learn more, choose help icon ° in the toolbar, then choose Editor Autoformatting.

Autoconvert for pasted links

When you paste certain URLs into Confluence, the editor will analyze what you're pasting and automatically
convert it into something that will display well in Confluence. Examples include:

YouTube videos

Jira issue queries

Google Maps

Confluence pages, blog posts, comments, user statuses, user profiles.
Shared screenshot links from Skitch

And more.

Drag-and-drop for external images and files

You can drag files, like images, multimedia, Office files and PDFs, from your computer and drop them
directly into the editor. The contents of the file will be embedded into the page or blog post.

Drag-and-drop within the editor
In the editor panel, you can drag an image or a macro from one location to another on the page. Hover your
cursor over the image or the macro placeholder and your cursor changes to a drag-and-drop icon. Click the

image or macro and drag it to a new location.

Keyboard shortcuts
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To view the available keyboard shortcuts, choose the help icon ? in the editor toolbar.

Find and replace text

Click the @ icon on the toolbar, or use the keyboard shortcut Ctrl+F (Windows) or Cmd+F (Mac OS).
Search matches are highlighted in yellow. You can step through the results one by one, replace the

matching text strings one by one, or replace all matching strings at once. Find and replace works only within
the current page.

Invite people to edit with you

Speed up your draft and review cycles and get input from the right people by inviting them to edit the page
with you. The page does not need to be published.

Hitthe T button in the editor and either grab the link, or add people, groups or email addresses to invite,
just like sharing a page.

Sharing or inviting someone to edit a page or blog post does not automatically grant any permissions - they
will still need the appropriate Confluence permissions to access Confluence and view or edit the page.

Up to 12 people can edit the same page at the same time (your administrator can change this limit).

Record change comments and notify watchers

When you finish editing a page, you can add a comment to let others know what you changed. Type a short
message in the change comments field in the footer. The comment will be visible in the page history.

If you want to send a notification to people watching the page, select Notify watchers. The change
comment will be included in the notification email.

The Notify watchers checkbox remembers your last selection for each page, so if you choose not to notify
people, the checkbox will be deselected for you next time you edit that page.

Notify watchers Update Close
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Symbols, Emoticons and Special Characters

You can add various symbols and special characters to Confluence pages.
You can also use them in other places that display content, such as blog
posts, comments, and the dashboard welcome message.

On this page:

® [nsert symbols and
special characters

® Insert emoticons

® Prevent emoticons
from appearing

Insert symbols and special characters

1. Edit the page (if you're viewing the page, press E on your keyboard)
2. Choose Insert > Symbol
3. Choose a symbol to insert it Related pages:

® The Editor

Symbol
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Cancel

Insert emoticons
There are two ways to add an emoticon, or smiley, to your page.
By choosing an emoticon from those available:

1. Choose Insert > Emoticon
2. Choose an emoticon to insert it

By typing a character combination:

You can also type the following characters to insert emoticons. This can be useful when the Insert menu is
not available, for example in an inline comment.
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Prevent emoticons from appearing

To undo the conversion of a character combination into an emoticon, press Ctrl+Z (Windows) or Cmd+Z
(Mac).

To prevent Confluence from converting text to emoticons automatically, disable 'Autoformatting' in your user
profile. See Edit Your User Settings.
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Collaborative editing

Collaborative editing takes teamwork to the

next level by letting you and your team work On this page:

together in real time on software requirements,

meeting notes, retros, and any other Confluence * Drafts and unpublished changes
page. See who's editing the page with you, and see * Things you should know

changes as they happen. Hit * to invite more
people to edit with you.

Changes save and sync automatically, so everyone
editing sees the same thing. And, because we're
saving all the time, there's no need to manually
save. Publish now or keep the draft and publish it
later—you're in control.

Up to 12 people can edit the same page at the
same time. Your administrator can change this limit
using a system property.

Once you and your team are done editing you can:
® publish (or update if the page has previously been published) to make everyone's changes visible
® close the editor and keep everyone's work to finish later

® revert to the published version of the page, discarding everyone's unpublished changes
* delete the draft page entirely, if it has never been published.

We'll warn you if you're about to publish (or discard) other peoples' changes along with your own.

= & Confluence Spaces v People Create

Paragraph + B I U A~ £+~ = 2 B 2 22 = = = @ B & @y +v = ~ a 2

Teams in Space / Pages | Teams in Space Home [ Launch Pad Product Requirements % UMPUBLISHED CHANGES Qﬂ Q + ."_o
Launch Pad Product Requirements

Background
©—. .. ¢
We need a way to launch rockets into space, so that we can have you know... Teams in Space.

Reguirements

User Story Description Priority
As an operator | want to have a launch pad The launch pad will be used to blast rockets into space 1- MVP
As an operator | want to have a cancel button  This will be a manusl override 1- M\-’FP
As an operater | want to have a turbo button This will enable super fast launches into space 2 - Nice to have
@ Ready lo go fhat d u change Motify watchers Update Close

1. Invite more people: see who is editing the page and invite others to edit with you.
2. See what they're doing: watch others edit the page in real time.

Drafts and unpublished changes

What is a draft?

A draft is a page that has never been published before. Draft pages have a lozenge that says draft, and are
only visible to their author, and to anyone that author shares their draft with. Nobody else will be able to see
your draft, as it is only accessible from the Recently worked on list of each of the people who've contributed
to it.

What are unpublished changes?
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A page with unpublished changes is a page that has been published, and has then had edits made to it,
but which has not yet been republished. Anyone who has unpublished edits will see the page in their Recentl
y worked on list, with a lozenge saying unpublished changes. People who haven't contributed to the
unpublished changes won't see this lozenge.

Those unpublished changes, however, are visible in the editor, and anyone can access them by editing that
page. Therefore, if you have unpublished changes and do not want someone else making additional
changes before they can be published, you might want to temporarily restrict editing on that page (leaving
the published version of the page visible).

& Confluence Spaces ~ People Create  «+

DISCOVER b
: Recently worked on Filte Exaste Seace
@ Al updates
|22 Popular
TonaY Welcome to Confiuence
MY WO B When should we launch?  UNPUBLISHED GHANGES

@ Recently worked on

B Launch Pad Product Requirements I
B
Recently visited
® ¥ B Workshaop planning 2019 DRAFT ) g
7 Saved for later -
{

IN THE LAST MONTH T P
MY SPACES ALL Mission essentials

¥ Devteam B 2018-01-17 Meeting notes Meet the SeeSpaceEZ Team

Teams in Space Roadmap

h’ Teams in Space a Workshop outline  UNPUBLISHED CHANGES

Things you should know

Limited content auditing

We don't yet have the same auditing capabilities with collaborative editing. All page changes are currently
attributed to the person that publishes the page, rather than the person who made each specific change.

Changes in drafts aren't versioned
We’'re saving all the time in collaborative editing, but we don’t save versions in a draft. When restoring an

earlier page version, you can only roll back to published versions (the page draft is deleted when you restore
a previous version)

No more personal drafts

Collaborative editing introduces a new type of draft, a shared draft. Previously, when you edited a page but
didn't save it, Confluence would create a draft that was only visible to you (a personal draft). Now,
Confluence creates a shared draft whenever anyone edits a page. All page editors work on this same shared
draft, and it exists until someone publishes the page.

When you publish a shared draft, you're publishing all the changes you have made and changes made by
others. Publishing creates a version in the page history.

If you discard a shared draft, you're discarding all changes, including changes made by others. Because
shared drafts aren't versioned, there's no way to get a discarded draft back.

Any existing personal drafts are still available, but are no longer editable. If you edit a page, you'll see the
shared draft of the page, not your personal draft (if one exists).

If you need to get content out of your previous personal drafts head to Profile > Drafts, locate your page
and copy the contents.
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Personal space

© Watching
Recently viewed

Recently worked on

Profile

Tasks

Saved for later
Watches
Drafts
Network

Settings

Log Out
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Move and Reorder Pages

The easiest way to set a page's location in Confluence is to navigate to the

space where you want the page to live and, if necessary, find its parent On this page:

page and choose Create. Sometimes though, you'll want to change a

page's location either while you're creating it, or after it's been created. ® Set page location
or move a page

You can also move and reorder pages in the page tree (hierarchy). * Reorder pages

within a space
®* Notes about

Set page location or move a page

permissions
1. Do either of the following: Related pages:
® While creating a page — choose the location icon i: at the ® Create and Edit
top of the page Pages
® Once apage is created — choose *** > Move ® Copy a Page
2. Use the tabs on the left of the 'Set Page Location' dialog to help you ® Delete or Restore
find the new space and/or parent page for your page (the Current a Page

location and New location breadcrumbs at the bottom of the dialog
indicate the current parent page and new parent page)

3. Select Reorder if you want to move the page to a different position
amongst the child pages (when you choose Move in the next step,
you'll be able to reorder the page)

4. Choose Move (If you're reordering the child pages, choose the new
position for the page and choose Reorder)

The page — along with any attachments, comments, and child pages — is moved to your chosen location.
Confluence will automatically adjust all links to the moved pages, to point to the page(s) in its new location.

(D When completing the New parent page field, you need to select the page suggested by
Confluence's autocomplete. Typing or pasting the page name (or using your browser's
autocomplete) won't work.

Screenshot: Setting the location or moving a page

Set Page Location Help

Advanced Specify the new parent page for this page and its children by space and title.
Search
Recently Viewed Mew space:  Dev team

e New parent page Dev team Home

Start typing a page titls to see & Bst of suggestions.

Current Dev team ' Dav team Home

ocation:

New location: Dev team ' Dav team Home

Reorder pages within a space

You can change the location of a page within its space, and reorder pages in the hierarchy. This allows you
to:
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® Move a single page, or a family of pages, to a different parent within the space.
® Reorder pages that are children of the same parent.

All links to the page are maintained. When you move a parent page, the entire hierarchy of child pages will
move too.

To move or reorder a page:

1. Go to the space and choose Space tools > Reorder pages from the bottom of the sidebar
2. Expand the branches to locate the page you want to move.
3. Drag the page to a new position in the tree.

Alternatively, you can choose to order a group of child pages alphabetically by choosing the Sort

Alphabetically (A-Z) icon. The Sort Alphabetically (A-Z) icon only appears next to the parent page if the
page family is currently sorted manually.

If you change your mind, you can use the Undo Sorting icon to revert back to the previous manual page
order. This option is only available immediately after sorting the page, while you're still on the Reorder
Pages tab, and haven't performed any other action.

v Teams in Space Home 7| e (1]

Decisionlog ¥) e (2]
When should we launch?

Where should we store our files?

Meeting Notes

1. Alphabetical: sort all child pages alphabetically.
2. Undo: undo sorting.

Notes about permissions
To move a page, you need the following permissions:
® 'Add' permission on the page you're moving, and
® 'View' permission on the page's parent page. If you're moving the page to a different parent, you need
'View' permission on the new parent.

To move a page into a different space, you also need:

® 'Delete’ permission on the space you're moving from, and
® 'Add' permission on the space you're moving to.

If the page has restrictions, and you want to keep the page restrictions in the new location, you'll also need

'Restrict' permission on the space you're moving to. Alternatively, remove the page restrictions before
performing the move.
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Copy a Page

If you need to duplicate the contents of a page, the easiest way is to copy

the page. You can copy pages into the same space or to a different space. On this page:

When you copy pages into the same space, you'll need to rename them, as * Copy pages

two pages with the same name can't live in the same space. We give you ® Copy the contents
some handy tools to help rename your pages during the copy process. of an entire space

@ You need the 'Create Page' permission to copy pages. See space

permissions for more information.
Related pages:

® Create and Edit
Pages

® Move and Reorder
Pages

Copy pages

Single page

To copy a single page:

Go to the page and choose *** > Copy.
Choose a Location for the new page.

Choose whether to include attached files and images.
Hit Copy.

pPwDNPE

Confluence will open the copy of the page in the editor and name it 'Copy of [original page title]'. You can
then rename the page and work in the editor like any ordinary page.

Any restrictions are not copied over. If the page contains private information, click the padlock icon in the
editor to apply restrictions before you publish.

Copy page

Pick a location for your new page.

Space | Development team
Parent page | Projects

@ Include attached files and images

Inclede child pages

Page hierarchy
To copy a page and all its child pages:
1. Go to the page and choose *** > Copy.

2. Choose a Location for the new pages.
3. Select Include child pages.
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4. Use the options provided to customize your new page titles.
You can add a prefix, replace a keyword or phrase in existing titles, or both. The preview will give you
a good idea of what your new page hierarchy will look like, and warn you if there are any problems.
5. Deselect any items you do not want to copy over (attached files, labels, restrictions)

6. Hit Copy.

You'll find a link to your newly copied pages in the copy complete message.

4. Note: It's not possible to selectively copy multiple pages. You will be copying the entire hierarchy.

Copy pages

Hare's a preview of your new pages.
« Projects
~ gamma project kick-off
« Decision register - project gamma
+ Designs - project gamma

« Technical spike - project gamma

Customise your new page titles and
cheose what to include in the capy,

Start titlas with

Replace title text

alpha

With this text

gamma

Inciude Learn more
@ Labels

@ Attached files and images

@ Restrictions

Back (LT Cancel

What's included when you copy a page?

Here's some more info on what's included when you copy a page.

Single Page and its child pages

page
Page contents (text, = Yes Yes
macros)
Attached files and Optional - if you choose not to include attachments, you may see ‘unknown-
images attachment' errors on the copied pages.
Comments No No
Labels Yes Optional
Restrictions No Optional - you may not be able to change this option if you don't have
appropriate 'Restrict' space permissions.
Watchers No No
Saved for later info No No
History No No

Child pages with -
view restrictions

Yes - if you have permission to see the child pages.

No - if you do not have permission to see the child pages.

Space permissions and page restrictions
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Your space permissions and any existing page restrictions have an impact on what you can copy:

®* To copy pages you need the 'Create' page permission in the destination space.
® To copy pages with restrictions intact, you need the 'Restrict' page permission in the destination
space.

When copying a page and its child pages, you also have a choice to copy over any existing page
restrictions. This is useful if you need to maintain the current view or edit restrictions. If you don't have
'Restrict' page permission in the destination space, you won't be able to choose this option.

Copy the contents of an entire space

Confluence does not provide an option to copy a space, however if your space has less than 1000 pages,
you can use copy page to copy all the pages in an existing space to a hew space.

To copy the contents of a space to a new space:

Create a new space.

Go the homepage of the space you want to copy, and choose *** > Copy.

Set your new space as the Location.

Select Copy child pages then hit Copy.

In the new space, go to Space Tools > Reorder pages and drag your copied homepage to the root
of the space (so it is no longer a child of the current space homepage).

Go to Space tools > Overview > Edit space details.

Enter the copied space homepage title in the Home page field and Save.

RN WNR

N

That's it. You can now delete the homepage that was automatically added when you created the space.

Note that this is a new space, and no space settings (permissions, color schemes, templates etc) will be
copied. See these instructions on copying a space for some other workarounds.
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Delete or Restore a Page

When you delete a Confluence page, we'll move it to the space's trash. It's
not permanently deleted, and can be restored by a space admin, until the
page is permanently deleted from the trash.

Don't see a delete option? Delete only appears if you are allowed to
delete the page. Both space permissions and page restrictions can prevent
you from deleting.

Delete a single page

When you delete a page in Confluence, you're deleting its page history too.
If you only want to delete a specific version of a page, take a look at the
instructions below for deleting a specific version.

To delete a page:

1. Go to the page and choose *** > Delete.
2. We'll warn you of any issues, such as incoming links that will
break. Choose Delete to proceed.

The page will be sent to the trash, where it can be restored by a space
admin.

Any child pages (including any restricted pages that you are not allowed to
see) will move up to the nearest parent page.

Delete a page hierarchy

On this page:

Delete a single
page

Delete a page
hierarchy
Delete an
unpublished page
Delete a page
version

Restore deleted
pages

Empty the trash
or permanently
delete a page

Related pages:

Cannot edit page:

Editing or Deleting
a Page That Won't
Render

Copy a Page

When deleting a page that has child pages you have the option to delete the entire page hierarchy.

To delete a page hierarchy:

1. Navigate to the parent page and choose *** > Delete.
2. Choose Also delete child pages then hit Next.

3. We'll warn you of any issues, such as incoming links that will break. Choose Delete to proceed.

The pages will be sent to the trash, where they can be restored by a space admin.

Any pages that are restricted (that you are not allowed to see or delete) will not be deleted and will move up

to the nearest parent page.

Delete an unpublished page

To delete a page that has never been published (a draft), in the editor go to *** > Delete unpublished page.

Deleted drafts are not sent to the trash, so cannot be restored. If other people have contributed to the draft,

you will be deleting their work as well as your own.

Delete a page version

Space admins can delete specific versions from the page history. This is useful if you need to prevent older
versions of a page being restored in future. Deleting a page version is permanent and cannot be undone.

To delete a specific version of a page:

1. Go to the page and choose *** > Page History
2. Choose Delete next to the version you want to delete.

Once you've deleted a version, the other versions are re-numbered where necessary.
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Restore deleted pages

If you're a space admin you can restore deleted pages back into a space. This is useful if someone
accidentally deletes a page and needs to get it back.

To restore a deleted page:
1. Go to the space and choose Space tools > Content Tools from the bottom of the sidebar
2. Choose Trash.

3. Choose *** > Restore next to the page you wish to restore.

Pages are restored to the root of the space. Head to Space Tools > Reorder Pages to drag your restored
page back into the page hierarchy.

Empty the trash or permanently delete a page

If you're a space admin you can permanently delete a page (and all its attached files) by purging it from the
trash. Once purged, the page and all its versions and attached files will be gone for good.

To purge deleted pages:
1. Go to the space and choose Space tools > Content Tools from the bottom of the sidebar

2. Choose Trash.
3. Choose *** > Purge next to a specific page or you can Purge all to completely empty the trash.
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Add, Remove and Search for Labels

Labels are key words or tags that you can add to pages, blog posts and
attachments. You can define your own labels and use them to categorize,
identify or bookmark content in Confluence.

On this page:

® |abel a page or

For example, you could assign the label ‘accounting’ to all accounts-related blog post
pages on your site. You can then browse all pages with that label in a single ® | abel an
space or across the site, display a list of pages with that label, or search attachment
based on the label. ® The Labeled

_ content page
Because labels are user-defined, you can add any word that helps you * Search by label
identify the content in your site. ® Search for labeled

_ ) pages using a URL

You can also apply labels (known as categories) to spaces, to help organize * Remove labels

your Confluence spaces. See Use Labels to Categorize Spaces.
Related pages:

Label a page or blog post e Use Labels to

Categorize Spaces
® Display Pages with
Label Macros

Any user with permission to edit a page can add labels to it. Any existing
labels appear at the bottom-right of the page, below the page content.

To add a label to a page or blog post:
1. At the bottom of the page, choose Edit labels ® orhit L on your keyboard

2. Type in a new label (existing labels are suggested as you type)
3. Choose Add

Labels Help

new-label Add

confluence ¥ label-example %

Shortcut tip: In page view, pressing | also opens this dialog box Close

@ i you're editing or creating a page, and you want to add labels, choose the Edit label icon W atthe
top of the page.

Label an attachment

1. Do either of the following:
® Go to the page that contains the attachment and choose Go to *** > Attachments
® Go to the space and choose Space tools > Content Tools from the bottom of the sidebar,
then choose Attachments
You'll see a list of attachments, with any existing labels listed in the Labels column.

2. Choose the Edit label icon ® beside the list of labels and type in a new label (existing labels are
suggested as you type)
3. Choose Add

You can also add labels in a list of attachments displayed by the Attachments macro, by choosing the edit
icon ® beside each label.
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@ If you add one or more labels to a template, that label will be copied to the page when someone adds a
page based on that template. See Creating a Template.

The Labeled content page

If you're viewing a page or post that has labels or displays the Attachments macro, you can choose any label
to go to the Labeled content page for the space. Choose Popular Labels or All Labels from the cog at the
top-right — to view the most-used labels or all labels in the space — or choose See content from all spaces
from the cog to view labeled content from all spaces in your Confluence site.

Screenshot: The Labeled content page

Labelled content (O |

See content from all spaces
This list shows content tagged with the following label: playbook
ag g Py Popular Labels

To add a label to the list of required labels, choose '+ labelname’ from All Labels

Related Labels. :
+ health-monitor + plays
E Team playbook update: health monitor

43 minutes ago « Rach Admir
confluence playbook health-monitor teams
plays

E Team playbook update: customer interviews
0, 2018 « Rach Admin

playbook confluence teams plays interview

The Popular Labels option displays a word cloud, where the bigger a label is displayed, the more popular it
is. Choose any label to view content tagged with that label.

You can also navigate to the labels view for a space by entering the following URL (replace SPACEKEY with
the space's key):

<your . Confl uence. site>/1 abel s/l i stl abel s-al phavi ew. acti on?key=SPACEKEY

Search by label
You can use the ' | abel Text: ' prefix to search specifically for content that has a specific label. For

example, if you're looking for pages with the label 'chocolate’, type | abel Text : chocol at e into the search
field in the Confluence header. For more examples of searching by label, see Confluence Search Syntax.

Search for labeled pages using a URL
Entering a URL with an appended label or labels is another way to search for pages with particular labels.

In your browser's address bar, enter the following URL and press enter: htt p: // <your. Conf | uence.
site>/| abel / f oo+bar

The Labeled content page will load, showing search results for pages with the both labels, 'foo' and 'bar'.
Replace 'foo' and 'bar' with the label(s) you want to search for, and separate multiple labels with a + symbol.

Adding a label to your results:

Once you're on the Labeled content page, you can add more labels to your search by choosing them from
the Related Labels list at the top-right of the page. Each label is listed with a plus (+) sign.
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If you want to remove labels from your search, locate the included labels at the top of the page and choose
the label(s) you want to remove. Each included label will be listed with a minus (-) sign.

Remove labels

When viewing page, blog post, or attachment labels, an x appears alongside each label. Choose the x to
remove the label.

(D You can't remove, consolidate or manage labels directly. A label is created by adding it to a page for
the first time, and ceases to exist once its been removed from all pages it was added to.

If you have deleted pages that contain a label, you may need to purge the deleted pages from the
space's trash to ensure that the label disappears too.
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Display Pages with Label Macros

Using labels and macros, you can categorize pages and then display them

in Confluence in a number of ways. Related pages:

® Add, Remove and

As an example, you could label all pages relevant to the marketing team Search for Labels
with 'marketing’, and then add more specific labels like 'online’, 'mobile’, and ® Macros
‘physical’ to different pages where required. ® Use Labels to

. ] Categorize Spaces
You could then use the Content by Label Macro to display different

combinations of pages with the marketing label. Some combinations you
could use would be:
® All pages with the label 'marketing'.
® Pages with all of the following labels: 'marketing’, 'mobile’, and
‘online’.
® Pages with either the 'mobile’ or ‘online’ labels, in the Marketing
space.

There are a lot of ways you can filter the content, making it easier for you to find content that's relevant to
you.

Other label macros

Here are some other macros that use labels, and can help you categorize and display your content.
Navigation Map macro

The Navigation Map macro renders the list of pages associated with a specified label as a navigation map.
Related Labels macro

The Related Labels macro lists labels commonly associated with the current page's labels.

Content by Label macro

The Content by Label macro displays a list of content marked with specified labels.

Content Report Table macro

The Content Report Table macro displays a set of pages and blog posts in tabular format, based on the
specified labels.

Labels List macro
The Labels List macro lists all labels of a space, grouped alphabetically.
Recently Used Labels macro

The Recently Used Labels macro lists labels most recently used in a specified scope - global (site), space,
or personal.

Popular Labels macro

The Popular Labels macro displays popular labels in a list or in a heatmap (also called a cloud).



Drafts

A draft is a page you've never published. Unpublish
ed changes are edits that you've made to a
published page, without republishing them.

On this page:

® Find drafts and unpublished changes

Confluence autosaves your drafts and unpublished ® Resume editing a draft

changes as you work, so if you get interrupted and * Resume editing a page with unpublished
close your tab or navigate away, your content lives changes

on for you to resume editing when you're ready. * Discarding unpublished changes

_ - _ ¢ Delete a draft
If you're creating or editing, but don't want to publish

your changes yet, hit Close at the bottom-right of
the editor. This will save those changes in the editor
without publishing, and you can return to them at
any point. Closing the editor will land you back on
the published version of the page, or, if you're
working on a draft, on your Recently worked on
list.

Find drafts and unpublished changes

Drafts and pages with unpublished changes appear in Recently worked on in the dashboard. You can
easily differentiate between these as they'll have a 'draft' or 'unpublished changes' lozenge next to their
tittes. The 'unpublished changes' lozenge is only visible to people who have contributed to the draft or
unpublished changes, so you don't have to worry about it distracting your viewers.

= & Confluence Spaces~ People Create

St Recently worked on Filter Cnete Soace

@ All updates

|#» Popuiar
TODAY Welcome to Confluence

MY WORK E When should we launch?  UNPUBLISHED GHANGES

[E] Recently worked on B Launch Pad Product Requirements I
®
Re Iy wisd
(® Recently visited B Workshap planning 2019 DRAFT . d
¢ Saved for later N
{

IN THE LAST MONTH o P
MY SPACES ALL Mission essentials

W Devteam B 2018-01-17 Meeting notes Meet the SeeSpaceEZ Team

£ " Cman 1 Teams in Space Roadmap
k& Teams in Space B Workshop outline  UNPUBLISHED CHANGES A

Resume editing a draft
You can find your drafts under Recently worked on or by heading to your profile and clicking on Drafts

(only drafts that you created show in your profile). Clicking on a draft will drop you straight into the editor so
you can keep editing and/or publish.

G} If you didn't enter a page title, the draft will be called 'Untitled'.

Resume editing a page with unpublished changes

If you've been editing a page that's already been published, you can find the page again either through the
page tree or under your Recently worked on. The 'Unpublished changes' lozenge makes them easy to
spot.

Edit the page to see the unpublished changes and keep editing, then, when you're ready, hit Publish.

Discarding unpublished changes
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If you make changes to a published page, then change your mind, you can discard all changes by reverting
to the last published version of the page. This will discard all unpublished changes made by you and any
others who have edited the page since the last time it was published.
Before you revert to the last published version you should:
® Check who else has edited the page since last publish - their avatars will be shown at the top of the
editor.
® In the editor, go to *** > View changes to see all changes that have been made since last publish.
The changes won't be attributed to individual users.

Once you've checked to make sure you aren't going to inadvertently discard someone else's changes, go to
*=* > Revert to last published version to discard all changes.

Delete a draft
To delete a draft go to *** > Delete unpublished page.

Because drafts have never been published, you'll be deleting the entire page or blog post. Discarded drafts
are not sent to the trash.

1 Drafts in Confluence are shared, meaning other people can work on them with you. If you delete a
draft that other people have worked on, you're deleting their changes too.
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Concurrent Editing and Merging Changes

(i) This page covers the concurrent editing behavior in Confluence 6.0 Related pages:
g(rjilzlrt]er when your administrator has chosen to disable collaborative e Page History and
9- Page Comparison
In most cases, this won't apply to your Confluence site Views
' pplytoy ' ® Drafts
Sometimes, another user may edit the same page as you're editing, at the
same time you do. When this happens, Confluence will do its best to ensure
nobody's changes are lost.
How will | know if someone else is editing the same page as | am?
If another user is editing the same page as you, Confluence will display a
message above your edit screen letting you know who the other user is and
when the last edit was made.
Screenshot: Concurrent editing notification
() This page is also being edited by Ewan User. Your changes will be merged with theirs when you save. b ]

What happens if two of us are editing the same page and the other user saves before | do?

If someone else has saved the page before you, when you click Save, Confluence will check if there are any
conflicts between your changes and theirs. If there are no conflicting changes, Confluence will merge the
changes.

If there are conflicts, Confluence will display them for you and give you the option to:

® Continue editing - Continue to edit the page; useful if you want to manually merge the changes.

® Overwrite - Replace the other person's edits with yours (their edits will not be included in the latest
version).

® Cancel - Discard your changes and exit the editor, keeping the other person's edits.

Example Scenario
For example, Alice and Bob both edit the same page at the same time.

If Alice clicks save before Bob, Bob is now effectively editing an out-of-date version of the page. When Bob
clicks save, Confluence will examine his changes to see if any overlap with Alice's. If the changes don't
overlap (i.e. Alice and Bob edited different parts of the page), Bob's changes will be merged with Alice's
automatically.

If Bob's changes overlap with Alice's, Confluence will display an error message to Bob showing where Alice
has changed the page, and giving Bob the options to overwrite Alice's changes with his own, to re-edit the
document to incorporate Alice's work, or to cancel his own changes entirely, maintaining Alice's changes.



Page Restrictions

Page restrictions allow you to control who can view
and/or edit individual pages in a space. So, if you're
working on a page that shouldn't be viewed by just
anybody, it's easy to lock it down to the people who
need to know. You can add restrictions for
individuals or for Confluence groups.

To add or remove page restrictions, you'll need to
have permissions to edit the page and 'Restrict' or
'Admin' permission in the space.

Restrict a page or blog post

To restrict who can view or edit a page or blog post:

On this page:

Restrict a page or blog post
Remove restrictions from a page
Copy a restricted page

Get access to a restricted page
View all restricted pages in a space
Notes

1. Choose the Restrictions B icon at the top of the page.
2. Choose whether you just want to limit only who can Edit, or who can View and / or Edit.
3. Enter users or groups then click Add to add them to the list.
If you chose Viewing and Editing restricted you can further specify for each person or group

whether they can edit or just view the page.
4. Apply the restrictions.

You can add as many users and/or groups as you need. You can apply page restrictions to published and

unpublished (draft) pages.

Restrictions

B No restrictions -

B No restrictions
Everyone can view and edit

b Editing restricted
Everyone can view, only some can edit

@ Viewing and editing restricted
Only some can view or edit

- ™

Everyone can view arj

O CAN SEE THIS?

Right now everycne can view and eq
permissions. Use the dropdown abd

Learn more about restrictions

In this example, some users and groups can view only, others can also edit, plus there are inherited

restrictions that might impact who can view the page.
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Restrictions Help

] Viewing and editing restricted « Only some people can view or edit this page. There are inherited view @——————— e
restrictions.

o—. a Emma McRae x (P Cassie Owens x Can view and edit . Add
@ Ewveryone Has no access
a Rach Admin Can view and edit e
@ £mad Abdi Can view s Remove

1. Speed it up: apply the same restriction to multiple people and groups.

2. Watch out: restrictions on other pages can affect this one.

3. Be specific: choose exactly what each group or person can do.
Who is ‘everyone'?
When we say "everyone can view this page" everyone means all the people who can view the page by
default. There are two things that can affect who can view a page - the space permissions, and view
restrictions on any parent pages that are being inherited.

Restrictions don't override a person's space permission. For example, if you say a person ‘can view' in the
restrictions dialog and they don't have 'view' permissions for the space, they won't be able to see the page.

How do inherited restrictions work?

View restrictions are inherited, which means a restriction applied to one page will cascade down to any child
pages. Edit restrictions are not inherited, which means pages need to be restricted individually.

The restrictions dialog will tell you when there are inherited restrictions that might affect who can view your
page.

Here's the basics:
® |f you restrict viewing to a person or group, only they will be able to see that page and all its child
pages (unless there are further restrictions on the child pages).
® |f you restrict editing to a person or group, they'll be able to see and edit that page, plus see its child
pages.
® Parent pages (higher up in the page hierarchy) can have their own view restrictions that may prevent
people from viewing your page.
If the person you've listed as a viewer or editor can't see the page, check to make sure:
® they have View space permission for that space, or

® there's no view restriction on a page higher up the page hierarchy that prevents them seeing any
children of that page.

View current page restrictions
The restrictions icon at the top of the page gives you a clue that the page has restrictions:

fh Viewing this page is not restricted. Everyone can see this page (but editing may be restricted).

6 The page is restricted. Click the icon to see the list of who can view and edit this page.
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The page is inheriting restrictions from another page. Click the icon then choose Inherited
Restrictions to see a list of pages this page is inheriting restrictions from.

Remove restrictions from a page

Removing restrictions is easy. Choose No restrictions to remove all restrictions, or click Remove next to
each person or group in the list if you want to change who can view or edit the page.

Copy a restricted page

When you copy a single page, we don't automatically copy the restrictions. If the page contains information
that should be private, remember to reapply restrictions in the editor before you publish, to avoid notifying
people who are watching the space.

When you copy a page and all its child pages, you have the option to copy all restrictions, or skip copying
restrictions on all pages. See Copy a Page for more information.

Get access to a restricted page

If you navigate to a page that you're not able to view or edit because it has page restrictions applied (for
example from a link, an invite, or page URL) you may be able to request access to the page.

M
?

You don't have permission to view this page

Hit the request access button and we'll find someone who
can give you access.

If the request access message above doesn't appear, you're not able to request access for that particular
page. This usually is because the page has inherited view restrictions from a parent page, you don't have
adequate space permissions, or there is no mail server set up.

Request access
To request access to a restricted page:
1. On the restricted page choose Request access.

2. Confluence will send an email to up to 5 people most likely to be able to grant you access.
3. Wait for an email confirming that access has been granted.
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v/ Request sent X
We've asked Cassie Owen, Alana Grant and 2
more users to give you access. You'll get an
email once the request is approved.

Grant access
To grant access to a restricted page:
1. In the request access email, choose Grant access.
You'll be taken to the restricted page, and a dialog will appear with the access request.
2. Choose Grant access.
(We'll let you know if someone else got there before you, and has already granted access)

The user will receive an email confirming that access has been granted.

Pages / Sample space &

2020 Plannir

Access request
Created by Rach Admin, las

Emma McRae (emma) wants to view this page.
It's time to start our 20:

Add your ideas to this p Grant access Deny

This process is the same as navigating to *** > Restrictions and adding a 'View' restriction for the user.

Who can grant access?

When a user requests access to a restricted page, Confluence will send an email to up to 5 people who are
most likely to be able to grant access, in the following order:

1. people who have contributed to the page in the past, can see the page and have 'Restrict' or 'Admin’
space permission (sorted by last edit date)
2. space administrators who can see the page (sorted alphabetically).
This means that the request should be actioned quickly, as it prioritizes the people who have been

interacting with the page most recently. There's no follow up email if none of the 5 people respond, the user
will need to contact a space administrator directly to ask for access.

Disable the ability to request access
If you don't want people to be able to request access to restricted pages, for example if you're using

Confluence for public documentation, you can disable the Confluence Request Access Plugin. See Managin
g System and Marketplace Apps.

View all restricted pages in a space

You need space admin permissions to view the list of restricted pages in a space.
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To view restricted pages:

1. Go to the space and choose Space tools > Permissions from the bottom of the sidebar

2. Choose Restricted Pages.

Screenshot: Restricted pages in a space

Permissions Restricted Pages

This repeort shows all the pages where access is restricted to specific groups or users by page level permissions.
Title (Space) Type Permitted User/Group Creator Created
B Launch Pad Praduct Edit admin Emad Abd Jan 29, 2018
Requirements (Teams
Edit cassie Emad Abd Jan 29, 2018
Edit emma Emad Abd Jan 29, 2018
Teams in Space Marketing Edit admin Emma McRae May 10, 2017
Launch (Teams in Spaca)
B Froduct Requirements {Tesms View admin Rach Admin Jan 29, 2018
Edit admin Rach Admin Jan 29, 2018

Operations

Notes

® You can't exclude yourself

When you apply a restriction, Confluence will automatically add you to the list. You can't remove

yourself from this list.

® Space Admin and System Administrator access to restricted pages
Users with 'Admin’ permissions in a space, or users with the System Administrator global permission
can remove restrictions from pages, even if the page restriction prevents them from viewing the

page. Go to Space Administration > Restricted Pages.
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Links

You can create links to pages, blog posts, anchors, attachments, external
websites, Jira issues and more. Links can be text or images, and can be
added in many different ways.

Links to pages within your Confluence site are relative, which means that
you can move pages and rename pages without breaking links.

This page explains the most common ways to create links.

Insert a text link
To insert a link on a page:

1. Select some text or position your cursor where you want to insert the
link

2. Choose Link on the toolbar or use the keyboard shortcut Ctrl+K

3. Select a page, blog post or attachment, or enter an external URL
(see below for how to link to particular types of content)

4. Enter or modify the link text (this is the text that will appear on the
page. If this field is left blank, the page name or URL will be used as
the link text.)

5. Choose Insert

Other ways to do this
There are a few other ways to insert a link:

® Type [ followed by the page or attachment name. Autocomplete will
suggest matching items for you, or

® Paste a URL directly onto your page. Confluence will automatically
create the link, and if the URL is for a page in the current site, the
page name will be set as the link text.

i, Confluence doesn't provide an option to configure a link to open in a new
window or tab. Users can choose to right click / CTRL+click the link if they
want to open it in a particular way.

Insert an image link

1. Select an image on your page
2. Choose Link on the Image Properties toolbar
3

On this page:

® |nsert a text link
® Other ways
to do this
Insert an image link
Modify a link
Remove a link
Link to specific
types of content
® Link to Confluence
pages from other
websites
® Link to a comment
® Using shortcut
Links

Related pages:

® Anchors

® Inserting JIRA
Issues

® The Editor

. Select a page, blog post or attachment, or enter an external URL (see below for how to link to

particular types of content)
4. Choose Insert

150px s 5§ 8 QOriginal Border & Link Properties
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Modify a link

1. Select the link text or image
2. Choose Edit from the link properties toolbar
3. Modify the link and choose Save

Remove a link

1. Select the link text or image
2. Choose Unlink from the properties toolbar

Click to find out more

Go to link Edit Unlink

Link to specific types of content

Confluence supports many methods for creating links. Some of the common ones are listed here.

Type of link

Link to a page

Link to a page in
another space

Link to a blog post

Ways to do this

Choose Link > Search then enter part of the page name.

or

Choose Link > Recently viewed and select a page from the list.

or

Type [ and enter part of the page name then select the page from the list.
or

Paste the URL of the page onto your page (Confluence will automatically create the
link).

Choose Link > Search enter part of the page name and select All Spaces from the
drop down.

or

Choose Link > Advanced then enter the space key followed by the page name spa
cekey: nypage.

or

Type [ and enter part of the page name then select the page from the list.
(you can hover over each suggestion to see which space the page is from).

Choose Link > Search and enter part of the blog post name.
or

Type [ and enter part of the blog post name then select the blog post from the list.
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Link to an
attachment or
image on this page

Link to an
attachment on
another page

Link to a website

Link to an email
address

Link to an anchor
on a page

Link to a heading
on a page

Link to a comment
on a page

Choose Link > Attachment then upload or select an attachment from the list.
or

Type [ and enter part of the attachment file name then select the attachment from
the list.

Choose Link > Search and enter part of the attachment name.

or

Typg [ and enter part of the attachment file name then select the attachment from
Eggdlitan hover over each suggestion to see which space the page is from).
Choose Link > Web Link then enter the website URL.

or

Type or paste the URL onto the page (Confluence will automatically create the link).
Choose Link > Web Link then enter the email address.

or

Type or paste the email address onto the page (Confluence will automatically
create a 'mailto:' link).

Choose Link > Advanced then enter the anchor name in one of the formats below.
For an anchor on this page: #anchor nane.
For an anchor on another page in this space: page nane#anchor nane.

For an Anchor on another page in another space: spacekey: page
name#anchor nane.

See Anchors for more information on using anchors.

Choose Link > Advanced then enter the heading in one of the formats below.
Heading text is case sensitive and must be entered without spaces.

For a heading on this page: #MyHeadi ng.
For a heading on another page in this space: Page Nanme#MyHeadi ng.

For a heading on another page in another space: spacekey: Page
Nane#MyHeadi ng.

Be aware that these links will break if you edit the heading text. Consider using the
Table of Contents macro or an Anchor instead.

Go to the comment, right click the Date at the bottom of the comment and copy the
link. Paste the link directly onto your page or choose Link >Web Link and paste in
the URL.

or

Type [$ then enter the Comment ID ('12345' in this example): [ $12345]
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Link to an Choose Link > Advanced then enter the new page name (a page will be created
undefined page on click).

(a page that does

not exist yet) or

Type [ then enter the new page name then choose Insert link to create page.

See Undefined Page Links for more information on undefined pages.

Link to a personal Choose Link > Search then enter the user's name and select their personal space
space or user homepage or their profile from the list.
profile

or

Type [ then enter the user's name and select their personal space homepage or
their profile from the list.

Link to a Jiraissue = Paste the Jira issue URL - Confluence will automatically create a Jira Issue macro.
(where Confluence

is connected to

Jira)

Link to Confluence pages from other websites
The best way to link to a Confluence page from outside Confluence, for example from another site or in an
email, is to use the share link which is a permanent URL. This ensures that the link to the page is not broken
if the page name changes.
To access the permanent URL for a page:

1. View the page you wish to link to.

2. Choose Share.

3. Copy the Share link.

You do not need to use the share link to link to pages within your Confluence site. Confluence automatically
updates links when you rename or move a page to another space.

If you want to link to specific content such as anchors, headings or comments you need to use the following
link syntax. Note that there are no spaces in the page name, anchor name or heading text.

In the examples below, the anchor name is 'InsertLinkAnchor' and the heading text is 'Insert a link'.

Purpose Link syntax

Link to an htt p://nyconfl uence. com di spl ay/ spacekey/ Page+nane#pagenane-
anchor anchor nane

(from an

external Example from this page:

website)

htt ps://confl uence. at | assi an. cont di spl ay/ DOC
/ Wor ki ng+wi t h+Li nks#Wor ki ngwi t hLi nks-1 nsert Li nkAnchor

Linkto a http://nyconfl uence. com di spl ay/ spacekey/ Page+nane#pagenane-
heading headi ngt ext

(from an

external Example from this page:

website)

htt ps://confl uence. atl assi an. coni di spl ay/ DCC
[ Wor ki ng+wi t h+Li nks#Wor ki ngwi t hLi nks-1nsertal i nk
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Link to a htt p://nyconfl uence. com di spl ay/ spacekey/ pagenane?
comment f ocusedConment | d=comment i d#conment - conment i d

(from an

external Example from this page:

website)

htt ps://confl uence. atl assi an. cont di spl ay/ DOC/ Wor ki ng+wi t h+Li nks?
f ocusedComrent | d=368640803#conment - 368640803

Some things to note when linking to anchors from a website or email message:
® The page name is repeated in the URL, after the # sign. The second occurrence of the page name is
concatenated into a single word, with all spaces removed.
® There is a single dash (hyphen) between the concatenated page name and the anchor name.
® The anchor name in the full URL is concatenated into a single word, with all spaces removed.

® The anchor name is case sensitive. You must use the same pattern of upper and lower case letters
as you used when creating the Anchor.

Link to a comment

You can add a link to a comment by using the comment URL (a permanent link), or by using wiki markup to
link to the Comment ID.

To find out the comment URL and comment ID:

1. Go to the comment you wish to link to
2. Choose the Date at the bottom of the comment and examine the URL

The number after ‘comment-' is the Comment ID. An example is shown here.
https://confluence. atl assi an. conl di spl ay/ DOC/ Wor ki ng+wi t h+Li nks?f ocusedConment | d=368640803#conmment -

368640803

You can use wiki markup directly in the editor to link to a comment. Enter [$ followed by the Comment ID, for
example [ $12345] where '12345' is the Comment ID.

Using shortcut Links

I We ended support for shortcut links in Confluence 7.0
Shortcut links can still be added and used on pages, but we will no longer fix bugs relating to this
feature, and plan to remove it in a future Confluence release.

If you have configured shortcut links on your Confluence site, then you can link to an external site using a
shortcut link that looks like this:CONF- 17025@ i r a.

Our Confluence site (where this documentation is housed) is configured to allow shortcut links to our Jira
site, using the shortcut @i r a. So the shortcut link CONF- 17025@ i r a produces this link.

To add a shortcut link using the 'Insert Link' dialog:
1. Choose Link > Advanced and enter or paste the shortcut link into the Link field (shortcut links are
case-insensitive)
2. Modify or enter link text (this is the text that will appear on the page)
3. Choose Insert

You can also type '[' and choose Insert Web Link > Advanced to enter a shortcut link.

See Configuring Shortcut Links for more details.
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Anchors

You can use anchors to enable linking to specific locations on a page, and On this page:
they can be especially useful for allowing your readers to navigate to
specific parts of a long document. Anchors are invisible to the reader when ® Step 1: Create the
the page is displayed. anchor
_ ® Step 2: Create a
There are two steps to using an anchor: link to the anchor
®* Notes

Step 1: Create the anchor

) Related pages:
Step 2: Create a link to the anchor

® Links
Step 1: Create the anchor

Add the Anchor Macro to mark the location you want to link to:

1. Do either of the following in the Confluence editor:
® Choose Insert > Other Macros, then find and select the
Anchor macro
* Type { and the beginning of the macro name, then select the
Anchor macro
2. Enter the Anchor Name (For example, 'bottom' or 'important
information’)
3. Choose Insert

Macro options (parameters)

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default | Description

Anchor None This is the anchor name that you will use when creating the link.
Name
® The anchor name can include spaces. Confluence will remove the spaces
automatically when building a URL that points to this anchor.
® The anchor name is case sensitive. You must use the same pattern of upper
and lower case letters when creating the link as you used when creating the
Anchor macro.

Step 2: Create a link to the anchor
You can link to an anchor from:

® A page on the same Confluence site. The link may be on the same page as the anchor, another page
in the same space, or a page in another space on the same Confluence site.
® Another web page or another Confluence site, using a specifically formatted URL.
Link to an anchor on the same Confluence site:
1. Select some text or position your cursor where you want to insert the link

2. Choose Link in the toolbar or press Ctrl+K
3. Choose Advanced and enter the anchor name in the Link field, following the format below.

Anchor location Link syntax for anchor Examples
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Same page #anchor name #bottom
#important information
Page in same space | page name#anchor name My page#bottom
My page#important information

Page in different spacekey: page nane#anchor DOC:My page#bottom
space name
DOC:My page#important
information

4. Enter or modify the Link Text (this is the text that will appear on the page. If this field is left blank, the
page name or URL will be used as the link text)
5. Choose Save

®

® Anchor names are case sensitive

® Enter page and anchor names with spaces when you link to them in the same Confluence site

® |f you're linking to an anchor on a different page that has special characters in its name,
where the URL displays a page ID rather than a name, you should still enter the page name
when linking to it

Screenshot: The 'Advanced’ option in the link dialog

Insert link Help

Search Here you caninsert a link into the page using wiki markup.

Recently viewed
Files #goodstuff

Web link

Advanced

Link text | Link to the goad stuff

Link to an anchor from another web page or another Confluence site:

Use a full URL in the following format:

Link syntax Examples

http:// nyconfl uence. com di spl ay/ spacekey http://myconfluence.com/display/DOCS
/ pagenane#pagenane- anchor name IMy+page#Mypage-bottom

http://myconfluence.com/display/DOCS
IMy+page#Mypage-importantinformation

Notes about the full URL:

®* The page name is repeated in the URL, after the # sign. The second occurrence of the page name is
concatenated into a single word, with all spaces removed.

There is a single dash (hyphen) between the concatenated page name and the anchor name.

The anchor name in the full URL is concatenated into a single word, with all spaces removed.

The anchor name is case sensitive.

If the page name contains special characters, where the URL displays a page ID rather than a name,
the link to an anchor will look more like this ht t p: / / myconf | uence. conif pages/ vi ewpage.
acti on?pagel d=54689987#Test - pagel! - anchor

In this example the page title is Test - Page 1! and the anchor name is anchor .
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Notes

® Table of contents on a page: Consider using the Table of Contents Macro to generate a list of links
pointing to the headings on the page. The list of links will appear on the page, and will be
automatically updated each time someone changes the wording of a heading.

® Linking to headings: You can link directly to the headings of a page. See Links. However, if
someone changes the wording of a heading, those direct links will be broken. Use the Anchor macro
to ensure a lasting link within the body of a page.

® Site welcome message: If you are adding an anchor to a page that you are using in the site
welcome message, you can only link to that anchor from another page. Internal links within that page
will not work.

®* Templates: When you are previewing a template, a link to an anchor is displayed as a 'broken' link.
However, when you create a page using the template the resulting page will have the correct link.
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Tables

Confluence tables allow you to present important information and discuss it

with your team. Use familiar table formatting options —resizing columns, On this page:
coloring cells, rows and columns, and sorting the table by clicking the
column headers — to view the information the way you like it. ® Insert a table
® Edit your table
Using Confluence Cloud? Check out our info on the new Confluence * Shortcut keys
® Sort the table in

Cloud editor if your table looks like this one. :
view mode

® Sticky table
| 2 = headers in view
mode

Wblesalars + % Related pages:

¢ Page Layouts,
I bl Columns and
nsert a table Sections

® The Editor
To create a table:

1. Hit the Table button in the toolbar
2. Click a cell in the drop-down to set the number of columns and rows
in your table

s cCR+ - -

Ix3

Hold SHIFT for a table without a
heading.

Edit your table

To resize table columns, just click and drag the column's border. To make other changes to your table, click
inside it to reveal the table toolbar.

Here's a summary of the table tools:

- Column width modes
Responsive v

. ® Responsive — choose this mode if you want the table to expand as you add
Responsive content. You can drag to resize the columns. It'll also resize itself to fit the
page-viewer's window size (within reason).

Fixed width . . . .
® Fixed width — choose this mode if you want to drag column borders to set
width. Columns appear at your set size, regardless of content and window
size.
+ Rows
B8 95

Insert rows before or after the current row

Delete the current row

Cut, copy and paste the current row

Mark a row as a header row (shaded with bold text)

Ag
X = 3
=]
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Il.||. ﬂ. Columns

Insert columns before or after the current column

=

Delete the current column

Cut, copy and paste the current column

Mark a column as a header column (shaded with bold text)
Add a numbering column to automatically number each row

B @ x
i)

a Cells
® Merge selected cells
O, n * Split selected cells
® Change cell color

m Table

® Delete entire table

Shortcut keys

Windows Action Mac OS X

Ctrl+Shift+c Copy the current table row, or the selected rows. Cmd+Shift+c
Ctrl+Shift+i Insert a table. (Opens the Insert Table dialog.) Cmd+Shift+i
Ctrl+Shift+v Paste the table rows from your clipboard, placing them above the Cmd+Shift+v

current row.

Ctrl+Shift+x Cut the current table row, or the selected rows. Cmd+Shift+x
Alt+Up Arrow  Add a row above the current row. Alt+Up Arrow
Alt+Down Add a row below the current row. Alt+Down
Arrow Arrow

For more editor keyboard shortcuts, see Keyboard shortcuts.

Sort the table in view mode
When viewing a table on a page, you can sort it by clicking the sort icons in the header row.

Screenshot: A colorful, sortable table

Document Author Reviewer
Get started Sandy Pete
Installation guide Sandy Trinh
Upgrade guide Juan Lise

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

Confluence 7.4 Documentation

The default sort order is the order the table rows are listed in the editor. You can use the Cut row and Paste
row icons to move rows around in the editor.

Sticky table headers in view mode

In some instances the header rows of your table will stick to the top when you're scrolling down a page,
making those really long tables easier to read.

You don't need to do anything to enable sticky table headers, however there are a lot of situations where
headers won't stick. These include when your table:

Is inside a page layout, inside another table, or inside a macro.
Has no header row or there are cells in the top row that aren't marked as headers.
Has a header column, instead of a header row, and scrolls horizontally.

[ ]
[ ]
[ ]
® Contains another table, that has its own header row.

There's no way to freeze rows or columns in Confluence tables.

See

[J CONFSERVER-54343 - Table header with heading column not sticky when scrolling
LONG TERM BACKLOG

for issues with sticky table headers.
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Add, Assign, and View Tasks

Keep track of the things that need to get done with tasks. With the ability to

give each task an assignee and due date, and plenty of ways to see your On this page:
tasks, you can make sure nothing slips through the cracks.
® Add atask
® View tasks
Add a task e Notes

You can add tasks on any page in Confluence. For example, you might add
tasks under action items on a meeting notes page, or in a requirements
page — anywhere you need a lightweight task management solution.

To create a task:

1. In the editor, choose the Task list & button or use the keyboard shortcut [ ]
2. Start typing your task — @mention someone to assign the task to them, and type // and choose a due
date
The first person you mention in a task is the assignee; you can even assign tasks to yourself.

Note: If you assign a task to someone who doesn't have permission to view the page or space, they won't
see the task.

View tasks

There are a number of ways to keep track of tasks assigned to you, or tasks you've created for others.
On a page

The simplest way to see a task is on the page it was originally created on. It's easy to see if a task is

complete, who it's assigned to, and when it's due. If a task is nearing or passed its due date, the color of the
date will change (red for overdue, orange for due in the next 7 days).

Action items

@ Alana Grant to decide on name of project space
@ Cassie Owens to finish creating the new project space by

@Emma McRae to investigate venues for offsite and prepare costings for at
least three different options by ] 31 Mar 2018
@ Harvey Jennings distribute agenda for offsite [ 04 Apr 2018

In your profile

The tasks page in your profile gives you a place to see all the tasks relevant to you. Easily keep track of the
status of tasks assigned to you, and tasks you've created and assigned to others.

To view the tasks page, go to Profile > Tasks. Use the filters to show tasks that were assigned to you or
created by you in the last 6 months, and toggle between complete or incomplete tasks.
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Created by me Complete
Description Due date « Task appears on
Schedule a follow up meeting on 30 Jan 2018 30 Jan 2018 2018-01-17 Meeting notes
to finish creating the new project space by M 10 Mar 201 10 Mar 2018 2018-03-09 Meeting notes
10 investigate haw other teams are solving this problam Where shauld we store our files?
Prepare talk about new campaign - My to do list
Organise venue for offsite 2018-01-17 Meeting notes

If you need to see more than just your last 6 months of tasks, use a Task Report.
In a Task Report

If you're looking for a more custom view of tasks, the Task Report blueprint is a great way to track tasks
assigned to a specific team or project.

To create a task report:

1. Choose Create > Task Report
2. Select the type of report:

® Assigned to my team — for tasks assigned to particular people.

®* In my project — for tasks that appear in a specific space or page.

® Custom — for a wide range of filtering options, including by date or page label.
3. Follow the prompts to create the report.

This blueprint uses the Task Report Macro. You can also choose to use this macro on an existing page, for
example, on a project or team space homepage.

Planning meeting actions

Description Due date « Assignee Task appears on

to finish creating the new project space by 117 Jan 2018 17 Jan 2018  Cassie Owens Project plan

Schedule a follow up meeting on 7130 Jan 2018 30 Jan 2018  Cassie Owens 2018-01-17
Meeting notes
Harvey Jennings distribute agenda for offsite 7108 Feb 2018 08 Feb 2018 Harvey Jennings  Project plan
Notes

® The date picker can be triggered by typing // or by typing a date in the format dd/mm/yyyy or dd-mm-
yyyy. Typing other date formats in the editor won't trigger the date picker.

® Personal Tasks (created in the Workbox in older versions of Confluence) don't appear in the Tasks
view or Task Report. To migrate any incomplete personal tasks, go to Workbox > Personal Tasks an
d follow the prompts.

® The wiki markup based Tasklist Macro has been removed from the macro browser. If you have a
Tasklist macro on a page it will continue to work, but you will be unable to add new Tasklists using
this macro.
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(¥) Do more with Confluence

For even more ways to organize your tasks in Confluence, check out these apps from the Atlassian
Marketplace:

® Comala Workflows: Improve document collaboration by assigning users to review, approve,

and publish pages
® TodoMe for Confluence: Add, assign, and view tasks from every Confluence page
® Agile Retrospectives for Confluence: Interactively assign action items to team members
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http://creativecommons.org/licenses/by/2.5/au/
https://marketplace.atlassian.com/search?hosting=server&moreFilters=vendorSupported&product=confluence
https://marketplace.atlassian.com/search?hosting=server&moreFilters=vendorSupported&product=confluence
https://marketplace.atlassian.com/apps/142/comala-workflows?hosting=server&tab=overview
https://marketplace.atlassian.com/apps/1217636/todome-for-confluence?hosting=server&tab=overview
https://marketplace.atlassian.com/apps/1216054/agile-retrospectives-for-confluence?hosting=server&tab=overview

Autocomplete for links, files, macros and mentions

When using the Confluence editor, you can type a trigger character or press

a keyboard shortcut to see a list of suggested links, files or macros to add
to your page, or to mention another user (and automatically notify them of

this).
Summary of autocomplete

What you want to do Trigger

character

Add a link on your page |

Display an image, !
video, audio file or
document on your page

Add a macro on your {
page

Notify another user by @
email that you have
mentioned them on

your page

Using autocomplete for links

Keyboard
shortcut

Ctrl+Shift+K

Ctrl+Shift+M

None

None

Description

See a list of
suggested pages
or other locations
to link to from your
page. More...

See a list of
suggested images,
multimedia files
and documents to
embed in your
page. More...

See a list of
suggestions as
you begin typing a

macro name. More.

See a list of
suggested users
to mention. More...

On this page:

Summary of
autocomplete
Using
autocomplete for
links

Using
autocomplete for
images, videos,
audio files and
documents
Using
autocomplete for
macros

Using
autocomplete for
mentions
Canceling
autocomplete
Enabling and
disabling
autocomplete
Ignoring
autocomplete

Related pages:

Links

Using Images
Macros

Keyboard shortcuts
Your profile and
settings

Type T, or press Ctrl+Shift+K, to see a list of suggested pages or other locations to link to from your page.
You can link to pages, user profiles, images, documents and other file attachments.

To autocomplete a link:

1. Edit the page.

2. Click where you want to insert a link and do one of the following:
®* Type T and then the first few characters of the page title, user's name, image name or file

name.

® Type the first few characters of the page title, user's name, image name or file name (or select

relevant text) and then press Ctrl+Shift+K.

3. Click the relevant link from the list of suggestions.

If the item you need is not in the list, either:

® Choose Search for 'xxx' to continue looking for the page within Confluence, or
® Choose Insert Web Link to insert a link to an external web page using the link browser.

Screenshot: Autocomplete for a link
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| want to add a link to [ samp|

Link suggestions

B sample

Ef) Sample Blog
SampleVideco_1280x720_1Tmb.mp4

Amanda Sampson

Sampada Dhara
) A sample space

Q Search for ‘samp’
Insert web link

+ Insert link to create page

Using autocomplete for images, videos, audio files and documents

You can use the autocomplete as a fast way of embedding images, videos, audio files and documents into
your page. Type an exclamation mark or press Ctrl (or Cmd)+Shift+M to see a list of suggested images,
multimedia files and documents to display on your page. You can use autocomplete to embed the following
file types:

Images — any format that Confluence supports.

Videos, audio files and all multimedia formats that Confluence supports.

Office documents supported by the Confluence Office Connector: Word, Excel and PowerPoint.
PDF files.

@ Autocomplete works most efficiently for files that are already attached to the Confluence page.
To embed an image, video, audio file or document:

1. Edit the page.
2. Click where you want to insert the image, video, audio file or document and do one of the following:
® Type 'I"and then the first few characters of the image, file or document name.
* Type the first few characters of the name of the image, file or document (or select relevant text)
and then press Ctrl (or Cmd)+Shift+M.
3. Choose the relevant file from the list of suggestions.

If the item you need is not in the list, either:
® Choose Open file library to find images and documents using the image browser, or
® Choose Insert other media to embed videos, audio and other multimedia files using the macro

browser.

Screenshot: Autocomplete for an image or file
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| want to add an image !|

File suggestions

E] Data-Center-Confluence-brochure.p...

3 confluence_rgb_blue_atlassian.ai

gl

.. Pizza@2x.png

&7 Open file library

Insert other media

Using autocomplete for macros
Type '{ to see a list of suggested macros to add to your page.

Autocomplete provides access to all available macros in your Confluence site, including any user macros
that your administrator has added and made visible to all.

@ You need to know the name of macro. Autocomplete for macros will only match the name of the macro,
not the description.

To autocomplete a macro using '{":

Edit the page.

Click where you want to insert the macro.

Type '{' and then the first few characters of the macro name.
Choose the relevant macro from the list of suggestions.
Configure the macro by completing the form fields as prompted.

AN

If the macro you need is not in the list, choose Open Macro Browser in the list of suggestions to continue
looking for the macro in the macro browser. See Macros.

Screenshot: Autocomplete for a macro

| want to add a macro {|

Macro suggestions

@ Info

—— Status

Gallery

Table of Contents

» Open macro browser

Using autocomplete for mentions
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You can use autocomplete to automatically notify another Confluence user that you have mentioned them in
a page, blog post, or comment. Type '@’ and part of the person's name, to see a list of suggested users.

Note: Use the person's full name. Autocomplete will recognize users' full names only, not their usernames.

Canceling autocomplete

The autocomplete starts automatically when you press the trigger characters. You may want to close the
autocomplete menu or escape from autocomplete once it has started.

There are a few different ways to stop the autocomplete once it has started:

Press the escape key, 'Esc’, on your keyboard.

Click somewhere else in the editor panel.

Press an arrow key to move out of the autocomplete area.

For the link autocomplete only: enter a right-hand square bracket, like this: ]

Enabling and disabling autocomplete

You can turn off the triggering of autocomplete by the '[' and '!" characters. This will prevent the autocomplete
from starting automatically when you press one of the trigger characters. You can also turn it back on again.

Notes:

® This setting does not affect the keyboard shortcuts for autocomplete (Ctrl+Shift+K and Ctrl+Shift+M).
Even if the trigger characters are disabled, you can still use the keyboard shortcuts for autocomplete.

® This setting affects only you. Other people using Confluence can enable or disable the setting on their
user profiles independently.

® Note that autocomplete is enabled by default.

To enable or disable the autocomplete trigger characters:

1. Choose your profile picture at top right of the screen, then choose Settings
2. Choose Editor under 'Your Settings' in the left-hand panel.
3. Choose Edit.
4. Either:

® Disable autocompletion by selecting Disable Autocomplete.

® Enable autocompletion by clearing Disable Autocomplete.
5. Choose Submit.

Screenshot: User settings for the editor

People

Emma McRae

Profile Tasks Saved for later Watches Drafts MNetwork Settings

YOUR SETTINGS
Password . .
Editor Settings

Email Disab
Editor

GADGETS

View QAuth Access
Tokens

d text to be converted to its

Ignoring autocomplete
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You can add macros, links and images by wiki markup alone. Type the macro, including its parameters and
the closing curly bracket. Add a link, such as an anchor link, and end it with a square bracket. Insert an
image or other embedded object, enclosed between exclamation marks. As soon as you close the macro,
link, or embedded image, Confluence will convert it to rich text format and add it to the page.

For more information about mouse-free macros, links and images, choose Help > Keyboard Shortcuts
from the Confluence header.
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Page Layouts, Columns and Sections

The layout of your pages can have a big impact on how they're read, and
layouts, used well, allow you to position text, images, macros, charts, and
much more, to have the best visual impact.

On this page:

) ® The Section and
There are two ways to modify the layout of a Confluence page: Column macros

® Use page layouts to add sections and columns
® Use macros to add sections and columns.

Page layouts provide a simple, visual representation of your page layout in
the editor, while the macros are more flexible and allow for greater
complexity in your layout.

Use page layouts

The page layouts tool allows you to structure your page using horizontal sections and vertical columns. By
adding multiple sections with different column configurations you can build quite complex layouts very easily.

Screenshot: Editor view of a page showing three sections with different column configurations.

-+ Add section W Remove section T Moveup 4 Movedown B W IN N I W X

.
Devieam / Pages / Devteam Home % % @  DRaFT m J

Team playbook update: health monitor

The Health Manitor is for all teams = peried. Whether yaur team is high-perfarming, (
ar deaply dysfunctional; na matter vour level, functian, ar industry.

Part cure, part preventative medicine, the Health Monitor is your team's chance to

listen to each other and take an honest look in the mirror. You'll assess against ‘ ’ ‘q %

eight attributes common among healthy teams, and walk away with a better
understanding of your strengths (plus plans to address your weak spots).

Anybody can run a Health Moniter workshop, so don't wait around for some directive from on high. YOU are the change
you've been waiting for.

Start by adding a horizontal section to your page.

To add a section:

1. Choose the Page Layout [ hutton in the toolbar
The Page Layout toolbar appears.
2. Choose Add Section

The new section appears below your current content, with the boundaries of the section(s) indicated by
dotted lines (the dotted lines aren't visible when you view the page).

To change the column layout in a section:

1. Place your cursor in the section you wish to change
2. Choose a layout from the page layout toolbar (for example, two columns or three columns)

Any text, images or macros in your section are not lost when you change the column layout. When you
decrease the number of columns, Confluence will move your content to the left. When you increase the
number of columns, Confluence will add blank columns to the right of your existing content.

To move a section to another part of the page:

1. Place your cursor in the section you wish to move
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2. Choose the Move up or Move down buttons
The section and all of its content will be moved above or below other sections on the page.
To delete a section:

1. Place your cursor in the section you wish to remove
2. Choose Remove section

The section and all of its content will be removed.

Notes about Page Layouts

® Column width — The width of the columns are fixed. If you need more than three columns, or
columns of a specific width, you should use the Section and Column macros described below.

®* Very wide tables — The width of each column is set to a percentage of the page width. The icons in
the drop-down menu indicate the relative widths for each layout. In most cases, Confluence will adapt
the width of the columns to fit the width of the page. If a column includes an item that's too wide for it,
you'll see a horizontal scroll bar when viewing the page.

The Section and Column macros

You can use the Section and Column macros to add a set of columns to the page. The Section macro
defines an area that will contain the columns. You can have as many sections as you like. Within each
section, you can have as many columns as you like.

The Section and Column macros are useful if you want to define a specific percentage or pixel width for
each column.

To add a section and some columns to a page:

1. In the Confluence editor, choose Insert + ¥ > Other Macros
2. Find the Section macro, select it and insert it onto the page
3. Choose Insert > Other Macros again

4. Find and insert the Column macro

5. Add your content to the column

Insert as many columns as you like within the section.

I You should always have at least one column macro within a section macro. Using a section macro
without any column macros can negatively affect page loading time.

Screenshot: A section and two columns in the editor
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Column

Content for column 1 goes here

Column

Content for column 2 goes here

Macro parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameters of the Section macro

Parameter Default = Description
Show Border  false Select this option to draw a border around the section and columns.

Note: Without a Column macro , the border will not be displayed correctly.

Parameters of the Column macro

Parameter = Default Description

Column 100% of the page width, divided Specify the width of the column, in pixels (for

Width equally by the number of columns = example, 400px) or as a percentage of the available
in the section. width (for example, 50%).

1 All content within your section must be enclosed within a Column macro, otherwise the section
layout will not work as expected.
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Create Beautiful and Dynamic Pages

Confluence has a number of features that help you

build attractive pages to engage your readers and On this page:
give them the opportunity to interact with up-to-date .
information. This page summarizes those features ® Add visual appeal
and provides links to detailed instructions. ¢ Bring numbers to life
® Display presentations and documents
. ® Pullin content from Jira applications
Add visual appeal ® Tell a story in pictures
) ® Vary the structure of your pages
Pictures, photographs and ® |Integrate your content with social media
screenshots. Confluence pages °

. . Show activity streams
can display images from your

Confluence site and from other

; . ; Related pages:
websites. To put an image into

. Confluence, you can upload it ® Macros
and attach it to a page or blog ® The Editor
post, then display it on any page, ® Create and Edit Pages

blog post or comment. Alternatively, display a
remote image using its web address (URL). See Dis
playing Images.

Galleries. Use the Gallery Macro to display a set of
images. When viewing the page, people can click
any of the pictures to zoom in and view the images
as a slide show.

People. Add a Profile Picture Macro to show a picture of a Confluence user, or a User Profile Macro to show
a summary of the person's profile as well as their avatar.

Multimedia. You can display movies, animations and videos, and embed audio files on your Confluence
page. For example, Confluence supports Adobe Flash, MP3, MP4, and various other movie formats. See Em
bedding Multimedia Content.

Social video and image sharing. The Widget macro displays live content from social sites such as YouTube

and other video sharing sites, and Flickr for shared photographs. See the guide to the Widget Connector
Macro.

Bring numbers to life

The Chart Macro offers a variety of graphs and charts that you can use to illustrate statistics and other
numerical data.

Hlustration: A 3-dimensional bar chart produced by the Chart macro
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B Revenue W Expense

Display presentations and documents

Display your Office documents and other presentations directly in Confluence.

® Attach your Office documents to a Confluence page then display them on the page, using the View
File Macro. This works for Excel spreadsheets, PowerPoint presentations and Word documents.

® Display PDF files in Confluence too, also with the View File Macro.

® Use the Widget Connector Macro to show slide decks hosted on SlideShare and other online
presentation sites.

WAtlassian o

lllustration: A PowerPoint slide deck

Pull in content from Jira applications

Many project teams and customers also use Jira applications such as Jira Software or Jira Service Desk.
Rather than copying and pasting issues onto your Confluence page, you can display it directly from the
source, thus ensuring that the information shown in Confluence is always up to date.

Link to a feature request in your issue tracker, or display a list of fixed issues — useful for release notes and
project planning. See the Jira Issues Macro.

Tell a story in pictures

A number of Marketplace apps for Confluence provide sophisticated tools for creating diagrams and
mockups.

For example:
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Balsamiq Mockups for Confluence
Creately for Confluence

Gliffy Confluence Plugin

Graphviz Plugin for Confluence
Lucidchart for Confluence

Search the Atlassian Marketplace for more apps.
Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's

information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our
guidelines on add-on support.

Space

Home page

:

Files Files Files Files

Hlustration: A Gliffy diagram

Vary the structure of your pages

You can build up a custom layout by using the page layout tool to add sections and columns to your page.
See the detailed guidelines to Page Layouts, Columns and Sections.

Do you need to display tabular data, which your readers can sort when viewing the page? See Tables.
Use other macros to highlight and format sections of your page:

®* Panel

® Info, Tip, Note, and Warning
® Code block

® Noformat

Integrate your content with social media
People share information on various social sites. You can make Confluence a focal point where people
collect their shared information and see what is happening in the areas that matter to them.

Use the Widget Connector macro:

® Show a live stream of tweets from a Twitter user, or tweets matching a Twitter search.
® Display a video from YouTube or other online movie sites.

® Share photographs from Flickr.

® See what else the Widget Connector macro can do.
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Tweets W Follow @confluence

v Atlassian Confluence 2ul —
<#¥ @confluence L

Walking the requirements
documentation tightrope in an agile
world atlss.inf13hgGlh via @atlassian

Expand
vy Atlassian Confluence 27 Jun
¥ @confluence

Keep up-to-date with the new Watch
button in Confluence — available
today! ow.ly/mgm 11 #collabaration
#atlassian

Tweet to @confluence

lllustration: Twitter stream via the Widget macro

Show activity streams
Make your Confluence pages dynamic and interactive with:

® An activity stream showing updates and comments on Confluence and other linked applications. See

Gadgets.
® An RSS feed from within Confluence or an external site. See Subscribe to RSS Feeds within

Confluence.
® A list of recent blog posts from within Confluence. See Blog Posts Macro.
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Page Templates

When you add a new page, you don't have to start from scratch. Instead,
you can base your new page on a template — a Confluence page with
predefined content. Some templates are provided by blueprints or
Marketplace apps, and you can even create your own templates.

Some examples of useful templates are:

® The meeting notes template will help you and your team collaborate
on notes and follow-up tasks

® The requirements template allows you to capture your software
/hardware product requirements, and create related Jira issues from
the page

Global templates and space templates
In Confluence, there are two categories of page templates:

® Space templates: These page templates are available in a specific
space only. If you have space administrator permission, you can
define templates via the space administration screen.

®* Global templates: These page templates are available in every
space on your site. If you have Confluence Administrator permission,
you can define global templates via the Confluence Administration
Console.

If you're a system administrator, you can also download predefined
templates.

Create a template

On this page:

Global templates
and space
templates

® Create a template
® Use atemplate
® Templates

provided by
blueprints

Promote templates
in the Create dialog
System templates

Related pages:

® Create a Template
® Administering Site

Templates
Importing
Templates
Create a Page
from a Template

You can write your template using the Confluence editor. You can also add special variables to the page, if
you want to include fields that the author will complete when adding the page. See Create a Template for

more information.

Use a template

Page templates are used only when adding a page. It is not possible to apply a template to an already-

existing page. Once a page has been added using a template, the template is no longer linked to the page.
All further editing is performed as if the template was never used. Some Marketplace apps provide enhanced
template functionality. You can search the Atlassian Marketplace for template apps. See Create a Page from

a Template for more information.

Templates provided by blueprints

A blueprint is a page template with added functionality to help you create, manage and organize content in
Confluence, and there's a collection of predefined ones that ship with Confluence. You can also download
additional blueprints from the Atlassian Marketplace. You can customize the blueprint templates to suit your

individual needs, disable particular blueprints or even develop your own blueprints.

Promote templates in the Create dialog

If you're a space administrator, you can choose to promote specific templates and blueprints in the Create
dialog. Promoting items can help ensure consistency in a space by encouraging users to create particular

types of content, instead of blank pages.

The promoted templates or blueprints will appear at the top, with all other content types, including Blank
Page and Blog Post collapsed under them. To view the other types of content available choose the Show

more link.
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Create Filter
Select space Teams in Space - Parent; Teams in Spac
N Decision Meeting notes
Record important project decisions and 3 Plan your meetings and share notes and
communicate them with your team. actions with your team,

o Show more
———

1. Show more: see more templates and blueprints.
To promote a template or blueprint:
1. Goto Space Tools > Content Tools
2. Choose Promote next to the templates or blueprints you want to appear in the Create dialog. You can

only promote templates created in this space.

Remember, by promoting a blueprint or template you'll be hiding all other items, including blank page and
blog post, under the Show more link.

If you use the Show more link in the create dialog more than three times in a single space, the dialog will
show you all templates by default from then on.

System templates

Confluence also provides 'system templates' containing content like the site welcome message and default
space content. See Administering Site Templates.
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Create a Template

In Confluence, there are two categories of page templates:

On this page:
® Space templates: These page templates are available in a specific
space only. If you have space administrator permission, you can ® Add atemplate
define templates via the space administration screen. ® The template editor
® Global templates: These page templates are available in every * Template
space on your site. If you have Confluence Administrator permission, variables
you can define global templates via the Confluence Administration ¢ Labels
Console. ® Images and
other
attachments
® |Instructional
Add a template toxt

® Add a description
to your template

® Edit or delete a
template

® Notes

To create a new space template:

1. Go to the space and choose Space tools > Content Tools from the
bottom of the sidebar

2. Choose Templates > Create new template.

Related pages:
To create a new global template:

® Create a Page

1. Goto el General Configuration Global Templates and from a Template
Blueprints. ® Page Templates
2. Choose Add New Global Template ¢ Add, Remove and
Search for Labels
Macros
® The Editor

(¥ Check out the article How to document releases and share release notes to see how helpful creating
templates in Confluence can be.

The template editor

When you create or edit a template, you'll be using the editor in much the same way as when you edit a
page or blog post. In addition you can add variables, which will produce a form for data collection when
anyone adds a page based on the template.

Screenshot: The template editor with an image, table, text, and variables
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Dev team [ Templates %

Cross-team sync

Host team  (ITSTIIIEN § JP:'H
Location  (FETED) i =

Date am I j
1

Time [Stime]

Attendees Text Multi-line Text  List
Apologies

gonnmm introduction

Tell us a bit about your team

current challenges

What are you working on, what are the biggest challenges

Screenshot: The form displayed when you create a page based on the template

Dev teamn |/ Pages / Dev team Home

Page Template Wizard

Step 2: Fill in template variables

The information you supply will become part of the content in your new page.

Host team squir (teamName)
Location amsterdam | (location)

Date (date)

Time (time)
Attendees

Apologies
Squir (teamName)introduction

Tell us a bit about your team

Saqulr (teamName)current challenges

What are you working on, what are the biggest challenges

<< Back Next>>

Template variables
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When you add variables to your template, they will act as form fields. When you create a page based on a
template, you'll see a text entry box for each field. Enter data into each field, and it'll be added to the page.

You can add the same variable more than once in the same template, which is useful if you need the same
information in more than one place on the page.

To insert a variable into a template:
1. Choose Template > New Variable from the editor toolbar (or choose an existing variable to add it to
the page)
2. Enter a name for the variable
3. Press Enter (by default this will create a single-line text input field)

To change the variable type, click the variable placeholder and the variable's property panel will appear.
Choose one of the variable types: Text, Multi-line Text, or List.

You can change the number of lines and width in characters of a Multi-line Text field. If you choose List,
enter each of the items in your list, separated by commas.

SteamName

5 X 100 Text Multi-line Text List

$location

Sydney,Gdansk, Amsterdam Text  Multi-line Text  List

Hint: Type $ and the variable name, then press Enter to add a new variable or to select an existing variable
from a list of suggestions. The suggestions dialog shows variables already defined in this template.

Labels

If you'd like all pages created using this template to have one or more labels, choose the labels icon % next
to the breadcrumbs at the top of the page to add them.
Images and other attachments

You can't upload an image or other file into a template directly. First you'll need to upload the file to a page in
your site, then in your template, choose Insert > Files > Search on other pages to embed the file or image.

Instructional text

Instructional text is placeholder content in a template, and is only visible while you're editing the page. Use it
to give guidance to whoever is creating a page from the template.

To insert instructional text:

1. Choose Template > Instructional Text in the toolbar
2. Type in your instructional text (for example, Insert an image of the interface here.)

Instructional text appears in italics with a shaded background, to distinguish it from normal paragraph text.

You can also change the placeholder type from Text to either:
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® User mention — Opens the user mention dialog.
® Jira Macro — Opens a dialog that allows you to create a new Jira issue, or search for one or more Jira
issues to include on the page.

Add a description to your template

The template description displays in the 'Create' dialog, and is useful for explaining the purpose of your
template to other users.

To add a description to a template:
® Go to the space or global templates page (as described above)

® Choose the Edit icon in the 'Description’ column
® Enter your description and choose Save

User Created Templates Create New Template
Name Description Last Updated By Updated Operations
Cross-team sync New template for tmam Cassie Owen Jan 18, 2018 Promate - Edit - Dalate

sync meetings #

1. Edit: use the pencil icon to edit your template's description.

Edit or delete a template

If you need to change anything about your template, or want to delete it, navigate to either your space or
global template (as described above) and choose either Edit or Delete.

Notes

® Page templates are used only when adding a page. It is not possible to apply a template to an already-
existing page. Once a page has been added using a template, the template is no longer linked to the
page. All further editing is performed as if the template was never used. Some Marketplace apps
provide enhanced template functionality. You can search the Atlassian Marketplace for template apps.

® When you use a Table of Contents macro in a template, you'll see an error when you preview the
template, but the Table of Contents macro works on the pages that people create from the template.

® The editor for templates is available only in Confluence 4.3 and later. Please refer to the earlier
documentation for a description of the wiki markup editor templates.

® Confluence also provides 'system templates' containing content like the site welcome message and
default space content. See Administering Site Templates.
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Create a Page from a Template

You can create a page based on a global template (available to all spaces)

or a space template (available only to that space). On this page:

® Information copied

@ If you want to quickly create a blank page, hit the Create button in from the template
the header; if you want to create a page from a template, hit the Cre to the page
ate from template button. ® Form fields

displayed by the

o e template
® Using a template to
create a page

® Notes
1. Create blank page
2. Create from template Related pages:
® Create a Template
® The Editor
Information copied from the template to the page * Add, Remove and

Search for Labels

When you create a page based on a template, Confluence will copy the
following content and information from the template to the new page:

Labels

Text and styles

Layouts and formatting

Macros

Embedded images and other files. Note that you cannot attach an
image or other file to a template. But if the template displays an
image or file from another page, the new page will display that image
or file too.

Form fields displayed by the template

If the template author included variables in the template, Confluence will display a form prompting you to
supply values for the variables when you add the page.

Using a template to create a page

To create a page based on a template:

1. Choose Create from template - in the Confluence header
2. Select a space and the template you want to use and choose Next
If the template contains variables, you'll see a form allowing you to add values for the form variables.
3. Type the relevant information into the form fields, and choose Next
Now you'll see a new page based on the template. If you added information in the form fields, the
page content will include that information.
4. Name your page, add content or make any other changes required and hit Save

Screenshot: Form showing template variables when creating a page from a template
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Dev team [ Pages / Dev team Home

Page Template Wizard

Step 2: Fill in template variables

The information you supply will become part of the content in your new page.

Host team Squirf (teamName)

Location amsterdam &) (location) T_;
Date (date) =

Time (time) u
Attendees i
Apologies

Squir (teamName)introduction

Tell us a bit about your team

Squir (teamMName)current challenges

What are you working on, what are the biggest challenges

<< Back Next >>

Notes

Page templates are used only when adding a page. It is not possible to apply a template to an already-
existing page. Once a page has been added using a template, the template is no longer linked to the page.
All further editing is performed as if the template was never used. Some Marketplace apps provide enhanced
template functionality. You can search the Atlassian Marketplace for template apps.
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Blueprints

What's a blueprint?
On this page:
A blueprint is a set of page templates with added functionality to help you

create, manage and organize content in Confluence more easily. * What's a blueprint?

® Create content
using a blueprint
Customize
blueprint templates
® Promote blueprints

Create meeting notes, shared file lists and requirements documentation out
of the box, and Customize the blueprint templates to suit your individual °
needs. You can even develop your own blueprints.

Create content using a blueprint in the Create dialog
® Add more
- blueprints
1. Choose Create from template in the Confluence header * Disable a blueprint
2. Select a blueprint from the create dialog * Fulllist of blueprints
3. Hit Create

Related pages:
The editor will open, and, depending on the blueprint selected, a prompt to
enter information or the page will appear. You can now follow the
instructions built in to the blueprint to add content.

® Page Templates
® Request
Marketplace Apps

The first time a blueprint is used in a space, Confluence creates an index page and adds a shortcut to your
sidebar (if you're using the default theme). The index displays a list of pages made with the blueprint, and
information selected from your blueprint pages. For example, the meeting notes index displays a list of all
meeting notes pages in the space, who created them, and when they were last modified. Here's the index
page for the Meeting Notes blueprint:

Meeting notes

réated by Racl 3, 2018

Create meeting nate ."_o

Incomplete tasks from meetings

Description Due date « Assignee Task appears on
finalise focus areas by 110 Feb 2018 10 Feb 2018 Emma McRae 20M8-01-18 Meeling notes
o All meeting notes
—
Title Creator Modified
2018-01-18 Meeting notes Emad Abdi just a moment aga
2017-12-12 SeeSpaceEZ Team Meeting Alana Grant Jan 18, 2018

1. Easy to find: notes from all your meetings are listed here.
2. Start a new meeting: create a new meeting notes page here.

Customize blueprint templates

Blueprints are made up of templates that can often be customized for an individual space or the whole site.
This means you can adapt the content of the blueprint pages to suit your specific needs. For example, you
might update the Meeting Notes blueprint templates to include a heading for apologies.

If you have space administrator permissions, you can customize blueprint templates for the spaces you are
an administrator of. You must be a Confluence Administrator to customize blueprint templates for a whole
site. See Administering Site Templates for more information.
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To customize a blueprint template for a space:
1. Go to the space and choose Space tools > Content Tools from the bottom of the sidebar
2. Choose Edit beside the blueprint template you wish to edit
3. Make your changes to the template and choose Save
Editing a blueprint template is very similar to editing a page template, except:
® Be careful not to remove any macros that the blueprint page or index page may use to store and
display information
® You can't remove a blueprint template or change the template name
Not all blueprints are customizable. Some, including the Team Playbook blueprints (health monitor,
DACI, project poster, and experience) can't be edited.
To reset a blueprint template back to the default:

1. Go to the space and choose Space tools > Content Tools from the bottom of the sidebar
2. Choose Reset to default beside the blueprint template you wish to reset

See Working With Templates and Administering Site Templates for more information on templates.

As with user created space and site templates, editing a blueprint template will not change existing pages,
but any new blueprint pages will be based on the updated template.

Promote blueprints in the Create dialog

If you're a space administrator, you can choose to promote specific templates and blueprints in the Create
dialog. Promoting items can help ensure consistency in a space by encouraging users to create particular
types of content, instead of blank pages.

The promoted templates or blueprints will appear at the top, with all other content types, including Blank

Page and Blog Post collapsed under them. To view the other types of content available choose the Show
more link.

Create Filter

Select space Teams in Space hd Parent: Teams in Spac

1Y Decision m Meeting notes
Record important project decisions and Plan your meetings and share notes and
communicate them with your team. actions with your team,

o Show more
———h

1. Show more: see more templates and blueprints.
To promote a template or blueprint:
1. Goto Space Tools > Content Tools
2. Choose Promote next to the templates or blueprints you want to appear in the Create dialog. You can

only promote templates created in this space.

Remember, by promoting a blueprint or template you'll be hiding all other items, including blank page and
blog post, under the Show more link.

If you use the Show more link in the create dialog more than three times in a single space, the dialog will
show you all templates by default from then on.

Add more blueprints

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/
https://confluence.atlassian.com/display/CONF74/Administering+Site+Templates

Confluence 7.4 Documentation

You can find more blueprints for Confluence in the Atlassian Marketplace. Blueprints are managed using
apps (also known as add-ons, or plugins).

See Request Marketplace Apps for information on how you can search for new blueprint apps and send a
request to your System Administrator.

If you are a System Administrator, see Managing System and Marketplace Apps for information on how to
install new blueprint apps.

You can also develop your own blueprints. See our developer documentation on Writing a Blueprint.

Disable a blueprint

You may want to disable particular blueprints. For example, you may not want to see the Product
Requirements blueprint in the create dialog in an HR or Social space. If you are a Confluence Administrator
you can also disable particular page and space blueprints for the whole site.

To disable a blueprint in a space:

® Go to the space and choose Space tools > Content Tools from the bottom of the sidebar
® Choose Disable next to the blueprint you wish to disable in that space

You can re-enable the blueprint at any time.

To disable a blueprint across a whole site:

® Choose the cog icon E then choose General Configuration (You need Confluence Administrator
permissions to do this)

® Choose Global Templates and Blueprints

® Choose Disable next to the page or space blueprint you wish to disable

The blueprint will not appear in the 'Create’ or 'Create Space' dialogs.

Full list of blueprints

Here's the full list of blueprints bundled with Confluence.

Page blueprints Space blueprints

Meeting notes ® Documentation space
File list ® Team space

Decision ® Knowledge base space
How-to article

Troubleshooting article

Jira report

Product requirements

Retrospective

Share a link

Task report

DACI decision (Atlassian Team Playbook)

Experience canvas (Atlassian Team Playbook)

Health Monitor (Atlassian Team Playbook)

Project poster (Atlassian Team Playbook)
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Decisions Blueprint

The Decisions blueprint helps you make decisions and record the outcomes
with your team.

The first time you use the Decisions blueprint in a space, Confluence will
create an index page and add a shortcut on your space sidebar (if you're
using the default theme). The index acts as your Decision Log and lists all
the decisions in that space.

@ If you want to quickly create a blank page, hit the Create button in
the header; if you want to create a page from a template, hit the Cre
ate from template button.

1. Create blank page
2. Create from template

To create a decision page:

Choose Create from template - in the Confluence header
Select Decision and hit Next

3. Enter information about the decision and relevant stakeholders (the
blueprint will prompt you) and hit Create

N

Once you save your first decision page, Confluence will create a decision
log page for the space you're in, and add a shortcut to it in the space's
sidebar.

Here's how the decisions page looks in the editor:

Related pages:

Blueprints
File List Blueprint
Meeting Notes
Blueprint

® Product
Requirements
Blueprint

When will we launch?

| Page properties | label

Status 1N PROGRES...

Stakeholdars @ Michelle Admin @ Sophie Lisar

Outcome What did you decide?

Due date Y 19 Mar 2019

Owner @ Michelle Admin
Background

+ The conference will be on again in 2020, so we need to be locked-in well in advance,
« (@ Michefle Admin will be on leave in December 2018, so that may hold things up.
* We have 4 teams working on this throughout that period. Is this enough?

Once you save your first decision page, Confluence will create a decision log page for the space you're in,
and add a shortcut to it in the space's sidebar. The decision log lists all the decisions in that space.
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Pages | Product Development & # Edit 7 Save for later @ Watching =4 Share
Decision log
Created by Michelle Admin on Jun 26, 2018
Create decision 0-—-9
Decision Status Stakeholders Outcome Due date Owner
o_-. When will we launch? IN PROGRESS @Sophle User 19 Mar 2019
How do we split work? @Sophie User Split for 5.7 onwards. D8 Oct 2018
Where should we store our MOTSTARTED  (@Kate User = 04 Aug 20718

files?
1. Decision pages: your existing decisions appear here.
2. More decisions: create new pages using the decision template.
The Decisions blueprint uses these Confluence features:
® Page Properties and Page Properties Report macro - content that you enter within the page

properties macro can appear on the index page.

® Mentions - add a user as a stakeholder, owner or @mention them on the page and they will be
notified in their workbox.

(-:f) For an example of the Decisions Blueprint, and some other great page elements, check out: How to
make better decisions as a development team.
Customizing this blueprint
You can customize the templates that are used by the Decisions blueprint - see Customizing the blueprint
templates. For example, you might choose to edit the decisions index page in a space to change the

columns displayed by the Page Properties Report macro.

You can also edit the page template to add headings or instructional text to the background section, or even
add rows to the Page Properties macro. For example, a row for the date the decision was made.

See Instructional text to find out more about using instructional text in templates.
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File List Blueprint

The File List blueprint helps you to create lists of files to share with your

team. Great for organizing documents, images and presentations. Related pages:

® Blueprints

The first time you use the File List blueprint in a space, Confluence will * Meeting Notes

create an index page and add a shortcut to your space sidebar (if you're Blueprint

using the default theme). The index page lists the latest File List pages in * Product

that space. You can have as many File List pages as you need. Requirements
Blueprint

@ If you want to quickly create a blank page, hit the Create button in
the header; if you want to create a page from a template, hit the Cre
ate from template button.

1. Create blank page
2. Create from template

To create a file list:

. Choose Create from template - in the Confluence header

Select File List and hit Next

Enter the details for your file list and hit Create

Drag files from your desktop or choose browse for files to search for files on your computer

PowbdpE

Here's an example of a file list page:
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Presentations
Gresiad by Rosie Admin 32 minies sgo
File
+ [3] Atlassian presentation graphic assets key zip
+ 3] IX Image Tools key.zip

T) 10 tach writing tips keyzip

v [
0—-

10 tech writing fips . ppix

2k # 1 » e

Labals
No tabals J#

Wersion histary
ersion 3 {current version) Modified by Frank Admin
Version 2 Modified by Administrator

Version 1 Created by Rosle Admin

View Edit in Office Properties Delete

e—-. pinad or browse for files

¥ Download All

1. Expand: view each file's details and preview.

Modified -

30 minuies ago by Rosia Admin
30 minuies ago by Rosle Admin
30 minuies ago by Rosle Admin

24 minutes ago by Frank Admin

24 MinUtes a0 B— e
26 minutes ago

28 minutes ago

2. Upload and download: drop files to upload, and download all files.

3. Version history: see and manage other file versions.

Attachments appear on the page, and you can expand each attachment to preview the file and/or view its

details.

In this example, we've created three file list pages to store project-related presentations, images and
customer feedback. Confluence looks after the versioning of the files, so there's no need to use the

document file name to mark version numbers.

Once you save your page, Confluence will create an index page and add a shortcut to your space sidebar.
The index page lists the latest File List pages in the space. Create as many File List pages as you need.

e Blue Sky Profact Pages / Blue Sky Project Home

& Pages

File lists
Corited by Roge Admin 18 minuiss sge

BPACE EHORTCUTS

: Title
it Customar Fasdback
o L Projact Images
=i Tl fists

PAGE TREE

Presentailons

# Edil < Walch B2 Share LF Tools =

e
Create file list e

Creator Modified
Frank Admin a minte ago
Frank Admin & minute ago

Rosie Admir 18 minules ago  {e——— e

1. Space shortcut: a quick way to find all of your file lists in this space.

2. Create a new list: create more file lists in this space.
3. Current file lists: see all the file lists in this space.

Customizing this blueprint
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You can customize the templates that are used by the File List blueprint - see Customizing blueprint
templates.

The File List blueprint template uses the attachments macro. You can customize the macro to change the
sort order or hide features such as version history and the upload attachment fields.

You can also edit the Content Report Table macro used on the Index page to specify the number of pages
you want to display.

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/
https://confluence.atlassian.com/display/CONF74/Blueprints#Blueprints-CustomiseTemplate
https://confluence.atlassian.com/display/CONF74/Blueprints#Blueprints-CustomiseTemplate
https://confluence.atlassian.com/display/DOC/Content+Report+Table+Macro

Meeting Notes Blueprint

The Meeting Notes blueprint helps you to plan your meetings and share

notes and actions with your team. Related pages:

® Blueprints

The first time you use the Meeting Notes blueprint in a space, Confluence * File List Blueprint
will create an index page and add a shortcut on your space sidebar (if you ® Product

are using the default theme). The index page lists the latest Meeting Notes Requirements
pages in that space. Blueprint

{-:f} If you want to quickly create a blank page, hit the Create button in the header; if you want to create
a page from a template, hit the Create from template button.

1. Create blank page
2. Create from template

To create a meeting notes page:

Choose Create from template - in the Confluence header
Select Meeting Notes and hit Next

Enter the information required by the template and hit Create
Save your page and get ready to attend your meeting

PwdPR

You can edit the page during or after your meeting, and enter your notes, action items and @mention users
to assign tasks to them.

Screenshot: A Meeting Notes index page

Pages / Marketing team home # Edit © Watch [ Share eee

Meeting notes

Created by Gil User, last modified just a moment ago

Create meeting note

All meeting notes

Title Creator Modified
Gil and Nick 1:1 2015-04-28 Gil User Apr 29, 2015
Cloud space relaunch kick-off meeting Gil User Apr 24, 2015

Cloud relaunch - product stakeholder meeting Gil User Apr 14, 2015
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Screenshot: A blank Meeting Notes page showing instructional text

4
i
1

Heading 2 - B I U A~ %A~ = = | = =

People / Gil User / Pages /... / Testingpage 7 % &

2015-05-04 Meeting notes

Date

104 May 2015

Attendees

+ Gil User
» @mention a person to add them as an attendee and they will be notified.

Goals

» Set goals, objectives or some context far this meefing.

Discussion items

Time [Iltem Who Notes

5min = Agendaitem  Name = Notes for this agenda item

Action items

Type your task here. Use "@" to assign a user and "//" to select a due date.

The Meeting Notes blueprint uses some cool Confluence features:

® |Instructional text - this handy text prompts you to enter information and disappears when you start
typing or view the page.
Mentions - @mention a user on the page and they will be notified in their workbox.

® Task lists - @mention a user in a task to assign it to them — the task will appear as a personal task in
their workbox. You can also add a due date by typing //, then choosing a date from the calendar.

Customizing this blueprint

You can customize the templates that are used by the Meeting Notes blueprint — see Customizing the
blueprint templates.

You might choose to edit the headings or add additional headings, or change the instructional text that
prompts users to enter information to suit your context. To find out more about using instructional text in a
template, see Instructional text.

You can also edit the Content Report Table macro used on the Index page to specify the number of pages
you want to display.
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Product Requirements Blueprint

The Product Requirements blueprint helps you to define, scope and track

requirements for your product or feature. Related pages:

Blueprints

File List Blueprint
Meeting Notes
Blueprint

Learn more about writing downsized product requirements

The first time you use the Product Requirements blueprint in a space,
Confluence will create an index page and add a shortcut on your space
sidebar (shortcut only available in the default theme). The index lists all the
Product Requirements pages in that space, and displays a summary of the
information on each page (such as status and owner). You can have as
many Product Requirements pages as you need.

(¥ If you want to quickly create a blank page, hit the Create button in the header; if you want to create
a page from a template, hit the Create from template button.

1. Create blank page
2. Create from template

To create a requirements page:

1. Choose Create from template - in the Confluence header
2. Select Product Requirements and hit Next
3. Enter information about your product or feature (the instructional text will prompt you) and hit Create

You can @mention team members to bring them into the conversation about the page.

In this example we've created a series of Product Requirements pages. The index page shows summary
information about each one.

a B Pages | Project Incaplicn Homs o ZEl O Wam ESwm e

Product Requirements

Molos Add Product Requiramants — o
SHACE BHORTOUTE = )
'

Titia Beslgnar

Thama
Motficasons

Hobficafions

! aitan Valier Faiia e " s Jomy Coem. &
F Tace gn| Jobw e %
Sigrup da Facsbook ey Tapis Armn Dorming e Sl Marrsour BRAFT Giener Mard 50 Orboardng .—e
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1. New requirements: create more requirements pages in this space.
2. Requirements pages: see the existing requirements pages in this space.

Here's how a requirements page looks in the editor:


https://www.atlassian.com/agile/requirements
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Pluggable Notifications
} Page properties
Target release 4.4

Epic ﬁ JIRA NF-1

Document status IN PROGRESS

Document owner  Frank Admin
Designer Rosie Admin Josh User
Developers Lead developer
QA Lead tester
Goals
« E.g. Simplify the user experience, reduce friction efc...

Background and strategic fit

Why are you doing this? How does this relate to your overall product strategy ?

The Product Requirements blueprint uses these Confluence features:
® Page Properties and Page Properties Report macro - content that you enter within the page
properties macro can appear on the index page.
® Instructional text - this handy text prompts you to enter information or create a Jira issue

and disappears when you start typing or view the page.
®* Mentions - @mention a user on the page and they will be naotified in their workbox.

Customizing this blueprint

As no two products or projects are alike, you can customize the templates that are used by the Product
Requirements blueprint - see Customizing the blueprint templates.

You might choose to edit the index page in a space to change the columns to be displayed by the Page
Properties Report macro.

You might choose to edit the page template to:
® edit the headings or add additional headings
® change the instructional text that prompts users to enter information to suit your context

® add or remove rows within the Page Properties macro.

See Instructional text to find out more about using instructional text in templates.
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Shared Links Blueprint

The Shared Links blueprint helps you take content from the web and share

it with your team. You can use Shared Links to share and collaborate on Related pages:

web content, or to create a centralized repository of useful links. * Blueprints
- . . ) ® Decisions Blueprint
The first time you use the Shared Links blueprint in a space, Confluence will * File List Blueprint
create an index page and add a shortcut on your space sidebar (if you're * Meeting Notes
using the default theme). The index lists all the shared links in that space. Blueprint
® Product
(& If you want to quickly create a blank page, hit the Create button in gﬁ%‘g:ﬁ?ems

the header; if you want to create a page from a template, hit the Cre
ate from template button.

1. Create blank page
2. Create from template

To create a shared links page:

1. Choose Create from template - in the Confluence header
2. Select Share a link and hit Next
3. Enter the URL of the web content you want to share, then hit Create

You can also:
® Include topics to help categorize your links — these are added as labels to your page.

® Share the link immediately with another user or group — users will receive a notification.
* Add a comment to start the discussion.

(¥) To make sharing links even faster, you can add a Share on Confluence button to your browser's
toolbar. Click this button and the webpage you're currently viewing will be added as a shared link!

To add the Share on Confluence button to your browser:

1. Choose Create from template - , then select Share a link
2. Drag the Share on Confluence button to your browser toolbar

Now, when you want to share a link in Confluence, choose the Share on Confluence button in your browser
and follow the prompts.

Screenshot: Share a link from the Create dialog.
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Share a Link

Link' | Paste a link fo any website About sharing Links

Share links to anything you find on the web. To

Title" | Title of the page make sharing easier. drag this bookmarklet to
your bookmarks bar.

Topics Topics for the shared link
P ropies & T X Share on Confluence
Share with Share this page with users It will appear like this in your browser.
Comment | Share your thoughts about this link 800 /' Mew Tab
€ > C % E
\'{ Atlassian ¥ Share on Confluence
4

Security considerations and limitations

To prevent people from accidentally or maliciously sharing links that may pose a security risk to your site,
domains must be added to the whitelist, before they can be shared using the share a link blueprint. For
example if you wanted to use the blueprint to share links to this documentation site you would need to add htt
ps://confluence.atlassian.com/ to the whitelist. The shared link blueprint is different to just inserting a link on
a page because it shows a preview of the linked site. See Configuring the whitelist for more information.

We also prevent users from creating a shared link page if external connections is disabled for your
site. Your admin can enable this at B > General Configuration under Connection Timeouts.
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Jira Report Blueprint

The Jira Report blueprint helps you create easy to read reports to
communicate the progress of your Jira Software projects and releases. You On this page:
can choose from a Change Log report that generates a list of Jira issues or

a Status Report that includes charts to visually communicate your progress. e Create a Change

The first time you use the Jira Reports blueprint in a space, Confluence will N é?gate a Status

create an index page and add a shortcut on your space sidebar (if you're Report

using the default theme). N Cugtomizing this
blueprint

@. If you want to quickly create a blank page, hit the Create button in
the header; if you want to create a page from a template, hit the Cre
ate from template button.

1. Create blank page
2. Create from template

To use the Jira Report Blueprint your Confluence and Jira application (such
as Jira Software) must be connected via Application Links .

Create a Change Log

The Change Log report displays a list of issues from your Jira application. This list can be static or dynamic,
automatically updating as the status of your issues change in Jira.

To create a static change Log:

Choose Create from template - in the Confluence header
Select Jira report and hit Next

Select a Change log and hit Next

Enter the information required for the change log and hit Create

PwDdPE

A report page will be created with sample text and a list of all issues for the project and fix versions selected,
organized by issue type. This list of issues is static; it won't be updated when the issues are updated, and is
visible to users who don't have Jira access or permissions to view that project.

Screenshot: Creating a Change Log in simple mode.


https://confluence.atlassian.com/display/CONF74/Linking+to+Another+Application
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Change log

Fix Version(s) 54 % search, JIRA URL or JQL query.

Server | JAC = About Change Log

Keep a log of your teams progress or
communicate deliverables. Generate a static
or dynamic list of JIRA issues from a saved

F'I'CIJEEI, Confluence =

Switch to advanced

Title Confluence 5.4

Back m Close

Screenshot: Static list of Jira Issues displaying in the Change Log.

All updates for this release
Improvement

¢ CONF-29057 (Resolved): Automatically embed WuFoo forms and Reports in Confluence when pasting a URL
Bug

s CONF-31163 (Resolved): Cursor doesn't appear in editor in Chrome 30

s CONF-27451 (Resolved): Login should say "Log in"

To create a dynamic change log:

A WNR

6.

Choose Create from template - in the Confluence header

Select Jira report and hit Next

Select a Change log and hit Next

Choose Switch to advanced

Enter a JQL query or paste in the URL of a Jira search (find out about using JQL in the JIRA
Documentation)

Hit Create

A report page will be created with sample text and a Jira issues macro that's configured to show your issues.
The macro is dynamic and will update when the issues are updated. For more information on changing the
information displayed, refer to the JIRA Issues macro.

Screenshot: Dynamic list of Jira Issues displaying in the Change Log.

All updates for this release

Key Summary Type Updated Priority  Status

CONF-31163  Cursor doesn't appear in editor in Chrome 30 [ Oct 21,2013 4 ¢ Resolved

CONF-29057  Automatically embed WuFoo forms and Oct 18, 2013 & Resolved
Reports in Confluence when pasting a URL

CONF-27451  Login should say "Log in" (o] Octo2, 2013 ¥> Resolved

3issues ¥ Refresh
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Create a Status Report

The Status Report displays the progress of a Jira project and fix version in pie charts by status, priority,
component and issue type. The Status Report uses the Jira Chart macro, and is dynamic.

To create a status report:

1. Choose Create from template n in the Confluence header
2. Select Jirareport and hit Next

3. Select a Status report and hit Next

4. Enter the information required for the report and hit Create

A report page will be created with sample text and a series of pie charts, using the Jira Chart macro. The
macro is dynamic and will update when the issues in Jira are updated. For more information refer to the JIR
A Chart macro.

As with the Change Log, you can switch to Advanced mode and use JQL or paste in a Jira URL to search for
issues to display in the report.

Screenshot: Excerpt from the Status Report.

Confluence 5.3

Release Confluence 5.3

Status Oct 28, 2013 - GREEN

Report summary

This is the report summary - you can add a summary or some commentary on the status of your project here.

Overall status for 70 issues Priority

Resolved
8

Irrelevant
= 3

Major =
18

—__ Critical =
13

Awaiting
Quality
: /' Review =

- Trivial = 2
L Minor=_ =
19

—_— —_ Blocker =
= 0pen =1 2

Customizing this blueprint

You can customize the templates used by this blueprint. The Change Log uses the Snapshot Jira Report
Template (for static list of issues) and the Dynamic Jira Report Template, and the Status Report uses the
Status Report Template. See Customizing the blueprint templates. Variables represent the Jira Issues and
Jira Chart Macros. While these can't be edited, they can be moved around the page or deleted if you don't
want every chart to be included.

You can also choose to edit the page template to modify the format of the page, change some headings, or

modify the instructional text. To See Instructional text to find out more about using instructional text in
templates.
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Retrospective Blueprint

Retrospective pages help you track team successes and opportunities after
projects or at the end of a sprint. Use this blueprint to document what went

well, what needed improvement, and assign actions for the future.

The first time you create a retrospective page in a space, Confluence will
automatically create an 'index' page, which will list all retrospectives in the

space, and add a shortcut to it in the space sidebar.

Related pages:

Blueprints

File List Blueprint
Meeting Notes
Blueprint

(¥ If you want to quickly create a blank page, hit the Create button in the header; if you want to create
a page from a template, hit the Create from template button.

T
1. Create blank page

2. Create from template

To create a retrospective page:

1. Choose Create from template - in the Confluence header

2. Select Retrospective and hit Next

3. Add participants, change the title if you want to and click Create

Run a Retrospective

Title | 2013-10-24 Retrospective

Participants | | [ Ruth Buchanan %

About retrospectives

Brainstorm and vote on what went well and
what could be impraved in your last sprint or
project with your team, then set out some
action items.

Back Close

Screenshot: The 'retrospective’ template page
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2014-10-13 Retrospective

I Page proparties

Date 14 Oct 2014

Particlpants  Rosie Admin Josh User

Retrospective

= p =. Panel

Pane|

What did we do well? What should we have done better?

List all ems that you did wed! that you should bave done batfer

Actions

@mention @ person to assign them an actian item

The Retrospective blueprint uses the following Confluence features:

® Page Properties and the Page Properties Report macro make content listed within the macro visible

on the index page.
® |nstructional text prompts you to enter information and disappears when you start typing or view the

page.
® Mention a user on the page to notify them in their workbox.

(-:-*) Check out how the retrospectives blueprint can be used in the article Create sprint retrospective and
demo pages (like a BOSS).

Customize this blueprint

Every team conducts retrospective meetings differently, so you can customize the Retrospective blueprint
template to match your team's culture and practices. You can:

® Edit headings and pre-populated text
® Add instructional text to capture specific information
® Add additional sections and content

See Customize blueprint templates for instructions.
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How-To Article Blueprint

The How-To Article blueprint helps you to provide step-by-step guidance for

completing a task. Related pages:

Blueprints
To create a How-To Article page: * Troubleshooting
Article Blueprint
- ® Create Technical
1. Choose Create from template in the Confluence header and Onboarding
2. Select How-To Article and hit Next Documentation
3. Enter the article name and some labels and hit Create ® Use Confluence as

a Knowledge Base

@. If you want to quickly create a blank page, hit the Create button in
the header; if you want to create a page from a template, hit the Cre
ate from template button.

BN °

1. Create blank page
2. Create from template

Screenshot: A blank How-To Article page showing instructional text

How to prepare for Winter

Describe when someone wouid need this information. For example “when connecting to wi-fi for the first time”,

Step-by-step guide
Add the steps involved:

1. Insert your steps.
2. You can also copy and paste or drag and drop images into your instructions.

@ Info

You may also want to use visual panels to communicate related information, tips or things users need to be aware of.

Related articles
Related articles appear here based on the labsls you select. Click to edit the macro and add or change labels.

[ content by Label | cql = laba

¥ Page properties | hidden = true

Related issues

Once you save your page, Confluence will create an index page and add a shortcut to your space sidebar.
The index lists all the How-To Article pages in that space, and displays a summary of the information on
each page (such as creator and modified).
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How-to articles

Created by Desires Concelcao yesterday at 3:01 PM

Add how-to article

Title Creator Modified
How to groom a direwolf Desiree Conceicao yesterday at 3:01 PM
How to grow a weirwood Desiree Conceicao yesterday at 3:01 PM

The How-To Article blueprint uses some cool Confluence features:

® |nstructional text - Prompts you to enter information and disappears when you start typing or view the
page.

® Content by Label Macro - Displays lists of pages that have particular labels, to let you collect related
pages together.

® Page Properties Macro - This works together with the Page Properties Report Macro to automatically
create a list of 'related issues' on each article.

Customizing this blueprint

You can customize the templates used by the How-To Article blueprint - see Customizing the blueprint
templates. For example, you might choose to edit the How-to index page in a space to change the columns
displayed by the Page Properties Report macro.

You can also edit the page template to add headings or instructional text to the background section, or even
add rows to the Page Properties macro. For example, a row for the date the How-To Article was created.

See Instructional text to find out more about using instructional text in templates.
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Troubleshooting Article Blueprint

The Troubleshooting Article blueprint helps you to provide solutions for Related pages:
commonly-encountered problems.
® Blueprints
® How-To Atrticle
) ] Blueprint
To create a Troubleshooting Article page:
® Create Technical

- and Onboarding
1. Choose Create from template in the Confluence header Documentation
2. Select Troubleshooting Article and hit Next ® Use Confluence as
3. Enter the article name and some labels and hit Create a Knowledge Base

@} If you want to quickly create a blank page, hit the Create button in the header; if you want to create
a page from a template, hit the Create from template button.

1. Create blank page
2. Create from template

Screenshot: A blank Troubleshooting Article page showing instructional text

Winter is coming

Problem

Describa the problem as the user would experfence It. Forexample "Level 7 printer is flashing red and wont print*

Solution
Frovide steps al the user can take (o Soive the probiem. For axample "The fevel 7 printer will fash red wihen It (5 out of paper. Add paper G tray 1°
= Panel

Yo may wanit o use @ panel to highlight imporiant steps

1. Use numbened lisis io provide step-by-step help,

2. Copy and paste or dreg and drog images fo add them to this page.

Related articles
Retated articles appear here based on the Ibas you seiect. Click o eait The macro and add or change fabeis.
[ Cortent by Label | cql = |abal = 'kbtroublash.,

B Fage properties | hidden = trie

Related issues

Once you save your page, Confluence will create an index page and add a shortcut on your space sidebar.
The index lists all the Troubleshooting Article pages in the space, and displays a summary of the information
on each page (such as creator and modified).
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Troubleshooting articles

Created by Desiree Concelcao, last modified 10 minutes ago

Title
Winter is coming
The wall is understaffed

Ghost is hungry

Creator

Desiree Conceicao

Desiree Conceicao

Desiree Conceicao

Add troubleshooting article

Modified
less than a minute ago
2 minutes ago

4 minutes ago

The Troubleshooting Article blueprint uses some cool Confluence features:

® Instructional text - Prompts you to enter information and disappears when you start typing or view the

page.

® Content by Label Macro - Displays lists of pages that have particular labels, to let you collect related

pages together.

® Page Properties Macro - This works together with the Page Properties Report Macro to automatically

create a list of 'related issues' on each article.

Customizing this blueprint

You can customize the templates used by the Troubleshooting Article blueprint - see Customizing the
blueprint templates. For example, you might choose to edit the decisions index page in a space to change

the columns displayed by the Page Properties Report macro.

You can also edit the page template to add headings or instructional text to the background section, or even
add rows to the Page Properties macro. For example, a row for the date the Troubleshooting Article was

created.

See Instructional text to find out more about using instructional text in templates.

You can also edit the Content Report Table macro used on the Index page to specify the number of pages

you want to display.
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Create a Blueprint-Style Report

Using a combination of templates and macros you can make a wide range of reports for managing anything
from customer interviews, product requirements to IT service catalogs and more. In this tutorial we'll guide you
through the process of creating a blueprint-style report.

In this example, we'll create a multi-team status report. Here's the scenario we'll use for this tutorial.

The Design, Development and QA teams working on the Blue Sky Project need to produce a short status
update page each week, containing the focus area for the week, contact person, risks and overall status for
each team. They like the way the Product Requirements blueprint works and want to be able to manage their
status updates in a similar way.

What do each of the players want out of this report?

Project Lead — Wants an at-a-glance report that shows only the status for each team.

Team Leads — Want a summary report, including the focus areas and risk, just for their team.

All team members — Want it to be easy to create the new page each week.

Management Team — Want to see all the details for a week on one page, and don't want to have to
look at a different page for each team.

With this scenario in mind, this tutorial will guide you through how to:

1.

2.
3.
4,

Create a status update template containing a separate page properties macro for each team's section of
the report.

Create a high level status report, showing just the status of all teams.

Create a summary report for each team.

Create your first status update page.

(D You'll need Space Administrator permissions to complete some of the steps in this tutorial.

Part 1: Create a status update template

First we'll create a page template and add the Page Properties macros.

S

Go to Space Admin > Content Tools > Templates

Choose Create Template

Give the template a name (in this example the template will be called 'Status Update’)
Add the skeleton of your status report to the page

Choose the label icon A at the top of the page to add a label to the template (in this example, we'll add
the label: 'status-update’)

Screenshot: Adding teams to our status update template
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10.

11.

Heading2 = B I U A~ ‘'~ |1 = [ & EHe B~ ++ N Q,

Gil User | Templates %

Status update

Executive Summary
Text summary of the week's siatus, fo be completed by the project lead
Design Team

Development Team

QA Team

Preview m Cance

Now we'll add a Page Properties macro to record the status of the Design team.

Choose Insert > Other Macros > Page Properties to add the Page Properties macro to the page

In the macro body create a two column table and remove the heading row

In the left column enter the column headings for your report (these are known as metadata 'keys'")

In this example we'll add 'Design Focus', 'Design Status', 'Design Contact' and 'Design Risks").

In the right column, leave the cells blank, or enter some instructional text to prompt your users (Choose T
emplate > Instructional Text)

We've also added a status macro.

Edit the Page Properties macro and enter a Page Properties ID for this macro (in this example we'll use
'status-update-design'. This will allow us to report on the status of just the Design team later on)

Repeat this process for the Development and QA teams, remembering to specify a different ID for each
macro (we used 'status-update-dev' and 'status-update-qa’).

Finally, add any other headings, instructional text or content to your template and Save.

You can enter a Description for your template - this appears in the Create dialog.

Screenshot: Our status update template

Design Team

i Page properties | Id

Design Focus What was your tearm's main focus this week?
Design Status STATUS
Design Contact Wi is the contact person?

Design Risks Risks that have emergsd thiz waek

Development Team

I Page proparties

Dev Focus What was your team's main focus this week?
Dev Status STATUS
Dev Contact  Who fs the conl

Dev Risks Risi

Part 2: Create a report showing the high level status of each team

Next we'll create an index page, just like you see in many blueprints.
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1. Inyour space create a new blank page (this will be our 'Status Report - all teams' page, showing just the
status of each team)

2. Choose Insert > Other Macros > Page Properties Report to add the Page Properties Report macro to
the page

3. Enter the Label to report on (in this example, it'll be the 'status-update' label we added to the template
page)

4. Leave the Display options > Page Properties ID field blank (we want to report on all the macros on the
page)

5. Inthe Columns to Show field, list the 'keys' from each macro that you want to include in the report (in
this example, we only want to show the values of 'Design Status', 'Dev Status’, 'QA Status")

6. Choose Save to add the macro to the page

Screenshot: The page properties report macro on the 'Status Report - all teams' page

Edit ‘Page properties report’ Macro

¥5 Preview
Options

Page properties 1D (optional) Title
Na cantent found.
Tithe column heading
Changa the haamng of tha Tiia calumn
s links io pages. Mazimum
5 characters

Columns to show

Dasign Status, Dev Status, QA Sta

Number af ltems 1o cisplay

Select macro Save Cancal

Now we'll add a button to the page to allow team leads to easily create new status update pages from the
template we created earlier.

7. Choose Insert > Other Macros > Create from Template to add the Create from Template macro to the
page

8. Enter the text for the button (in this example we'll call the button ‘New Status Update Page’)

9. Select the template from the Template Name drop down (in this example our template was called 'Status
Update")

10. Specify the title of any pages to be created (This is a great way to keep your titles consistent. In this
example we'll call the page 'Status update week ending @currentDate', which will append the current
date when the page is created, as in the meeting notes blueprint)

11. Choose Insert

12. Add any other content, links or images to the page and Save

13. Choose Space Tools > Configure Sidebar > Add Link to add a shortcut to the page on the sidebar

Part 3: Create a separate report for each team

Now we'll create some index pages that show a more detailed summary for each team, starting with the Design
team.

1. Create a new blank page — this will be the 'Design Status Report' index page, showing just information for
that team.

2. Choose Insert > Other Macros > Page Properties Report to add the Page Properties Report macro to
the page

3. Enter the Label (the page label is once again 'status-update’, the label we added to the template)

4. Expand the Display options and enter the Page Properties ID that was specified in the Page Properties
macro in the template (in this example it was 'status-update-design') — this allows us to report on just
information in that macro.

5. Leave all of the other fields blank (we want to show all columns from this Page Properties macro)

6. Choose Save to add the macro to the page
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Screenshot: The page properties report macro on the 'Design Status Report' index page

Edit 'Page properties report’ Macro

¥ Preview
Label *

ks

status-update Title

In space N content found
Current space =<

Add a Tield

Options

Page properties 1D (optional)
sialus-update-design

Titie column heading

Change the heading af the Titie cobimn

whirh ronfaine fnke fn manse Masimiemn

Select macro Save  Cancel

7. Add any other content, links or images to the page and Save
8. Choose Space Tools > Configure Sidebar > Add Link to add a shortcut to the page on the sidebar
9. Create a new page and repeat this process for each team
Remember to specify a different Page Properties ID each time (in this example 'status-report-dev' and
'status-report-qa’).

If your Design, Dev and QA teams have their own team spaces, this summary report could even be created in

their team spaces. Just be sure to specify the space where the Status Updates pages are created in the Restrict
to spaces field, to make sure the macro can find the pages to report on.

Part 4: Create your first status update page

That's it! Create from template n in the Confluence header, then select Status Update, or use the Create
a new status update button to make your first status update page. Just like a blueprint, but 100% made by you.

Here's how our finished pages look.

Screenshot: Team Leads and the management team still have a single page for the weekly status update
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e Biue Sky Project

(3l Pages

=\ Blog

SPACE SHORTCUTS

[2 Status Report - all teams
PAGE TREE

» Status Report - all b

Status update week ending 2014-03-08

Stalus update week ending 2014-03-0%

5 update week ending 2074-02-21

Qrt - Design

- Development

eport - QA

Space lools = o«

Pages / Blue Sky Projecl Home / Sialus Report - all keams

Status update week ending 2014-03-08

Cre

andiast mooifed oy Rach &dmin on Feb 28, 2014

Executive Summary
This week saw the release of Widgels 5.0 Suppor activity was higher than usual

Teams are moving on fo thair 3 Iocus areas from this week

Design Team

Design Focus ADG In all modal dialogs

OM TRACK

@ fosh User

Design Status
Design Contact

Deslgn Risks =« Notime to POI:SI’\ new GE‘SIQ[’\S

Development Team

Dev Focus Warranty bugs

Dev Status DELAYED

Dev Cantact 2 Linknowmn Liser (sophis)

Dev Risks = Notime to implement new designs

« Introduce new bugs

QA Team

QA Focus Visual regressions

QA Status

QA Contact G Ewan User

QA Risks = None identriied this week
@ Like Be tha first to like thic

© Watch [ Share

slatus-update | +#

Screenshot: The Project Lead can see the status of each team, each week, at a glance in the All Teams status

report.
~ Fages J Blue Sky Project Home # Edit © Waich [ Share =
Biue Sky Projecl
Status Report - all teams
(3 Pages Crested and lact modified by Rach Admin on Fel 28, 2014
 Biog
New Slatus Update Page
EPACE SHORTCUTS
2 Status Report - all teams Title Design Status Dev Status QA Status
DAGE TREE Slatus update week ending 2014-02-2 STATUS STATUS STATUS
- Status Repert - all teams 15 update week ending 209 4-03-08 DELAVED
SRS e WOk SO0 IO 5 update week ending 20714-03-01 BEHIND TARGET
date week ending 2014-13-01
@ Like  Be the first to like this Mo labels #
Status Report - Development ﬂ i
Status Report - QA

Screenshot: Each team can see their focus, risks and status at a glance in their status report.
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9 Biue Sky Project

3 Pages

N Biag

SPACE SHORTCUTS

=| Status Report - all teams
FAGE TREE
Status Report - all teams
Etatus Report - Design

Statie Report - Developme it

Siatus Report - QA

Pages
Status Report - Design

Created and last

! Blue Sky Project Home

odified by Rach Admin 18 minules aga

Title Design Centact
Slalus update week ending 2014-02-21
Status update week ending 2014-03-08 @ Josh User

Stalus updale week ending 2014-03-01 5 Josh User

@ Like  Be the first to like this

Design Focus

ADG in all modal dialogs

Sentence case all the things

# Edit o Watch rt Share e

Design Risks Design Status

STATUS
« to time to polish new designs
« Team members nol available BEHIND TARGET

stalus-update: #

Remember, these concepts don't just apply to status updates — you can use them for any purpose at all.
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Import Content Into Confluence

There are a number of ways you can get existing

content, such as text, images and other content into On this page:
Confluence.
. ® |mport content from other Confluence sites
Import content from other Confluence sites * Import content from a Microsoft Word
document

To import content from another Confluence site you
can:

Import web content

Importing content from another wiki
Import other content

Migrate to Confluence Cloud

® |mport a backup of the entire Confluence site

® Import an XML export of an individual space.
Page history, attachments, and page content
will be preserved.

See Restoring a Site and Restoring a Space for more information.

Import content from a Microsoft Word document

The Office Connector allows you to create pages by importing Word documents. The document content is
copied onto one or more Confluence pages. See Import a Word Document into Confluence.

Import web content
To embed web content on a page:
® Use the Widget Connector Macro to display videos, slide shows, twitter chats, documents and more,
sourced from other web sites and displayed on your Confluence page.
Embed an external web page into Confluence with the HTML Include macro.
® Use HTML code in a page with the HTML macro.

Note: The HTML macro is not enabled in all sites. Talk to your Confluence Admin about whether you can
use this macro.

Importing content from another wiki
Confluence does not provide a method for importing content from another wiki.

You may be able to build your own import solution using our REST APIs, as mentioned below, or work with
an Atlassian Solution Partner to develop a custom solution.

Import other content
Importing non-wiki markup into Confluence requires a conversion process:

® Text with basic formatting can be pasted directly into the editor. This includes simple Word documents
or web pages.

® Confluence pages saved to disk can be imported from disk.
Files can be uploaded in bulk using the Confluence WebDav Plugin. See Use a WebDAV Client to
Work with Pages.

® Build your own import solution using the Confluence APIs.

Migrate to Confluence Cloud

If you're migrating from Confluence Server to Confluence Cloud, you can use the Confluence Cloud
Migration Assistant to migrate your content and spaces.


https://confluence.atlassian.com/display/CONF74/Restoring+a+Site
https://confluence.atlassian.com/display/CONF74/Restoring+a+Space
https://www.atlassian.com/partners
https://confluence.atlassian.com/display/CONF74/Import+a+Text+File
https://confluence.atlassian.com/display/DOC/Use+a+WebDAV+Client+to+Work+with+Pages
https://confluence.atlassian.com/display/DOC/Use+a+WebDAV+Client+to+Work+with+Pages
https://developer.atlassian.com/display/CONFDEV/Confluence+Server+REST+API
https://confluence.atlassian.com/display/Cloud/Confluence+Cloud+Migration+Assistant
https://confluence.atlassian.com/display/Cloud/Confluence+Cloud+Migration+Assistant

Import a Word Document into Confluence

The Office Connector allows you to import Word
documents and create one or more Confluence On this page:
pages from the content.

Import a Word document
Import options
Supported file types
Limitations

You can create a single page, or divide the contents
up into multiple pages, based on the headings in
your document.

This is useful if you have a lot of content stored in
existing documents, or if you are migrating from

another system or platform that allows you to export * Export Content to Word, PDF, HTML and
to Word format. XML

Related pages:

Import a Word document
To import a Word document in Confluence:

1. Create a page in Confluence or go to an existing page (you want to view the page, not edit it).

2. Choose ®*** >Import Word Document

3. Choose Browse and locate the Word document you want to import, then choose Next.
The import document options appear.

4. Enter atitle for the new page (useful if you don't want to use the file name as your page title).

5. Choose where you want to import the file (as a brand new page, or overwriting an existing page with
the same title).

6. Choose how to handle title conflicts (rename the new pages or replace existing pages).

7. Choose whether to create a single page or multiple pages based on the heading styles in the file (this
option is only available if the file contains heading styles).

8. Click Import.

When the upload has finished, pages will be created with the content of the Word documents. You can then
view and edit this page as normal. There's no connection between the original Word document and this page.

Import options

There are a number of options when importing a Word document that control how pages are created,
whether the import should overwrite existing pages in the space, and how it should handle page name
conflicts.

Option = Description

Root This is the title of the page that will be created or updated by the import.

page
title

Where | Controls whether the document is imported into the current page (the page you were viewing
to when you selected Tools > Import) or created as a hew page. Choose from
import
P ®* Import as a new page in the current space - a new page will be created as a child of the
space home page.
®* Replace <page name> - content will be imported into the current page. The title of this
page will change to the title you specified in the Root page title field.
® Delete existing children of <pagename> - any existing children of the current page will be
removed when the content of the page is replaced.
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Title Controls how page name conflicts (a page with the same title already exists in the space) are
conflicts handled.

® Rename imported pages if page name already exists - new pages get a new name (a
number added to the end of the page title). Existing pages will be unchanged.

®* Replace existing pages with imported pages of the same title - overwrite the content of
existing pages. The change will be shown in the Page History for the page.

® Remove existing pages with the same title as imported pages - remove original pages
and then create new pages. The change is not shown in the Page History for the page.

Split If the document contains Word heading styles you can choose to create multiple pages based
by on the heading. Options are:
heading

®* Don't split - creates a single page.
® |evel Headings - creates multiple pages in a hierarchy based on the heading levels in the
document.

A preview of the pages that will be created appears under Document Outline.

Screenshot: Import Word options for a document that contains multiple heading levels.

Import Word Document: Configuration
Root page title: Qutline doc

Where to import: @ Import as a new page in the current space
Replace Temp

Delete existing children of Temp

Title conflicts: @ Rename imported pages if page name already exists
Replace existing pages with imported pages of the same title

Remove existing pages with the same title as imported pages

Split by heading: Don't split 2]
Document Outline: Outline doc
Import

Supported file types

Confluence can import the content from Microsoft Word 97-2013 documents (.doc and .docx).

Limitations
In order to prevent out of memory errors, we limit the uncompressed size of the file you can import to 20 MB.

Your administrator can change this limit using the conf | uence. wor d. i nport . maxsi ze system property.
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Undefined Page Links

You can add links to pages that don't yet exist in Confluence, but you intend to create later. Known as links to
‘undefined pages', they allow you to create a link which, when clicked, will create a page with the name you
specify in the link.

Create an undefined page link
1. Choose Insert > Link or press Ctrl+K on your keyboard.
2. Choose Advanced.
3. Enter the name of the page to be created in the Link field.

A link to an undefined page is shown in dark red while in the editor. When anyone clicks the link, Confluence will
create a new page with the name you typed in the Link field.

View undefined pages in a space

The Undefined Pages view shows you all undefined pages in your space. The undefined page links are
badged with a -- icon to remind you that those pages are yet to be created.

To view a list of the undefined links in a space:

1. Go to the space and choose Space tools > Content Tools from the bottom of the sidebar
2. Choose Undefined Pages.

You can choose the link for an undefined page to create the page and add content to it.

Links to pages that are in the trash are not considered undefined links, and will not appear in this list.



View Page Information

The Page Information view for a page shows you useful information about the page.
To see the information about the page:

1. View the page.
2. Choose *** > Page Information

You will see the following information:

® Page details: Title, author, date of creation, date of last modification and the tiny link (permalink) of the
page.
Page hierarchy: Parent-child relationships of the page.
Incoming links: Lists other pages in your Confluence Site that have links to this page, or reference this
page in an Include Page or Excerpt Include macro.
Labels: Any labels (tags) that have been applied to this page. See Add, Remove and Search for Labels.
Page Permissions: Displays page-level security restrictions that apply to the page (if present). See Page
Restrictions.

® Recent Changes: Links to the five most recent versions of the page along with the name of the editor
and the date of modification. See Page History and Page Comparison Views. Choose View page history
to see the page history view, all the versions of the page in reverse chronological order and allows you
to compare versions or to restore a previous version.

® Qutgoing links: A summary of the links contained on this page, pointing to other pages on the
Confluence site or to external websites.

Note: if there is no information to report (for example the page has no restrictions or no incoming links), that
section of the Page Information won't appear.

Screenshot: Page information for this page

Dashboard / Sample space [/ Meeting notes

Page Information

~ \liew Page ¥ Save for later

Title: Meeting notes Recent Changes

Author: Rach Admin Mar 18, 2019
Since you last logged in:

Last Changed by: Rach Admin Mar 20, 2019 : .
g v ; Rach Admin made 2 changes. (view)
Tiny Link: (useful for email) http://localhost:8080/x/A4Aa
Export As: Waord « PDF Time Editor
Operations: Copy Mar 20, 2019 14:27 Rach Admin View Changes
Mar 18, 2018 17:00 Rach Admin
Incoming Links View Page History

Sample space {2)
Bl 2019-03-19 Retrospective Outgoing Links

B When should we launch?
External Links (1)

ahttps://team-bamboo.company.com/browse/RELEASE

Hierarchy Sample space (2)
B Engineering rituals

Parent Page B Team playbook

L. Sample space

Children {3)
B 2019-02-28 Meeting notes
B 2019-03-10 Meeting notes
B 2019-03-19 Meeting notes

Page Permissions

Page restrictions:
» Only users in group developers can edit this page. (set by
Rach Admin at Mar 20, 2019 14:42) o
Labels « Only admin can edit this page. (set by Rach Admin at Mar 20,

2019 14:42) 'Y
Global Labels (2)
dev-team | staff




Page History and Page Comparison Views

Confluence tracks the history of changes to each page by creating a new

version of the page each time it's modified. You can view the changes On this page:
between different versions, and roll back to a previous version if you need
to. ® Access the page
history
® View an older
Access the page history version _
® Restore a previous
To view the history of a page: version 3
® Delete a specific
1. Go to the page and choose *** > Page History o version
2. Choose a version number to view the content of that version V'eéV the changes
made
Screenshot: Page history ¢ View unpublished
changes
Page History d Compal’e tWO
versions
............. - o Ghrwes s ® More about the

CLRAFHT {v. &) dan 31, 3018 10:96

vl comparison view

Related pages:

V31, 21B 1008

an 31, 2008 1008 O o v

®* View Page
Information

® Create and Edit
Pages

® Watch Pages,
Spaces and Blogs

Hover over each avatar to see the names of people who contributed changes in that version. It is not
possible to view the individual changes made by each person in a single page version.

View an older version

When you select a previous version of the page, you'll see a header like this at the top of the page:

You are viewing an old version of this page. View the current version.

Compare with Current - Restore this Version - View Page History

« Previous Version 3 Current »

@ If you want to send this page version to someone, copy and paste the URL from your browser. The link
will look something like this: ht t p: // conf | uence. at | assi an. conl pages/ vi ewpage. acti on?
pagel d=12345.

When you're viewing a specific version of the page, the following functions are available:

Function Description
current version View the latest version of the page.
Compare with Compare the differences between the version of the page you are viewing and the

Current current version.
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Restore this Roll back the content of the page to the previous version that you are viewing.
Version

View Page History Return to the list of page versions.

<< Previous and Ne | View the previous or next version of the page.
xt >>

Restore a previous version
1. Go to the page and choose *** > Page History
2. Choose Restore this version beside the version you want to restore (or at the top of the page if

you've opened the version)
3. Change the default change comment if necessary, and choose OK

@ All page history is retained; restoring an older version creates a copy of that version. For example, if you
restore version 39, Confluence will create a copy of version 39 and the copy will become the new, current

version.

If the page has an unpublished draft, the content of the draft will be lost when you restore a previous version.

We'll warn you if there is an unpublished draft.

Delete a specific version

Choose Delete next to a version in the page history, to remove that version.

View the changes made
Using the page history view or the page information view, you can see the recent changes made to a page.
To view recent changes made to a page:
1. Choose *** > Page Information
In the section titled 'Recent Changes' you'll see the most recent versions of the page, along with the
date of their modification and the name of the modifying author.
2. Choose View Changes beside the required version

The page comparison view is displayed, showing the differences between the selected and previous
versions.

View unpublished changes

When you're in the editor, you can see all changes since the page was last published. Goto *** > View
changes.

Changes are not attributed to individual people. The avatars of everyone who has contributed will be shown
at the top of the editor.

Compare two versions
1. Go to the page and choose *** > Page History
2. Choose the versions you want to compare by selecting the check boxes beside them
3. Choose Compare selected versions

You'll see the page comparison view showing the differences between the selected versions. Changes are
highlighted as follows:
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Highlighted color | Meaning

Green Added content
Red Deleted content
Blue Changed formatting

Screenshot: Comparing changes

Versions Compared Key
This line was added.
1 Current Thisti .
Cassie Owens Cassie Owens Formatting was changed.
less than a minute ago less than a minute ago

View Page History

We-dertreedthistextanymore This text was added

My heading has been reformatted

More about the comparison view

When you view a page comparison, all large sections of unchanged text are hidden and reduced to an
ellipsis (. . .).

You can view page changes between versions which are adjacent to your current page comparison view.
Click the link containing:

® << to view the page comparison with the earlier adjacent version
® >>to view the page comparison with the more recent adjacent version

For example, if your page comparison view is between v. 30 and v. 34 of a page, you can view changes
between:

® v. 29 and v. 30 by clicking << Changes from 29 to 30
® v. 34 and v. 35 by clicking Changes from 34 to 35 >>
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Confluence Markup

This section describes two types of markup found in Confluence:

® Confluence storage format. Confluence stores the content of
pages and blog posts in an XHTML-based format. Advanced users
can view the storage format of a page and even edit it, provided their
Confluence site is configured to allow that.

® Wiki markup. Confluence allows data entry via a shorthand code
called wiki markup. Some parts of the Confluence administration
interface also accept wiki markup for defining content. For a
description of the wiki markup syntax, see Confluence Wiki Markup.

Wiki markup code examples for macros can be found in the documentation
for each macro.

Related pages:

® Macros
® The Editor



Confluence Storage Format

This page describes the XHTML-based format that Confluence uses to

store the content of pages, page templates, blueprints, blog posts and On this page:
comments. This information is intended for advanced users who need to
interpret and edit the underlying markup of a Confluence page. ¢ Headings
® Text effects
We refer to the Confluence storage format as 'XHTML-based'. To be ¢ Text breaks
correct, we should call it XML, because the Confluence storage format does ® Lists
not comply with the XHTML definition. In particular, Confluence includes ® Links
custom elements for macros and more. We're using the term "XHTML- ® Images
based' to indicate that there is a large proportion of HTML in the storage ® Tables
format. ® Page layouts
® Resource identifiers
You can view the Confluence storage format for a given page by choosing ® Template variables
® |nstructional Text

*** > View Storage Format. This option is only available if one of the
following is true:

® You are a Confluence administrator.
® Your Confluence site has the Confluence Source Editor plugin
installed and you have permission to use the source editor.

* |f you would like to edit the storage format for a page, your
Confluence system administrator will need to install the Confluence
Source Editor plugin.

® Clarification of terminology: If you choose *** > View Source, you'l
see the format used within the editor panel, not the storage format of

the page.
Headings
Format type In Confluence 4.0 and later What you will get
Heading 1 <h1>Headi ng 1</ h1> Heading 1
Heading 2 <h2>Headi ng 2</h2> HEﬂding 2
Heading 3 <h3>Headi ng 3</h3> Heading 3

Headings 4 to 6 are also available and follow the same pattern

Text effects
Format type In Confluence 4.0 and later What you will get

strong/bold <strong>strong text</strong> strong

emphaS|S <enpltalics Text</en> emphaSIS


https://marketplace.atlassian.com/plugins/com.atlassian.confluence.plugins.editor.confluence-source-editor
https://marketplace.atlassian.com/plugins/com.atlassian.confluence.plugins.editor.confluence-source-editor
https://marketplace.atlassian.com/plugins/com.atlassian.confluence.plugins.editor.confluence-source-editor

strikethrough

underline

superscript

subscript

monospace

preformatted

block quotes

text color

small

big

center-align

right-align

Text breaks
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<span styl e="text-decoration
l'i ne-through; ">
stri ket hrough</ span>

<u>under | i ne</ u>

<sup>superscri pt </ sup>

<sub>subscri pt </ sub>

<code>npbnospaced</ code>

<pre>preformatted text</pre>

<bl ockquot e>
<p>bl ock quot e</p>
</ bl ockquot e>

<span style="color: rgb(255,0,0);">red text
</ span>

<smal | >smal | text</small>

<bi g>bi g text</big>

<p style="text-align: center;">centered text

</ p>

<p style="text-align
</ p>

right;">right aligned text

underline

superscript

subscript

nonospaced

preformatted text

block quote

red text

small text

big text

centered text

right aligned text
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Format type In Confluence 4.0 and later

New paragraph

<p>Par agr aph 1</ p>

<p>Par agr aph 2</p>

Line break Line 1 <br /> Line 2

Note: Created in the editor using Shi ft + Return/Enter

Horizontal rule <hr />

— symbol andash:
- SymbOI &ndash;
Lists

Format type

Unordered list — round
bullets

Ordered list (numbered list)

Task Lists

Links

Format type

In Confluence 4.0 and later

<ul >

<li>round bullet list itenx/li>
</ ul >

<ol >

<li>nunbered list item</li>
</ ol >

<ac:task-list>
<ac: t ask>
<ac: t ask- st at us>i nconpl et e</ ac: t ask-
stat us>
<ac:task-body>task list itenx/ac:task-
body>
</ ac:task>
</ac:task-list>

In Confluence 4.0 and later

What you will get
Paragraph 1

Paragraph 2

Line 1
Line 2

What you will get

® Round bullet list
item

1. Ordered list item

® task list item

What you will
get
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Link to another
Confluence page

Link to an attachment

Link to an external site

Anchor link (same page)

Anchor link (another
page)

Link with an embedded
image for the body

A note about link bodies

<ac:|ink>

<ri:page ri:content-title="Page Title" />
<ac: pl ai n-text-1ink-body>

<! [ CDATA[ Li nk to anot her Confluence Page]]>
</ac: pl ai n-text-Ilink-body>

</ac:link>

<ac:|ink>

<ri:attachment ri:filename="atl assian_logo.gif" />
<ac: pl ai n-text-1ink-body>

<! [ CDATA[ Link to a Confluence Attachnment]]>

</ac: pl ai n-text-Ilink-body>

</ac:link>

<a href="http://ww. atl assi an. conf >At| assi an</ a>

<ac:link ac:anchor="anchor">

<ac: pl ai n-text-1ink-body>

<! [ CDATA[ Anchor Link]]>

</ ac: pl ai n-text-1ink-body>
</ac:|ink>

<ac:link ac:anchor="anchor">
<ri:page ri:content-title="pagetitle"/>
<ac: pl ai n-text-1ink-body>
<! [ CDATA[ Anchor Link]]>
</ ac: pl ai n-text-1link-body>
</ac:link>

<ac:link ac:anchor="Anchor Link">
<ac: | i nk- body>
<ac:image><ri:url ri:val ue="
http://confluence. atl assi an. com
i mges/ | ogo/ confl uence_48_trans. png" /></ac:inage>
</ ac: | i nk-body>
</ac:link>

1 For rich content like images, you need to use ac

:1'i nk-body to wrap the contents.

Link to another
Confluence page

Link to an
attachment

Atlassian

Anchor Link

Anchor Link

All links received from the editor will be stored as plain text by default, unless they are detected to contain
the limited set of mark up that we allow in link bodies. Here are some examples of markup we support in link

bodies.
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An example of different link bodies

<ac:|ink>
<l-- Any resource identifier -->
<ri:page ri:content-title="Hone" ri:space-key="SANDBOX" />
<ac: | i nk-body>Sone <strong>Ri ch</strong> Text</ac:|ink-body>
</ ac:link>
<ac:|ink>
<ri:page ri:content-title="Plugin devel oper tutorial stuff" ri:space-key="TECHWRI TING' />
<ac: pl ai n-text-1ink-body><![ CDATA[ A plain <text> |ink body]]></ac: pl ai n-text-1Iink-body>
</ ac: link>

<ac:|ink>
<ri:page ri:content-title="Plugin devel oper tutorial stuff" ri:space-key="TECHWRI TI NG' />
<l-- Alink body isn't necessary. Auto-generated fromthe resource identifier for display. -->

</ ac:link>

The markup tags permitted within the <ac:link-body> are <b>, <strong>, <em>, <i>, <code>, <tt>, <sub>,
<sup>, <br> and <span>.

Images

Format type In Confluence 4.0 and later What you will get

Attached <ac: i mage>
image <ri:attachment ri:filename=

T, ]
o {Atlassian
</ ac:image> -

External image = .. mage> \/
<ri:url ri:value="http://confluence. atl assi an.
conl -¢ﬂ.
i mges/ | ogo/ confl uence_48_trans. png" /></ac:
i mge>

Supported image attributes (some of these attributes mirror the equivalent HTML 4 IMG element):

Name Description

ac:align image alignment

ac:border Set to "true" to set a border
ac:class css class attribute.

ac:title image tool tip.

ac:style css style

ac:thumbnail = Set to "true" to designate this image as a thumbnail.

ac:alt alt text
ac:height image height
ac:width image width

ac:vspace the white space on the top and bottom of an image
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ac:hspace the white space on the left and right of an image

Tables

Format type

Two column, two row (top header row)

Two column, three rows, 2nd and third with
merged cells in first row

Page layouts

In Confluence 4.0
and later

<t abl e>

<t body>

<tr>

<t h>Tabl e Headi ng
Cell 1</th>

<t h>Tabl e Headi ng
Cell 2</th>
</tr>

<tr>

<td>Normal Cell 1<
/td>

<td>Nornmal Cell 2<
/td>
</tr>

</ t body>
</t abl e>

<t abl e>
<t body>
<tr>

<t h>Tabl e Headi ng
Cell 1</th>

<t h>Tabl e Headi ng
Cell 2</th>
</tr>

<tr>

<td rowspan="2"
>Merged Cel | </td>

<td>Normal Cell 1<
/td>
</tr>

<tr>

<td col span="1"

>Normal Cell 2</td>

</tr>
</t body>
</ tabl e>

What you will get

Table
Heading
Cell 1

Normal Cell 1

Table
Heading
Cell 1

Merged Cell

Table
Heading
Cell 2

Normal Cell 2

Table
Heading
Cell 2
Normal Cell 1

Normal Cell 2
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Confluence supports page layouts directly, as an alternative to macro-based layouts (using, for example, the
section and column macros). This section documents the storage format XML created when these layouts

are used in a page.

Element
name

ac:
| ayout

ac:
| ayout -
section

ac:
| ayout -
cell

In Confluence 5.2 and later

Indicates that the page has a layout. It should be the top level element in the

page.

Represents a row in the layout. It must be directly within the ac: | ayout tag.
The type of the section indicates the appropriate number of cells and their

relative widths.

Represents a column in a layout. It must be directly within the ac: | ayout -
sect i on tag. There should be an appropriate number of cells within the layout-

section to match the ac: t ype.

The recognized values of ac: t ype for ac: | ayout - secti on are:

ac: type

single

two_equal

Expected number of
cells

1

2

two_| eft_sidebar 2

two_right_sideba |2

r

t hree_equal 3

three_with_sideb |3

ars

Description

One cell occupies the entire section.

Two cells of equal width.

Attributes

None

ac:type

None

A narrow (~30%) cell followed by a wide cell.

A wide cell followed by a narrow (~30%) cell.

Three cells of equal width.

A narrow (~20%) cell at each end with a wide cell in

the middle.

The following example shows one of the more complicated layouts from the old format built in the new. The
word { cont ent } indicates where further XHTML or Confluence storage format block content would be

entered, such as <p> or <t abl e> tags.
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<ac: | ayout >
<ac: |l ayout-section ac:type="single">
<ac: |l ayout-cel | >
{content}
</ac: |l ayout-cell>
</ ac: | ayout - secti on>
<ac: | ayout-section ac:type="three_w th_sidebars">
<ac: |l ayout-cel | >
{content}
</ac:layout-cell>
<ac: |l ayout-cel | >
{content}
</ac: |l ayout-cell>
<ac: |l ayout-cel | >
{content}
</ac:layout-cell>
</ ac: | ayout - secti on>
<ac: |l ayout-section ac:type="single">
<ac: |l ayout-cel | >
{content}
</ac: |l ayout-cell>
</ ac: | ayout - secti on>
</ ac: | ayout >

Emoticons

Format type In Confluence 4.0 and later What you will get

Emoticons <ac:enoticon ac:nane="snile" /> -

<ac: enoticon ac: nane="sad" /> -

<ac: enoticon ac: nane="cheeky" /> -

<ac: enoticon ac:nane="|augh" /> =

<ac: enoticon ac: nane="w nk" /> -

<ac: enoticon ac: nane="t hunbs-up" />

<ac: enoticon ac: nane="t hunbs- down" />

<ac:enoticon ac: nane="information" /> ‘3

<ac:enoticon ac: nane="tick" /> ‘9
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<ac: enoticon ac: nane="cross" /> 9

<ac: enoticon ac: nane="warni ng" />

Resource identifiers

Resource identifiers are used to describe "links" or "references" to resources in the storage format.
Examples of resources include pages, blog posts, comments, shortcuts, images and so forth.

Resource @ Resource identifier format

Page <ri:page ri:space-key="FOO' ri:content-title="Test Page"/>
Notes:
® ri:space-key: (optional) denotes the space key. This can be omitted to create a
relative reference.
® ri:content-title: (required) denotes the title of the page.
Blog Post <ri:blog-post ri:space-key="FQOO' ri:content-title="First Post" ri:posting-day="2012/01
/130" />
Notes:

® ri:space-key: (optional) denotes the space key. This can be omitted to create a
relative reference.

® ri:content-title: (required) denotes the title of the page.

® ri:posting-day: (required) denotes the posting day. The format is YYYY/MM/DD.
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Attachment <ri:attachnment ri:filename>
resource identifier for the container of the attachment
</ri:attachment>

Notes:

® ri:fil enane: (required) denotes the name of the attachment.

® the body of theri : at t achnment element should be a resource identifier denoting the
container of the attachment. This can be omitted to create a relative attachment
reference (similar to [foo.png] in wiki markup).

Examples:

Relative Attachment Reference

<ri:attachnent ri:filename="happy.gif" />

Absolute Attachment Reference

<ri:attachnent ri:filename="happy.gif">
<ri:page ri:space-key="TST" ri:content-title="Test Page"/>
</ri:attachment>

URL <ri:url ri:value="http://exanple.org/sanmple.gif"/>

Notes:

® ri:val ue: (required) denotes the actual URL value.
Shortcut <ri:shortcut ri:key="jira" ri:paraneter="ABC 123">

Notes:

® ri: key: (required) represents the key of the Confluence shortcut.
® ri: paraneter: (required) represents the parameter to pass into the Confluence

shortcut.
® The example above is equivalent to [ ABC- 123@ i r a] in wiki markup.

User <ri:user ri:userkey="2c9680f 7405147e€0140514c26120003"/ >

Notes:

® ri:userkey: (required) denotes the unique identifier of the user.

Space <ri:space ri:space-key="TST"/>

Notes:

® ri:space-key: (required) denotes the key of the space.
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Content
Entity

<ri:content-entity ri:content-id="123"/>

Notes:

® ri:content-id: (required) denotes the id of the content.

Template variables

This screenshot shows a simple template:

Dashboard » Chocolate » Browse Space » Edit Template

Sarah template

Paragraph B I U A A = | iE| =

This is Sarah's template

A single-line text variable: (L9
A multi-line text variable: B0
A selection list: EI0TEE

End of page.

The template contains the following variables:

Variable name = Type Values

SMyText Single-line text

SMyMulti Multi-line text = Size: 5 x 100

$MyList List List items: Appl es, Pear s, Peaches

The XML export produces the following code for the template:
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<at:decl arations>
<at:string at:name="MText" />
<at:textarea at:colums="100" at:name="MyMulti" at:rows="5" />
<at:list at:name="MList">
<at:option at:val ue="Apples" />
<at:option at:val ue="Pears" />
<at:option at:val ue="Peaches" />
</at:list>
</ at:decl arati ons>

<p>This is Sarah's tenpl ate</p>
<p>A single-line text variable: &bsp; <at:var at:name="MText" /></p>
<p>A multi-line text variable: &bsp; <at:var at:name="MWMilti" /></p>

<p>A sel ection |list:&bsp; <at:var at:name="MWList" /></p>

<p>End of page. </ p>

Instructional Text

Instructional text allows you to include information on how to fill out a template for an end-user (the person

using creating a page from the template). Instructional text will:

® automatically clear all instructional text as the user types in a specific text block, and
® automatically trigger a @mention prompt for user selection (for 'mention’ type instructional text).

Screenshot: Example of instructional text.

|

H

|
Lx

(
'
1
|
|
il

Paragraph - B I U A ~3%*A~

e This is an example of instruction text that will get replaced when a user selects the

@mention example. This placeholder will automaticailly search for a user to mentig

<ul >

<l i ><ac: pl acehol der>This is an exanple of instruction text that will get replaced when a user selects

the text and begins typing.</ac:placehol der></1i>

</ ul >
<ac:task-list>
<ac:task>

<ac: task-status>i nconpl et e</ ac: t ask- st at us>
<ac: t ask- body><ac: pl acehol der ac:type="nention">@renti on exanpl e. This placehol der will

automatically search for a user to nention in the page when the user begins typing.</ac: pl acehol der></ ac:

t ask- body>
</ ac:task>
</ ac:task-list>
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Confluence Wiki Markup

This page describes the wiki markup used on some administration screens
in Confluence.

Wiki markup is useful when you want to do one of the following:

® Type wiki markup directly into the editor. Confluence will convert it to
the rich text editor format as you type.

® Create links using the Advanced tab of the Links Browser.

® Add custom content to the sidebar, header or footer of a space.

® |nsert a block of wiki markup (or markdown) into the Confluence
editor. (Choose Insert > Markup.)

Note: You cannot edit content in wiki markup. Confluence does not
store page content in wiki markup. Although you can enter wiki markup into
the editor, Confluence will convert it to the rich text editor format
immediately. You will not be able to edit the wiki markup after initial entry.

Can | type wiki markup into the editor?

On this page:

Can | type wiki
markup into the
editor?

Can | insert
markdown?
Headings
Lists

Tables

Text Effects
Text Breaks
Links

Images

Page Layouts
Macros

Yes. You can type wiki markup directly into the editor, and Confluence will convert it as you type. (You

cannot edit the wiki markup after conversion.) See it in action in this video:

Can | insert markdown?

Confluence supports inserting content in markdown. This is often used in ReadMe files. See Markdown

syntax guide for some examples of markdown syntax.
To insert markdown in the editor:

1. Choose Insert > Markup
2. Select Markdown

3. Type or paste your text - the preview will show you how it will appear on your page

4. Choose Insert.

As with wiki markup, Confluence will convert your markdown to the rich text editor format. You will not be

able to edit your content using markdown.

Headings

To format a line as a heading, type "hn." at the start of your line, where n can be a number from 1 to 6.

What you need to type

hi. Biggest heading Bjggest heading

h3. Bi g headi ng

What you'll get

Big heading

h5. Smal | headi ng Small heading

Lists

Wiki markup allows you to create bulleted or numbered lists, and is flexible enough to allow a combination of

the two list types.

@ If you need to separate the text within lists using line breaks, make sure you do so using a double slash (

/). Empty lines may disrupt the list.
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Simple lists

Use the hyphen (-) to create simple lists with square bullets. Make sure there's a space between the hyphen
and your text.

What you need to type = What you'll get

- sone
- bullet ® some

- points = pullet
" points
Bulleted lists

Use the asterisk (*) to create bullets. For each subsequent level, add an extra asterisk.
Make sure there is a space between the asterisk and your text.

What you need to type = What you'll get

* sonme

* bul | et ¢ some

** jndent ed * bullet

** pullets ® indented
* points * bullets

® points

Numbered lists

Use the hash (#) to create numbered lists.
Make sure there is a space between the hash and your text.

What you need to type = What you'll get

# a
# nunber ed 1. a
# 1ist 2. numbered

3. list

A second level of hashes will produce a sub-list, such as the alphabetical sub-list shown below.

What you need to type What you'll get

# Here's a sentence. ,

## This is a sub-list point. 1. Here's a sentence.

## And a second sub-list point. a. This is a sub-list point.

# Here's another sentence. b. And a second sub-list point.

2. Here's another sentence.

You can use a third level of hashes to produce a sub-sub-list.

What you need to type What you'll get
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# Here's a sentence.

## This is a sub-list point. 1. Here's a sentence.

### Third list |evel. a. This is a sub-list point.

### Another point at the third |level. i. Third list level.

## And a second sub-list point. ii. Another point at the third level.

# Here's anot her sentence. . .
b. And a second sub-list point.

2. Here's another sentence.

Note: In numbered lists as described above, the format of the 'number' displayed at each list level may be
different, depending upon your browser and the style sheets installed on your Confluence instance. So in
some cases, you may see letters (A, B, C, etc; or a, b, ¢, etc) or Roman numerals (i, ii, iii, etc) at different list
levels.

Mixed lists

What you need to type = What you'll get

# Here

#* is 1 Hel’e

#* an ® s

# exanpl e ® an

o 2. example

#* a o of

# m xed °

# 1ist a
3. mixed
4. list

Tables

You can create two types of tables.

Table Type 1

Allows you to create a simple table with an optional header row. Once you've added this type of table, you
can set the width of the columns using the table controls in the toolbar.

Use double bars for a table heading row.

What you need to type:

| | headi ng 1] | headi ng 2| | headi ng 3| |
|cell Al|jcell A2|cell A3]
|cell Bl|cell B2|cell B3|

What you'll get:

heading 1 | heading 2 heading 3
cell Al cell A2 cell A3

cell B1 cell B2 cell B3

You can also use a vertical header.

What you need to type:
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| | heading 1| col Al|col A2|col A3|
| | headi ng 2| col B1|col B2|col B3|

What you'll get:
heading 1 colAl col A2 col A3

heading 2 col Bl colB2 col B3

Table Type 2

This method uses section and column macros to create the table, and allows you to specify the width of the
columns in the markup.

What you need to type

{'secti on: border=true}

{col um: wi dt h=30%

Text for this colum goes here. This is the smaller colum with a width of only 30%
{col um}

{col um: wi dt h=70%

Text for this columm goes here. This is the larger colum with a width of 70%

{col um}

{section}

What you'll get

Text for this column goes here.

This is the smaller column with

a width of only 30%.

Text for this column goes here. This is the larger column with a width of
70%.

@ For more details please see the Column Macro and the Section Macro.

Advanced Formatting

Color and Other Formatting

To add color and other formatting to your tables, you can use the Panel Macro within columns.
More table-formatting options may be available if your Confluence administrator has installed additional macr
0s.

Lists
Here's an example of how to embed lists in a table:
What you need to type

| | Headi ng 1| | Headi ng 2] |
|* Item1

* Item 2

* ltem3|# Item 1

# ltem 2

# Item 3|

What you'll get

Heading 1 | Heading 2
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® Jtem1l 1. ltem1
® Jtem 2 2. ltem 2
® |Jtem3 3. Iltem 3

Text Effects

Use the markup shown in the examples below to format text.

What you need to type
*strong*

*pold text*

_emphasis_

_italics_

??citation??
-deleted-
+inserted+

Text with superscript®

Text with~subscript~

{{rmonospaced}}

bg. Here's how you make a
par agr aph appear as a bl ock

quot ati on.

{color:red}look ma, red text!{color}

What you'll get
strong

bold text
emphasis

italics

Hint: To italicize parts of a word, add braces (curly
brackets) around the underscore. For example,

Thi ng{ _} x_

gives you this: Thingx
citation

deleted

inserted

Text Withsuperscript

Hint: There are two ways to make superscripts work,
when used directly after another word or character:

® Add a space before the superscript. For example, kg
/ m 73~ gives you this: kg/m 3

® Add braces (curly brackets) around the superscript
markup. For example,

kg/ n{~3"}
gives you this: kg/m3

Text Wlthsubscript

nonospaced

Here's how you make a paragraph
appear as a block quotation.

look ma, red text!
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Text Breaks
Paragraph Break

In wiki markup, a paragraph is a continuous line of text ending in two carriage returns. This is equivalent to a
continuous line of text followed by a blank line.

When rendered into HTML, the result is a line of text wrapped in a set of <p></ p> tags.
Line Break
Confluence provides two options for forcing a line break within a paragraph of text:

* |mplicitly, by entering a single carriage return at its end.

® Explicitly, by entering two consecutive backslashes: \\

When rendered into HTML, the result is a paragraph of text that is split into separate lines by <br > tags,
wherever a forced line break appears.

@ For most purposes, explicit line breaks are not required because a single carriage return is enough.

The examples below show how to use explicit line breaks.

What you need to type What you'll get
here is some text here is some text
W divided

using line
di vi ded \\
_ _ breaks

using line \\ \\
br eaks\\
This is a short list: This is a short list:
* Point 1
Text to go with point 1 ®* Point1l
* Point 2 Text to go with point 1

W ® Point 2

Text to go with point 2 with a break
Text to go with point 2 with a break Xt 10 go with point 2 wi

If you wish to use multiple consecutive line breaks, each should be separated by a space character. For
example, use this for two consecutive line breaks:

WA
Horizontal Rule

To create a horizontal line across the width of your page or content block, type four dashes (like this: ----) at
the beginning of a line, then press Enter or space.

Make sure that the dashes are on a separate line from the rest of the text.

What you need to type What you'll get

here is some text here is some text

divided by a horizontal rule
divided by a horizontal rule
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Links

You can use wiki markup to add hyperlinks to your text.

What you need to type
[#anchor]

[Confluence Wiki
Markup”~attachment.ext]

[pagetitle]

[pagetitle#anchor]
[pagetitlerattachment.ext]
[spacekey:pagetitle]
[spacekey:pagetitle#anchor]

[spacekey:
pagetitle®attachment.ext]

[/2004/01/12/blogposttitle]
[spacekey:/2004/01/12
/blogposttitle]

[/2004/01/12]
[spacekey:/2004/01/12]
[spacekey:]

[~username]
[phrase@shortcut]
[http://confluence.atlassian.
com]

[mailto:
legendaryservice@atlassian.
com]

[file://z:/file/lon/network/share.
txt]

['http://external/image.png!
|http://external/link.html]

What you'll get
A link to an anchor on the same page.

A link to a file attached to the page.

A link to a page.

A link to an anchor on another page.

A link to a file attached to another page.

A link to a page in another space.

A link to an anchor on a page in another space.

A link to a file attached to a page in another space.

A link to a blog post.

Note: blogposttitle is the title of the blog as it appears on the page.

A link to a blog post in another space.
Note: blogposttitle is the title of the blog as it appears on the page.

A link to a whole day's blog posts.

A link to a whole day's blog posts in another space.

A link to the space homepage (or the space summary page of the space.
A link to the user profile page of a particular user.

A shortcut link to the specified shortcut site. Shortcuts are configured by
the site administrator.

A link to an external resource.

A link to an email address.

A link to a file on your computer or on a network share that you have
mapped to a drive. This only works on Internet Explorer.

Displays an external image and links to an external URL.

Note that Confluence treats headings as anchors, so you can link to headings using this pattern: [spacekey:
pagename#headingname], where headingname is case-sensitive and must be entered without spaces.

For each of these link forms:
® You can prepend a link alias, so that alternate text is displayed on the page. Example: [link

alias|pagetitle#anchor]
® You can append a link tip, which appears as a tooltip. Example: [pagetitle#anchor|link tip]
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Images

You can display images from attached files or remote sources.

What you What you'll get
need to

type

http://www. | An image from a remote source is displayed on the page. Uses a fully qualified URL.
host.com
/image.gif!

lattached- An image file attached to the page is displayed.
image.gif!

! An image file attached to a different page is displayed.
pageTitleNim
age.gif!

IspaceKey: An image file attached to a page in a different space is displayed.
pageTitleNim
age.gif!

1/2010/05/23 = An image file attached to a blog post is displayed.

/My Blog

Posttimage.

gif!

limage. The image is displayed as a thumbnail on the page (only works with images that are

jpgjthumbnai = attached to the page). Users can click on the thumbnail to see the full-sized image.
I Thumbnails must be enabled by the site administrator for this to work.

limage. For any image, you can specify attributes of the HTML image tag as a comma separated
giflalign=righ | list of name=value pairs.
t, vspace=4!

Available HTML image tags include:

Image Details
tag

align Available values are 'left’, 'right', 'bottom’, ‘center’, 'top'.
border = Specifies the width of the border (in pixels).

borderc = Use with the 'border' tag. Specify colors by name or hex value.
olor

hspace @ Specifies the amount of whitespace to be inserted to the left and right of the image (in pixels).
vspace @ Specifies the amount of whitespace to be inserted above and below the image (in pixels).
width Specifies the width of the image (in pixels). This will override the natural width of the image.

height Specifies the height of the image (in pixels). This will override the natural height of the image.

title Specifies alternate text for the image, which is displayed when the pointer hovers over the
image.
alt Specifies alternate text for the image. This text is retrievable via search, and contributes to

accessibility of the page for text-only viewing.

Page Layouts
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There is no wiki markup representation for page layouts.

Macros

Storage format and wiki markup examples have been included in the documentation for each macro.
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Files

Share your team's PDFs, Office documents, images, and more in one place
by uploading your files to Confluence. Automatic versioning, instant
previews, permissions, and full-text search, means shared network drives
can be a thing of the past for your team.

When you upload a file it is attached to the current page or blog post. This
is why files are often referred to as attachments in Confluence.

You can attach anything from project plans and design mockups to video
and audio files. You and your colleagues can also collaborate by commentin
g on files displayed on Confluence pages.

Using Files

Upload Files

Display Files and Images

Manage Files

Share and Comment on Files

Edit Files

Edit in Office using the Office Connector
Install Atlassian Companion

Permissions

On this page:

® Using Files
® Permissions

Related pages:

® Configuring
Attachment Size

® Configuring your
Attachment Storage

The 'Add Attachment' and 'Delete Attachment' permissions are used to control who can upload and delete

attachments in a space.

Users with 'Add Page' or 'Add Blog' permissions can insert existing attachments to their pages, but not

upload new attachments unless they also have the 'Add Attachment' permission.

There is no permission that controls downloading attachments. See our knowledge base article about disabli

ng the download of attachments if you need to do this.


https://confluence.atlassian.com/display/CONF74/Configuring+Attachment+Size
https://confluence.atlassian.com/display/CONF74/Configuring+Attachment+Size
https://confluence.atlassian.com/display/CONF74/Attachment+Storage+Configuration
https://confluence.atlassian.com/display/CONF74/Attachment+Storage+Configuration
https://confluence.atlassian.com/pages/viewpage.action?pageId=215484007
https://confluence.atlassian.com/pages/viewpage.action?pageId=215484007

Upload Files

When you upload a file, such as an image or

document, it will be attached to the current page. On this page:
You can then choose to display the file on the page ® Upload a file
as a link, an image or embed it in the page (using a * Accepted file types and size
macro). ®* File versions
® What happens after a file is uploaded?
To upload a file you'll need the ‘Add Attachments' ® Notes

space permission.
Related pages:

Upload a file Files

Configuring Attachment Size
Display Files and Images
Manage Files

There are many ways to attach a file to a page.
In the editor you can:
® Drag the file directly onto the page.

® Goto Insert > Files and images and upload
a file.

When viewing a page you can:

® Drag the file directly onto the page.
® Goto *** > Attachments and upload a file.

You can attach multiple files at a time.

Accepted file types and size

Confluence allows you to attach most file types, but you cannot attach a folder of files (including folders
created by applications like Keynote - you'll need to export your presentation to zip or other format).

Although just about any file type can be attached to a page, not all file types can be displayed on or
embedded in a page. See Display Files and Images to find out more.

The maximum file size you can upload to Confluence is set by your system administrator. By default it is
10mb, but your administrator may have increased or reduced this limit.

File versions

If you upload a file with the same name as an existing attachment on the same page, Confluence will
overwrite the existing attachment. Version history is kept for all attachments. See Manage Files to find out
more.

Any changes you make to the source file will not affect the copy that was uploaded to Confluence. To update
the Confluence copy, you need to upload the new version of the file.

What happens after a file is uploaded?

Text extraction and indexing

When a file is uploaded, its text is extracted and indexed. This allows people to search for the content of a
file, not just the filename.

See Configuring Attachment Size for more information on how files are indexed.
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Thumbnail and preview generation

When you insert an uploaded file into a page (for example a Word document, or Excel spreadsheet),
Confluence will generate thumbnail images of the file contents, so it can be viewed inline in the page, or in
the preview.

Because this process can be very memory intensive, a 30 second time limit applies when performing
document conversion for complex image or presentation files (such as PPT, PPTX, EMF, WMF). Your
administrator can increase or decrease this timeout using the conf | uence. docunent . conver si on.

i magi ng. convert.timeout orconfl uence. docunent. conversion. slides.convert.timeout sy
stem properties.

Thumbnails are not generated for TIFF or PSD (Photoshop) files by default. Your administrator can override
this behaviour using the conf | uence. docunent . conver si on. i magi ng. enabl ed. ti f orconfl uence
. docunent . conver si on. i magi ng. enabl ed. psd system properties.

In Confluence Server, document conversion is handled by Confluence. In Confluence Data Center this

process is externalised, to minimise the impact on individual Confluence nodes. See Document conversion
for Confluence Data Center to find out about how this affects thumbnail and preview generation.

Notes
i. We recommend you don't use special characters in page or attachment names, as the page or

attachment may not be found by Confluence search, and may cause some Confluence functions to behave
unexpectedly.
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Display Files and Images

Files can be displayed on a page as a thumbnail or as a link. There are a
few different ways to Upload Files.

You can control how the file appears on your page. The options available
depend on the type of file.

Insert a file into your page
There's a few ways to insert a file into your page:

® Go to Insert > Files on the editor toolbar and select any of the
previously uploaded files, or

® Drag the file directly into the editor (this will upload and insert the file
in one step), or

® Type ! and choose an attached file from the autocomplete drop down.

Your file will appear on your page as a thumbnail. Click the thumbnail to
resize it or to switch to showing the file as a link.

) Blues kyPresentationODT.odp

s W Show as link

Insert a file attached to another page

On this page:

® |nsert afile into
your page
® |nsert afile
attached to
another page
® Insert an
image file
from the web
® Delete files
from your
page
Preview a file
Office and PDF files
Image files
Multimedia files
Show a list of files
on a page

Related pages:

® Links
® Manage Files
® Edit Files

You can display a file that's attached to a different page of the same Confluence site, if you know the name

of the file.
To display an image attached to a different page:

Go to Insert > Files and choose the Search on other pages.
Enter the name of the file.

AN

Select the file from the search results and choose Insert.

Insert an image file from the web

Choose whether to search the current space or All Spaces and choose Search.

You can display an image from a remote web page on your Confluence page, without needing to attach it to
your page. You need to know the URL for the image, not for the web page it appears on. This is only

available for image files, not other types of files (like documents).

To display an image from a web page:

1. While editing the page, position the cursor where you want to place the image.

2. Choose Insert > Files and choose Images from the web.

3. Enter a URL for the image. (example: http://atlassian.wpengine.netdna-cdn.com/wp-content/uploads

/AtlassianBushRegeneration-12January2012-083-trunc.jpg
4. Choose Preview to check that the URL and image are correct.
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5. Choose Insert.

Delete files from your page

If you delete a file or image in the editor, the attached file will not be deleted. Go to *** > Attachments to

delete the attachment completely from the page.

Seeing an 'unknown attachment' placeholder on your page? This means that the attached file has been

deleted from the page (or another page).

Preview a file

Click an image, file thumbnail or link when viewing a page to launch the preview.

The preview includes images from the web that are displayed on the page and files that are attached to the

page (even if they are not currently displayed on the page).

In the preview you can:

Download the image file.

Upload a new version of the file (attached files only).

Comment on the file.

Choose to edit the file with a desktop application.

Zoom in, out or fit the image to the width of your browser.

Browse like a slideshow using the next and back buttons.

See other files attached to the page and select a thumbnail to preview that file.
Switch to a full screen presentation mode.

Many file types can be previewed, including Office files, PDFs and many image types.

Images files

JPEG
PNG
TIFF
PSD
WMF
EMF
ICO
ICNS
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Office files Other files

DOC * PDF
DOCX * MP3
PPT * MP4
PPTX
XLS
XLSX
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1. See more files: see other files also attached to this page.
2. Manage this file: download the file, upload a new version or share with your team.
3. Add a comment: drag the pin to comment on the file.

Office and PDF files

Inserting a file in a page is a great way to make useful documents, spreadsheets, presentations and other
files available to your team.

As with all file types, you can choose to insert the file as a link, or as a thumbnail. The thumbnail shows a
preview of the document's contents, and can be resized.

To view an Office or PDF file, click the link or thumbnail to see the full preview (no need to have Excel, Word
or PowerPoint installed). Alternatively, use the Download button in the preview to download the file and view
offline.

You can even edit and comment on Office and PDF files.

Image files

When editing the page, select an image to show the image properties panel. The panel allows you to set the
display size, add a border and effects and link the image to other pages.

662px & W Original Border < Link Properties

From the image properties panel you can:

® Choose a preset size for the image
® Enter a width for the image (between 16px and 900px)
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® Add a border around the image

® Link the image to a page or URL

® Align the image (you can use the left and right align buttons to make the text wrap around the image
too)

® Add a title, which is shown when you hover over the image (go to Properties > Title)

® Add alt text, which is used by screen readers and when the image can't be shown (go to Properties >
Title)

® Add effects to the image such as drop shadow or snapshot (go to Properties > Effects).

To add a caption to an image using the Instant
Camera effect:

® Choose Effects in the image properties panel
and choose the Instant Camera image effect.

® Save the page.

® Goto *** > Attachments to go to the
'Attachments' view of the page.

® Choose Properties next to the image file.

®* Add a comment to the attachment. The text in
your comment will appear as the image caption.

You will need to re-enter the comment each time you
upload a new version of the image.

Note: The Instant Camera effect only works with Latin

character languages, due to a lack of handwriting style

fonts in multi-byte languages.

Note about image effects

Displaying image effects can be resource intensive. Confluence limits the threads that are dedicated to
displaying image effects so that it does not impact your whole instance. If a thread is not available,
Confluence will display the image without the effect.

The following knowledge base article provides information if you need to adjust the number of threads - Imag
e effects are not displayed in Confluence 5.5 or later.

Multimedia files

The file preview also supports MP3 audio and MP4 video files. It uses HTML5 to play attached audio and
video files. This means the file types people can play in the preview depends on the audio and video formats
their browser supports.

You can also display a wider range of multimedia files (video, audio and animation) using the Multimedia
Macro.

Display online video (such as YouTube or Vimeo videos) using the Widget Connector Macro.

Show a list of files on a page

There are several ways you can display a list of files on a page. You can:
® Use the Attachments Macro to show files attached to the current page.
® Use the Space Attachments Macro to show all files in a space.

® Use the Gallery Macro to show thumbnails of images attached to a page.

You can also use the File List blueprint for uploading, viewing and managing lists of files.

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/
https://confluence.atlassian.com/display/CONFKB/Image+effects+are+not+displayed+in+Confluence+5.5+or+later
https://confluence.atlassian.com/display/CONFKB/Image+effects+are+not+displayed+in+Confluence+5.5+or+later

Manage Files

Files are attached to Confluence pages. See Upload
Files to find out about attaching files to pages.

Once attached you can download, delete and edit
these files, for example if you need to upload a new
version of the file, or change the page it is attached
to.

Download attached files

Any user with permission to view a page can also
download any files attached to that page.

To download an individual file:

® Click the Download button in the file
preview, or

® Goto *** > Attachments

® and then right click on the file name and save
the link.

To download all files attached to a page as a zip
file:

1. Goto *** > Attachments
2. Click Download All.

There's no option to download all attachments in a
space.

Delete an attached file

On this page:

Download attached files

Delete an attached file

Upload a new version of an attached file
Move a file to another page

Edit properties of an attached file

View all attached files in a space

Related pages:

® Files
® Display Files and Images

You'll need the 'Delete Attachment' space permission to delete an attached file.

To delete all versions of an attached file:

Go to the page that contains the attachment.
Goto *** > Attachments

e

Choose Delete to confirm your action.

Choose Delete next to the attachment you want to delete.

Deleted files can be restored from the trash. You'll need to be a space admin to do this.

Space Admins can also delete specific versions of an attachment:

1. Goto *** > Attachments

2. Click the expand arrow next to the attachment name to see the list of attachment versions
3. Choose Delete next to the version you want to delete.

Deleted file versions are not recoverable from the trash.

Screenshot: Attachments and attachment versions
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Attachments
Name Size Creator Greation Date Labels Commant
B User journey.pdf 12 kB Alana Grant Jan 04, 2013 14:36 No abels B View | Properties | Edit | Dele
Version 3 (current) 12 kB Alana Grant Jan 04, 2019 14:36 Dele
Version 2 12 kB Alzna Grant Jan 04, 2019 14:36 Revised with new designs Dele
Version 1 12kB Alana Grant Jan 04, 2018 14:33 Dele
B8 Annual Financial Report, xisx 20 kB Emma McRae Jan 04, 2013 14:32 o fabeis R View | Properties | Edit | Dele
» [ Project overview.docx 1 kB Emad Abdi Jan 04, 2019 14:28 No labels By View | Properties | Edit | Dele
* Download All

Upload a new version of an attached file
There are two ways up upload a new version of an attached file. You can:

® Upload a file with the same file name to the page.

® Use the Upload a new version button in the file preview to upload a file with a different name (for
images and PDFs only).

To view attachment versions:

® Goto *** > Attachments
® Click the expand arrow next to the attachment name.

All earlier versions of the file will appear.

You can't revert to an earlier version of the file, but you can choose to remove earlier versions if you have
Space Administrator permissions.

Move a file to another page

You'll need the 'Add Page', 'Add Attachment' and 'Remove Attachment' space permissions to move an
attached file to another page.

To change the page that a file is attached to:

® Goto *** > Attachments

® Choose Properties next to the attachment you want to move.
Enter the name of the page you want to move the attachment to (for example My Desti nati on
Page) .

® Choose Save.

If you want to move the file to a page in another space, add the space key before the page name (for
example DOC:My Destination Page).

Edit properties of an attached file
You'll need the 'Add Attachment' permission in the space to edit the file properties.
To edit the properties of an attached file:

® Goto *** > Attachments
® Click Properties beside the attachment you want to edit.

You can:

change the file name

add a comment (used in the version list and also by the Snapshot image effect)
change the MIME type

move the attachment to another page
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® add a label.

Changing the MIME type may cause your file to display incorrectly.

View all attached files in a space

There are two ways you can view all files in a space. You can:

® Use the Space Attachments macro to display the list of files on a page.

® Go to the space and choose Space tools > Content Tools from the bottom of the sidebar Then

choose Attachments.

You can use the filters to only show files with a particular label or file extension.

Screenshot: Space attachments macro
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Share and Comment on Files

Collaboration doesn't just happen on pages; often you'll need to collaborate

with your team on documents, presentations, images and spreadsheets. On this page:
Whether it's mockups for a new marketing campaign or a full project plan,
you can simplify your team'’s feedback loop by working together on files in e Share a file
Confluence. * Comment on a file
Share a file Related pages:

. L ® Files
Do you have lots of files on a page and want to get a team member's input ¢ Edit Files

on just one of them? You can share the file with them directly. Display Files and

Images

® Comment on
pages and blog
posts

It works just like sharing a page:

1. Click the thumbnail or link to preview the file.

2. Choose the Share button.

3. Enter an email address, user name or group name, add your
message and send.

Your team members will get an email with your message and a link to view
the file.

@ Share notifications are only sent by email, they won't appear in the workbox E

Comment on a file

Whether it's an image — like a mockup of the new marketing campaign that needs feedback — a PDF, a
presentation, or any other file you can preview in Confluence, you can drop a pin anywhere on the preview
and add your comment to start a conversation.

To comment on a file:

1. Click the thumbnail or link to preview the file.
2. Drag the pin icon from the bottom of the preview and drop it where you want to comment.
3. Add your comment and Save.

Pinned comments work just like inline comments on pages. You can use @mentions and links, and drop as
many pins as you need on any part of the file. You can even add simple macros such as the code macro
using wiki markup autocomplete. Anyone with permission to add comments to the page can add and reply to
comments on a file.

When you preview a file, you'll see pins for any existing comments on that version of the file. Select a pin to
view the comment.

Once the conversation is finished, you can resolve the comment to hide it (and any replies) from view. If you

need to see resolved comments again, you can reopen them. Go to ﬂ > Resolved comments in the
preview.
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|‘]| Product overview.pdf - v.1 [Current] ~

Measure and optimize

Discover how to use datag, benchmark
your usage pattern and improve
productivity.

Show all files 2

1. Resolved comments: Choose the 'more options' button to show or hide resolved comments.
2. Comments: Drag a pin onto a file to comment.

(@) You can't comment on files that are hosted on a web server and added to Confluence using their
URL, or on files that can't be viewed in the preview (such as videos, zip files, and some other file

types).

What happens to comments when you upload a new version?

Comments are specific to the version of the file. This is to avoid confusion when the part of the document or
image the comment is pinned to has changed significantly.

To see inline comments on a previous version of the file:
1. Click the thumbnail or link to preview the file.
2. Click the filename dropdown in the top left and select a previous version.
3. Comment pins will now be visible, for all comments made on that version.

How many comments can you add to one file?

While there is no limit to the number of comments that can be added to a file, Confluence can only display
100 comments. See [l CONFSERVER-43397 GATHERING INTEREST  for more information.
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Edit Files

This page covers how to edit files attached to a

Confluence page. On this page:

® |nstall and connect the Atlassian
Companion app

Change your default app

Manually upload an edited file

Limitations

Revoke trust between Confluence and the
Companion app

Related pages:

® Administering the Atlassian Companion
app

Confluence provides two methods for editing files:

® Edit files using the Atlassian Companion app
Allows you to edit any type of file, if you have a compatible application installed. Requires you to
install Companion on your computer.

® Edit in Office using the Office Connector
Allows you to edit Microsoft Excel, PowerPoint, and Word files with a compatible browser and
Microsoft Office application. Provided for organizations who can't use Companion.

Your Confluence administrator will decide which method is best for your organisation.
To check which method is available in your site, go to the file preview (click an image or file thumbnail). If

you don't see the Edit button, your site is using the Edit in Office method, so the information on this page
doesn't apply to you.

@ Confluence a history.doc « v.1 [Current] ~

Download the latest Companion version

Download the Atlassian Companion app for Mac or Windows.

See Install Atlassian Companion for a step-by-step guide.

Edit an attached file

You can edit any file attached to a Confluence page using your preferred desktop application, then when
you're ready, upload the file back to Confluence. You can edit Office documents, Photoshop files, Keynote
presentations — any attached file with a compatible application installed on your computer.

To edit a file you'll need the 'Add Attachments' space permission.

To edit files, you'll also need to install the Atlassian Companion app and allow it to connect to your
Confluence site. Once the Companion app is installed and running, you can start editing.

To edit a file in Confluence:

1. Go to the page containing the attached file.
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Click the file to open it in preview.

Click Edit.

Your browser will prompt you open / launch the Companion app.

The Companion window will appear, and your file will open in the default application for that file type.
Make your changes and then save your file in the desktop application.

In the Companion window, click Upload to upload the edited file. It will be saved as a new file version.

NOGOAWN

Screenshot: Editing an image file with Companion.

localhost

Get ready to edit
The Atiassian Companion app is required to
edit this file. Once installed, your browser wil
prompt you fo launch the sop.

Download for Mac « Download far Windowse

[ Atlassian Companion
Current files

VividOperaHouse.jpg

Meeting agenda.doex

1. Edit button - if a file can be edited, you'll see an Edit button in the preview.

2. Download Companion - if you haven't already installed Companion, you can download it from this
flag. The flag always appears, but you only need to download Companion once.

3. Launch Companion - your browser will ask for your permission to open Companion. The prompt is
different in each browser, and will appear each time you edit a file.

4. Upload or discard file - once you have saved the changes to your file, click the Upload button
to upload your edited file back to Confluence, or click the x icon to discard the changes, and remove
the file information from the list.

(@) There is a known issue with editing attached files in some browsers in Confluence 6.11 to 7.2. See C
an’t edit files in Confluence Server using Atlassian Companion app in Internet Explorer, Edge,
Firefox, or Safari for more information and some workarounds.

Other ways to edit files

You can also edit a file from the attachments macro, view file macros (Word, Excel, PowerPoint, and PDF),
or the attachments page.

To edit a file from the attachments page:
1. Go to the page that contains the attached file.

2. Goto *** > Attachments
3. Next to the file name, click Edit , then follow the instructions above to edit and save your changes.

Install and connect the Atlassian Companion app
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The Atlassian Companion app manages the download and re-upload of files you edit in Confluence.

The first time you edit a file, you'll be prompted to install the Companion app and allow it to connect to your
Confluence site.

Click the file to open it in preview.

Click Edit.

Follow the prompts to download and install the Atlassian Companion app.
Launch the Companion app.

In Companion, click Trust to confirm you want to connect to Confluence.
Return to Confluence, and follow the steps above to edit the file.

SO AWNR

You can also download and install the app manually for Mac or Windows or use a Microsoft Installer (.msi
file). See Administering the Atlassian Companion app for details.

For detailed installation instructions for your operating system, see Install Atlassian Companion.

Change your default app
Confluence allows you to edit files in your operating system's default app for that file type (for example, .psd

files will open in Photoshop). To change the app your Confluence file opens in, change the default app in
your operating system.

Manually upload an edited file

You can only upload changes back to Confluence if those changes are saved in the original file. You won't
be able to upload if:

® you edit the file and save it as a new version (save as)
® the application you're using saves the file in a different format to the original — for example, from a
PowerPoint file (.pptx) to a Keynote file (.key).

If this happens, you can upload your new version manually:

1. Click the original file in Confluence to open it in preview.

2. Click the Upload a new version button and select your new file version.
3. Click Done.

What to do if you lose your edited file

Any files you've opened with Companion will remain listed in the Companion window. The status information
below the file will indicate the time since the file was downloaded, edited, or uploaded. Files that haven't
been edited in the last 60 days are cleared when Companion app restarts.

You can also follow our guide to accessing Confluence files edited with the Atlassian Companion app if the
file isn't listed or you're not able to re-open it in your desktop application.

Limitations

File size limits

Confluence won't allow you to upload your changes if the edited file is larger than your site's maximum file
size limit. This limit is set by your system administrator. By default the limit is 10 MB, but your admin may
have increased or reduced it. Check out Upload Files for more information.

Blocked file types

We block file types that might pose a risk to your security, including executable files such as .exe or .bat
files.

It's possible to modify the file types companion can open using an environment variable. See How to
change the file types blocked by Companion in Windows.
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Cross file links and references

If your file links or references to other files (for example if you link a worksheet in one Excel file, to another
Excel file) these links will not work once the files have been uploaded to Confluence.

Revoke trust between Confluence and the Companion app

If you want to disconnect the Companion app from your Confluence site, you can remove it as a trusted site.

To revoke trust:

1. Click the Companion app icon in your system's toolbar.
2. Choose Clear all trusted domains.

Note: clearing trusted domains won't kill active connections. If you select Clear all trusted domains while
editing a file, you'll still be able to upload those changes back to Confluence.

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

Edit in Office using the Office Connector

This page covers how to edit files using the legacy E
dit in Office method. Editing Office files attached to a page
Other ways to edit

Office Connector pre-requisites
Enable Edit in Office

Troubleshooting

Confluence provides two methods for editing files:

® Edit files using the Atlassian Companion app
Allows you to edit any type of file, if you have a compatible application installed. Requires you to
install Companion on your computer.

® Edit in Office using the Office Connector
Allows you to edit Microsoft Excel, PowerPoint, and Word files with a compatible browser and
Microsoft Office application. Provided for organizations who can't use Companion.

Your Confluence administrator will decide which method is best for your organisation.
To check which method is available in your site, go to the file preview (click an image or file thumbnail). If

you see the Edit button, your site is using the Companion app method, so the information on this page
doesn't apply to you.

U| Confluence a history.doc - v.1 [Current] ~

Editing Office files attached to a page

The Office Connector allows you to edit Office files that are attached to pages, if your site does not use the
Companion App method. You'll need to use a browser, operating system and application (either Microsoft
Office or OpenOffice) as described in the compatibility matrix below.

To edit an Office document attached to a Confluence page:

1. Goto °** > Attachments

2. Choose Edit in Office beside the attachment you want edit.
Your browser will ask you to confirm that you want to open the file.

3. Choose OK.
You may also see a security warning or be asked to log in to your Confluence server - enter your
Confluence username and password, then choose OK.

4. The file will open in your Office application - make your changes then save the document. It will be
saved back to Confluence.

i. Edit in Office will not work on files that have special characters (such as ' # @ or €) in the filename.

Screenshot: Edit in Office option on the attachments page


http://www.microsoft.com/office
http://www.microsoft.com/office
http://www.openoffice.org/
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Pages [ sample space Home + \iew Page o
Attachments
Name Size Creator Creation Date Labels Comment
» [w] Meeting agenda-1E 44 KB Rach Admin Oct 14, 2014 09:33 Mo labels ¢ View | Edit in Office
11.00cx | Properties | Delete
» [x] Spreadsheet xis 7T KB Rach Admin Oct 14, 2014 0903 Mo labels ## sew | Edit in Offip
||
* Download All

Other ways to edit
Edit options also appear in the:
® Attachments macro (choose Edit in Office beside each attached office file)

® Office Word and Office Excel macros — choose the Edit button above the content.
® Office PowerPoint macro — choose the edit icon on the viewer.

Office Connector pre-requisites

You can only edit files using the Office Connector if your system administrator has enabled this feature on
your site. By default, Confluence requires you to install the Atlassian Companion app to edit attached files.
See Edit Files

Configuration matrix

Edit in Office is only compatible with desktop applications. Online versions of Office applications are not
supported.

You need one of the following software combinations to edit Office files from your Confluence page.

Software Operating system = Browser

Microsoft Office 2010 SP2, 2013, 2016, 2019

®* Windows ® Chrome
* Firefox!
® Internet Explorer 11
® Edge
Microsoft Office 2011, 2016, 2019
®* Mac OS ® Chrome
®* Firefox
® Safari
Microsoft Office XP, 2003, 2007, 2010 SP1
® Windows ® |Internet Explorer 11
OpenOffice 2.x — 3.x
®* Windows ® Chrome
® Linux ®* Firefox
® Safari
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LibreOffice 6.x

®* MacOS ® Chrome
* Windows ® Firefox
® Linux ® Safari

! Firefox only works in Windows with Confluence 7.1 and later.

Note

The known supported Office editors for Linux are OpenOffice & LibreOffice, but in theory it should work with
any WebDAV-aware application.

If you experience problems editing documents using the Office Connector (using an application, operating
system and browser combination above) contact our support team, who can raise an issue about it. Tell us
as much as you can about your operating system, application version, document version (if it's different to
the version of Office / Open Office you're using to open the document) and browser.

Here are a few common issues:

® Using Internet Explorer? You can only edit documents in Microsoft Office. OpenOffice is not
supported.

® Using Linux? You can only edit documents in OpenOffice. Microsoft Office is not supported.

® Special characters in the filename? Edit in Office does not work for files with special characters
(like ' # @ €) in the filename. See

[J CONFSERVER-22403 - Attaching office documents with special characters stops the ability to
edit from office GATHERING IMPACT

®* Not seeing the Office Connector options? Your system administrator needs to enable this feature,
and can control how it appears on your site. See Enable Edit in Office as a dark feature and Configurin
g the Office Connector.

Enable Edit in Office
You need System Administrator global permission to do this.

To enable the legacy Edit in Office functionality:

1. Goto E > General Configuration > Office Connector.
2. Choose Enable Edit in Office for all users and save your changes.

This will disable Companion app functionality for all users in the site.

Troubleshooting
Having problems with the Office Connector?

® The WebDAYV plugin must be enabled, because the Office Connector uses WebDAYV to transfer
information to and from Office documents. The WebDAYV plugin is bundled with Confluence, and can
be enabled or disabled by the System Administrator. If necessary, refer to the instructions on managin
g system and marketplace apps and configuring the WebDAV options.

® Ensure that your Confluence server's base URL is set correctly (see Configuring the Server Base URL
to find out how to check this). When a user edits a Confluence page in Word and then uploads the
page back to the Confluence server, the base URL determines where the document will be saved. If
the base URL is incorrect, the documents may be saved to a different Confluence server.

® Using Office 2013? Your administrator will need to enable 'Allow authentication tokens in the URL
path' in the Office Connector configuration. See Configuring the Office Connector.

See the Office Connector Limitations and Known Issues knowledge base article for more troubleshooting
tips.
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Install Atlassian Companion

If your site uses Atlassian Companion method to edit files, you will need to install the Atlassian Companion app
before you can start editing. Learn more about Editing Files.

The way you install Companion will depend on your operating system, and your organisation's environment.

Download the latest Companion version

‘ Download the Atlassian Companion app for Mac or Windows.

Windows
These instructions are for Windows 10. The process is similar in earlier, supported Windows versions.
1. Download the Companion app from Windows download

2. Double click to run the Atlassian Companion-1.X.X Setup.exe file you just downloaded.
3. That's it. You may briefly see a progress indicator like the one below.

Atlassian Companion

-

Once installed, Companion runs in the background. You may need to click the Show hidden items arrow in the
system tray to see it. Right click the Companion icon to see the version you have installed.

Version: 0.7.3
Give Feadback

Show Licenses

v Launch on Startup

View Logs

The first time you edit a file, you'll be prompted to trust your Confluence site. Once that's done, Companion is
ready to use.


https://update-nucleus.atlassian.com/Atlassian-Companion/291cb34fe2296e5fb82b83a04704c9b4/latest/darwin/x64/Atlassian%20Companion.dmg?_ga=2.10316533.1504161906.1537741913-1368551695.1536192141
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https://update-nucleus.atlassian.com/Atlassian-Companion/291cb34fe2296e5fb82b83a04704c9b4/latest/win32/ia32/Atlassian%20Companion.exe
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Mac

These instructions are for MacOS 10. Your version may look slightly different.
1. Download the Companion app from Mac download
2. Double click the Atlassian Companion.dmg file you just downloaded.

3. The install dialog will appear. Drag the Atlassian Companion icon to the Applications folder icon.

ene B Atiassian Companion

& Confluence

Drreg Atlossion Companion to your Applications folder

o |

Atlasslan Companion.app Applications

Sug sl

4. Launch the companion app:
a. In Finder, go to your Applications folder, and click Atlassian Companion.app, or
b. In Launchpad, select Atlassian Companion, or
¢. In Spotlight, search for Atlassian Companion.

Once launched, Companion runs in the background. Click the Companion icon in the status area of the menu
bar to see the version you have installed.

PN © % = « 8% Fri2d Jan 8:37am

Give Feedback
Show Licenses

v Launch on Startup

| View Logs

Quit

The first time you edit a file, you'll be prompted to trust your Confluence site. Once that's done, Companion is
ready to use.

Linux

Atlassian Companion is not currently available for Linux.

Managed or restricted environments

If you're not able to install applications on your computer, your administrator or IT team may need to do this for
you.

Send them a link to Administering the Atlassian Companion App for information about MSI installation.

Troubleshooting
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Companion is installed twice in Windows
It's possible to have two versions of Companion installed simultaneously if you have installed Companion using
the installer (.exe) and the MSI (.msi). If this happens, you should uninstall both versions from Add/Remove

programs and then re-install Companion (either using the . exe or the . nsi depending on how you want to be
able to update Companion in future).

Remove residual files after uninstalling Companion in Windows

If you need to completley uninstall Companion you may want to check if any residual files remain.

The default installation directories are:

* EXE: %LOCALAPPDATA%/atlassian-desktop-companion
® MSI: Program Files (x86)/Atlassian Companion

The app stores temporary data and edited files in:

* %APPDATA%/Atlassian Companion
® C:\Users\<UserName>\.atlassian-companion

Companion creates the following registry entries:
® Computer\HKEY_CLASSES_ROOT\atlassian-companion
¢ Computer\HKEY_CURRENT_USER\Software\Classes\atlassian-companion
®* Compute\HKEY_CURRENT_USER\Software\Microsoft\atlassian-desktop-companion

You can do a registry search for "atlassian" to locate them. These are used for both the MSI and EXE.
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Confluence Mobile

There are two ways to stay connected to your team's work in Confluence
while you're out and about - the Confluence Server mobile app for iOS and
Android, or via your device's browser.

On this page:

®* What you'll need

If you're a Confluence user, check out the two ways you can use ® Considerations for
Confluence on your device. administrators
. . ® Limitations and
® Using the Confluence Server mobile app known issues

® Using Confluence via your mobile browser

@ If you're an administrator, read on to find out whether your team will
be able to use the mobile app. Once you've met the requirements, |
nvite your team to use the app!

What you'll need

Confluence requirements
In order for your users to try the Confluence Server mobile app, you will need to:
® upgrade your Confluence site to Confluence 6.8 or later

® allow users to access your site on their device (if your site isn't accessible on the public internet,
people will need be connected to your network or use a VPN)

Device requirements
In order to use the app, your users will need a device with either:

® Android 4.4 (KitKat) or later, or
® jOS 11 or later (iPhone, iPad or iPod Touch)

Users will need to log in to use the app, even if your site allows anonymous users.

Considerations for administrators
Here are some things to consider when determining whether your users will be able to use the app.
VPN and firewalls

If your Confluence site is not accessible on the public internet, users will need to connect their device to your
network or virtual private network (VPN) in order to use the app.

We recommend providing your users with step-by-step instructions on how to connect to your VPN when
you let them know the mobile app is available, as this is something Atlassian Support will not be able to help
them with.

The mobile app will also attempt to check the compatibility of your site prior to presenting the login screen. If

you've configured a custom filter to prevent unauthenticated requests to your server, you will need to change
it to allow <conf | uence- base-url >/ server-info. acti on to pass through without authentication.

HTTPS and certificate requirements
In the latest version of the iOS and Android apps, you can connect to the app using either HTTP or HTTPS.
If you're using HTTPS your proxy must allow TLS 1.2 traffic. This is an iOS requirement that we've chosen to

implement for both the iOS and Android apps to prevent confusion (for example where one device can log in,
and another cannot).
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Ideally, your certificate should be from a trusted Certificate Authority. If you have certificate that is self-
signed, or from an unknown Certificate Authority (for example, you are your own CA), users may still be able
to use the app by manually installing your certificate on their device. See our Knowledge base article for
more information on how to do this.

iOS 13 introduced a number of other requirements that your certificate will need to meet if your users will be
using the app on iOS devices. See Requirements for trusted certificates in iOS 13.

Login and authentication

The app supports all common Confluence user management configurations, including external user
directories and SAML single sign-on. Users will need to sign in to use the app, even if your site allows
anonymous access.

Mobile Device Management (MDM)

You can distribute the Confluence Server app to people in your organisation using your MDM solution. For
more info on how to do this, see Mobile Device Management.

Marketplace apps, themes, and visual customizations

The mobile app provides a simple, lightweight way for users to view, create, edit and collaborate on pages.
Complex interactions, including those provided by Marketplace apps, such as blueprints, calendars,
workflows will not be available in the app. Some third party macros may be available, depending on whether
the third-party app supports rendering these macros on mobile.

Any theming or look and feel customizations you've made to your site will not be reflected in the mobile app.

Cloud services

In order to provide push naotifications to users' devices, we have developed a cloud-based notification
service. This service is developed and maintained by Atlassian, and is hosted on our AWS infrastructure
(AWS SNS). See Push notifications service below for more information.

This is the only cloud-based service used by the app.

Push notifications service

The Confluence Server mobile app can push notifications directly to users' devices. Users choose whether
they'd like to receive push natifications from the app, and can opt out at any time. This feature uses a cloud-
based notifications service developed and maintained by Atlassian and hosted on our AWS infrastructure.
No user or message content is sent to the service, only notification IDs, and we don't store any data.

If you need to avoid using any cloud-based services you can choose to disable push notifications entirely.
Head to el General Configuration > Mobile apps.

If you're using restrictive firewall or proxy server settings, you'll need to allow (whitelist) htt ps: // nobi | e-
server-push-notification.atlassi an. com to ensure push notifications work as expected.

For sites that are not accessible on the public internet (for example users need to be connected via VPN to
use the app) we adapt the push notification message as follows:

® |f the user is connected to your network or VPN, we'll show the full notification, for example "Sara
Leung shared 'End of year party' with you"

® |f the user is not currently connected to your network or VPN, we'll show a shorter notification, for
example "1 new notification".

Mobile web and linking directly to pages
It is not possible to go directly from a link, for example in an email notification, to the app. To help with this
limitation, when people land on a Confluence page in their device's browser, they'll see the Open in app

button. Tapping this prompt will open the app, if they have it installed, or take them to the App or Play store
to download it.
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If you don't want this button to display in mobile web, you'll need to disable the entire Confluence Mobile
plugin, which is required to use the mobile app.

Limitations and known issues

Not all macros are available

Not all macros will display in the app or mobile web. If a macro can't be displayed, you'll see the message
below, and have the option to tap through to the desktop version of the page, in your device's browser.

Screenshot: Error that appears when a macro is not rendered in Confluence mobile

View macro in desktop version

Administrators can disable Confluence mobile on your site

If you're not able to use the mobile app or mobile web, it may be because your administrator has disabled
one or both of the following system apps:

® Confluence mobile plugin (required to use the mobile app)
® Confluence mobile web plugin (required to use mobile web)

() Disabling the 'Confluence Mobile Plugin' will also disable all the modules of the Workbox - Host
Plugin plugin. This issue is being tracked at

[0 CONFSERVER-40782 - Disabling the Confluence Mobile Plugin also disables the Workbox -
Host Plugin in Confluence GATHERING IMPACT

Seperate Cloud and Server mobile apps
While the functionality of the two mobile apps is very similar, you will need to download the Confluence

Server mobile app to be able to authenticate with a server site. You can't use the Confluence Cloud app
with a Confluence Server site or vice versa.
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Using the Confluence Server mobile app

Stay connected to your team's work with the Confluence mobile app. No
matter whether you have an iPhone, iPad, Android phone, or Android tablet,

On this page:

we've got you covered when you're away from your desk.

® Confluence Server

If you're the first in your organisation to try the app, ask your Confluence for Android
admin to have a read through Confluence Mobile - Considerations for ¢ Confluence Server
administrators, so they can make sure you're able to connect. for iOS

0]

® Customizing push
Which app do | need? notifications

Confluence Server app - If you're using Confluence 6.8 or later,
download the Confluence Server app from Play Store or App Store.

Confluence Cloud app - If you're using Confluence Cloud (your
Confluence version number is 1000 or higher) head over to our
Cloud documentation to find out about the Confluence Cloud app
for iOS and Android.

Confluence Server for Android

Here's what you'll get, and what you can do in the app:

Create and edit pages

Create a quick page when you're on site with a customer, or fix that typo on an existing page before
anyone notices. Create and edit lets you do the important stuff, wherever you are.

Notifications when you need them most

Get push natifications for mentions, comment replies, page shares, and tasks assigned to you, so you
can act quickly when it really matters.

Collaborate on the go

Comment on pages to keep work moving, wherever you are. Like pages to show your support, and
share them via email and other apps.

Get back to your work, fast

The Recents tab lets you quickly find pages you've viewed recently. Find those meeting notes you
added yesterday, or the blog post you were reading earlier.

Visit any space, and browse using the page tree

The Spaces tab lets you visit your My Spaces, and any other space on your site. Pick a space and
browse using the familiar Confluence page tree.

Create, edit, share, and It's all here when you need it Comment, like and share Stay in sync with your team
collaborate on the go

Have ideas on how to make the app even more useful? We want your feedback! Shake your phone (or head
to Settings > Feedback) to drop us a note.
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Limitations and known issues

Some page macros won't display in the app or mobile web. You'll need to view the page in your
browser (or switch to full desktop mode on your device).

Image and file upload is not currently available in the app.

Links to Confluence pages (from emails or other apps) don't automatically open in the app.

® Admins can disable push notifications for your entire site.

Confluence Server for iOS

Confluence Server for iOS is a universal app for iPhone and iPad, so you can choose the best device for the
job. If you'd rather not create and edit pages on your iPhone, switch over to your iPad and take advantage of
the larger screen and keyboard. You can also use split view on iPad and work side by side with other apps.

Here's what you'll get, and what you can do in the app:

Create and edit pages

Create a quick page when you're on site with a customer, or fix that typo on an existing page before
anyone notices. Create and edit lets you do the important stuff, wherever you are.

Notifications when you need them most

Keep up with what your team is doing with push natifications for new pages and posts, comments,
mentions, page shares, likes, and tasks assigned to you.

Get back to your work, fast

The Your work tab serves up pages you've viewed or worked on recently. Find those meeting notes
you added yesterday, or the blog post you were reading earlier.

Visit any space, and browse using the page tree

The Spaces tab lets you visit your My Spaces, and any other space on your site. Pick a space and
browse using the familiar Confluence page tree. While you're in the spaces list, you can add spaces
to My Spaces or remove the ones that aren't important any more.

Stay connected to your team

The activity feed lets you see all activity on your site, or filter it by space. Like and comment on pages,
or share a link to any page, right from the app.

Create, edit, share, and It's all here when you need it Find your recent work, fast Stay in synec with your team
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collaborate

Have ideas on how to make the app even more useful? We want your feedback! Shake your phone (or head
to Settings > Feedback) to drop us a note.

Download an the

w App Store

Limitations and known issues
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® Some page macros won't display in the app or mobile web. You'll need to view the page in your
browser (or switch to full desktop mode on your device).
Image and file upload is not currently available in the app.
Links to Confluence pages (from emails or other apps) don't automatically open in the app.

® Admins can disable push notifications for your entire site.

I Did you participate in our beta?

First of all, thank you! @ Your feedback was invaluable to us. To keep using the app, however, you'll
need to:

® Upgrade your site to Confluence 6.8 or later, and
® Update your app to version 1.x or later:
® For Android, head to the Play Store and hit Update.
® For iOS, head to the App Store to download the official app.

If you update your app without upgrading Confluence, the app will still work for a while, but you won't

get access to new features, like push notifications. Also, once you log out, you won't be able to log
back in, as the app checks that you have the required Confluence version.

Customizing push notifications

Push notifications are a great way to stay in the loop, as they appear on your device, even when you're not
using the app. Tap the notification, and be taken straight into the app.

& confluence + now = CONFLUENCE

Emma McRae Emma McRae assigned you a task on
Emma McRae assigned you a task on "2018-01-18 Meeting notes"
2018-01-18 Meeting notes

There are three notification levels, 'All activity', 'Activity for me', and 'None'. iOS users also have an
additional 'Custom' option, where they can turn off individual notifications.

To change your push natification settings:

® For Android tap H- Settings > Push
® ForiOS tap x> Settings > Push

Here's a summary of common Confluence actions, and whether a push notification is sent.

Push notification setting
Action All activity Activity for me None
Someone mentions you (v} (] [x]
Someone shares a page / blog post with you
Someone assigns a task to you
Someone comments on a page / blog post you're watching
Someone comments on a page / blog post you created

Someone replies to your comment

O 00000
Q00O 0 0o
0O 0O 0 0 0 O

Someone likes a page / blog post you created
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Someone likes your comment or your reply (V] (V] [x]
Someone likes a page / blog post you're watching [x] [x] [x]
Someone invites you to edit a page / blog post [x] [x] [x]
Someone edits a page / blog post / comment [x] [x] [x]

If you're using the iOS app, choose 'Custom’ to further tailor your notifications, and turn off any of the
following notifications individually:

Shares

Mentions

Tasks

Comments on pages / blog posts you created

Likes on pages / blog posts / comments you created
Comments on pages / blog posts you're watching.

Good to know

® |f your site isn't accessible on the public internet (for example you need to be connected to your office
wifi, or use a VPN to access it from home) we adapt the push notification message, so that you get a
shorter version when you're not connected to your network.

| % CONFLUENCE

& Confluence - now
1 new notification 1 new notification

® Your admin can disable push notifications for the entire site. If this is the case, you'll see a message
when you go to the Push settings screen in the app.

® OniOS, when you first install the app, you'll be prompted to allow the app to send notifications to your
device. We recommend you choose Allow, as you can very easily mute the notifications in the app
later. If you do choose Don't allow, and change your mind, you'll need to go to Settings > Notificatio
ns > Confluence then make sure Allow notifications is enabled.
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Using Confluence via your mobile browser

() This page is about Confluence mobile web, which is accessed On this page:
using the browser your your device.

® The dashboard —

For a richer experience, try the Confluence Server mobile app for the first thing you

iOS and Android.

see

® Searching for
When you access Confluence using the browser on a mobile device, you'll content and people
see a version of Confluence which is optimized for mobile viewing. ¢ Viewing pages,
Confluence chooses the mobile or desktop interface based on your device, blog posts and
but you can still switch to the desktop site on your mobile by choosing menu comments
é ) ) ) ® Viewing people's

then choosing Switch to desktop version. profiles
® Following up on
notifications

® Viewing tasks

You can also swap from the desktop view to the mobile view if you're on a mobile device, by choosing Switc
h to Confluence Mobile at the top of the page.

On your supported mobile device, you can:

View the Confluence dashboard, pages, blog posts, and user profiles.
Add or reply to a comment on a page or blog post.

Like a page, blog post or comment.

Watch a page or blog post.

See your notifications and tasks.

You can't add or edit pages or blog posts, or edit existing comments, using the mobile interface.

The dashboard — the first thing you see
Choose a tab to see:
® Popular content — what people like in your wiki.
® Recent blogs — the latest blog posts.

* Network — updates by people in your network.

Tap the links to view the full content of a page, blog post or comment.

Popular Recent Blogs MNetwork

H JIRA 5.2 Bug Fixing
m Re: On culture and ideas

Workshop - "The Business
Case" - Why is Customer
Experience Important? v T

[
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Searching for content and people

Tap the menu icon E to open the menu panel on the left of the page. Then type text or a person's name
in the Search box. The mobile interface offers the quick search, which returns matches on page title only. To
use advanced search, switch to desktop mode.

O\Eaarch people and content

Dashboard Pop

Recently viewed

MNotifications

Tasks

Give Atlassian feedback

Switch to desktop version

Log out

Viewing pages, blog posts and comments

Tap a link on the dashboard or on any other page. Confluence will display the linked page, blog post or
comment.

You can:

® View the content, tap a link to move to another page, and interact with the page using the standard
functionality supported by mobile browsers.

® |ike or unlike a page, blog post or comment.

® Watch or stop watching a page or blog post.

® Add or reply to a comment.

Viewing people's profiles

Search for a person's name, then view that person's user profile. Tap the options to phone, SMS or email a
colleague directly from your mobile device.

Following up on notifications

You can view and respond to your notifications on your phone or other mobile device. Tap the menu icon

to open the menu panel on the left of the page. Choose Notifications, and tap a notification to see its
details. You can reply, watch or like via the inline actions. Tap Open to open the page or blog post in a new
page. For full details, see Workbox Notifications.

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

Confluence 7.4 Documentation

Notifications

¢ 7 likes of Feedback requested - all .., »

¢ Joe Clark liked Last chance for a da... >

L) Re: Ul Text Guidelines >

| Atlassian Foundation's bush regene... >

- EOFY 2012: Choose your own Adv... >

- 2 comments on Confluence for tech... »
Maore

Viewing tasks

You can view and manage your tasks on your phone or other mobile device too. Tap the menu icon E to
open the menu panel on the left of the page. Choose Tasks then tap a task to see its details.

— Tasks
To Do Completed
Atlassian Foundation's bush rege... >

| Overview of FY12 Speaking Events >
Leave work early to pick up choco... »
Sarah Maddox = buy the chocolates  »
Sarah Maddox — write the docum... >

Recommended database migratio... »
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Invite your team to use the app

If you're running Confluence 6.8 or later, invite your team to start using the Confluence Server mobile app.

Head to Confluence Mobile to read up on some considerations for administrators, and find out whether you can
use the app with your site.

Users don't need any additional permissions to use the app, you just need to let them know where to download

it and how to log in. If your Confluence site is not accessible on the public internet, you may also need to help
them connect to your network or VPN on their device.

Email template

Here's a suggested email template that you can adapt to let your users know that the Confluence Server mobile
app is available. Don't forget to test that you can connect to your site before sending!

() Hieveryone,
Confluence mobile apps are now available for Android and iOS, and you can use them with our
Confluence instance. With the mobile apps, you can create, edit and read pages, straight from your
device.

To use the app, you'll need a device with either Android 4.4 (KitKat) or later, or iOS 11 or later (iPhone,
iPad or iPod Touch).

Download the app for:

® Android: https://play.google.com/store/apps/details?id=com.atlassian.confluence.server
® iOS (Apple) https://itunes.apple.com/us/app/id1288365159?7mt=8.

To log in you'll need our Confluence URL: <add your full URL, e.g. https://yoursite.customer.com
/confluence>

<If your site isn't accessible outside your network>
To use the app you'll need to be connected to our network / VPN. <Add steps for connecting to VPN,
if applicable>

<If your certificate is self-signed or from an unknown Certificate Authority>
You'll also need to install our certificate on your device. <Add steps for downloading the certificate>

Best,

Your name here


https://play.google.com/store/apps/details?id=com.atlassian.confluence.server
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Mobile Device Management (MDM)

You can distribute the Confluence Server app to people in your organisation using your MDM solution. This
allows you to:

® Deploy the Confluence Server app to company-approved iOS and Android devices.

®* Pre-populate your Confluence site URLs (just the URL, we don't pass login credentials). People will still
be able to enter a URL, which is useful if you have some rarely used sites, and don't want to pre-populate
them all. Requires Confluence Server iOS app version 1.8.0 / Android app version 0.4.3 or later.

MDM Function Supported for Jira Server app

App deployment Yes

App configuration Yes - to pre-populate the site URL only
App tunnel Yes

Single sign-on (SSO) | No
Access control No

Security policies No

Read more about AppConfig and what we currently support in our AppConfig Technical Capabilities white
paper.

Distribute the app to managed devices
The way you do this will depend on your particular MDM provider. In most cases you will:

® Add the app to your MDM app catalog.
® For iOS you will likely bulk purchase through the Apple VPP store, then link the app in your MDM
solution (this might be by providing an sToken, or could happen automatically)
® Choose which devices should be able to install the app (this might be called something like distributing or
assigning the app).

Refer to the documentation for your MDM provider for more information.

Pre-populate site URLSs on the login screen

If your MDM solution supports the AppConfig standard, you can save your users time and prevent mistakes by
pre-populating your site URL in the app.

To pre-populate the mobile app login screen with one site URL:

1. In your MDM, navigate to the App Config section. Check the documentation for your MDM for how to do
this.

2. Add a new key called "sites"

3. In the Value field for the key, enter your site title and URL in JSON format as shown in the examples
below. Replace the title and base URL with your own site detalils.

For a single URL:

[
{ "title": "My Confluence Site", "baseURL": "https://conf.exanple.conl}

]

For multiple URLSs:


https://www.appconfig.org/
https://confluence.atlassian.com/download/attachments/976762352/Jira-Server-AppConfig-ISV-Capabilities.pdf?version=1&modificationDate=1567636315067&api=v2
https://www.appconfig.org/
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[
{"title": "My Docs Site", "baseURL": "https://docs.exanple.coni} ,

{"title": "Intranet", "baseURL": "https://team exanpl e.coni confluence"}

]

Copy the JSON carefully, including the [ and ].

4. Save your changes. We recommend you access the Confluence Server app on a device to check you
have passed the URLs correctly, before distributing the app config changes to your users. You'll see an
error if the app can't display your list of sites.

Here's an example of how the AppConfig looks in Airwatch and Mobilelron, two popular MDMs. These
screenshots are for the Jira Server app, but the process is the same for Confluence.
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Details Distribution App Configurations Reviews

App Configurations Summary » I0S Managed App Configuration

Configuration Setup

Name

Jira site URLs

Description

List of Jira sites to provide on login screen

i0OS Managed App Settings

Kay Valua
sites [ [ "titla": *My Jira Sita", "baseURL™: *htt e
+ Add
Distribute this App Config
Choose one of these options
— e
F \\ J/'/ Y
I III { \I
X | R
! \ /
A o \\ i
I - S S -~
Everyone with App No One Custom
All Users who have the app Stage this App Config for later distribution This config goes to a custom detined set of users

andfor user groups

Jira Server - Add Assignment X

App Tunneling { ENABLED DISABLED K@)

L

Application Configuration ENABLED DISABLED |(1)
UPLOAD XML

(© Enter Key-Value pairs to configure applications for users:

Application Configuration
Configuration Key Value Type Configuration Value

[ [ { “title": "My Jira Site",
sites strin ¥ " ® Insert Lookup Value
g baseURL": P L+ p

ADD CANCEL
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Macros

Using macros helps you to expand the capabilities of your Confluence
pages, allowing you to add extra functionality or include dynamic content. On this page:
For example, use the Attachments macro to list files attached to a page, or
use the Widget Connector macro to include things like a YouTube video or

[ ]
Twitter feed. Add a Macro to

your Page
® Confluence macros
Add a Macro to your Page * Creating your own

macros
Including Macros with the Macro Browser ® Getting more

macros from The
To add a macro to a page: Marketplace

® Macro usage
1. From the editor toolbar, choose Insert * ~ > Other Macros statistics
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro
name, to see a list of suggested macros. In this example we're inserting the

cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit.
This will open the macro details, so you can edit the macro parameters.

Edit Remove

Macro Parameters
Many macros have optional parameters you can use to control the macro's output.
With the Attachments Macro, for instance, you have two optional parameters allowing you to:

® Specify the file formats of the attachments displayed
® Choose whether or not you want old versions of the attachments displayed

Macro Placeholders
Macro placeholders are displayed in the editor where you have added a macro to the page.
When editing a page, you can:

® Double-click a macro placeholder (or click the placeholder and choose Edit) to open the macro dialog
window and edit the macro's parameters
® Select a macro placeholder to cut, copy and paste the macro

Confluence macros

Below is a list of the macros currently bundled with Confluence. Click a macro name for details of the usage,
including optional parameters and examples.

Anchor Macro
Attachments Macro
Blog Posts Macro
Change History Macro



Confluence 7.4 Documentation

Chart Macro

Cheese Macro

Children Display Macro
Code Block Macro

Column Macro

Content by Label Macro
Content by User Macro
Content Report Table Macro
Contributors Macro
Contributors Summary Macro
Create from Template Macro
Create Space Button Macro
Excerpt Include Macro
Excerpt Macro

Expand Macro

Favorite Pages Macro
Gallery Macro

Global Reports Macro

HTML Include Macro

HTML Macro

IM Presence Macro

Include Page Macro

Info, Tip, Note, and Warning Macros
Jira Chart Macro

Jira Issues Macro

Labels List Macro
Livesearch Macro
Loremipsum Macro
Multimedia Macro
Navigation Map Macro
Network Macro

Noformat Macro

Office Excel Macro

Office PowerPoint Macro
Office Word Macro

Page Index Macro

Page Properties Macro
Page Properties Report Macro
Page Tree Macro

Page Tree Search Macro
Panel Macro

PDF Macro

Popular Labels Macro
Profile Picture Macro
Recently Updated Dashboard Macro
Recently Updated Macro
Recently Used Labels Macro
Related Labels Macro
Roadmap Planner Macro
RSS Feed Macro

Search Results Macro
Section Macro

Space Attachments Macro
Space Details Macro
Spaces List Macro

Status Macro

Table of Contents Macro
Table of Content Zone Macro
Task Report Macro

User List Macro

User Profile Macro

View File Macro

Widget Connector Macro
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Creating your own macros
Users with System Administrator permissions can create user macros - see Writing User Macros.

If you want to create something more complex, you can develop your own plugin - see Writing Confluence
Plugins.

Getting more macros from The Marketplace

You can find a wide range of Atlassian and third party macros at The Marketplace. These are distributed as
apps and can be installed by a Confluence Administrator.

Macro usage statistics

Confluence administrators can check how often each macro is used in your site.

To see how often a macro is used, go to E > General Configuration > Macro Usage. This lists how often
each macro is used in current spaces but doesn't include any macros used on pages in archived spaces or
macros provided by disabled apps.

() Do more with Confluence
Extend Confluence with one of the hundreds of other macros in the Atlassian Marketplace, such as:
® Composition Tabs & Page Layouts: Toggle or expand the visible of portions of your pages
with the Toggle and Cloak macro

® Content Formatting for Confluence: Over 30 easy-to-use Confluence macros gives you the
ability to create better, more engaging content
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Anchor Macro

Allows you to link to a specific part of a page. Add macro to the spot on the page you want to link to. Once the
page has been published, you'll be able to link to the anchor. For more information on using anchors see Anchors

The example below shows an example of an Anchor macro as it appears in the editor, and as it would appear to
someone viewing the page.

This text is part of the body of the page.

o—. L. Anchor

Important notes

This textis also part of the e 1ot 4 part of the body of the page.

Important notes
—O

This text is also part of the body of the page.

1. Anchor macro as it appears in the editor
2. Anchor macro as it appears when viewing a page (it isn't visible).

Using the Anchor macro

To add the Anchor macro to a page:

1. From the editor toolbar, choose Insert = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Macro options (parameters)
Parameters are options that you can set to control the content or format of the macro output. Where the

parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default = Description
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Anchor None This is the anchor name that you will use when creating the link.
Name

® The anchor name can include spaces. Confluence will remove the spaces
automatically when building a URL that points to this anchor.

® The anchor name is case sensitive. You must use the same pattern of upper
and lower case letters when creating the link as you used when creating the
Anchor macro.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: anchor
Macro body: None.

{‘anchor : her e}

Linking to an anchor
You can link to an anchor from:
® A page on the same Confluence site. The link may be on the same page as the anchor, another page in

the same space, or a page in another space on the same Confluence site.
* Another web page or another Confluence site, using a specifically formatted URL.

See Anchors for more information on link syntax.
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Attachments Macro

The Attachments macro displays a list of files attached to a page.

It also allows users (with appropriate permissions) to:

upload a file to the page, directly from the list

edit attachment properties and labels

delete an attached file (this deletes all versions of the file)
preview image attachments

download all files attached to the page.

Note: you can use the macro parameters to turn off previews if you have very large attachments.

Screenshot: the Attachments macro, showing details of an attachment

»

Pages / Product Marketing Home & @ # Edit % Save for later @ Watching = Share

Customer feedback

Created by Emma McRae, last modified by Emad Abdi just a moment ago

Have you received feedback from customers? Add it to this page.

File Modified *
» H Customer segments.pptx 22 minutes ago by Emma McRae
» [[1 Voice of the customer report Q1.docx 21 minutes ago by Alana Grant
Customer engagement map.jpeg 3 minutes ago by Ryan Lee
- BB Customer feedback Q1.xlsx a minute ago by Emad Abdi
Labels

customer-insights feedback marketing user-research

Version history

Version 1 (current version) Created by Emad Abdi a minute ago

Preview View Properties Edit Delete

acl or browse for files

+ Download All

and select the required macro

Using
the
Attach
ments
Macro

To add
the
Attachm
ents
macro
toa

page:

From
the
editor
toolbar,
choose |
nsert
+- s
Other
Macros
Find

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested
macros. In this example we're inserting the cheese macro.

{che

Macro suggestions

r

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit

Cheese

Remove

Parameters
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Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default = Description

Filename all A comma-separated list of regular expressions, used to filter the attachments by file
Patterns name. Note that the parameter values must be regular expressions. For example:
(patterns

) ® To match a file suffix of 'jpg’, use . *j pg (not *. j pg).

® To match file names ending in ‘'jpg' or 'png’, use . *j pg,. *png

Attachmen | (none) A list of labels, used to filter the attachments to display. If you wish to enter more

t Labels than one label, separate the labels with commas. Confluence will show only

(1 abel s) attachments that have all the labels specified. (The match is an AND, not an OR.)
For information on labeling the attachments, see Add, Remove and Search for
Labels.

Include false A value of t r ue will include previous attachment versions in the list.

Oold

Attachmen

t Versions

(ol d)

Sort By date The sort order for attachments. Note that people viewing the page can change the

(sort By) sort order by clicking the column headings. Valid values are:

date — sorts by updated date in reverse chronological order (newest first)
size — sorts largest to smallest

name — sorts alphabetically

created date - sorts by creation date in reverse chronological order (newest
first)

Sort Order  ascendi | Used in combination with the Sort By parameter, to sort the attachments in

(sortOrd | ng ascending or descending order.

er)

Allow true If selected, the list of attachments will include options allowing users to browse for,
Upload and attach, new files.

(upl oad)

Page Title = (none) Used to display attachments from another page. If you do not enter a page title, the
(page) macro will display the files attached to the current page.

Show true Used to display a preview of the attached file. If true, preview will be visible when
Previews the list item is expanded.

(previ ew)

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: att achnment s

Macro body: None.

{attachnents: ol d=f al se| patterns=. *png, . *j pg| sort by=nane| page=My page about
chocol at e| sort order =descendi ng| | abel s=chocol at e, cooki es| upl oad=f al se| previ ew=f al se}
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Edit an attachment
There are a few ways to edit attachments in Confluence.
To edit a file from the attachments macro list:

Click the arrow next to the file name to view its version history.

Click Edit.

Select the application in which you want to edit your file.

Make your changes and then save your file in the desktop application.

In Confluence, click Upload to confirm you want to save the edited file as a new version.

RN R

Learn more about editing files in Confluence.
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Blog Posts Macro

The Blog Posts macro allows you to display blog posts on a Confluence page. Clicking on a title takes you to
the blog post.

Using the Blog Posts Macro

To add the Blog Posts macro to a page:

1. From the editor toolbar, choose Insert T ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Required @ Default Description

Content No titles Available values:

Type to

Display ® titles — Display the title, creator, space, and created date stamp
for each blog post.

(content) ® excerpts — Display a short excerpt from each blog post. If the

post contains an Excerpt macro, the Blog Posts macro will
display the content defined in the Excerpt macro. If the post does
not contain an Excerpt macro, the Blog Posts macro will display
the first few sentences of the post.

® entire - Display the whole content of each blog post.

Time No no limit Specify how far back in time Confluence should look for the blog
Frame posts to be displayed.
(time)

Available values:

® m— Minutes

® h — Hours, so '12h' displays blog posts created in the last twelve
hours.

®* d — Days, so '7d' displays blog posts created in the last seven
days.

* w— Weeks
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(1 abel)

Restrict to
these Auth
ors

(aut hor)

Restrict to
these
Spaces
(spaces)

Maximum
Number of
Blog Posts
(max)
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No

No

No

No

None

None

@self, i.
e. the
space
which
contains
the page
on which
the
macro is
coded

15

Filter the results by label. The macro will display only the blog posts
which are tagged with the label(s) you specify here.

You can specify one or more label values, separated by a comma or
a space.

® To exclude content which matches a given label, put a minus
sign (-) immediately in front of that label value. For example: If
you specify a label value of - badpage you will get only content
which is not labeled with 'badpage’.

® To indicate that the results must match a given label value, put a
plus sign (+) immediately in front of that label value. For
example: If you specify a label value of +super page,
+goodpage you will get only content which has at least two
labels, being 'superpage’ and 'goodpage’.

Filter the results by author. The macro will display only the blog
posts which are written by the author(s) you specify here.

This parameter allows you to filter content by space. The macro will
display only the pages which belong to the space(s) you specify
here.

You can specify one or more space keys, separated by a comma or
a space.

®* To exclude content in a specific space, put a minus sign (-)
immediately in front of that space key. For example: If you
specify a space key of - BADSPACE you will get only content
which is not in the BADSPACE.

® To indicate that the results must come from a specific space, put
a plus sign (+) immediately in front of that space key. For
example: If you specify a space key of +GOODSPACE you will get
only content in GOODSPACE. (Note that this is not particularly
useful, because each content item belongs to one space only. If
you put a plus sign next to one space key and list other space
keys too, the other space keys will be ignored.)

Special values:

@el f — The current space.

@er sonal — All personal spaces.

@l obal — All site spaces.

@ avor it e — The spaces you have marked as favorite.
@ avourite— The same as @ avorit e above.

@l | — All spaces in your Confluence site.

* — The same as @l | above.

When specifying a personal space, remember to use the tilde (~)
sign in front of the username, such as ~j bl oggs or ~j bl oggs @xa
npl e. com

Specify the maximum number of results to be displayed. Note that
the results are sorted first, and then the maximum parameter is
applied.
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Sort By No creation
(sort)

Reverse No false
Sort

(reverse)

Wiki markup example

Specify how the results should be sorted. If this parameter is not
specified, the sort order defaults to descending order (newest first)
based on the creation date.

Values:

® title — Sort alphabetically by title.

® creation — Sort by the date on which the content was added.

* modified — Sort by the date on which the content was last
updated.

Select to change the sort from descending to ascending order
(oldest first). Use this parameter in conjunction with the Sort By
parameter. This parameter is ignored if the Sort By parameter is not
specified.

In storage format and wikimarkup a value of t r ue changes the sort
order.

This example is useful when you want to add a macro outside the editor, for example as custom content in the

sidebar, header or footer of a space.
Macro name: bl og- post s

Macro body: None.

{bl og- posts:content=titles|spaces=@elf,

ds| aut hor=j sm th|time=4w reverse=true| sort=creati on| max=10]| | abel =chocol at e, cooki es}
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Change History Macro

The Change History macro shows the history of updates made to a page: version number, author, date and
comment. It displays the information inline.

Screenshot: The Change History macro in Confluence

This is the change history macro

Version Date Comment
Current Version (v. 4) Feb 19, 2013 16:27 Rach Admin:
Formatting change
V.3 Feb 19, 2013 16:27 Rach Admin:
Added the change history macro
v 2 Feb 19, 2013 16:26 Rach Admin:
Added a macro
v 1 Feb 19, 2013 16:25 Rach Admin

To add the Change-History macro to a page:

1. From the editor toolbar, choose Insert + ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

—+ Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Lheese

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Required  Default @ Description

Number of versions | No blank Limit the amount of page history to display. Leave blank to
to display display all versions in the page history.

(limt)

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: change- hi story
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Macro body: None.

{change-history:limt=2}
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Chart Macro

The Chart macro allows you to display a chart

based on tabular data. When you add the macro to On this page:

a page, you:
® Using the Chart Macro
® supply the data to be charted by the macro ® Parameters
as a table in the placeholder of the macro. * Examples
¢ edit the macro parameters in the Macro ® Pie Chart

Browser to configure the format of the chart. Bar Chart

3D Bar Chart
Time Series Chart
XY Line Chart
XY Area Chart
Area Charts
e et ® Gantt Chart
o2 | 81 ® Code examples
s ® Chart type parameters
Chart display parameters
Chatrt title and label parameters
Chart data parameters
Chart color parameters
Chart axis parameters
Pie chart Parameters
Chart attachment parameters
Wiki markup example

Screenshot 1: A table of data in the Chart macro
placeholder

o chart) 1y nrreSaries mns = Weaks, [ssuss B

Humber of 1ssues
.

- 4 4L 4 4L 44 A A
- Z Z Z o Z oD oD o oo
L) L) L) L) L) L) L) L) L) L)
[0 ] [0 ] [0 ] [0 ] [0 ] [0 ] [0 ] [0 ] [0 ] [0 ]
L S S S S - S
- - - - oo oo oo oo oo o
o) o) o) o) o) o) o) o) o) o)
S 2 2 2 2 2 2 2 2 =2
un [0 ] o o [50] o (¥ =) [xal L) (¥ =)
L) — — [0 ] L) L) — [0 ] ™ L)
Weels

|ssues Burndown

Using the Chart Macro
To add the Chart macro to a page:

Edit the page and use autocomplete to add the Chart macro. (Type ‘{chart}'.)

Enter your chart data as one or more tables in the body of the macro placeholder. (See the screenshot
above.)

Click the macro placeholder and choose Edit.

Select a chart type using the Type parameter (see below).

Choose other parameter settings in the macro browser, as described below.

Click Refresh in the 'Preview' area, to check that the chart appears as you expect.

Click Save to add the chart to your page.

Click Save again when you are ready to save the page.

N

©No G hAW

Parameters



Confluence 7.4 Documentation

Chart Type Parameters | Display Control Parameters | Title and Label Parameters | Data Specification
Parameters | Color Parameters | Axis Parameters | Pie Chart Parameters | Attachment Parameters

Chart Type Parameters

These parameters determine the type of chart to display and the way the chart looks.

Parameter

Type

Display
Orientation

Show in
3D

Stacked
Values

Show
shapes

Opacity

Default

pie

vertical

false

false

true

® 75 percent for
3D charts

® 50 percent for
non-stacked
area charts

® 100 percent
for all other
charts

Display Control Parameters

Parameter

Width

Height

Display
rendered
data

Description

The type of chart to display. XY charts have numerical x- and y-axes.
The x values may optionally be time-based (see the Time Series
parameter).

Standard — pie, bar, line, area

XY Plots — xyArea, xyBar, xyLine, xyStep, xyStepArea, scatter,
timeSeries

Other — gantt
Applies to area, bar and line charts.

® vertical — y-axis is vertical

® horizontal — x-axis is vertical
Applies to area, bar and line charts.
Applies to area and bar charts.

Applies to line charts. Shapes are shown at each data point.

A percentage value between 0 (transparent) and 100 (opaque) that
determines how opaque the foreground areas and bars are.

Default = Description

300 The width of the chart in pixels. The maximum width is limited by the conf | ue
nce. chart. macro. wi dt h. max system property.

300 The height of the chart in pixels. The maximum height is limited by the conf | u
ence. chart. macr o. hei ght . max system property.

false Sets whether to display the rendered body of the macro (usually the data
tables). By default, the chart data table isn't rendered.

®* before — the data are displayed before the chart.
* after — the data are displayed after the chart.
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Image png The image format to be used for the chart.
format

¢ png

* ipg

Title and Label Parameters

Parameter Default = Description

Chart Title none The title of the chart.

Chart Subtitle none A subtitle for the chart, using a smaller font than for Title.
Horizontal-axis Label none The label for the x-axis (domain).

Vertical-axis Label none The label for the y-axis (range).

Show Legend true Show a legend or key.

Data Specification Parameters

The data for the chart is taken from tables found when the macro body is rendered. These options control
how this data is interpreted. By default, numeric and date values are interpreted according to the Confluence
global default language (locale) formats. If conversion fails, other languages defined in Confluence will be
tried. Additional conversion options can be specified using the parameters below.

Parameter = Default = Description

Tables all first Comma separated list of table ids and/or table numbers (starting at 1) contained
level within the body of the macro that will be used as the data for the chart. If data
tables tables are embedded in other tables, then table selection will be required. This

occurs when more complex formatting is done (for example using section and
column macros).

Columns all Comma separated list of column labels and/or column titles and/or column
columns | numbers for tables used for chart data. This applies to all tables processed.
Columns are enumerated starting at 1. Column label is the text for the column in
the header row. Column title is the (html) title attribute for the column in the

header row.
Content horizon
Orientation | tal ® vertical — data table columns will be interpreted as series.
® horizontal — data tables rows will be interpreted as series.
Time false
Series ® true — the x values in an XY plot will be treated as time series data and
so will be converted according to date formats.

Date Conflue | For time series data, the date format allows for additional customization of the
format nce conversion of data to date values. If a Date format is specified, it will be the first

languag @ format used to interpret date values. Specify a format that matches the time

e series data. See simple date format.

defined

date

formats
Time Day The time period for time series data. Defines the granularity of how the data is
Period interpreted. Valid values are: Millisecond, Second, Minute, Hour, Day, Week,

Month, Quarter, Year.
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Language @ none Use in combination with the Country parameter to form a locale.
These additional number and date formats will be used for data conversion
before the default languages.
Valid values are 2 character ISO 639-1 alpha-2 codes.

Country none Use in combination with the Language parameter to form a locale. Valid values
are 2 character ISO 3166 codes.

Forgive true
® true — the macro tries to convert numeric and date values that do not
totally match any of the default or user-specified formats.
® false — enforce strict data format. Data format errors will cause the chart
to not be produced.

Color Parameters

Colors are specified using hexadecimal notation or HTML color names.

Parameter Default = Description
Background White Background of the chart.
Color
Border Color no Border around the chart.
border
Colors Comma-separated list of colors used to customize category, sections, and

series colors.

Axis Parameters

Depending on the chart type, the range and domain axis may be customized. These values are
automatically generated based on the data but can be overridden by specifying one or more more of these
parameters.

Parameter = Default | Description

Range none Range axis lower bound.
Minimum
Value

Range none Range axis upper bound.
Maximum
Value

Range none Range axis units between axis tick marks.
Axis Tick
Unit

Range none Angle for the range axis label in degrees.
Axis Label
Angle

Domain none Only applies to XY plots. Domain axis lower bound. For a date axis, this value
AXxis must be expressed in the date format specified by the Date format parameter.
Lower
Bound
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Domain none
AXis

Upper

Bound

Domain none
Axis Tick
Unit

Domain none
AXxis Label
Angle

Category none
Label
Position

Date Tick start
Mark
Position

Pie Chart Parameters

Only applies to XY plots. Domain axis upper bound. For a date axis, this value
must be expressed in the date format specified by the Date format parameter.

Only applies to XY plots. Domain axis units between axis tick marks. For a date
axis, this value represents a count of the units specified in the Time Period
parameter. The Time Period unit can be overridden by specifying a trailing
character: y (years), M (months), d (days), h (hours), m (minutes), s (seconds),
u (milliseconds).

Only applies to XY plots. The angle for the domain axis label, in degrees.

Placement of the axis label text for categories.

up45 — 45 degrees going upward
up90 — 90 degrees going upward
down45 — 45 degrees going downward
down90 — 90 degrees going downward

Placement of the date tick mark.

® start —tick mark is at the start of the date period.
®* i ddl e — tick mark is in the middle of the date period.
®* end — tick mark is at the end of the date period.

Parameter = Default Description
Pie Show only the pie Format for how pie section labels are displayed. The format uses a
Section section key value string with special replacement variables:
Label
®* 9%0% is replaced by the pie section key.
®* %1% is replaced by the pie section numeric value.
®* 052% is replaced by the pie section percent value.
Example 1: "%0% = %1%" would display something like
"Independent = 20"
Example 2: "%0% (%2%)" would display something like
"Independent (20%)"
Pie No exploded Comma separated list of pie keys that are to be shown exploded.
Section sections Note: requires jFreeChart version 1.0.3 or higher.
Explode

Attachment Parameters

These are advanced options that can be used for chart versioning, to enable automation and to improve
performance. Use these options carefully! Normally, the chart image is regenerated each time the page is
displayed. These options allow for the generated image to be saved as an attachment and have subsequent
access re-use the attachment. This can be useful especially when combined with the Cache Pluginto
improve performance. Depending on the options chosen, chart images can be versioned for historical

purposes.

Parameter = Default

Description
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Attachment none The name and location with which the chart image will be saved as an
attachment. The user must be authorized to add attachments to the page
specified.

* rattachmentName.png — the chart is saved as an attachment to the
current page.

® page”attachmentName.png — the chart is saved as an attachment to
the page name provided.

® space:page”attachmentName.png — the chart is saved as an
attachment to the page name provided in the space indicated.

Attachmen  new Defines the the versioning mechanism for saved charts.
t Version
® new — creates new version of the attachment.
® replace — replaces all previous versions of the chart. To replace an
existing attachment, the user must be authorized to remove attachments
for the page specified.
® keep — only saves a new attachment if an existing export of the same
name does not exist. An existing attachment will not be changed or
updated.

Attachmen | none Comment used for a saved chart attachment.
t Comment

Thumbnail | false
®* true — the chart image attachment will be shown as a thumbnail.

Chart Type Parameters | Display Control Parameters | Title and Label Parameters | Data Specification
Parameters | Color Parameters | Axis Parameters | Pie Chart Parameters | Attachment Parameters

Examples
Pie Chart
Parameters in Macro Data Table in Macro Rendered Chart
Browser Placeholder
Type pie Fish Type = 2011 Fish Sold 2011
Chart Title Fish .
! Sold Herring 9,500
2011 Salmon 2,900
Show true
Legend Tuna 1,500 .
Herring —— Salmen
Content vertical
Orientation
Tuna
® Herring (9,500 - 658%)
®m Salmon (2,900 - 21%) = Tuna (1,500 - 11%)
Bar Chart
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Parameters in
Macro Browser

Type bar

Chart Title Fish
Sold

Show true

Legend

3D Bar Chart

Parameters in
Macro Browser

Type bar
Show in 3D true
Opacity 50

Show Legend | true

Time Series Chart

Parameters Data Tables in Macro Placeholder
in Macro
Browser
Type T Month Revenue Month
me
Se 11011 318 1/2011
ries
2/2011 @ 41.8 2/2011

Data Table in Macro

Placeholder

Fish 2010 2011
Type

Herring 9,500 | 8,300
Salmon 2,900 4,200
Tuna 1,500 1,500
Data Table in Macro
Placeholder

2009 @ 2010 2011
Re 124 31.8 41.1
ve
nue
Ex 43.6 41.8 31.1
pe
nse

Rendered Chart

Fish Sold

9,000
8,000
7,000
6,000
5,000
4,000
3,000
2,000

1,000

2010 2011

M Herring ® Salmon ®m Tuna

Rendered Chart

45
40
35
30
25
20
15
10
5
o
2009 2010 2011
B Revenue B Expense
Rendered Chart
Expenses
41.1
43.8
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Date M
Format M
lyy
yy
Time Mo
Period nth

Content | ver
Orientati = tic
on al

Range 0
AXxis

Lower
Bound

Show true
Legend

XY Line Chart

Parameters in

Macro Browser

Type
Show Legend

XY Area Chart

Parameters in
Macro Browser

3/2011
4/2011
5/2011
6/2011
7/2011
8/2011
9/2011

10
/2011

11
/2011

12
/2011

xyLine

true

Created in 2020 by Atlassian.

51.3 3/2011  45.3 -
33.8 4/2011  45.0 A
27.6 5/2011 | 44.6 ac
49.8 6/2011  43.8 -
51.8 7/2011  51.8 50
77.3 8/2011 523
73.8 9/2011 53.8 20
97.6 10 55.6 gl I : ,
/2011 94 9 9 49 0 9 9 c
101.2 11 61.2 5 8§83 85 85 8 8 ¢
/2011 - Revenue = Expenses
113.7 12 63.7
/2011
Data Table in Macro Rendered Chart
Placeholder
12 14 23

Revenue 41.1 31.8 124

Expense 31.1 41.8 43.6

—_— —— t it 4

1z 13 14 15 15 17 18 19 20 31 22 23

4 10 13 el Ll eg LD

= Revenue —— Expense

Data Table in Macro Rendered Chart
Placeholder
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Type xyArea 12 14 23 a5

Showlegend 'true  oocnue 411 318 124

35
Expense 31.1 41.8 43.6

30

25

20

15

LE]

5
(]
12 13 14 15 16 17 16 19 20 21 22 23
# Revenue & Expense

Area Charts

Example 1

Parameters Data Table in Macro Placeholder Rendered Chart

in Macro

Browser

Type 2; Satisfaction = 2009 2010 2011

Show true Very satisfied 20 23 34

Legend Satisfied 40 34 23

Width 300 piscatisied 25 26 | 25

Height 300 Very 15 17 18

Opacity 50 dissatisfied

2009 2010 2011

m Very satisfied m Satisfied m Dissatisfied

Very dissatisfied
Example 2
Parameters Data Table in Macro Placeholder Rendered Chart
in Macro
Browser
Type :; Satisfaction = 2009 2010 2011
Show Legend | true Very satisfied = 12 23 31
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Width 300 Satisfied 1 34

Height 300 Dissatisfied 4 6
Very 2 7

Stacked true 7 .

Values dissatisfied

Gantt Chart

Parameters Data Table in Macro Placeholder
in Macro
Browser
Type  gantt Plan @ Start End Status
Width 1300 giage 6/25  7/10  30%
Height 200 1 /2013 /2013
Colu ,, Stage 7/13 11/ 28 40%
mns 1234 - /2013 /2013
Date MM
format  /dd Stage 12/1  12/25
Iyyyy 3 /2013 /2013
Actual Start = End @ Status
Stagel 6/25 7/26 100%
/2013 /201
3
Stage2 7/29 12 40%
/2013 /01
/2013

Stage 3 12 12
/10 /25
/2013 /2013

10

36 hr
22 3C
12 B4

2009 2010 2011

m Very satisfied m Satisfied m Dissatisfied
Very dissatisfied

Rendered Chart

07/01/2013 O901/2013 11/01/2013 0101 21
-
Stage 1
]
e B
Stage 2
———
I
Stage 3
I

@ You must include the two leading commas in the column parameter (for example , , 1, 2, 3, 4) for the

chart to be created correctly.
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Code examples

This example is useful when you want to add a macro outside the editor, for example as custom content in
the sidebar, header or footer of a space.

Macro name: chart
Macro body: Accepts rich text, consisting of tables that hold the chart's data.

This macro recognizes a large number of parameters, listed here by type.

Chart type parameters

These parameters determine the type of chart to display and how the chart looks.

Parameter @ Required @ Default Description

type No pi e The type of chart to display. XY charts have numerical x-
and y-axes. The x values may optionally be time-based.
Seetheti meSeri es parameter.

Available values:
® Standard charts- pie, bar, line, area
® XY plots—xyArea, xyBar, xyLine, xyStep,

xySt epArea, scatter, tineSeries
® Other charts — gant t

orientati  No verti cal The display orientation. Applies to area, bar and line
on charts.
Available values:

® vertical - y-axisis vertical
® horizontal — x-axis is vertical

3D No fal se Show in three dimensions. Applies to area, bar and line
charts.
st acked No fal se Stacked values. Applies to area and bar charts.
showShapes No true Applies to line charts. Shapes are shown at each data
point.
opacity No A percentage value between 0 (transparent) and 100
® 75 percent | (opaque) that determines how opaque the foreground
for 3D areas and bars are.
charts
® 50 percent
for non-
stacked
area charts
* 100
percent for
all other
charts

Chart display parameters

Parameter @ Required @ Default = Description
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wi dt h No
hei ght No

dat aDi spl ' No
ay

i mgeForm No
at

300
300

fal se

png

Chart title and label parameters

Parameter = Required
title No

subTitle No

xLabel No
yLabel No
| egend No

Chart data parameters

Default
(None)
(None)
(None)
(None)

fal se

12

The width of the chart in pixels.
The height of the chart in pixels.

Determines whether to display the body of the macro,
consisting of the data table. By default, the chart data table is
not displayed.

Available values:
* false — the data is not displayed.
® true orafter — the datais displayed after the chart.
® bef ore - the datais displayed before the chart.

The image format to be used for the chart.

Available values:

[ ] png
®jpg

Description

The title of the chart.

A subtitle for the chart.

The label for the x-axis (domain).
The label for the y-axis (range).

Determines whether to show a legend (key) for the chart.

The data for the chart is taken from tables found in the macro body. The parameters below control how
this data is interpreted. By default, numeric and date values are interpreted according to the Confluence
global default language (locale) formats. If conversion fails, other languages defined in Confluence will be
tried. You can specify additional conversion options using the parameters below.

Parameter = Required

t abl es No

col ums No

Default

All first
level
tables

All
columns

Description

You can supply a comma-separated list of table IDs and/or
table numbers (starting at 1) contained within the body of the
macro that will be used as the data for the chart. If data tables
are embedded in other tables, then table selection will be
required. This occurs when more complex formatting is done
(for example using section and column macros).

You can supply a comma-separated list of column labels and/or
column titles and/or column numbers for tables used for chart
data. This applies to all tables processed. Columns are
enumerated starting at 1. Column label is the text for the
column in the header row. Column title is the HTML title
attribute for the column in the header row.
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dataOrien No
tation

timeSerie No
S

dat eForma No
t

ti mnePerio No
d

| anguage No

country No

forgive No

Chart color parameters

hori zo
nt al

fal se

Conflue
nce
languag
e
defined
date
formats

day

(None)

(None)

true

The content orientation. By default, the data tables will be
interpreted as columns (horizontally) representing domain and x
values.

Available values:

® vertical - datatable columns will be interpreted as
series.

® horizontal - data tables rows will be interpreted as
series.

If 't rue’, the x values in an XY plot will be treated as time
series data and so will be converted according date formats.

For time series data, the date format allows for additional
customization of the conversion of data to date values. If a dat e
For mat is specified, it will be the first format used to interpret
date values. Specify a format that matches the time series data.
See simple date format.

The time period for time series data. Defines the granularity of
how the data is interpreted.

Available values: m | | i second, second, m nute,
hour, day, week, nonth, quarter, year

Use in combination with the count ry parameter to form a
locale. These additional number and date formats will be used
for data conversion before the default languages.

Available values are the two-character ISO 639-1 alpha-2 codes.

Use in combination with the | anguage parameter to form a
locale. Valid values are the two-character ISO 3166 codes.

Determines whether the macro will forgive (allow) some data
formatting errors.

Available values:

® true — the macro tries to convert numeric and date values
that do not totally match any of the default or user-specified
formats.

® fal se — the macro enforces strict data formatting. If there
are data format errors, the chart will not be produced.

Colors are specified using hexadecimal notation or HTML color names.

Parameter = Required
bgCol or No

bor der Col | No
or

col ors No

Default
White

No
border

Description
Background color of the chart.
Color of the border around the chart.

A comma-separated list of colors used to customize the colors
of categories, sections, and series.
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Chart axis parameters
Depending on the chart type, the range and domain axis may be customized. These values are

automatically generated based on the data but can be overridden by specifying one or more more of
these parameters.

Parameter = Required Default Description

rangeAxi s No (None) Minimum value for the range axis.

Lower Boun

d

rangeAxi s  No (None) Maximum value for the range axis.

Upper Boun

d

rangeAxi s  No (None) Range axis units between axis tick marks.

Ti ckUni t

rangeAxi s No (None) Angle for the range axis label in degrees.

Label Angl e

donmai nAxi ' No (None) Only applies to XY plots. Domain axis lower bound. For a date
sLower Bou axis, this value must be expressed in the date format specified
nd by the dat eFor nat parameter.

domai nAxi | No (None) Only applies to XY plots. Domain axis upper bound. For a date
sUpper Bou axis, this value must be expressed in the date format specified
nd by the dat eFor nat parameter.

donmai nAxi ' No (None) Only applies to XY plots. Domain axis units between axis tick
sTi ckUni t marks. For a date axis, this value represents a count of the

units specified in the t i nePer i od parameter. The ti mePeri od
unit can be overridden by specifying a trailing character: y
(years), M(months), d (days), h (hours), m(minutes), s
(seconds), u (milliseconds).

domai nAxi = No (None) Only applies to XY plots. The angle for the domain axis label, in
sLabel Ang degrees.
le
cat egoryL No (None) Placement of the axis label text for categories.
abel Posi t
i on Available values:
® up45 — 45 degrees going upward
® up90 — 90 degrees going upward
®* down45 — 45 degrees going downward
® down90 — 90 degrees going downward

dat eTi ckM  No start Placement of the date tick mark.
ar kPosi ti
on Available values:

® start —tick mark is at the start of the date period.
® i ddl e — tick mark is in the middle of the date period.
® end — tick mark is at the end of the date period.

Pie chart Parameters

Parameter @ Required = Default Description
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pi eSectio No Show only the Formatof pie section labels. The format uses a string
nLabel pie section key | with special replacement variables:
value

* 9%9%is replaced by the pie section key.
* % %is replaced by the pie section numeric value.
* 9®2%is replaced by the pie section percent value.

Example 1: To display something like ‘Independent =
20"

W% = %%

Example 2: To display something like 'Independent
(20%)":

W% (%2%

pi eSectio No No exploded A comma-separated list of pie keys that are to be
nExpl ode sections shown exploded. Note: requires jFreeChart version
1.0.3 or higher.

Chart attachment parameters

These are advanced options that can be used for chart versioning, to enable automation and to improve
performance. Use these options carefully! Normally, the chart image is regenerated each time the page is
displayed. These options allow for the generated image to be saved as an attachment and have
subsequent access to re-use the attachment. This can be useful especially when combined with the
Cache plugin to improve performance. Depending on the options chosen, chart images can be versioned
for historical purposes.

Parameter = Required Default @ Description

attachnment No (None) The name and location where the chart image will be saved as
an attachment. The user must be authorized to add
attachments to the page specified.

Available syntax for this parameter:

® Mattachnent Nanme. png — the chart is saved as an
attachment to the current page.

® page nane”attachnment Nane. png — the chart is saved
as an attachment to the page name provided.

®* pane”att achment Nane. png — the chart is saved as an
attachment to the page name provided in the space
indicated.

attachrmen No new Defines the the versioning mechanism for saved charts.
t Ver si on
Available values:

® new— creates new version of the attachment.

® repl ace — replaces all previous versions of the chart. To
replace an existing attachment, the user must be authorized
to remove attachments for the page specified.

® keep — only saves a new attachment if an existing export
of the same name does not exist. An existing attachment
will not be changed or updated.
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attachnmen No (None) Comment used for a saved chart attachment.
t Comment
t hunbnail | No fal se If t r ue, the chart image attachment will be shown as a

thumbnail (small, expandable) image.

Wiki markup example

Below is a simple example of a pie chart. See more examples in Wiki Markup Examples for Chart Macro.

{chart:type=pie|title=Fish Sol d}
|| Fish Type || 2004 || 2005 ||
|| Herring | 9,500 | 8,300 |

|| Salmon | 2,900 | 4,200 |

|| Tuna | 1,500 | 1,500 |
{chart}

() Do more with Confluence

Create interesting and engaging charts for your Confluence pages with these top charts and
diagrams apps on the Atlassian Marketplace.
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Wiki Markup Examples for Chart Macro

This page is an extension of the documentation for the Chart Macro. This page contains additional examples for
the Chart macro.

Pie chart
Here is a simple example of a pie chart.
Wiki markup

{chart:type=pie|title=Fish Sol d}
|| Fish Type || 2004 || 2005 ||
|| Herring | 9,500 | 8,300 |

|| Salmon | 2,900 | 4,200 |

|| Tuna | 1,500 | 1,500 |
{chart}

Resulting chart

Fish Sold

® 2004 (1,500 - 50%) = 2005 (1,500 - 50%)

Bar chart
Here is a simple example of a bar chart.

Wiki markup

{chart:type=bar|title=Fish Sold}
|| Fish Type || 2004 || 2005 ||
|| Herring | 9,500 | 8,300 |

|| Salmon | 2,900 | 4,200 |

|| Tuna | 1,500 | 1,500 |
{chart}

Resulting chart
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Fish Sold

9,000

8,000

7,000

6,000

5,000

4,000

3,000

2,000

1,000 .
o

2004 2005

M Herring ® Salmon m Tuna

Time series chart
Here is an example of a time series chart.

Wiki markup

{chart:type=tineSeries| dat eFor mat =MV yyyy| ti nePeri od=NMbnt h|
dataOrientation=vertical | rangeAxi sLower Bound=0| donai naxi srot at eti ckl abel =t rue}
|| Month || Revenue ||

10/ 2005 | 97.6 |
11/2005 | 101.2 |
12/ 2005 | 113.7 |

| 1/2005 | 31.8 |
| 2/2005 | 41.8 |
| 3/2005 | 51.3 |
| 4/2005 | 33.8 |
| 5/2005 | 27.6 |
| 6/2005 | 49.8 |
| 7/2005 | 51.8 |
| 8/2005 | 77.3 |
| 9/2005 | 73.8 |
|

|

|

|| Month || Expenses ||
| 1/2005 | 41.1 |
| 2/2005 | 43.8 |
| 3/2005 | 45.3 |
| 4/2005 | 45.0 |
| 5/2005 | 44.6 |
| 6/2005 | 43.8 |
| 7/2005 | 51.8 |
| 8/2005 | 52.3 |
| 9/2005 | 53.8 |
| 10/2005 | 55.6 |
| 11/2005 | 61.2 |
| 12/2005 | 63.7 |
{chart}

Resulting chart
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= Revenue == Expenses
XY line chart

Here is an example of an XY line chart.

Wiki markup

{chart:type=xyline}

[F11 12 4 14 ] 23 ||

| Revenue | 41.1 | 31.8 | 12
| Expense | 31.1 | 41.8 | 43
{chart}

4|
.6 |

Resulting chart

A5

40

iz 13 1% 15 1s 17 18 19 20 2122 23

- Revenue — Expense

XY bar chart
Here is an example of an XY bar chart.

Wiki markup
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{chart:type=xybar| opaci t y=60}

|| || 2005 || 2006 || 2007 ||

| Revenue | 41.1 | 31.8 | 12.4 |
| Expense | 31.1 | 41.8 | 43.6 |
{chart}

Resulting chart
45

40
a5
30
25
20
15

10

2,005 2,006 2,007

I Revenue N Expense

XY area chart
Here is an example of an XY area chart.

Wiki markup

{chart:type=xyarea}

[T 12 4] 14 0] 23 ||

| Revenue | 41.1 | 31.8 | 12.4
| Expense | 31.1 | 41.8 | 43.6
{chart}

Resulting chart
45

an
33
30
25
20
15

10

12 13 18 15 16 17 18 19 20 21 22 23

& Revenue a Expense
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Area chart
Here are two examples of area charts.

Wiki markup for area chart 1

{chart:type=area| dat abi spl ay=t rue| | egend=t r ue| wi dt h=300| hei ght =300| opaci t y=50}
|| Satisfaction || 2002 || 2003 || 2004 ||

| Very satisfied | 20 | 23 | 34 |

| Satisfied | 40 | 34 | 23 |

| Disatisfied | 25 | 26 | 25 |

| Very disatisfied | 15| 17 | 18 |

{chart}

Resulting area chart 1

a0
35
30
25
20
15

10

2002 2003 2004

m Very satisfied m Satisfied m Disatisfied
I Very disatisfied

Satisfaction 2002 | 2003 2004
Very satisfied | 20 23 34
Satisfied 40 34 23
Disatisfied 25 26 25

Very disatisfied | 15 17 18

Wiki markup for area chart 2

{chart:type=area| dat abi spl ay=t r ue| | egend=t r ue| wi dt h=300| hei ght =300| st acked=t r ue}
|| Satisfaction || 2002 || 2003 || 2004 ||

| Very satisfied | 12 | 23 | 31 |

| Satisfied | 1| 34| 36 |

| Disatisfied | 4| 6| 22|

| Very disatisfied | 2| 7| 12 |

{chart}

Resulting area chart 2

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

Confluence 7.4 Documentation

100

2002 2003 2004

m Very satisfied m Satisfied m Disatisfied
Very disatisfied

Satisfaction 2002 2003 @ 2004

Very satisfied 12 23 31

Satisfied 1 34 36
Disatisfied 4 6 22
Very disatisfied | 2 7 12
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Cheese Macro

The Cheese macro simply displays the words "l like cheese!" You can use this macro to test the Confluence
macro functionality. =

To add the Cheese macro to a page:

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters
Note: There are no parameters for this macro.
Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: cheese
Macro body: None.

{cheese}



Children Display Macro

Use the Children Display macro to list the child pages of a page and the further descendants (children's
children). By default, the macro displays links to the child pages as shown in the screenshot below. People
viewing the page will see only the links for pages that they have permission to view.

Screenshot: The Children Display macro in Confluence

This is the Children Display macro

* Step 1 - download the game
Step 2 - Play

Step 3 - share your favourite nerd
Sample page

Games as a communication medium

Using the Children Display macro

To add the Children Display macro to a page:

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Example

This list of child pages is generated by a Children Display macro on this page:

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default Description

Show false Choose whether to display all the parent page's descendants.
Descendan

ts If t r ue shows the complete tree of pages underneath the parent page,

(all) regardless of Depth of Descendants
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Parent current
Page
(page)

Number of | none

Children

(first)

Depth of none

Descendan

ts

(dept h)

Heading none

Style

(style)

Include none

Excerpts

(excerpt)

Sort Manual if

Children manually

By ordered,

(sort) otherwise
alphabetical

Reverse false

Sort

(reverse)

Wiki markup example

Specify the page to display children for, from either the current space or a
different space. Enter:

* ' /' —to list the top-level pages of the current space, i.e. those
without parents.

® ' pagenane' — to list the children of the specified page.

® 'spacekey:' —to list the top-level pages of the specified space.

® 'spacekey: pagenane' — to list the children of the specified page
in the specified space.

Restrict the number of child pages that are displayed at the top level.

Enter a number to specify the depth of descendants to display. For
example, if the value is 2, the macro will display 2 levels of child pages.

This setting has no effect of Show Descendants is enabled.

Choose the style used to display descendants.

Allows you to include a short excerpt under each page in the list. Choose
between:

® None - no excerpt will be displayed

® Simple - displays the first line of text contained in an Excerpt macro
any of the returned pages. If there is not an Excerpt macro on the
page, nothing will be shown.

® Rich content - displays the contents of an Excerpt macro, or if there
is not an Excerpt macro on the page, the first part of the page content,
including formatted text, images and some macros.

Optional. Choose:
® creation — to sort by content creation date

® title — to sort alphabetically on title
®* modified — to sort of last modification date.

Use with the Sort Children By parameter. When set, the sort order
changes from ascending to descending.

This example is useful when you want to add a macro outside the editor, for example as custom content in the

sidebar, header or footer of a space.

Macro name: chi | dren

Macro body: None.

{children:reverse=true|sort=creation|styl e=h4| page=Hone| excer pt =none| first =99| dept h=2| al | =t rue}
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() Do more with Confluence

Extend Confluence with one of the hundreds of other macros in the Atlassian Marketplace. Here are a
couple for organizing your Confluence page:

Navitabs: Create tabs to group content to improve navigation between Confluence pages
® Advanced Children Display for Confluence: combine Confluence's built-in children display and

table of contents macros
® Subspace Navigation for Confluence: Use the navigation macro to create overviews of the menu

within a Confluence page
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Code Block Macro

The Code Block macro allows you to display source code in your page with syntax highlighting, like the one
below:

public static void main(5tring[] args)

1
System.out.println("Hello World!"});

}

Add the Code Block Macro

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

You type the code block directly into the macro placeholder in the editor. Note that any white space contained in
the placeholder is not manipulated in any way by the Code Block macro. This is to provide the writer with
flexibility over code indentation.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default @ Description
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Syntax java
highlighting

(1 anguage

)

Title none

Collapsible ' false
(coll apse

)

Show line false
numbers

(l'i nenum

ber s)

First line 1
number
(firstli

ne)

Theme Default

Specifies the language (or environment) for syntax highlighting. The default
language is Java but you can choose from one of the following languages
/environments:

ActionScript
AppleScript
Bash

C#

C++

CSS
ColdFusion
Delphi

Diff

Erlang
Groovy
HTML and XML
Java

Java FX
JavaScript
PHP

Plain Text
PowerShell
Python
Ruby

SQL

Sass

Scala
Visual Basic
YAML

Adds a title to the code block. If specified, the title will be displayed in a header row
at the top of the code block.

If selected, the code macro's content will be collapsed upon visiting or refreshing
the Confluence page. Clicking the expand sour ce link allows you to view this
content. If false, the code macro's content is always displayed in full.

If selected, line numbers will be shown to the left of the lines of code.

When Show line numbers is selected, this value defines the number of the first
line of code.

Specifies the color scheme used for displaying your code block. Many of these
themes are based on the default color schemes of popular integrated development
environments (IDEs). The default theme is Confluence (also known as Default),
which is typically black and colored text on a blank background. However, you can
also choose from one of the following other popular themes:

DJango
Emacs
FadeToGrey
Midnight
RDark
Eclipse
Confluence
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Configure the Code Block macro

You can configure the Code Block macro to use a specific language and theme by default and also upload new
languages. You need Confluence Administrator permissions to change the default theme and language and S
ystem Administrator permissions to upload new languages.

To set the default appearance of code blocks in your site:

1. Choose the cog icon E then choose General Configuration
2. Choose Configure Code Macro

3. Select a Default Theme and Default Language

4. Choose Save

All new code blocks will use the default theme and language unless you specify otherwise. Existing code blocks
will be unchanged.

To add an additional language:

Choose the cog icon E then choose General Configuration

Choose Configure Code Macro

Choose Add a new language

Locate your language file and enter a Name for the new language (this will appear when selecting the
language)

5. Choose Add

AWDNhR

Language files must be correctly formatted JavaScript files and adhere to the Custom Brush syntax.

To disable or remove a user-installed language:

1. Choose the cog icon E then choose General Configuration
2. Choose Manage Apps
3. Goto User-installed Apps and locate the app for your uploaded language - it will appear like this

'‘Custom Code Macro Highlighting for...'
4. Choose Uninstall or Disable
The language will no longer appear in the Code Macro.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: code
Macro body: Accepts plain text.

{code:title=This is nmy title|theme=FadeToG ey| | i nenunbers=true|l anguage=j aval firstline=0001| col | apse=true}
This is ny code
{code}
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() Do more with Confluence

Extend Confluence with one of the hundreds of other macros in the Atlassian Marketplace. Some of our
most popular include:

® Code Pro for Confluence - Get a real-time view of your code from any source in Confluence.
Include Bitbucket Server for Confluence - Easily include code snippets in Confluence that sync
automatically to Bitbucket Server.

® Markdown Extension for Confluence - Embed markdown from private and public Github &
Bitbucket repositories in Confluence.
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Column Macro

Used with the Section macro to define columns on a page. See Working with page layouts and columns and
sections.

Parameters
Parameter Required = Default Parameter description and accepted values
name
wi dt h No 100% of the page width, The width of the column. Can be specified either in
divided equally by the pixels (for example, 400px) or as a percentage of
number of columns in the the available page width (for example, 50%.
section.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: col umrm
Macro body: Accepts rich text.

{col um: wi dt h=100px}
This is the content of *columm 1*.
{col um}



Content by Label Macro

The Content by Label macro is used to display lists of pages, blog posts or attachments that have particular
labels. It's great for collecting related pages together and filtering out content that you don't want to see.

For example, you could use this macro to display a list of all pages that have the label 'feature-shipped' and
include the word 'Blueprint’, or to list any pages with the label 'meeting-notes' that you've been mentioned in.

Here's how the macro looks on your page:

meefing-notes

meeting-notes

meeting-notes

meeting-notes

meeting-notes

[5) Confluence PM Weekly - 30 Jan 2015 - ACE and PMM Update (Confluence PM)

[E AAC Migration Messaging Meeting notes (Confluence Questions)

5 2013-12-18 CQ Standalone Meeting Notes (Confluence Questions)

(5 AAC Migration to CQ Design Meeting notes (Confluence Questions)

& 2014-11-13 - Contextual Inquiry set up (Confluence Design)

And here's how you would set it up in the macro browser:

Label *

meeting-notes x

Mentioning user

B John Wetenhall x

Add a filter

Options

Select macro

Insert ‘Content by Label’ Macro

Show

. Preview

Help

(3 Confluence PM Weekly - 30 Jan 2015 - ACE and PMM Update (Confluence

PM)

meeting-notes

(2 AAC Migration Messaging Meeting notes (Confluence Questions)
meeting-notes

[ 2013-12-18 CQ Standalone Meeting Notes (Confluence Questions)
meeting-notes

(2 AAC Migration to CQ Design Meeting notes (Confluence Questions)
meeting-notes

[ 2014-11-13 - Contextual Inquiry set up (Confluence Design)
meeting-notes

Insert

Cance|

Using the Content by Label Macro

To add the Content by Label macro to a page:

1. From the editor toolbar, choose Insert + = > Other Macros
2. Find and select the required macro
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Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

CQL filters

CQL (Confluence Query Language) is a query language developed for Confluence, which you can use in some
macros and the Confluence search. Confluence search and CQL-powered macros allow you to add filters to
build up a search query, adding as many filters as you need to narrow down the search results.

Use the Add a filter link to add more filters to your query.
® For an OR search, specify multiple values in the same field.

So to show pages with 'label-a’, 'label-b' or both you'd put 'label-a’ and 'label-b' in the same Label
field, like this:

Label *

label-a x label-b %

® For an AND search, add more than one filter and specify a single value in each.
To show only pages with label-a and label-b you'd put 'label-a’ in one label field, then add a second
Label field to the macro, and put 'label-b' in the second one, like this:

Label *

label-a x

Label (x ]
label-b x

Put simply, OR values are entered in the same filter, AND values are entered in different filter.
Only some filters support AND. If the filter doesn't support the AND operator, you won't be able to add
that filter more than once.

®* For a NOT search, enter a minus sign (-) before the label. This'll exclude everything with that label.

You can use the following CQL filters to build your query:

Filter Description Operators
Label* Include pages, blog posts or attachments with these labels. OR (multiple values in the
same filter)

AND (multiple Label filters)
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Including
text**

With title

Of type**

Confluence 7.4 Documentation

Include pages that are children of this page.
This allows you to restrict the macro to a single page tree.

Include pages or blog posts that were created or edited by
these people.

Include items created by these people.

Include pages and blog posts that @mention these people.

Include only direct children of this page (further sub-pages
won't be included)

Include items from these spaces.

Include items that contain this text.

Include items that contain this text in the title.

Include only pages, blogs or attachments.

* This field is required in CQL-powered macros.

OR (multiple values in the
same filter)

OR (multiple values in the
same filter)

OR (multiple values in the
same filter)

OR (multiple values in the
same filter)

EQUALS (one page only)

OR (multiple values in the
same filter)

CONTAINS (single word or
phrase)

CONTAINS (single word or
phrase)

OR (multiple values in the
same filter)

** You can add these filters in CQL-powered macros but in search they're part of the standard search filters, so
they don't appear in the Add a filter menu.

Macro display options

These options control how the macro appears on your page.

Parameter

Sort by

Reverse sort

Maximum
number of
pages

List title

Show labels
for each

page

Show space

name for
each page

Default = Description

Modified | Sort the list by title, the date it was created, or the date it was last modified. If you
don't select an option, CQL default ordering by relevancy is used.

False Sort the list descending instead of ascending (Z - A, earliest - latest)

15 Limit the number of items to include in the list. This can be any value up to 500
pages.

Blank Include an optional heading for the macro

True Show or hide the labels applied to each item

True Show or hide the space name for each item
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Display False Allows you to include a short excerpt under each page in the list. Choose
excerpts between:

®* None - no excerpt will be displayed.
® Simple - displays the first line of text contained in an Excerpt macro any of
the returned pages. If there is not an Excerpt macro on the page, nothing will

be shown.
® Rich content - displays the contents of an Excerpt macro, or if there is not an

Excerpt macro on the page, the first part of the page content, as formatted
text, including images and some macros.

Exclude False Allows you to exclude the page the macro appears on from the list. This is useful
current page when the current page contains the same labels as the pages you want to
include in the list.
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Content by User Macro

The Content by User macro generates a tabulated list of the content items, throughout the Confluence
installation, that have been created by a specified Confluence user. The list includes all current pages,
comments and spaces created by the user. Each item in the table is linked to its corresponding page, page
comment or space dashboard.

Note that items for page comments contain a link to the page, followed by a second link to the comment itself,
with these separated by a greater-than sign (>).

Using the Content by User macro

To add the Content by User macro to a page:

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters
Parameters are options that you can set to control the content or format of the macro output. Where the

parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Required Default | Description
Username | yes none The Confluence username for a person who has created content.

(nane) Parameter is unnamed in wikimarkup.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: cont ent - by- user
Macro body: None.

{content -by-user:jsnith}



Content Report Table Macro

The Content Report Table macro displays a set of pages and blog posts in tabular format, based on the labels
specified in the macro parameters.

A working example

Below is a working example of the Content Report Table macro, displaying content with the label 'LDAP'.

Title Creator Modified

Managing Multiple Directories SarahA Jan 18, 2019
Connecting to an LDAP Directory SarahA Jan 18, 2019
Configuring User Directories SarahA Jan 18, 2019
Synchronizing Data from External Directories SarahA Dec 04, 2018
User Management Limitations and Recommendations SarahA Sep 04, 2018

Connecting to LDAP or Jira applications or Other Services via SSL  Nick Faiz Dec 12, 2017

Requesting Support for External User Management Matt Ryall Dec 12, 2017
Diagrams of Possible Configurations for User Management SarahA Dec 12, 2017
Configuring the LDAP Connection Pool SarahA Sep 26, 2017
Managing Nested Groups SarahA Feb 21, 2017
Configuring an SSL Connection to Active Directory SarahA Nov 08, 2016
Connecting to an Internal Directory with LDAP Authentication SarahA May 27, 2016

Using the Content Report Table Macro

To add the Content Report Table macro to a page:

1. From the editor toolbar, choose Insert + = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested
macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

2 Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Cheese

Edit Remove

Parameters


https://confluence.atlassian.com/display/DOC/Managing+Multiple+Directories
https://confluence.atlassian.com/display/~smaddox
https://confluence.atlassian.com/display/DOC/Connecting+to+an+LDAP+Directory
https://confluence.atlassian.com/display/~smaddox
https://confluence.atlassian.com/display/DOC/Configuring+User+Directories
https://confluence.atlassian.com/display/~smaddox
https://confluence.atlassian.com/display/DOC/Synchronizing+Data+from+External+Directories
https://confluence.atlassian.com/display/~smaddox
https://confluence.atlassian.com/display/DOC/User+Management+Limitations+and+Recommendations
https://confluence.atlassian.com/display/~smaddox
https://confluence.atlassian.com/display/DOC/Connecting+to+LDAP+or+Jira+applications+or+Other+Services+via+SSL
https://confluence.atlassian.com/display/~nick%40atlassian.com
https://confluence.atlassian.com/display/DOC/Requesting+Support+for+External+User+Management
https://confluence.atlassian.com/display/~mryall
https://confluence.atlassian.com/display/DOC/Diagrams+of+Possible+Configurations+for+User+Management
https://confluence.atlassian.com/display/~smaddox
https://confluence.atlassian.com/display/DOC/Configuring+the+LDAP+Connection+Pool
https://confluence.atlassian.com/display/~smaddox
https://confluence.atlassian.com/display/DOC/Managing+Nested+Groups
https://confluence.atlassian.com/display/~smaddox
https://confluence.atlassian.com/display/DOC/Configuring+an+SSL+Connection+to+Active+Directory
https://confluence.atlassian.com/display/~smaddox
https://confluence.atlassian.com/display/DOC/Connecting+to+an+Internal+Directory+with+LDAP+Authentication
https://confluence.atlassian.com/display/~smaddox
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Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Required Default | Description

Label(s) Yes None This parameter is required. Specify one or more labels, separated by a
(1 abel s) comma. The macro will display the content tagged with any of the label
(s) specified here.

For example, if you specify labels 'A' and 'B', the macro will display all
pages that have the label 'A', and all pages that have the label 'B', and
all pages that have both those labels.

Space(s) No (Al Specify one or more space keys, separated by a comma or a space.
(spaces) spaces) | The macro will display only the content which belongs to the space(s)
specified here.

When specifying a personal space, remember to use the tilde (~) sign
in front of the username, such as ~j bl oggs or ~j bl oggs @xanpl e.

com
Maximum No 20 Define the maximum number of pages that the macro will show in a
Number of single set of results. If there are more pages to be shown, the macro
Pages will display a link labeled 'Find more results'. People viewing the page
(maxResul can choose the link to go to a search view, which shows all pages
ts) tagged with the specified label(s).

Which pages will appear? Before displaying the results, Confluence
will sort them by the date the page was last modified. The most-
recently created/updated pages will appear first.

Wiki markup

Wiki markup is not available for this macro. You cannot add this macro via wiki markup.
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Contributors Macro

The Contributors macro displays a list of Confluence users who have made a contribution of some type to a
page. It can also be used to list watchers of the page.

The scope of this macro can be extended to include the immediate children or descendants of the specified
page. The list of contributors can be based on people who have:

® authored or edited the page(s)
® contributed comments or added labels to the page(s), or
® are simply watching the page(s).

Screenshot: Example list of Contributors

This is the Contributors macro

= Rach Admin
e Josh User
« Sophie Staunton

In this example, the Display Format parameter has been set to list.

Using the Contributors Macro

To add the Contributors macro to a page:

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters
Parameters are options that you can set to control the content or format of the macro output. Where the

parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Default Description



Contribution

Type
(i ncl ude)

Sort By
(order)

Reverse Sort
(reverse)

Maximum
Number of
Contributors

(limt)
Display

Format
(rmode)

Show
Anonymous

Contributions?

(showAnonym

ous)

Show Count?
(showCount)

Show Last
Contribution
Time?
(showLast Ti
me)

Page Name
(page)

Label(s)
(1 abel s)
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authors

count

false

no limit

inline

false

false

false

current

none

Filters by either the type of contribution made to a page (and optionally its
descendant pages), or the watches on the page. Contribution types are:

aut hor s - includes people who created or have edited the page(s)
conmment s - includes people who have added comments to the page(s)
| abel s - includes people who have added labels to the page(s)

wat ches - includes people who are watching the page(s).

You can specify one or more contribution types, separated by commas.

Specifies the criteria used to sort contributors. Sort criteria are:

® count - sorts people based on the total number of contributions to the

page(s)
® name - sorts people into alphabetical order
® update - sorts people based on the date of their last contribution to the

page(s).
Reverses the sort order of contributors in the list. Must be used in conjunction
with the Sort By parameter.

Limits the number of contributors in the list. If a number is not specified, all
contributors are included.

Sets how the list of contributor's names is formatted:
® inline — a comma-separated list

® |ist — a bullet list.

Sets whether to include those who contributed anonymously to a page.

Sets whether to show the number of times each person made a contribution
of the specified Contribution Type.

Sets whether to show the last time each person made a contribution of the
specified Contribution Type.

Specifies the page to use when generating the list of contributors. If Page
Name and Space(s) are left blank, the current page is assumed.

Filters the list of contributors to those who created the specified labels from a
page. You can specify one or more labels, separated by commas.
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Space(s) current Specifies the space key of the Confluence space that contains the page set in
(spaces) Page Name or alternatively, specifies the spaces to search. Space keys are
case-sensitive.

This parameter also takes special values, including:
* @l obal — All site spaces.
® @ersonal — All personal spaces.

® @l | — All spaces in your Confluence site.

You can specify one or more space keys or special values, separated by
commas.

If no Page Name and Label(s) are specified, all pages from the specified
set of spaces are included.

Content Type | both Restricts the content type to use when generating the list of contributors:
(content Type pages
) and blog ® pages — pages
posts ® blogposts — blog posts.
Blog Post none Specifies the publish date for a blog post. The date format required is: YYYY
Date /MM/DD.
(publ i shDat e
)

Include Page specified Specifies additional pages to include when generating the list of contributors:

Hierarchy page only
(scope) ® children — just the child pages of the specified page
® descendants — all descendants of the specified page.

Show false Sets whether to show a list of the pages used to generate the list of
Selected contributors.

Pages

(showPages)

Custom default Specifies the message to be used to override the default message that is
"None message displayed when no contributors are found.

Found"

Message

(noneFoundM

essage)

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: contri butors
Macro body: None.
This example specifies a content type of blog posts:

{contributors:|int=10] spaces=ds, @ersonal | reverse=true|l abel s=chocol at e,

cake| showPages=t r ue| noneFoundMessage=Ch dear, no contributors

f ound| showCount =t r ue| cont ent Type=bl ogpost s| i ncl ude=aut hor s, comment s, | abel s,

wat ches| node=l i st | showAnonynous=t r ue| or der =updat e| showLast Ti me=t r ue| publ i shDat e=2012/ 06/ 30}
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This example specifies a content type of pages:

{contributors:|imt=10| spaces=ds, @ersonal | reverse=true| scope=descendant s| | abel s=chocol at e,
cake| showPages=t r ue| noneFoundMessage=Ch dear, no contributors

f ound| showCount =t r ue| cont ent Type=pages| i ncl ude=aut hor s, conment s, | abel s,

wat ches| node=l i st | showAnonynous=t r ue| or der =updat e| page=ds: Advanced Topi cs| showLast Ti ne=t r ue}
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Contributors Summary Macro

The Contributors Summary macro displays a table of contribution-based statistics for a set of pages. These
statistics can be grouped according to individual pages or individual contributors.

The default scope for this macro is an individual page, but this can be extended to include the immediate
children or descendants of a specified page. The statistics cover the following types of contributions:

edits to the page(s)

comments added to the page(s)
labels added to the page(s)
people watching the page(s)

A simple example of the Contributors Summary macro is shown in the screenshot below. It lists statistics for the
number of times each contributor has edited, added comments and added labels to this page.

Screenshot: Example Contributors Summary table of statistics

User Edits Comments Labels
Sarah Maddox 2 2 0
Edwin Dawson 2 0 0
Giles Gaskell 2 0 0
Rosie Jameson | 2 0 0
Andrew Lui 2 0 1
Charles Miller 1 0 0
Andrew Prentice 0 0 1

In this example, all default parameter settings are used. For more information about this macro's parameters,
refer to the Parameters section below.

Using the Contributors Summary Macro

To add the Contributors Summary macro to a page:

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove
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Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Default

Group By contribut
(gr oupby) ors

Columnsto | edits,
Display comment
(col ums) s,labels

Sort By edits
(order)

Reverse Sort  false
(reverse)

Description

Specifies the basis for grouping contribution-based statistics:

contributors — group by the people who have contributed
pages — group by the pages used to find contributors.

Sets the columns that should appear in the table. The statistics or type of
information presented depends on the basis for grouping set with the Group By
parameter. Statistics may be calculated for:

edi t s — the number of times each contributor has edited the page(s) or the
number of edits made to each page.

edi t ed — a list of the pages edited by each contributor or a list of
contributors who have edited each page.

comrent s — the number of times each contributor has added comments to
the page(s) or the number of comments on each page.

comrent ed — a list of pages to which each contributor has added
comments or a list of contributors who have commented on each page.

| abel s — the number of times each contributor has added labels to the
page(s) or the number of labels on each page.

| abel ed — a list of pages to which each contributor has added labels or a
list of contributors who have added a label to each page.

| abel I i st — a list of labels either added by each contributor or on each
page.

wat ches — the number of pages being watched by each contributor/person
or the number of contributors/people watching each page.

wat chi ng — a list of pages being watched by each contributor/person or a
list of contributors/people watching each page.

| ast updat e — the last time each contributor made an update or when each
page was last updated. Valid updates can include edit, comment or label
modifications to a page.

One or more columns can be used.

Sets the criterion used for sorting items in the table. The items sorted depend on
the basis for grouping set with the Group By parameter. Sort criteria are:

edi t s — sorts items in the table based on the total number of edits made,
either by a contributor or to a page.

nane — sorts items in the table in alphabetical order, either by contributor or
page name.

edi t Ti me — sorts items in the table based on when the contributor last
edited a page (or a specified set of pages) or when the page was lasted
edited.

updat e — sorts items in the table based on when the contributor last made
any contribution to a page (or a specified set of pages) or when the page last
had any contribution made to it.

Reverses the sort order of items in the table, as specified using the Sort By
parameter. (Used only in conjunction with the Sort By parameter.)
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Maximum no limit
Number of

Items

(limt)

Show false
Anonymous
Contribution

s?

(showAnony

nmous)

Show Zero false
Counts?

(showZer oC
ounts)

Page Name current
(page)

Label(s) none

(1 abel s)

Space(s) current
(spaces)

Content both
Type pages
(content Ty | and blog
pe) posts
Blog Post none
Date

(publ i shDa

te)

Include specified
Page page
Hierarchy only
(scope)

Wiki markup example

Limits the number of contributors or pages in the table to the value specified. If
no number is specified, all items are included.

Includes individuals who have made anonymous contributions to a page.

Sets whether contributors or pages are included for which a calculated statistic is
zero.

Sets the page for which to calculate the contribution-based statistics. If no values
for Page Name and Space(s) are specified, the current page is assumed.

Restricts the contribution-based statistics to the specified labels only. You can
specify one or more labels, separated by commas.

Specifies the space key of the Confluence space which contains the specified
page name or alternatively, specifies a scope of spaces to search. Space keys
are case-sensitive.

This parameter also takes special values, including:
* @l obal — All site spaces.
® @ersonal — All personal spaces.

®* @l | — All spaces in your Confluence site.

You can specify one or more space keys or special values, separated by
commas.

If no Page Name and Label(s) are specified, all pages from the specified set of
spaces are included.

Restricts page types to either pages (pages) or blog posts (blogposts). If no
value is specified in the Macro Browser, both pages and blog posts are included.

Available values pages and bl ogpost s.

Specifies the publish date for a blog post. The date format required is: YYYY/MM
/DD.

Includes either the immediate children or all descendants of the specified
page. If no value is indicated in the Macro Browser, only the specified page is
included.

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: cont ri but or s- summary

Macro body: None.
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This example specifies a content type of blog posts:

{contributors-sunmary:|imt=10| spaces=ds,
@er sonal | rever se=true| showAnonynous=t r ue| or der =updat e| | abel s=chocol at e, cake| col utms=edi t s, conment s, | abel s,
| ast updat e| gr oupby=pages| cont ent Type=bl ogpost s| showZer oCount s=t r ue| publ i shDat e=2012/ 06/ 07}

This example specifies a content type of pages:

{contributors-sunmary:|imt=10| spaces=ds,

@er sonal | rever se=t r ue| showAnonynmous=t r ue| scope=descendant s| or der =updat e| page=ds: Advanced
Topi cs| | abel s=chocol at e, cake| col ums=edi ts, comment s, | abel s,

| ast updat e| gr oupby=pages| cont ent Type=pages| showZer oCount s=t r ue}
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Create from Template Macro

The Create from Template macro displays a button on a page, linked to a specific template. When someone
clicks the button, the macro opens the editor, ready to add a new page, and adds content to the page based on
the given template.

When adding the macro to the page, you can specify a blueprint or a user-created template in the macro. You
will also specify the name of the button displayed, and the space in which the new page will appear.

Example

Screenshot: A page with three buttons, all displayed by the 'Create from Template' macro

Pages / Doc Theme Test Space Home # Edit [ Share % Tools
How to write documentation

Added by Sarah Maddox, last edited by Sarah Maddox on Mar 14, 2013 (view change)

Done all your analysis and chatted to the SMEs? Now's the time to create your page. Choose a template:

Shared files Meeting notes Product requirements

Using the Create from Template Macro

To add the Create from Template macro to a page:

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Cheese

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Required = Default Description

Button '‘Create from | The description that people will see when viewing this macro on
Text Template' the page.
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Template None

Name

Template Blank

Title

Space Key The space
where the
current page
is located

Wiki markup

Select the template or blueprint to base the new page on. Only
global and user-created templates for the current space appear
(unless you have specified a different space in the 'Space Key'
field).

Specify a default title for pages created using this macro
(optional). You can include @currentDate, @spaceName and
@spaceKey variables in the title.

Supply the unigue space identifier (space key), to determine
where the new page will be created when someone uses this
macro to create a page.

Wiki markup is not available for this macro. You cannot add this macro via wiki markup.
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Create Space Button Macro

The Create Space Button macro displays a create space icon that links to the 'Create Space' page. To see this
icon, viewers need the 'Create Space' permission which is assigned by a site administrator.

Using the Create Space Button macro

To add the Create Space Button macro to a page:

1. From the editor toolbar, choose Insert T ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default = Description

Icon Size large Specify whether to use large or small icon. Available values:
si ze

® |arge

®* small

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: cr eat e- space- button

Macro body: None.

{create-space-button:size=smal |}
{creat e-space- button: hei ght =50px| wi dt h=50px}

The following additional paramteters are available in wiki markup.

Parameter Required = Default = Parameter description and accepted values
name
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wi dt h No Natural
size of
icon

(12
pixel
ratio)

hei ght No Natural
size of
icon

(12
pixel
ratio)

The width of the icon to be displayed, specified in pixels.
Confluence will stretch or shrink the width of the icon to the
number of pixels specified.

Note: This parameter is not available via the macro browser.

The height of the icon to be displayed, specified in pixels.
Confluence will stretch or shrink the height of the icon to the
number of pixels specified.

Note: This parameter is not available via the macro browser.
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Excerpt Include Macro

The Excerpt Include macro is used to display 'excerpted’ (that is, a segment of) content from one page in
another.

Before you can use this macro, the excerpt must have been defined using the Excerpt macro. Note that you can
have:

® any number of Excerpt Include macros on a page
* only one Excerpt macro on a page.

Example

The example below shows an example of an Excerpt Include macro as it appears in the editor, and as it would
appear to someone viewing the page. We have set the options to show both the title of the page and the panel
surrounding the content.

This text is part of the body of the page.

o m— Excerpt Include

This text is also part of the body of the page.

This text is part of the body of the page.
reusable note

[r—
This text is a reusable note, It's being included here from
anocther page.

This text is also part of the body of the page.

1. The Excerpt Include macro as it appears in the editor.
2. The Excerpt Include macro as it appears when viewing the page.

The content is being pulled from a Excerpt macro on a page called 'reusable note'.

Using the Excerpt Include Macro

To add the Excerpt Include macro to a page:

1. From the editor toolbar, choose Insert T ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters
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Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter

Page
Containing
the
Excerpt
(defaul t

par amet er

)

Remove
Surroundi
ng Panel
(nopanel)

Default

none

false

Wiki markup example

Description

Type the name of the page that contains the excerpt to be displayed. You can use
an excerpt from a page in the same space or another space in the same wiki.

When you type the name of the page into the Excerpt Include macro dialog,
Confluence will offer a list of matching pages, including those from other spaces.

Alternatively, you can type the space key followed by a colon (:) and the page
name, like this:

SPACEKEY: Page nane

This parameter is unnamed in wikimarkup.

Determines whether Confluence will display a panel around the excerpted content.
The panel includes the title of the page containing the excerpt, and the border of the
panel. By default, the panel and title are shown.

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: excer pt -i ncl ude

Macro body: None.

{excerpt-include: My page nane| nopanel =t rue}

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Excerpt Macro

The Excerpt macro is used to mark a part of a page's content for re-use. Defining an excerpt enables other
macros, such as the Excerpt Include and Blog Posts macros, to display the marked content elsewhere.

You can only define one excerpt per page. In other words, you can only add the Excerpt macro once to a page.

Using the Excerpt Macro

To add the Excerpt macro to a page:

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

To add reusable content to the macro:

1. Add your content inside the Excerpt macro placeholder.

2. Choose the macro placeholder to see the options panel, and select the option to Display on new line or
to Display inline. The default is to display the content of the macro on a new line. If you choose the
inline option, the content of the macro will form part of the same paragraph as the text preceding and
following it. Note that this option affects only the page that contains the Excerpt macro. It does not affect
any pages where the content is reused.

Screenshot: The Excerpt macro placeholder and options panel

Text before the Excerpt macro
Excerpt

This is my reusable text

Edt Remove

=

1. New line
2. Inline
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Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Default = Description

Hide false Controls whether the page content contained in the Excerpt macro placeholder
Excerpted is displayed on the page.

Content

(hi dden) Note that this option affects only the page that contains the Excerpt macro. It

does not affect any pages where the content is reused.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: excer pt
Macro body: Accepts rich text.

{excer pt: hi dden=t rue| at| assi an- macr o- out put - t ype=BLOCK}
This is the *text* | want to reuse in other pages. This text is inside an Excerpt nacro.
{excerpt}
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Expand Macro

The Expand macro displays an expandable/collapsible section of text on your page.

Here is an example:

This text is hidden until you expand the section.

Using the Expand Macro

To insert the Expand macro into a page using the macro browser:

1. From the editor toolbar, choose Insert * = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters
Parameters are options that you can set to control the content or format of the macro output. Where the

parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default Description

Title Click here to expand... = Defines the text that appears next to the expand/collapse icon.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: expand
Macro body: Accepts rich text.

{expand: This is ny nessage}
This text is _hidden_ until you expand it.
{ expand}

Notes
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® Textis expanded in PDF and HTML exports. When you export the page to PDF or HTML, the text

between the macro tags is expanded so that readers can see it in the PDF and HTML versions of the
page.

® Nesting your Expand macros. You can put one Expand macro inside another, and Confluence will
correctly show and hide the contents of all Expand macros, including the nested ones.

() Do more with Confluence
Extend Confluence with one of the hundreds of other macros in the Atlassian Marketplace, such as:
® Composition Tabs & Page Layouts: Toggle or expand the visible of portions of your pages with

the Toggle and Cloak macro

® Content Formatting for Confluence: Over 30 easy-to-use Confluence macros gives you the ability
to create better, more engaging content

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Favorite Pages Macro

Use the Favorite Pages macro to list the pages you've saved for later on a Confluence page. You can also get
to your saved pages from the Dashboard.

Screenshot: The Favorite Pages Macro in Confluence

This is the Favourite Pages macro

Favourite Pages

Displaying pages recently added to your favourites list.
Why | loved Angry Nerds (Angry Nerds)

Which nerd are you? (Angry Nerds)

[S) Our new logo (Angry Nerds)

* ¥ %

Using the Favorite Pages Macro
To insert the favorite pages macro into a page using the Macro Browser:

1. From the editor toolbar, choose Insert + = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Cheese

Edit Remove

There are no parameters for this macro.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: f avpages
Macro body: None.

{favpages}



Gallery Macro

The Gallery macro displays a collection of thumbnail images in a table, based on the images attached to a
Confluence page. When viewing the page, a user can click a thumbnail image to zoom into a screen-sized
image and then view the images as a slide show.

Overview:

® The images shown in the gallery are taken from the files attached to the Confluence page. You can also
specify a different page where the attachments are located. For information about attaching images to a
page, see Upload Files.

® The captions below the images are drawn from the comments on the attachments. For information about
adding comments to attachments, see Upload Files.

® By default, the gallery will include all the images attached to the page. You can also exclude or include
images using parameters.

® You can sort your images into a particular order.

® You can specify a title for the gallery and also configure how many columns you want for the table in
which your images are displayed.

lllustration: Live example of the Gallery macro

Some office photos, and a waterfall
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Using the Gallery macro

To insert the Gallery macro onto a page:

1. From the editor toolbar, choose Insert + ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested
macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

T2 Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Cheese

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

The full list of parameters is shown in the following table. If the name of an attached file or page contains a
comma, you can refer to it in the relevant parameters below by enclosing it in single or double quotes, for
example "t hi s, that.jpg", theother.png

Parameter = Default Description

Gallery Nothing Specify a title for your gallery.
Title

(title)
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Number of
Columns
(col ums)

Images to
Exclude
(excl ude)

Include
these
Images
Only

(i nclude)

Exclude
Images
with these
Labels
(excl ude
Label)

Include
Images
with these
Labels
Only

(i nclude
Label )

Use
Images in
these
Pages
(page)

Sort
Images By
(sort)

Reverse
Sort
(reverse)

Confluence 7.4 Documentation

No exclusions.
Include all the pictures
on the page.

Include all the pictures
on the page.

No exclusions.
Include all the pictures
on the page.

None. The images are
not filtered by label.

If no page is specified,
the gallery macro
displays the images
attached to the page
on which the macro is
used.

None. The sort order
is unspecified and
therefore
unpredictable.

Off. Sort order is
ascending

Image file formats

Specify the number of columns for your table.

The gallery will ignore any pictures specified. You can specify more
than one picture, separated by commas.

Note: The filename and filetype for this parameter are case-sensitive.
For example, 'my picture.PNG' will not be recognized as 'my picture.

png'.

If you specifically include one or more pictures, the gallery will show
only those pictures. You can specify more than one picture,
separated by commas.

Note: The filename and filetype for this parameter are case-sensitive.
For example, 'my picture.PNG' will not be recognized as 'my picture.

png'.

The gallery will ignore any pictures that have the specified label. You
can specify more than one label, separated by commas. For
information on labeling the attachments, see Add, Remove and
Search for Labels.

Filters the images to display, based on a list of labels. If you wish to
enter more than one label, separate the labels with commas.
Confluence will show only images that have all the labels specified.
(The match is an AND, not an OR.) For information on labeling the
attachments, see Add, Remove and Search for Labels.

Specify the title of the page which contains the images you want
displayed. You can specify more than one page name, separated by
commas. To specify a page in a different space, use the following
syntax: SPACEKEY: Page Title

Specify an attribute to sort the images by. Sort order is ascending,
unless you select the Reverse Sort parameter (see below). Options
are:

® name - file name.

* comment — comment linked to the attached file.

®* date — date/time last modified.

® sjze - size of the attached file.

Used in combination with the Sort Images By parameter above. Use

Reverse Sort to reverse the sort order, from ascending to
descending.

Available values in storage format and wikimarkup:

® true — Sortorderis descending.
® fal se — Sort order is ascending.
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You can attach image files of any format to a page. Confluence supports the following image formats in the
Gallery macro and when displaying an image on a page:

gif

jpeg

png

bmp (depending on browser support)

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: gal | ery
Macro body: None.

{gallery:title=My holiday pictures|reverse=true|sort=size| page=My pagel, ds:Welconme to
Conf | uence| excl udeLabel =badl abel 1, badl abel 2| col utms=3| excl ude=badpi ct ure. png}
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Global Reports Macro

The Global Reports macro displays a list of links to some reports about content on your site.

These reports include a list of new or updated pages, undefined pages, and RSS feeds for new pages and blog
posts.

Screenshot: The Global Reports macro

Global Reports
.1 New or updated pages since your last login.

.y Find all undefined pages.
Feed for new pages and blogs.

Using the Global Reports Macro

To add the Global Reports macro to a page:

1. From the editor toolbar, choose Insert T ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters
Parameters are options that you can set to control the content or format of the macro output. Where the

parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Default = Description

Width of 99% Specify the width of the table in which the links are displayed, as a percentage of
Table the window width.
(wi dt h)

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.
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Macro name: gl obal -reports
Macro body: None.

{gl obal -reports:w dt h=50%

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

HTML Include Macro

The HTML Include macro allows you to include the contents of an external HTML file (a webpage) in a
Confluence page.

(D HTML macros are disabled by default

The HTML macro will only be available if it has been enabled by an administrator. Enabling these
macros can make your Confluence site vulnerable to cross-site scripting attacks.

Using the HTML Include Macro

To insert the HTML Include macro into a page:

1. From the editor toolbar, choose Insert + = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

2 Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Cheese

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Required = Default = Description
HTML Page's URL @ Yes None The URL of the page to include.
(url)

Enabling the HTML Include Macro

The HTML Include macro is disabled by default. You'll need Confluence Administrator or System Administrator
permissions to enable this macro.

i, Enabling these macros can make your Confluence site vulnerable to cross-site scripting attacks. You should
only turn on these macros if you trust all your users not to attempt to exploit them. We strongly recommend
leaving this macro disabled if you allow self-signed up or anonymous users to create content.

To enable the HTML Include macro:

1. Goto EI > Manage apps
2. Select System from the drop down and search for the Confluence HTML Macros system app.
3. Expand the listing and enable the html-include (html-include-xhtml) module.
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Administrators can also choose to use the whitelist to restrict URLs that can be displayed in the HTML Include
macro.

Troubleshooting

® Administrators can define a whitelist of trusted URLSs. If a URL is not in the whitelist, you will see an error
message in the HTML Include macro.

® You can only use the HTML Include macro for pages with absolute links. If you use the macro to include
an HTML page that has relative links, you will see a 'Page Not Found' error. See

[ coNFSERVER-6567 - HTML Include macro should rewrite relative links to point to remote site
CLOSED

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: ht i -i ncl ude
Macro body: None.

{htm -include:url=http://ww.exanpl e. con}
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HTML Macro

The HTML macro allows you to add HTML code to a Confluence page.

(D HTML macros are disabled by default

The HTML macro will only be available if it has been enabled by an administrator. Enabling these
macros can make your Confluence site vulnerable to cross-site scripting attacks.

Using the HTML Macro

To add the HTML macro to a page:

1. From the editor toolbar, choose Insert + = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

—+ Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Cheese

Edit Remove

There are no parameters for this macro.

Enter the HTML code into the body of the macro placeholder.

Enabling the HTML Macro

The HTML macro is disabled by default. You'll need Confluence Administrator or System Administrator
permissions to enable this macro.

i, Enabling these macros can make your Confluence site vulnerable to cross-site scripting attacks. You should
only turn on these macros if you trust all your users not to attempt to exploit them. We strongly recommend
leaving this macro disabled if you allow self-signed up or anonymous users to create content.

To enable the HTML macro:

1. Goto EI > Manage apps.
2. Select System from the drop down and search for the Confluence HTML Macros system app.
3. Expand the listing and enable the html (html-xhtml) module.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: ht i

Macro body: Text, consisting of HTML code.


https://en.wikipedia.org/wiki/Cross-site_scripting
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{htm }<a href="http://ww. atl assi an.cont >Cl i ck here</a> to see the <b>Atl| assi an</b> website.{htm}

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

IM Presence Macro

The IM Presence macro indicates graphically when a contact is signed into an Instant Messaging (IM) service.
The IM Presence macro appears as a small icon on the page.

Using the IM Presence Macro

I We ended support for this macro in Confluence 7.0
The macro no longer appears in the macro browser and can't be added to a page.
Any macro already on a page will still work.

Parameters
Parameters are options that you can set to control the content or format of the macro output. Where the

parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Description

User ID/Screen Identify the user by their ID, account name or screen name.
Name

Service aim — AOL Instant Messenger

(service)

gtalk — Google Talk

icq—I1CQ

jabber — Jabber

msn — MSN Instant Messenger
sametime — IBM Lotus Sametime

skype — Skype. Note: Skype requires 'Show my status on the web' to be checked under
'Privacy’ preferences

skypeme — Skype
wildfire — Openfire Server
yahoo — Yahoo! Messenger

Show User ID Shows or hides the User ID of the contact.
(showi d)

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: i m
Macro body: None.

{i m MySkypeNane| servi ce=skype| show d=f al se}
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Include Page Macro

You can use the Include Page macro to display the contents of one Confluence page or blog post in another
page or blog post. Any changes to the original page are automatically reflected wherever it is included.

Using the Include Page Macro

To add the Include Page macro to a page:

1. From the editor toolbar, choose Insert T ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default = Description

Page to None This is the name of the Confluence page or blog post that you want to include in the
Include current page. Start typing a page title, and Confluence will suggest matching pages
from the current space and other spaces.

Alternatively you can specify the page as follows:

® If the page or blog post is located in another space, add the space key and a
colon in front of the page name. For example, DOC: My page nane. The space
key is case sensitive.

®* Toinclude a blog post, specify the date as well as the title of the blog post. For
example: / 2010/ 12/ 01/ My bl og post.

® You can include pages from personal spaces using ~user nane as the space
key, where 'username' is the person's username. For example, ~j smi t h: My
page nane.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: i ncl ude

Macro body: None.
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{i ncl ude: DOCC: My chocol at e page}

Notes

® If you want to include part of a page rather than the whole page, use the Excerpt and Excerpt Include
macros.

® To display a page's contents, you need 'View' permission for that page. Similarly, people who view the
page will need 'View' permissions for the embedded page as well as the page into which it is embedded.
See space permissions or contact your Confluence space administrator for more information.

* |f you want to embed an external page into a Confluence page, you need the HTML Include Macro.
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Sample Include Page

Start of sample page content

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Aliquam fermentum vestibulum est. Cras rhoncus.
Pellentesque habitant morbi tristique senectus et netus et malesuada fames ac turpis egestas. Sed quis tortor.
Donec non ipsum. Mauris condimentum, odio nec porta tristique, ante neque malesuada massa, in dignissim
eros velit at tellus. Donec et risus in ligula eleifend consectetuer. Donec volutpat eleifend augue. Integer gravida
sodales leo. Nunc vehicula neque ac erat. Vivamus non nisl. Fusce ac magna. Suspendisse euismod libero
eget mauris.

End of sample page content



Info, Tip, Note, and Warning Macros

The Info, Tip, Note, and Warning macros allow you to highlight information on a Confluence page. They
create a colored box surrounding your text, like this:

@ Info macro example &\ Note macro example

This text is rendered inside the info macro. This text is rendered inside the note macro.
© Tip macro example ®© Warning macro example

This text is rendered inside the tip macro. This text is rendered inside the warning macro.

To add an Info, Tip, Note, or Warning Macro to a page:

1. From the editor toolbar, choose Insert © ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details,
S0 you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Default = Description

Optional Title none The title of the box. If specified, the title text will be
(title) displayed in bold next to the icon.

Show information/tip/Exclamation true If "false", the icon will not be displayed.
Mark/Warning Icon

(icon)

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in
the sidebar, header or footer of a space.

Macro name: i nf o/ ti p/ not e/ war ni ng

Macro body: Accepts rich text.
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{info:title=This is ny title|icon=false}
This is _inmportant_ information.
{i nf 0}
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Jira Chart Macro

If your Confluence site is connected to a Jira
application, you can display issues as charts on
Confluence pages. You can connect Confluence to
any Jira application, including Jira Software and Jira
Service Desk.

Before you can use this macro, your Confluence
and Jira applications must be connected via Applicat
ion Links. People viewing the page will see charts
for publicly accessible issues. If your Jira application
has restricted viewing (that is, people need
permission to view issues) then they'll need to
authenticate before seeing the charts. This macro is
compatible with Jira 5.x and later.

Adding the Jira Chart macro to a page

To add a Jira chart to your page:

. In the editor choose Insert > Other macros > Jira Chart.

On this page:

Adding the Jira Chart macro to a page

Pie chart

Created vs Resolved chart
Two Dimensional Chart
Disabling the Jira Chart macro

Notes

1
2. Choose the type of report you want to create (for example Pie, Created vs Resolved)
3

Select your Jira server.

If you have multiple Jira servers linked to Confluence the drop down will default to the primary

application link.

Choose Preview to generate the chart.

Noaks

Choose Insert.

Choose Display Options to further control how your chart appears.

Search for issues - you can enter the query in JQL or paste a Jira URL directly into the search field.

To find out more about searching for issues see Displaying issues using JIRA Query Language (JQL).

Screenshot: The Jira Chart Macro in the macro browser

Insert JIRA Chart

JAC [=]

=

Awaiting
| Merge
=1

/’:‘ Quality

="/ Review
=1

Enter a width in pixels, percent or leave blank to automatically resize

Pie Chart =
Project = 'CONF' AND fixVersion ='5.4'
Mol L Coftie Search using any isue key, search URL, JIRA link, JOL or plain text
Resolved
=19 T
¥ Display options
Chart by Status
Width | 90%
[T Show border
1 show chart information
Select Macro
Pie chart

Insert

Pie charts can be used to report on issue status, priority, assignee and more.

Preview

Cancel
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To further control how this chart appears on your page. Choose Display options:

Chart by - select the field you want to segment the pie chart by such as:
® Status
Fix version
Assignee name
Priority
Component
® |ssue type
Width - define the total width of the chart area. You can enter values in pixels, percent or leave blank
to auto fit.

® Show border - add a border around the chart area.
® Show chart information - include a text summary under the chart with the total issues count and

Resolved

chart by value.

=830 [T

Created vs Resolved chart

Created vs Resolved charts can be used to show the difference between the number of issues created
versus the number of issues resolved over time.

To further control how this chart appears on your page choose Display options:

Period - choose a time frame to report by (week, month, quarter etc).

Days previously - the total number of days to report on (counting back from today).

Cumulative totals - choose to progressively add totals or report individual values for each period.
Show unresolved trend - add a subplot showing unresolved issues over time.

Show versions - indicate version release dates as a vertical line on the chart.

Width - define the total width of the chart area. Enter values in pixels, percent or leave blank to auto
fit.

Show border - add a border around the chart area

Show chart information - include a text summary under the chart with the total issues count and
chart by value.
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2 1-Apr 2B-Apr S-May 12-May

Two Dimensional Chart

Two Dimensional Charts can be used to show issue statistics in a matrix. You can configure the X and Y
axes to display these issue fields:

Status
Priority
Assignee
Fix version
Component
Issue type.

For example you could use the chart to show issue types by status (as shown above).
To configure the chart axes choose Display options:
® X Axis - the issue field to display on the X axis (columns).

® Y Axis - the issue field to display on the Y axis (rows).
® Rows to display - the maximum number to display in the chart.

Status
Issue Type OPEN || RESOLVED | | CLOSED || TECHHNICAL REVIEW  HEW T:
() Bug 13 121 41 1 0 176
Improvement 3 105 30 0 3 141
New Feature 1 11 2 0 1 15
Sub-task 0 169 430 0 0 599
Total Unique Issues: | 28 836 652 1 22 1539

Showing 4 of 6 statistics. Show more
View in JIRA

Disabling the Jira Chart macro

The functionality is provided by a system app (plugin) called 'Jira Macros'. This is also used for the Jira
Issues macro. To make the macro unavailable on your site, you can disable the app See Disabling and
enabling apps.

Notes
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HTTPS: The Jira Chart macro can access a Jira site running under SSL provided the Confluence server is
configured to accept the Jira SSL certificate. See Connecting to LDAP or Jira applications or Other Services
via SSL.

Authentication: If the query includes issues that require authentication (issues that are not visible to
anonymous users in Jira), users will be prompted to authenticate to view charts on the Confluence page.

In order to search for issues in the macro browser you will need to authenticate.
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Jira Issues Macro

If your Confluence site is connected to a Jira application, you can create and display Jira issues on Confluence
pages. You can connect Confluence to any Jira application, including Jira Software and Jira Service Desk.

Before you can use this macro, your Confluence and Jira application must be connected via Application Links.
People viewing the page will see the publicly accessible issues from the Jira site. If your Jira site has restricted
viewing (that is, people need permission to view issues) then they will need to authenticate before seeing the
restricted issues. See more about restricted Jira issues below.

What you can do with the Jira Issues macro
Using the Jira Issues macro, you can:

Display a list of issues on your page, based on a JIRA Query Language (JQL) search, filter or URL.
Display a single issue.

Display a count of issues.

Create new issues and display the issues on your page without leaving Confluence.

Adding and updating the Jira Issues macro — an overview

Quick guide to using the macro on a Confluence page:

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Screenshot: Example of Jira issues macro on a Confluence page
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Key Summary T Updated - P Status Resolution
CONF-30894  User is not prompted before overwriting changes of another (8] Ooct22 2013 T RESOLVED | Fixed
user if attempting to save after an editor error is thrown

CONF-30866  TableOfContents Macros navigation is not working in D] Sep 24, 2013 RESOLVED Fixed
Firefox 23.x/ 24 x and Opera 12.16

CONF-30663  Left panel overlaps custom banner in Chrome (o] Sep 23, 2013 RESOLVED Fixed

CONF-30690 Dashboard popular stream won't render when it contains D] Sep 19 2013 T RESOLVED Fixed
content from an anonymous user

4issues 5 Refresh

Displaying issues via a Jira Query Language (JQL) search

You can use the macro to display a table of issues on your page, based on the results of a search using JIRA
Query Language (JQL).

JQL is a simple query language that is similar to SQL. A basic JQL query consists of a field, followed by an oper
ator (such as = or >), followed by one or more values or functions.

Examples:
® The following query will find all issues in the "'TEST' project:

proj ect = "TEST"

® The following query will find all issues in the 'documentation' component of the 'CONF' project:

proj ect = CONF and conponent = docunentation

For more information about JQL syntax, see Advanced searchingin the Jira Software documentation.
To display a table of issues based on a JQL search:

Insert the Jira Issues macro onto your Confluence page, as described above.

Choose a Jira server next to the Search button.

If prompted, log in to the Jira server.

Enter the JQL query into the Search box.

Choose Search.

If you want to customize the display, choose Display options and adjust the columns and number of
issues that will appear in your table of issues.

7. Choose Insert.

S0k WN =

Screenshot: Display options in the Jira Issues macro browser.
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v Display options
Display as
Display the macro as a single issue.
Total issue count
Display total number ofissues as alink. E.g. 22 issues

@ Table

Customise your columns below,

Maximum issues | 20

get all issues.

Leave empty to

Columns to display Key » || Summary % | | Issue Type x | | Created =
Updated x | Due Date x | | Assignee x | Reporter »
Priority % | | Status x | | Resolution %

Displaying issues via a Jira URL

You can paste any of the following Jira application URLSs into the Jira Issues macro. Confluence will immediately
convert the URL to a JQL search.

® Any URL for an issue search or filter.
® A URL for a single issue.
® The URL of the XML view of a search.

Auto-convert: You can paste URLs directly into the Confluence editor (without calling up the macro browser).
Confluence will automatically convert the URL into a Jira Issues macro.

Displaying a single issue, or selected issues
To display a single Jira issue, choose one of the following methods:

® Paste the URL of the issue directly onto the Confluence page. (There is no need to use the macro
browser.) Confluence will auto-convert the link to a Jira Issues macro.

® Or: Add the Jira issues macro to the page as described above, and choose Recently Viewed to see the
issues you have visited recently. Select an issue and choose Insert.

® Or: Add the Jira issues macro to the page as described above, and paste the issue URL into the search
box in the macro browser.

® Or: Add the Jira issues macro to the page, define your search criteria in the macro browser via JQL as
described above, then select the check box next to the issue in the search results, within the macro
browser.

You can choose to show just the issue key, or the issue key and a summary. Select the macro placeholder and
choose Show Summary or Hide Summary.

To display a subset of Jira issues from your search results:
1. Add the Jira issues macro to the page.
2. Define your search criteria in the macro browser via JQL, as described above.

3. Select the check boxes next to the required issues in the search results, within the macro browser.

Screenshot: Selecting a subset of issues to display
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Insert JIRA Issue

Search project = CONF Q

Create New |ssue Search using any issue key, search URL, JIRA link, JOL or plain text

Recently Viewed O Key Summary
[ [#] CONF-31418 Error getting content from PDF document
(7] CONF-31417 Page Properties Report Macro should offer filters on specifi...
[ (e] CONF-31415 Special Characters Entered into Link Macro Causes Link to ...
(7] CONF-31414 Add Attachments Macro (and Tools--Attachmenis) plugin po...
[ [¢) CONF-31413 Code Block Macro creates hyperlinks from URLs when set f...
[ (o) CONF-31411 Activity Stream gadget doesn't respect the Look and Feel 5. ..
(Z) CONF-31410 Editor: Control of the Insert pull-down menu
[ [# CONF-21409 Use NoCookie directive in Multimedia Widgets for external ...
[ () CONF-31408 Merge Two Pages and Preserve the Incoming Links for Both
~ Display options

Select Macro Hint: type "Ctri+Shift+J" in the editor to quickly access this dialog Insert = Cancel

Displaying a count of issues

You can choose to display the number of issues returned by your search, rather than a table of issues. The Jira
Issues macro will display a count of issues, linked to the search in your Jira application.

Screenshot: The Jira Issues macro displaying an issue count on a Confluence page

28227 issues

To display an issue count:
1. Add the Jira Issues macro to the page.
2. Define your search criteria in the macro browser via JQL, as described above.

3. Choose Display options, then choose Total issue count next to 'Display options' in the macro browser.
4. Choose Insert.

Creating a new issue

While editing a Confluence page, you can create an issue in Jira and display it on your Confluence page,
without leaving the Confluence editor.

To create an issue and add it to your page:
1. Add the Jira Issues macro to the page, as described above.

2. Choose Create New Issue.
3. Supply the information about your Jira server, project, and issue, as prompted.
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4. Choose Insert.

Confluence will send a request to your Jira application, to create the issue, then display the newly created issue
on your page.

Limitations
The Jira Issues macro will notify you if it is unable to create an issue in the selected project. This may be

because the project has a required field, field configuration or other customization that is not supported by the
Jira Issues macro. In this situation you will need to create the issue directly in your Jira application.

Configuring application links to display restricted issues

Before you can use this macro, your Confluence and Jira sites must be connected via Application Links.

If the Jira site allows anonymous users to view issues, you must configure an application link, but there's no
need to configure any incoming or outgoing authentication between the Jira application and Confluence. People

viewing the Confluence page will see the publicly accessible issues.

If your Jira site has restricted viewing, or if some projects or issues are restricted to viewing by certain people,
then people will be prompted to Log in & Approve before seeing the restricted issues.

Rendering HTML from Jira applications

Formatted fields from Jira can be displayed in Confluence if you set up a Confluence-to-Jira application link.
Otherwise, such formatted fields will be escaped within the output of the Jira issues macro. This is to prevent
the possibility of malicious HTML being served by an untrusted Jira server. The most likely field where you will
notice this is in the description field.

This example shows how a description column may be displayed in Jira:
Description
This is
® the description

® of my issue

If there is no application link between Jira and Confluence, the description will appear in the Jira issues macro
like this:

Description

<p>This is<ul><li>the description</li><li>of my issue</li></ul></p>

Disabling the Jira Issues macro

The functionality is provided by a system app called 'Jira Macros'. To make the macro unavailable on your site,
you can disable the app. See Disabling and enabling apps.

Notes

HTTPS: The Jira Issues macro can access a Jira application running under SSL provided the Confluence server
is configured to accept the Jira SSL certificate. See Connecting to LDAP or Jira applications or Other Services
via SSL.

Custom fields can be added as columns to the table simply by using the name of the field with no quotes. Earlier
versions of the macro required you to use the custom field id, e.g. cust onfi el d_10100.
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Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: j i rai ssues
Macro body: None.

This example uses a Jira filter.

{jirai ssues: anonymous=true|url=https://jira.atlassian.conlissues/?filter=41225}

A number of additional parameters that are not available via the macro browser are available in storage format
and wiki markup.

Parameter Required = Default = Parameter description and accepted values
name

anonynous | No fal se If this parameter is set to 'true’, your Jira application will return only
the issues which allow unrestricted viewing. That is, the issues
which are visible to anonymous viewers. If this parameter is
omitted or set to ‘false’, then the results depend on how your
administrator has configured the communication between the Jira
application and Confluence. By default, Confluence will show only
the issues which the user is authorized to view.

Note: This parameter is available only if you insert the macro via
wiki markup or by editing the storage format of the page. The
macro browser does not offer this parameter.

baseur | No The If you specify a 'baseurl’, then the link in the header, pointing to
value of | your Jira application, will use this base URL instead of the value of
the 'url' | the 'url' parameter. This is useful when Confluence connects to
paramet @ Jira with a different URL from the one used by other users.
er
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col ums No By
default,
the
following
columns
are
shown:

* type
* key
® sum
mary
® assig
nee
® repor
ter
® priori
ty
® status
* resol
ution
® creat
ed
® upda
ted
® due

count No fal se

cache No on

hei ght No 480 (if
render
mode is
dynamic)

A list of Jira column names, separated by semi-colons (;). You can
include many columns recognized by your Jira application,
including custom columns.

Some columns, such as those that need to be calculated by Jira
like 'work ratio’ or 'time to resolution’, can't be viewed in
Confluence.

If this parameter is set to 'true’, the issue list will show the number
of issues in Jira. The count will be linked to your Jira site.

The macro maintains a cache of the issues which result from the
Jira query. If the 'cache' parameter is set to 'off', the relevant part
of the cache is cleared each time the macro is reloaded. (The
value 'false' also works and has the same effect as 'off'.)

Note: This parameter is available only if you insert the macro via
wiki markup or by editing the storage format of the page. The
macro browser does not offer this parameter.

The height in pixels of the table displaying the issues.
Note that this height specification is ignored in the following
situations:

* |f the 'renderMode’ parameter (see below) is set to 'static'.
®* When the issues are displayed in a PDF or Word document, in
an email message or in an RSS feed.

Note: This parameter is available only if you insert the macro via
wiki markup or by editing the storage format of the page. The
macro browser does not offer this parameter.
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render Mode No static | If the value is 'dynamic', the Jira Issues macro offers an interactive
display which people can manipulate as follows:

Click the column headers to sort the output.

Drag and drop the columns into a different order.
Temporarily remove a column from the display.

View a page of issues at a time, for faster response times.

A value of 'static’ will disable the dynamic display features.

Note: This parameter is available only if you insert the macro via
wiki markup or by editing the storage format of the page. The
macro browser does not offer this parameter.

title No Jira You can customize the title text at the top of the issues table with
Issues this parameter. For instance, setting the title to 'Bugs-to-fix' will
replace the default 'Jira Issues' text. This can help provide more
context to the list of issues displayed.

Note: This parameter is available only if you insert the macro via
wiki markup or by editing the storage format of the page. The
macro browser does not offer this parameter.

ur | Yes none The URL of the XML view of your selected issues.

Note: If the URL in the 'url' parameter does not contain a t enpMax
argument, then the value of t enpMax will default to 500. If your
Jira server is version 3.12 or earlier, this means that the Jira
Issues macro will return a maximum of 500 issues. If your Jira
server is version 3.13 or later, a value of 500 means that the Jira
Issues macro will return a maximum of 500 issues per page.

wi dt h No 100% The width of the table displaying the issues. Can be entered as a
percentage (%) or in pixels (px).

Note: This parameter is available only if you insert the macro via

wiki markup or by editing the storage format of the page. The
macro browser does not offer this parameter.

(¥) Do more with Confluence and Jira
Take displaying Jira issues to the next level, with these apps on the Atlassian Marketplace:
® |ssue Macro from Jira to Confluence: customize the look of a single Jira Issue report or generate

a well-formatted filter report
® |ssues Forms for Confluence: Create and display Jira issues/tickets on Confluence pages
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Labels List Macro

The Labels List macro displays a list of all labels within the current space. Each label in the list links to a page
that displays all pages in the current space that contain that label.

Using the Labels List macro

To add the Labels List macro to a page:

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter name Required = Default Parameter description and accepted values
Restrict to this Space No Current The key of the space whose labels you want to

Key space display.

(spaceKey)

Excluded label(s) No Blank The labels that you do not want to appear in the list.

(excl udedLabel s)

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: | i st | abel s
Macro body: None.

{li stl abel s: spaceKey=DOC}



Livesearch Macro

The Livesearch macro allows you to add a search box to a Confluence page. When users enter a search term
into the search box, Confluence will dynamically display matching results as they type.

Using the Livesearch macro

To add the Livesearch macro to a page:

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Default = Description

Restrict to all Specify a space key to limit the search to the given space. Case-sensitive.
this Space Key | spaces

(spacekey) Alternatively, use @el f to restrict the search to the current space.
Restrict to Specify labels to limit the search to content with that label. If unspecified will
label(s) search all content regardless of label.

(1 abel s)

Size medium | Choose a medium or large search field size.

(size)

Placeholder Specify the placeholder text to appear in the search field, for example 'Search
text this space’

(pl acehol der

)

Type all Specify the content types to be included in the search - choose from pages,
(type) blogs, comments, space descriptions, or all content types.
Additional space Display the space name, a page excerpt or nothing under the search result.

(additional) name
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Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: | i vesear ch
Macro body: None.

{li vesearch: spaceKey=DOC]| si ze=I ar ge| pl acehol der =Search thi s space}
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Loremipsum Macro

The Loremipsum macro displays paragraphs of pseudo-Latin text (more information). You can use this macro to
generate more-or-less meaningless text for demonstration purposes in pages showing a draft layout or
arrangement of page elements. The text is deliberately non-meaningful so that it does not influence the viewer's
perception of the page arrangement or design.

A basic example of the Loremipsum text:

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Aliquam fermentum vestibulum est. Cras rhoncus.
Pellentesque habitant morbi tristique senectus et netus et malesuada fames ac turpis egestas. Sed quis
tortor. Donec non ipsum. Mauris condimentum, odio nec porta tristique, ante neque malesuada massa, in
dignissim eros velit at tellus. Donec et risus in ligula eleifend consectetur. Donec volutpat eleifend augue.
Integer gravida sodales leo. Nunc vehicula neque ac erat. Vivamus non nisl. Fusce ac magna. Suspendisse
euismod libero eget mauris.

Using the Loremipsum macro

To add the Loremipsum macro to a page:

1. From the editor toolbar, choose Insert = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Default = Description
Number of 3 Determines the amount of pseudo-Latin (space-filler) text to display. The macro
Paragraphs will display a maximum number of 30 paragraphs.

Parameter is unnamed in storage format and wikimarkup.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: | or enmi psum

Macro body: None.


http://en.wikipedia.org/wiki/Lorem_ipsum
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{l orem psum 2}

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Multimedia Macro

Use the multimedia macro to embed attached video, animation, and other multimedia files to your page. The
macro uses the HTML5 <vi deo> tag, so the type of video your page viewers can see depends on the video
formats their browser supports with the HTML5 <vi deo> tag. For example, Quicktime videos (.mov or .qt) can
only be viewed in Safari, as that file type is not supported by other browsers.

(D If you want to display online multimedia content, like YouTube and Vimeo videos, take a look at the Wid
get Connector Macro.

The file preview also supports MP3 audio and MP4 video files. This is handy when you want to play a
video in a larger format.

To add the Multimedia macro to your page:

1. From the editor toolbar, choose Insert = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Required = Default Parameter description and accepted values

name

Page name | No Current page The name of the page to which the multimedia file is

(page) attached. Start typing the name of the page and then select it

from list of suggested pages. Include the spacekey if you
want to specify a page in another space (for example, MYSPAC
E: My Page Title)

File* (nanme) | Yes None File name of the attached multimedia file.

Width No If not specified, Width of the movie window to be displayed on the page. By
the browser will | default, this value is specified in pixels. You can also choose
determine the to specify a percentage of the window's width, or any other

width based on value accepted by HTML.
the file type.
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Height No If not specified,
the browser will
determine the
height based on
the file type.

Autoplay (a No fal se
utostart)

Wiki markup example

Height of the movie window to be displayed on the page. By
default, this value is specified in pixels. You can also choose
to specify a percentage of the window's height, or any other
value accepted by HTML.

If the parameter is set to t r ue then the video or audio file will
start playing as soon as the page is loaded. If this option is
set to f al se then the file will not play until the user clicks the
icon or image on the page.

This example is useful when you want to add a macro outside the editor, for example as custom content in the

sidebar, header or footer of a space.
Macro name: mul ti nedi a

Macro body: None.

{mul ti medi a: space=DOC| page=My macr os| name=ni nj as. swf | aut ostart =true}

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Navigation Map Macro

The Navigation Map macro displays a navigable map of the pages tagged with a given label.

Using the Navigation Map Macro

To add the Navigation Map macro to a page:

1. From the editor toolbar, choose Insert T ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default = Description
Label none Specify the label associated with the pages you want to show in the navigation map.
This parameter is unnamed in storage format and wikimarkup.

Map Title none Specify a title for the navigation map.
(title)

Number of | 5 Specify the number of cells in a row
Cells Per
Row

(wr apAft
er)

Cell Width 90 Specify the cell width (enter a number only, don't include px)
(Pixels)

(cellWd

t h)

Cell 60 Specify the cell height (enter a number only, don't include px)
Height

(Pixels)

(cel | Hei

ght)
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Navigation @ Conflue @ Define a theme for the navmap (Server only).

Map nce
Theme If you want to create your own navmap 'look and feel' (for example, one with
(thene) rounded corners), you need to add a customized navmap macro theme file to the \\E

B- I NF/ cl asses/ coni at | assi an/ conf | uence/ pl ugi ns

/ macr os/ advanced directory. The file name convention to use is navmap-

myt hene. vm Use the name of your choice for the nmyt hernre part of the file name,
which is also the value you use for this parameter. Hence, if your theme was called
navmap- r oundededges. vm use the value of r oundededges for this parameter.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: navmap

Macro body: None.

{navmap: nyl abel | wapAfter=4|title=My map nane| cel | Hei ght =50px| t heme=navnap- nyt here. vnj cel | W dt h=80px}

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Network Macro

The Network macro displays a list of Network activity on a Confluence page or blog post. You can specify the
user whose network activity you wish to show. These interactions include the users that the specified user is
following or users who are following the specified user. The Network macro shows each listed user by their
profile picture. It also provides a choice of two themes and the ability to limit the number of users in the list.

Screenshot: Network macro

Following

Rach Admin is following 3 users

e ]=

Using the Network macro

I We ended support for this macro in Confluence 7.0
The macro no longer appears in the macro browser and can't be added to a page.
Any macro already on a page will still work.

Parameters
Parameters are options that you can set to control the content or format of the macro output. Where the

parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default Description

Username | Current The username of the Confluence user whose network interactions you wish to
user's show. If no username is specified, then current user's (that is, your) network
username interactions are shown.

Mode following Determines which users are listed, with respect to the specified user:

* following — those who the user is following.
® followers — those who are following the user.

This parameter is unnamed in storage format and wikimarkup.
Theme full Determines how the user's network is displayed:
® full — shows a large version of user's profile pictures and, if the following

mode is set, provides an entry field function to follow more users.
® tiny — shows only the small version of user's profile pictures.

Maximum No limit Restricts the number of users displayed. If the number of users exceeds the
Results imposed up | specified maximum, then a Show All link is provided. This link leads to the

toa specified user's Network view, showing the complete list of network interactions.
(max) maximum

of 30

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.


https://confluence.atlassian.com/display/CONF74/End+of+Support+Announcements+for+Confluence
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Macro name: net wor k

Macro body: None.

{network: f ol I ower s| user nane=admni n| max=10| t heme=f ul | }

Disabling the Network macro

The Network macro is provided by the 'network’ module in the 'Profile Macros' system app (plugin). To remove
the macro from your site, you can disable this module. See Disabling and enabling apps.

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Noformat Macro

The Noformat macro displays a block of text in monospace font with no other formatting.

Using the Noformat Macro

To add the Noformat macro to a page:

1. From the editor toolbar, choose Insert T ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Enter the content that is to be unformatted into the body of the macro placeholder.

Parameters
Parameters are options that you can set to control the content or format of the macro output. Where the

parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default | Description

No Panel False Removes the panel around the content.
(nopanel)

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: nof or mat
Macro body: Accepts plain text.

{nof or mat : nopanel =t rue} ht t p: / / ww. exanpl e. con{ nof or nat }



Office Excel Macro

The Office Excel macro displays the content of an Excel spreadsheet on a wiki page. First attach the
spreadsheet to a Confluence page, then use the macro to display the content. When viewing the page, people
will see the content of the spreadsheet, without needing to have Office installed.

For details, see the View File Macro.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: vi ewxl s
Macro body: None.

{vi ewxl s: col =5| page=Docs| nane=My docunent . x| s| gri d=f al se| sheet =nysheet | r ow=5}



Office PowerPoint Macro

The Office PowerPoint macro displays the content of a PowerPoint presentation on a wiki page. First attach the
presentation to a Confluence page, then use the macro to display the content. When viewing the page, people
will see the content of the presentation, without needing to have Office installed.

For details, see the View File Macro.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: vi ewppt
Macro body: None.

{vi ewppt : hei ght =20% page=Docs| wi dt h=20% name=My docunent. ppt| sl i de=4}



Office Word Macro

The Office Word macro displays the content of a Word document on a wiki page. First attach the document to a
Confluence page, then use the macro to display the content. When viewing the page, people will see the
content of the document, without needing to have Office installed.

For details, see the View File Macro.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: vi ewdoc
Macro body: None.

{vi ewdoc: page=Docs| name=My docunent. doc}



Page Index Macro

The Page Index macro creates an alphabetical index of all pages in the current space.

The top section provides the total number of pages in the space, followed by a count of pages for each letter.
Click any letter to jump to the bottom section, which lists all the pages in the space alphabetically. The first few
lines of each page will be included if there are less than 200 pages in the space.

(D The Page Index macro can be quite memory hungry in large spaces. To prevent it causing out of
memory errors in your site, we don't show page excerpts when there are more than 200 pages in the
space, and don't list any pages if there are more than 5000 in the space.

This limit is configurable. System Administrators can use the page. i ndex. nmacr 0. max. pages
system property to reduce the number of pages displayed.

Screenshot: Page Index macro (partial view)

Space Index
Total number of pages: 9
0-9 .1 A B...1 c...1 D._.0 E...O
0 ... | ... 1 J...0 K...0
0 M... 0 M...0 o1 P__.0 Q.0
R0 S T...1 U...0 V... 0 W_..Q
x...0 Y ... 0 £_..0 l@#s ... 0
0-9 A
[S] 25 reasons people like Confluence (#] Angry Nerds Home
Integration with JIRA Great product lts a Welcome to Angry Merds, a sample Confluence space. We
wiki User experience design think you're gonna like it here!
B c
[2) Blog ideas (=] Confluence hints and tips
Do users need to be told left side /right What hints and tips do you share with other Confluence
side of screen Macros and what you can users?
do with them
D E

Using the Page Index macro

To add the Page Index macro to a page:

1. From the editor toolbar, choose Insert + = > Other Macros
2. Find and select the required macro
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Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

This macro accepts no parameters.
Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: i ndex

Macro body: None.

{i ndex}

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Page Properties Macro

The Page Properties and Page Properties Report macro work together to
show summary information from one page on a another page. You can see
examples of these two macros in action in the Decisions and Product
Requirements blueprints.

Adding the Page Properties macro to a page
The Page Properties macro uses key/value pairs.
To add the Page Properties macro to a page:

1. In the editor, choose Insert > Other Macros > Page Properties

2. In the macro body create a two column table

3. In the left column list your 'keys' — these will be the column headings
in your report table

4. In the right column list the value for each key — these will populate
the rows in your report table

5. Add a label to your page (you'll need to specify this label in the page
properties report macro)

6. Save your page

Next you need to add the Page Properties Report macro to another page.

On this page:

® Adding the Page
Properties macro
to a page

® Using multiple
Page Properties
macros on one
page

® Parameters

Related pages:

® Page Properties
Report Macro

® Decisions Blueprint

® Product
Requirements
Blueprint

Here's an example of the Page Properties macro in the editor. Deadline, Current Status, and Team will be

column headings in the report.

V| Page properties

Deadline 1 June
Current Status Mot Started

Team Purple Monkeys

Here's what the example above will look like in the Page Properties Report.

Title Current status Deadline
Project DEF Mot started 1 June
Project ABC In Progress 15 Movember

Team
Purple Monkeys

Green Parrots

You can also set up the Page Properties macro horizontally. To do this:
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® Create a two row rather than two column table, and ensure the first row has the heading row style

m
applied.
® List your keys in the first row, and values in the second row.

The Page Properties Report Macro will be able to pull this information accurately even if you're using the
Page Properties Macro vertically elsewhere.

Using multiple Page Properties macros on one page

You can add multiple Page Properties macros on a single page, and choose whether to include all or only
specific macros in the report. You might use multiple macros because you want the information in the macro
to display in context with the rest of the page, or because you want to be able to report on individual Page
Properties macros separately.

The Page Properties macro includes an optional ID parameter that can be used to identify specific Page
Properties macros.

To show the contents of all Page Properties macros in the report:

1. Add a label to the page containing the Page Properties macros
2. Specify this label in the Page Properties Report macro

To show the contents of selected Page Properties macros in the report:
1. Add a label to the page containing the Page Properties macros
2. Specify an ID in the Page Properties macro that you want to report on

3. Specify both the label and ID in the Page Properties Report macro

Note: The Page Properties Report macro can only accept one page label, and one ID.

@ See the Page Properties macro in action in How to document product requirements in Confluence.
This powerful macro lets you create a summary page that pulls in information from multiple pages.
Parameters
Parameters are options that you can set to control the content or format of the macro output. Where the

parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default = Description

Page (None) Optional ID used to identify a particular Page Properties macro on a page.
Properties Specify this ID in the Page Properties Report to include summary information
ID from macros with this ID only.

Hidden False Determines whether the data in the Page Properties macro will be displayed on

the current page. This setting does not affect the display of the detail in the
Page Properties Report macro.

Notes

® You can't use macros in the left column as the data in this column is used to populate the column
headings in your Page Properties Report macro.

® Itis not possible to reference the metadata using the metadata key from within the page, or anywhere
else on a Confluence page.

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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® There is a known issue where the Page Properties Report macro does not correctly display content
from multiple Page Properties macros. See [l CONFSERVER-344414 CLOSED  for more
information.

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Page Properties Report Macro

The Page Properties and Page Properties Report macro work together to
enable you to show summary information from one page on a another
page. You can see examples of these two macros in action on the Decision
and Product Requirements blueprints.

This macro was previously known as the Details Summary macro.

Adding the Page Properties Report macro to a page
To add the Page Properties Report macro to a page:

1. In the editor, choose Insert > Other Macros > Page Properties
Report.

2. Enter the Labels you want to report on - this is the label added to
pages containing the Page Properties macro.

3. Further narrow down your search by adding more fields, or
specifying a Page Properties ID (more info on this below)

4. Choose Insert.

On this page:

Adding the Page
Properties Report
macro to a page
Reporting on
specific Page
Properties macros

® CQL fields
® Macro display

options
Troubleshooting

Related pages:

Page Properties
Macro

® Decisions Blueprint

® Product
Requirements
Blueprint
Here's how the macro looks on your page:
Title Current status Deadline Team
Project DEF Mot started 1 June Purple Monkeys
Project ABC In Progress 15 November Green Parrots

And here's how you would set it up in the macro browser:
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Insert ‘Page properties report’ Macro He
s Preview

Label *
Brojeet %) (CHITeI # Title Current status Deadline Team

In space Project DEF Mot started 1 June Purple Monkeys
Current space x Project ABC In Progress 15 November Green Parrots

Add a field

Options Show

Select macro Insert | Canc

Reporting on specific Page Properties macros

It's possible to add multiple Page Properties macros on a page, and choose whether to include all or only
specific macros in the report. The Page Properties macro includes an optional ID parameter that can be
used to identify specific Page Properties macros.

To show the contents of:
® Selected Page Properties macros in the report - specify the label for the page and the ID of the
particular Page Properties macro (under Options)
® All Page Properties macros in the report - specify just the label for the page - leave the Page
Properties ID field blank.

Note: The Page Properties Report macro can only accept one ID.

CQL fields

CQL (Confluence Query Language) is a query language developed for Confluence, which you can use in
some macros and the Confluence search. Confluence search and CQL-powered macros allow you to add
filters to build up a search query, adding as many filters as you need to narrow down the search results.

Use the Add a filter link to add more filters to your query.
®* For an OR search, specify multiple values in the same field.

So to show pages with 'label-a’, 'label-b' or both you'd put 'label-a’ and 'label-b' in the same Label
field, like this:

Label *

label-a x label-b %

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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® For an AND search, add more than one filter and specify a single value in each.
To show only pages with label-a and label-b you'd put 'label-a’ in one label field, then add a
second Label field to the macro, and put 'label-b' in the second one, like this:

Label *

label-a

Label [x )
label-b x

Put simply, OR values are entered in the same filter, AND values are entered in different filter.
Only some filters support AND. If the filter doesn't support the AND operator, you won't be able to
add that filter more than once.

®* For a NOT search, enter a minus sign (-) before the label. This'll exclude everything with that label.

You can use the following CQL filters to build your query:

Filter Description Operators
Label* Include pages, blog posts or attachments with these labels. = OR (multiple values in the
same filter)

AND (multiple Label filters)
With Include pages that are children of this page. OR (multiple values in the
ancestor same filter)
This allows you to restrict the macro to a single page tree.

Contributor | Include pages or blog posts that were created or edited by = OR (multiple values in the

ok these people. same filter)
Creator Include items created by these people. OR (multiple values in the
same filter)

Mentioning | Include pages and blog posts that @mention these people. = OR (multiple values in the
user same filter)

With parent | Include only direct children of this page (further sub-pages EQUALS (one page only)
won't be included)

In space** Include items from these spaces. OR (multiple values in the
same filter)

Including Include items that contain this text. CONTAINS (single word or

text** phrase)

With title Include items that contain this text in the title. CONTAINS (single word or
phrase)

Of type** Include only pages, blogs or attachments. OR (multiple values in the
same filter)

* This field is required in CQL-powered macros.

** You can add these filters in CQL-powered macros but in search they're part of the standard search filters,
so they don't appear in the Add a filter menu.

Macro display options

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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These options control how the macro appears on your page.

Parameter

Page
Properties
ID

Title
column
heading

Columns
to show

Number of
items to
display

Sort by

Show
Comments
Count

Show
Likes
Count

Default

Blank

Title

30

Modified

No

No

Troubleshooting

Description

If not specified, the report will show data from all Page Properties macros on a
page, where there are multiple macros. Specify an ID to include only data from
Page Properties macros with the same ID.

The heading to display on the first column in the report table. This column
contains links to pages displayed by the report. The default column heading is
Title'".

If not specified, the report will show all columns. You can specify a comma
separated list of columns to include.

If your column heading includes commas, use double quotes around the column

name. If your column heading includes quotes, use double quotes. For example,
A column, "My "'new"" column, yes", Third column

Number of items to display in the table before displaying pagination options for
additional items.

Sort the table by a specific column heading. Enter the column name, exactly as
it appears in the corresponding Page Properties macro.

Select the Reverse Sort check box to sort the table in reverse order.

Displays the number of comments for each page in the table.

Displays the number of likes for each page in the table.

If your report is empty, check:

® You have entered the label correctly and that the label does appear on pages containing a Page

Properties macro.

® The Page Properties macros on each page are configured correctly.
® Any other fields you have specified have not narrowed your search too far (for example there are no
pages with that label under the Parent page you've specified).

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Page Tree Macro

The Page Tree macro displays a dynamic, hierarchical list of pages starting from a specified parent (root) page.
It can act as a table of contents or a list of related topics. When viewing the page tree, your reader can click a
link to view the relevant page. The page's current position is highlighted in the page tree.

Using the Page Tree Macro

To add the Page Tree macro to a page:

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Click Refresh in the Macro Browser to see the effect of changes to the macro parameters.

Macro Parameters
Parameters are options that you can set to control the content or format of the macro output. Where the

parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter =~ Default | Description

Root Page @ The Specify the parent page for the page tree. The tree will include all children of the
(root) home given page, plus their children and grand-children etc. The tree will not include the
page of | root page itself.
the
space Specify the page title or a special value as follows:

® Your page title — to specify a page name for the parent or root of the tree. The
tree will include all children and grand-children of the specified root. The tree
will not include the specified root page itself.

* '‘@home' — will include all pages under the home page of the space (default).

* '@self' — will include all pages under the current page.

* '@parent' — will include all pages under the parent of the current page,
including the current page.

* '‘@none' — will include all pages in the space, including orphaned pages and
the home page.
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Sort position | Specify the order to display the pages in the tree. This sort order is for display
Pages By purposes only. It does not permanently re-arrange the page order. The value may
(sort) be one of the following:
®* bitwise — sort alphabetically, for example: titlel, title10, title2.
® creation — sort by date of creation.
* modified — sort by order of date last modified.
® natural — sort in 'natural’ alphabetical order, for example: titlel, title2, title10.
® position — sort by the default Confluence sorting rules. If your pages have
been ordered manually, this sort will respect the defined order. Otherwise the
pages will be displayed in the 'natural' alphabetical order, such as: titlel, title2,
title10.
Include false Select if you want the page tree to show excerpts from each page. The excerpts
Excerpts must be defined on each page by the Excerpt macro.
in Page
Tree
(excerpt)
Reverse false Select to show the pages in reverse (descending) natural order. Must be used in
Order combination with the Sort Pages By parameter.
(reverse)
Include false Select if you want to include a search box above the page tree. The search box
Search allows your readers to search within the page tree for the specified value.
Box above
Page Tree
(sear chBox
)
Show false Select if you want to display the 'expand all' and 'collapse all' links at the top of your
Expand page tree. Your readers can click these links to open or close all branches of the
/Collapse tree at once.
Links
(expandCo Available values in wikimarkup and storage format:
Il apseAll .
) ®* true - Show the 'expand all' and 'collapse all' options.
* fal se — Do not show the options.
Start Depth | 1 Enter any number greater than 0 to set how many levels of children the tree should
(startDep show when it opens for the first time.
t h)

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: paget r ee

Macro body: None.

{ paget r ee: r oot =Page
Nare| sort =nat ur al | excer pt =t rue| rever se=f al se| st art Dept h=3| expandCol | apseAl | =t r ue| sear chBox=t r ue}

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Page Tree Search Macro

Using the Page Tree Search macro, you can add a search box to your Confluence page. When a viewer enters
a search term, Confluence will search a hierarchy of pages starting from a specified parent (root) page and
return the search results.

You can also add a search box as part of a dynamic page tree, which looks like a table of contents. See the Pag
e Tree macro .

Using the Page Tree Search macro

To add the Page Tree Search macro to a page:

1. From the editor toolbar, choose Insert = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters
Parameters are options that you can set to control the content or format of the macro output. Where the

parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default = Description

Name of none The name of the root page whose hierarchy of pages will be searched by this
Root Page macro. If this not specified, the root page is the current page.
(root)

Note: Unlike the Page Tree macro, the Page Tree Search macro does not accept
the special values that start with an @ sign, such as @home or @self.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: paget r eesear ch
Macro body: None.

{paget reesearch: root =My page nane}



Panel Macro

The Panel macro displays a block of text within a customizable panel, like this:

A formatted panel. ‘

Handy hint: You can use panels within columns, in table cells and in the sections defined by page layouts.

Using the Panel macro

To add the Panel macro to a page:

1. From the editor toolbar, choose Insert T ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Default = Description

Panel Title none The title of the panel. If specified, this title will be displayed in its own title
(title) row.

Border Style solid The style of the panel's border. Accepted values are sol i d, dashed and
(border Styl e) other valid CSS border styles.

Border Color The color of the panel's border. Colors can be specified as HTML color
(bor der Col or) names or hexadecimal codes.

Border Pixel Width The width of the panel's border (in pixels).

(Value Only)

(bor der W dt h)

Background Color The background color of the panel. Colors can be specified as HTML
(bgCol or) color names or hexadecimal codes.
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Title Background The background color of the title row of the panel. Colors can be specified
Color as HTML color names or hexadecimal codes.
(titleBGCol or)

Title Text Color The color of the text in the title row of the panel. Colors can be specified
(titleColor) as HTML color names or hexadecimal codes.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: panel

Macro body: Accepts rich text.

{panel :title=My

title| borderStyl e=dashed| bor der Col or =bl ue| tit| eBGCol or =#00a400]| ti t | eCol or =whi t e| bgCol or =#72bc72}
A formatted panel

{panel }

(¥) Do more in Confluence
To further customize panels, check out these apps on the Atlassian Marketplace:
® Panelbox: Create a set of designed panelboxes to display identical topics in the same style,

keeping your pages clear and easy to read
® Panels: Make your intranet more interactive with a customizable panels

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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PDF Macro

The PDF macro displays the content of a PDF document on a page. First attach the document to a Confluence
page, then use the macro to display the document.

For details, see the View File Macro.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: vi ewpdf
Macro body: None.

{vi ewpdf : page=Docs| name=My docunent . pdf}



Popular Labels Macro

The Popular Labels macro displays the most popular labels used throughout your Confluence site or within a
space. A popular label is a label that has been added to many pages.

Using the Popular Labels Macro

To add the Popular Labels macro to a page:

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Default = Description

Number of 100 Specifies the total number of labels to display in the heatmap.

Labels to Display

(count)

Restrict Labels to | none Restricts the list of popular labels to the specified space.

this Space Key

(spaceKey)

Style of Labels list

(style) ® list — displays the popular labels as a bulleted list, ordered by popularity
(highest first).

®* heatmap — displays the popular labels using different font sizes for each
label depending on the label's popularity, ordered by label names.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: popul ar -1 abel s

Macro body: None.
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{ popul ar - | abel s: styl e=heat map| count =20| spaceKey=ds}

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

Profile Picture Macro

You can use the Profile Picture macro to display a

user's profile picture on a page, and it's useful for © Here'san SEple G e o L8 tie Plolle
things like creating team pages that show all Picture macro: How to build a release
members of a project team. planning page in Confluence.

Hover your mouse-over the picture to see the Hover
Profile for the user, and choose the user's picture or
name to view their user profile. When editing the

page, you can also select the macro and choose Vie
w User Profile to see the profile for the user. n Josh User

-l
-4y josh@user.com

Add the Profile Picture Macro Follow More.~
1. In the Confluence editor, choose Insert > Oth Profile Page
er Macros Status Updates Page

2. Find and select the 'Profile picture' macro

Network Page
3. Search for and select the user and choose Sa

ve

Speeding up macro entry with autocomplete: Typ
e { and the beginning of the macro name, then
select the macro from a list of suggested macros.
For more information, see Using Autocomplete.

Wiki markup

Wiki markup is not available for this macro. You cannot add this macro via wiki markup.


https://confluence.atlassian.com/display/DOCM/.Using+Autocomplete+v1.0
https://confluence.atlassian.com/doc/blog/2015/08/how-to-build-a-release-planning-page-in-confluence
https://confluence.atlassian.com/doc/blog/2015/08/how-to-build-a-release-planning-page-in-confluence

Recently Updated Dashboard Macro

The Recently Updated Dashboard macro displays a list of the most recently changed pages, blogs and files in
your site. It is similar to the Recently Updated macro but with tabs to allow you to see all updates, updates from
your favorite spaces or updates from your network (the people you follow).

Using the Recently Updated Dashboard macro

To add the Recently Updated Dashboard macro to a page:

1. From the editor toolbar, choose Insert = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default Description
Space(s) The space which Filter content by space. The macro will display only the pages etc
(spaces) contains the page which belong to the space(s) you specify here. You can specify one or

on which the macro = more space keys, separated by commas.

is added

Use ™ for all spaces.

Include all types Filter content by type. You can specify one or more types, separated by
these commas. Available types are: page, bl ogpost or news, spacedesc,
Content attachnent, conment, mai | , useri nfo.
Types
Only
(types)
Label(s) none Filter content by label. The macro will display only the pages etc which
(1 abel s) are tagged with the label(s) you specify here. You can specify one or

more labels, separated by commas.
Note: If there are no pages matching any of the specified labels, then
Confluence will ignore the labels and will list all recently updated pages.

User(s) all users Filter by username of the user who updated the content. The macro will
(users) only display content created and updated by the user(s) you specify
here. You can specify one or more usernames separated by commas.
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Width of 100% Specify the width of the macro display, as a percentage of the window
Table width.

(wi dt h)

Show false Select whether profile pictures of the users who updated the content
User are displayed.

Profile

Pictures

(showPr o
filePic)

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: r ecent | y- updat ed- dashboar d
Macro body: None.

{recent|y-updat ed- dashboar d: spaces=ds| user s=adni n| wi dt h=50% showPr of i | ePi c=t rue| | abel s=choc| t ypes=page}

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Recently Updated Macro

The Recently Updated macro displays a list of the most recently changed content within Confluence.

Using the Recently Updated Macro

To add the Recently Updated macro to a page:

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default Description

Author(s) None Filter the results by author. The macro will display only the pages etc which were
by specified. last modified by the author(s) you specify here.

username | Thatis,

(aut hor) display all You can specify multiple users.

content
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Space(s) @el f This parameter allows you to filter content by space. The macro will display only
(spaces) the pages etc which belong to the space(s) you specify here.
That is,
the space You can specify one or more space keys, separated by a comma or a space.
which
contains ® To exclude content in a specific space, put a minus sign (-) immediately in
the page front of that space key. For example: If you specify a space key of -
on which BADSPACE you will get only content which is not in the BADSPACE.
_the macro ® To indicate that the results must come from a specific space, put a plus sign
is used (+) immediately in front of that space key. For example: If you specify a

space key of +GOODSPACE you will get only content in GOODSPACE. (Note
that this is not particularly useful, because each content item belongs to one
space only. If you put a plus sign next to one space key and list other space
keys too, the other space keys will be ignored.)

Special values:

@el f — The current space.

@er sonal — All personal spaces.

@) obal — All site spaces.

@ avorit e — The spaces you have marked as favorite.
@ avourite —The same as @ avori t e above.

@l | — All spaces in your Confluence site.

* — The same as @l | above.

When specifying a personal space, remember to use the tilde (~) sign in front of
the username, such as ~j bl oggs or ~j bl oggs@xanpl e. com

Label(s) None Filter the results by label. The macro will display only the pages etc which are
(1 abel s) specified i. | tagged with the label(s) you specify here.
e. display

all content | You can specify one or more label values, separated by a comma or a space.

® To exclude content which matches a given label, put a minus sign (-)
immediately in front of that label value. For example: If you specify a label
value of - badpage you will get only content which is not labeled with
'‘badpage’'.

® To indicate that the results must match a given label value, put a plus sign
(+) immediately in front of that label value. For example: If you specify a label
value of +super page, +goodpage you will get only content which has at
least two labels, being 'superpage’ and ‘goodpage’.

The labels parameter only applies to the page and bl og content types.

Width of 100% Specify the width of the macro display, as a percentage of the window width.
Table
(wi dt h)

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Include
these
Content
Types
Only
(types)

Maximum
Number of
Results

( max)

theme
(there)

Show
User
Profile
Pictures
(showPro
filePic)

Hide Title

(hi deHea
di ng)

Notes
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All types

15

conci se

fal se

False

This parameter allows you to filter content by content type. The macro will
display only the content of the type you specify here.

You can specify one or more types, separated by a comma or a space.

To exclude content of a given content type, put a minus sign (-) immediately in
front of that content type. For example: If you specify a content type of -
bl ogpost you will get pages and all other content except for blog posts.

Available values:

page — Pages.

bl ogpost or news — Blog posts, also known as news items.
conmment — Comments on pages and blog posts.

att achnent — Attachments.

Specify the maximum number of results to be displayed. If this parameter is
omitted, then a maximum of 15 results are displayed. The theoretical maximum
value that this parameter can accept is 2 to the power of 31, minus 1 (or
2147483647), though this has been limited to 200 in the code, for performance
reasons. More details are here.

Choose the appearance of this macro:

® conci se — the default list, showing the nhames of pages which were
updated or commented on, the users who made the page modifications and
time when the modifications occurred.

® soci al — lists recent modifications in reverse chronological order, but
groups them by user into short time segments. A 'sub’ list appears within
each user's time segment, showing the names of pages which they updated
or commented on and time when these modifications occurred.

® sidebar — lists recent updates in reverse chronological order, showing the
names of pages which were updated or commented on and time when the
page modifications occurred. This theme does not show authorship.

Specify showPr of i | ePi c=t r ue to display the profile pictures of the users who
updated the content.

Determines whether the macro hides or displays the text 'Recently Updated' as a
title above the list of content. Only available in wikimarkup and storage format.

Accepted values:

® true —Title is hidden.
®* fal se — Title is shown.

® The Recently Updated Dashboard macro is similar to this macro, but is intended for display on the

Confluence dashboard.

® If you would like to change the wording displayed by the Recently Updated macro, please refer to the
document on modifying the Confluence interface text.

Wiki markup example

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: recent | y- updat ed
Macro body: None.

{recent|y-updat ed: spaces=ds| aut hor =adm n| max=10| hi deHeadi ng=t r ue| wi dt h=50%
| t heme=si debar | showPr of i | ePi c=true| | abel s=choc| t ypes=page}

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Recently Used Labels Macro

The Recently Used Labels macro displays a list of the labels that have been most recently added to a page,
blog post or attachment. You can define the number of labels to be displayed and the scope (the current space,
your personal space or site spaces, also known as 'global’ spaces).

Using the Recently Used Labels macro

To add the Recently Used Labels macro to a page:

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters of this macro

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Default = Description

Number of Labels @ 10 Specifies the total number of labels to display in the list.

to Display

(count)

Scope for global Specifies the scope of labels to be displayed in the list. Valid values include:

Retrieving Labels

(scope) ® global — covers all site spaces (non-personal) in the Confluence
installation.

® space — the current space.
® personal — your own personal space.

List Style list
(style) ® [ist — displays the list of labels horizontally.
® table —includes additional information such as the page to which the
label was added and the user who added it.
Table Title none Adds a title to the top of the list in table style. Titles are only visible when the
(title) List Style parameter has been set to table.

Wiki markup example
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This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: recent | y-used- | abel s
Macro body: None.

{recently-used-labels:title=My title|scope=space|styl e=tabl e|] count =20}

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Related Labels Macro

The Related Labels macro lists all labels from every page which has one or more labels in common with the
current page.

Using the Related Labels Macro

To add the Related Labels macro to a page:

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Default = Description

Restrict to these | none Specify the labels for which you want to view related labels. For example, do
Labels cunent ation, ny: stuff.

(1 abel s)

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: r el at ed- | abel s
Macro body: None.

{rel at ed-| abel s: | abel s=choc, cake}



Roadmap Planner Macro

Create simple, visual timelines that are useful for planning projects, software releases and much more with
the Roadmap macro.

Roadmaps are made up of:

bars to indicate phases of work

lanes to differentiate between teams, products or streams
markers to highlight important dates and milestones

a timeline showing months or weeks.

You can provide more information about items on your roadmap by linking a bar to a page.

Here's how it appears on a page:

2014
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LiH]
= JIRA Chart: Pie
E
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o
&}
c Topic wizard SEOQ
®
é [3 SEO Requirementis
Team Hulk working

on SEQ optimisation

Performance improvements

o
Lo
E
m
@
—

Questions 1.0 Confluence 5.4 Confluence 5.5

Adding the Roadmap macro

To add the Roadmap macro to a page:

1. From the editor toolbar, choose Insert + = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

2 Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details,
S0 you can edit the macro parameters.
Cheese

Edit Remove

Editing your Roadmap

To edit your roadmap:
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Select the roadmap and choose Edit.

Add lanes, bars and markers.

Drag lanes, bars and markers to the desired location on the roadmap.

Select lanes, bars and markers to add text, change colors and remove from the roadmap.
Select bars to add links to existing pages, create new pages or add a description.

Set the start and end dates for the roadmap and choose to display it by weeks or months.

Here's how the roadmap planner appears in the editor:

Insert Roadmap Planner

Viewby Monifs § INA0SOT - 20160131

+ Addlana 4+ Addbar  + Add marker

Prepare launch
campaign

| Linkpage « Creata pags

Ciick in add dascripion.

Doigtn tar

1. Add lanes: to differentiate your teams or streams of work.
2. Date range: display the plan by weeks or months.
3. Add bar info: to provide more info or link a bar to a page.

Parameters

This macro does not use the macro browser to set parameters. You also cannot add this macro via wiki
markup or by editing the storage format directly.

Notes
The Roadmap macro was previously available from The Marketplace. The macro has changed significantly.

If you had an older version of the macro installed you will be able to view your existing roadmaps but not edit
them.

(¥) Do more with Confluence
To extend Confluence's roadmap capability, check out these apps on the Atlassian Marketplace:
® Live Roadmap: Build your Roadmap and keep it alive connecting it to your Jira

® ProductPlan for Confluence Server: Embed your roadmap in Confluence to keep your team
aligned around high-level goals

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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RSS Feed Macro

The RSS Feed macro embeds an RSS feed on a page. It can display the contents of external feeds, or of
internal feeds generated by Confluence. To display blog posts or to list recently updated pages in a space, use
the Feed Builder to create an internal feed, then render it using this macro.

-

@ CAUTION: Including unknown HTML inside a webpage is dangerous.

HTML inside an RSS feed can contain active scripting components. This means that it would be
possible for a malicious attacker to present a user of your site with script that their web browser would
believe came from you. Such code could be used, for example, to steal a user's authentication cookie
and give the attacker their Confluence login password.

\

The RSS Feed macro may be disabled by your Confluence administrator. Also, your Confluence administrator
can define a whitelist of trusted URLs. You will see an error message on the Confluence page, if the included
URL is not in the whitelist.

Using the RSS Feed macro

To add the RSS Feed macro to a page:

1. From the editor toolbar, choose Insert + = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested
macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Lheese

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Default = Description

RSS Feed URL none The URL of the RSS feed link you want to show.
(url)

Maximum Number of Entries 15 Limit the number of entries displayed.

(max)

Show Item Titles Only false Show only the titles of the news items, not the content.

(showTi t] esOnl y)


https://confluence.atlassian.com/display/CONF74/Configuring+the+Whitelist
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Show Name/Title of RSS Feed | true Hide the feeds title bar.
(titleBar)
How up to date is the feed?
By default, the RSS Feed macro caches the feed results for 60 minutes before fetching the data again.

If you wish to change the default caching, use the Cache macro to define how often the RSS Feed macro
fetches the feed updates. You will need to install the Cache plugin onto your Confluence site.

What happens to a page containing a disallowed URL?

Your Confluence Administrator can set up a whitelist of allowed URLSs. If this is the case, you may see an error
on the pages which contain the RSS Feed macro.

A user can add the RSS Feed macro or the HTML-include macro to a Confluence page. The macro code
includes a URL from which the content is drawn. When the page is displayed, Confluence will check the URL
against the whitelist. If the URL is not allowed, Confluence will display an error message on the page.

The error message says that Confluence "could not access the content at the URL because it is not from an
allowed source" and displays the offending URL. If the person viewing the page is a Confluence Administrator,
they will also see a link to the Administration page where they can configure the URL whitelist.

Here is an example of the error message, including the link shown only to Confluence Administrators:

Could not access the content at the URL because it is not from an allowed source.
http:{/ffeathers wordpress.com

Confiqure whitelist =

Here is an example of the error message, but without the link.

Could not access the content at the URL because it is not from an allowed source.
http:{fffeathers wordpress.com

You may contact your site administrator and request that this URL be added to the list of allowed sources.

Authentication

Private feeds from external sites

RSS feeds which require authentication cannot be accessed using the RSS Feed macro.
Accessing internal HTTPS feeds

This applies only to Confluence instances which have enabled HTTPS for all content. If your site is fully HTTPS,
the RSS Feed macro cannot access internal feeds. To enable the RSS Feed macro to access internal feeds
without affecting your HTTPS setup, enable local-only HTTP access:

1. Shut down Confluence.

2. Consult the SSL guide to enable HTTP access to Confluence. You'll want to ensure that you have an
HTTP connector and an SSL connector, both commented in. This means that Confluence will be
accessible via both HTTP and HTTPS. However, you should not have a redirect port, nor rules in web.
xml to redirect all traffic.
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3. Instead of using web.xml to redirect traffic, insert a firewall rule to redirect all HTTP requests not from the
Confluence server to the equivalent HTTPS URL. This ensures that users will only be able to access
Confluence via HTTPS, as intended. If you have still left HTTP access for attachments enabled (to avoid
the IE download bug) you must selectively enable those URLS as well.

4. Modify your Confluence RSS Feed macro feed link to use the HTTP URL, and restart Confluence.

Enabling the RSS Feed macro
The RSS Feed macro is disabled by default.

To enable the RSS Feed macro:

1. Goto E > Manage apps.
2. Select System from the drop down and search for the Confluence HTML Macros system app.
3. Expand the listing and enable the rss (rss-xhtml) module.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: rss
Macro body: None.

{rss: max=10| showTi t| esOnl y=true| url =http:// nmybl og. coni feed| titl| eBar=fal se}
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Search Results Macro

The Search Results macro searches your Confluence site based on search terms specified in the macro
parameters, and displays the results on the wiki page.

Using the Search Results macro

I We ended support for this macro in Confluence 7.0
The macro no longer appears in the macro browser and can't be added to a page.
Any macro already on a page will still work.

Parameters
Parameters are options that you can set to control the content or format of the macro output. Where the

parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Default = Description

Search none The search terms which this macro will use to generate its results.
Terms
(query) You can refine your search query by using operators such as 'AND' and 'OR'. For

example: my_queryl AND ny_query?2

For more information, take a look at the documentation on the Confluence search

syntax.
Maximum 10 Set a limit to the number of search results displayed.
Number of
Results
(maxLimt)
Restrict to all Start typing the space name to find the space, or specify the key of the space you
this Space want to search in. Note that the key is case sensitive.
Key
Content all Specify the content type. The content types are: page, comment, blogpost, attac
Type hment, userinfo (the content of user profiles only) and spacedesc (the content of

(type) space descriptions only).
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Last all Specify a period of time in weeks, days, hours and/or minutes, to see the content
Modified modified within that time frame.
( l ast Modi These are the values you can use:
fied)

®* w=weeks

®* d=days

® h =hours

® m= minutes

For example:
® 2h 35m
® 3d 30m
Notes:
® If no time category is specified, Confluence assumes minutes.
® |f you specify more than one time period (for example, weeks and days), you
must separate the periods with a space. You can put them in any order.

® The time categories are not case sensitive. For example, '4d' is the same as '4D
Restrict to all Specify the username of a Confluence user, to show only content created or
this updated by that user.
Username
(contribu
tor)

Notes

Permissions: When a user views the page containing the Search Results macro, the search results will show
only pages and other content types for which the user has 'View' permission.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: sear ch

Macro body: None.

{search: | ast Modi fi ed=3w| quer y=choc| contri but or =adm n| maxLi m t =10| t ype=page| spacekey=ds}
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Section Macro

Used with the Column macro to define columns on a page. See Working with page layouts and columns and
sections.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: secti on
Macro body: Rich text, consisting of one or more Column macros.

{section: border=true}

{col um: wi dt h=100px}

This is the content of *columm 1*.
{col um}

{col um}

This is the content of *columm 2*.
{col um}

{section}



Space Attachments Macro

The Space Attachments macro displays a list of all files attached to pages in a space. It shows details of the file
and the includes a link to the page a file is attached to.

Filters allow you to show only files with a particular label or file extension.

Screenshot: The Space Attachments macro

Sample Page
i3 Added by Rach Admin, last edited by Rach Admin on Feb 15, 2013 (view change)
Aftachments in this space - displayed via the space attachments macro.
Filter By File Extension: Filter By Label:
Name Size Creator Creation Last Modification Labels Attached To
Date Date
a2 penguin_png 5 kB Rach 20 minutes 20 minutes ago penguin 2 Sample Page
Admin ago chocolate o
@ad iBugs gif 22 Josh User about an hour about an hour ago useful logo o [2) Sample Page
kB ago
@ad sitelogo png 2 kB Josh User about an hour about an hour ago logo  confluence [Z) Sample Page
ago 4
ad 10 Rach Feb 13, 2013 Feb 13, 2013 No labels # [ Fancy Page
DefaultSpacelLogo_AngryNerds.png kB Admin

Using the Space Attachments macro

To add the Space Attachments macro to a page:

1. From the editor toolbar, choose Insert + = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Cheese

Edit Remove

Parameters

The Space Attachments macro displays a list of all the attachments in a space. You can choose to show
attachments from the current space, or another space.

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).
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Parameter = Default = Description

Space (none) Selects the Confluence space to display attachments for. If you do not specify a
space, the current space will be used.

Show true Determines whether or not the filter panel is shown. If you select this option, people
Filter viewing the page will be able to filter the list of attachments by file type (extension)
Controls and by label.

(showFi |

ter)

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: space- att achment s
Macro body: None.

{space- attachnent s: showFi | t er =f al se| space=ds}
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Space Details Macro

The Space Details macro displays the details of a Confluence space, including the space name, description,
and more.

Using the Space Details macro

I We ended support for this macro in Confluence 7.0
The macro no longer appears in the macro browser and can't be added to a page.
Any macro already on a page will still work.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Default = Description

Width of 100% The width of the space details table, specified as a percentage (%) of the page
Table width.

(w dth)

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: space-detail s
Macro body: None.

{space-detai |l s: wi dt h=50%
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Spaces List Macro

Use the Spaces List macro to display a list of spaces on a page.

Using the Spaces List macro

To add the Spaces List macro to a page:

1. From the editor toolbar, choose Insert * ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Required?  Default = Description
Scope of spaces no all The view from which spaces are listed. Available options
are:

® (blank) - All spaces in your site, with tabs.

® all — All spaces in your Confluence site.

® category — Spaces grouped according to space
categories.

® favorite — Spaces which you have added to My
Spaces.

® new — spaces created within the last 7 days.

This parameter is unnamed in wiki markup and storage

format.
Width of List no 100% The width of the spaces list, specified as a percentage
(wi dt h) (%) of the window width.
Include archived no False Include spaces that have been archived in the list. These
spaces are excluded by default.
(i ncl udeAr chi vedS
paces)

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.
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Macro name: spaces
Macro body: None.

{spaces: favourite|w dt h=80%
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Status Macro

The Status macro displays a colored lozenge (a

rounded box) that is useful for reporting project @ See the Status macro put to excellent use
status. You can choose the color of the lozenge and in How to build a release planning page in
the text that appears inside the lozenge. The macro Confluence.

also displays its current status in the editor, and you
can change the status directly in the editor.

ALL GOOD

Screenshot: Click on the Status macro lozenge to change the status.

ALL GOOD

Edit ALL GOOD [ BB removwe

Using the Status macro

To add the Status macro to a page using the Macro Browser:

1. From the editor toolbar, choose Insert * = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details,
S0 you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default | Description

Color Grey The color of the lozenge. The following colors are available: Grey , Red, Yellow,
(col our) Green and Blue.

Title The The text that will appear inside the lozenge. If you do not specify any text, the
(title) color title will be the color of the lozenge, that is 'Grey’, 'Red’, 'Yellow', '‘Green' or

thatyou @ 'Blue'.
select.
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Use False The style of the lozenge and its border. The default style lozenge is a solid
outline background color with white text. The outline style lozenge is white with a
style colored border and colored text as shown here

(subtle)

ALL GOOD!

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in
the sidebar, header or footer of a space.

Macro name: st at us
Macro body: None.

{status:colour=Green|title=On track|subtle=true}

() Do more with Confluence
For more customizable status macros check out these apps on the Atlassian Marketplace:
® Build Status Tracker for Confluence: Provide visibility on build status from Bamboo or Jenkins
on your Confluence pages

® Spectrum Formatting Macros: Show a page status as a draft, as outdated, as action required
or as official
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Table of Contents Macro

The Table of Contents macro scans the headings

on the current Confluence page to create a table of @ Wwant to see the Table of Contents macro in
contents based on those headings. This helps action? Check out how it's used in Creating
readers find their way around lengthy pages, by insightful customer interview pages.

summarizing the content structure and providing
links to headings.

Using the Table of Contents macro
Hint: For quick access from the editor toolbar, choose Insert > Table of Contents.

To add the Table of Contents macro to a page:

1. From the editor toolbar, choose Insert © ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details,
S0 you can edit the macro parameters.

Edit Remove

Macro parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default | Description

Output list

Type ® list — produces a typical list-type table of contents.

(type) ® flat — produces a horizontal menu-type series of links.

Display clear Select the check box to apply outline numbering to your headings, for example:
Section 11,1.2,1.3.

Numbering

(outline)
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List Style
(style)

Heading
Indent
(i ndent)

Separator
(separ at
or)

Minimum
Heading
Level

(m nLevel

)

Maximum
Heading
Level
(maxLevel

)

Include
Headings
(i ncl ude)

Exclude
Headings
(excl ude)

Printable
(printab
| e)

CSS Class
Name
(cl ass)
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disc

brackets

checked

Select the style of bullet point for each list item. You can use any valid CSS
style. For example:

® none — no list style is displayed

® circl e — thelist style is a circle

® di sc — the list style is a filled circle. This is the typical bullet list, and is
used for this example list.

® squar e — the list style is a square

® deci mal —the listis numbered (1, 2, 3, 4, 5)

® | ower - al pha — the list is lower-case, alphabetized (a, b, c, d, €)

® | ower - r oman — the list style is lower roman numerals (i, ii, iii, iv, v, vi)

® upper - roman — the list style is upper roman numerals (1, Il, I, IV, V, VI)

Sets the indent for a list according to CSS quantities. Entering 10px will
successively indent heading groups by 10px. For example, level 1 headings will
be indented 10px and level 2 headings will be indented an additional 10px.

This parameter applies to flat lists only. You can enter any of the following
values:

br acket s — Each item is enclosed by square brackets: [ ].

br aces — Each item is enclosed by braces: { }.

par ens — Each item is enclosed by parentheses: ().

pi pe — Each item is separated by a pipe:

anything — Each item is separated by the value you enter. You can enter
any text as a separator, for example "***". If using a custom separator, be
aware that text displays exactly as entered, with no additional white space to
further separate the characters.

Select the highest heading level to start your TOC list. For example, entering 2
will include levels 2, and lower, headings, but will not include level 1 headings.

Select the lowest heading level to include. For example, entering 2 will include
levels 1 and 2, but will not include level 3 headings and below.

Filter headings to include according to specific criteria. You can use wildcard
characters. See Sun's Regex documentation for examples of constructing
regular expression strings.

Filter headings to enclude according to specific criteria. You can use wildcard
characters. See Sun's Regex documentation for examples of constructing
regular expression strings.

By default, the TOC is set to print. If you clear the check box, the TOC will not
be visible when you print the page.

If you have custom TOC styles in your CSS style sheet, use this parameter to
output the TOC inside <di v> tags with the specified class attribute.
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Absolute By default, the links in the TOC are relative URLs pointing to the current page. If
URL checked, the links in the TOC will be full URLs. This setting is useful when you
(absol ut are including a page with a Table of Contents in another page, and want to
elrl ) control where the links should take the user.

Examples

The examples below are based on this table of contents:

* Places
« Favourite Places
« Lnknown Places
« Foods
« Favourite Foods
« Unknown Foods
e Things
« Favourite Foods
« nknown Foods

Filtered Table of Contents

This example filters the headings to include those that contain 'Favorite', but excludes headings which end
with 'Things'. The list is styled with Roman numerals.

Parameter Value
List Style upper - roman

Include Headings  Favourite.*

Exclude Headings . * Thi ngs

The resulting table of contents is:

I. Favourite Places
Il. Fawvourite Foods

Flat List

This example filters all headings to render a flat list of 'Unknowns' enclosed in square brackets (the default

list style).
Parameter Value
Output Type flat

Maximum Heading Level 2

Include Headings Unknown. *

The resulting table of contents is:
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[ Unknown Places ] [ Unknown Foods ][ Unknown Foods ]

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in
the sidebar, header or footer of a space.

Macro name: t oc
Macro body: None.
This example shows a list-type table of contents.

{toc: printabl e=true| styl e=squar e| maxLevel =2| i ndent =5px| mi nLevel =2| cl ass=bi gpi nk| excl ude=[ 1// 2]
| type=list|outline=true|include=.*}

This example shows a flat table of contents.

{toc: printabl e=true| naxLevel =2| m nLevel =2| cl ass=bi gpi nk| excl ude=[ 1/ / 2]
| type=flat|outline=true| separator=pipe|incl ude=.*}

Notes and known issues

®* When you use a Table of Contents macro in a template, you will see an error when you preview the
template itself. But the Table of Contents macro works on the pages that people create from the
template — the table of contents shows up after they have saved the page. (This is probably because
the template is not defined as a page, and the Table of Contents macro works for pages only.)

® The Table of Contents macro only displays page or blog post content. You can't use it to add a table
of contents of headings in a comment for example.

® Due to an outstanding issue in the Table of Contents macro (CONF-10619), the macro browser's Refr
esh function does not render any parameter modifications. Currently, the rendering of parameter
value modifications to the Table of Contents macro occurs only after the page is saved.

® Using HTML heading markup with the Table of Contents macro
The Table of Contents macro cannot handle HTML heading markup on its own. Hence, if you use the
HTML and HTML Include macros to render HTML heading markup in a Confluence page, the Table of
Contents macro will not create a contents list out of these headings.
However, if you insert an HTML anchor into each HTML heading on your page (based on the
following syntax), the Table of Contents macro will incorporate these headings into your contents list.

<h2><a nane="pagenane- headi ngnane" ></ a>Headi ng Nanme</ h2>

The syntax for the anchor name is the page name and heading name separated by a hyphen.
Remove all spaces and convert all text to lower case. Convert all punctuation marks to their URL-
encoded equivalent.

® There is a known issue where if you click a heading in the Table of Contents macro, then click the
back button in your browser, you won't be returned to the table of contents (or to your previous page).
As a workaround, use the Table of Content Zone Macro. See

[0 CONFSERVER-40462 GATHERING IMPACT | and Bl CONFSERVER-52497 | GATHERING IMPACT
for more information.
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(¥) Do more with Confluence

Extend Confluence with one of the hundreds of other macros in the Atlassian Marketplace. Here's
some specific to documentation:

® Scroll Office for Confluence - turn your Confluence pages pages into professionally styled
documents

® Advanced Children Display for Confluence: combine Confluence's built-in children display and
table of contents macros
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Table of Content Zone Macro

You can use the Table of Content Zone macro to mark out a section (zone) within the page from which to create
a table of contents. You can style the headings as a flat list, and place the list of links at the top and bottom of
the section or page, to provide navigation bars similar to web navigation.

Using the Table of Content Zone macro

To add the Table of Content Zone macro to a page:

1. From the editor toolbar, choose Insert = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters
Parameters are options that you can set to control the content or format of the macro output. Where the

parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default = Description

location both Specifies where in the zone the output list is displayed: top, bottom, or both, which
(location encloses the page zone content.

)

Output list Specifies the layout for the table of contents:

Type

(type) ® list — produces a vertical list, typical of a TOC.

* flat — produces a horizontal menu-type series of links, for example: [Heading 1]
[Heading 2] [Heading 3].

Display false Select to apply outline numbering to your headings, for example: 1.1, 1.2, 1.3.
Section

Numbering

(outline)



List Style
(style)

Heading
Indent
(i ndent)

Separator
(separ at
or)

Minimum
Heading
Level

(m nLevel

)

Max
Heading
Level
(maxLevel

)

Include
Headings
(i nclude)

Exclude
Headings
(excl ude)

Printable
(printab
| e)

CSS Class

Name
(cl ass)

Examples

none

brackets

1

true
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Specifies the style of bullet point for each list item. You can use any valid CSS
style. For example:

none — no list style is displayed

circl e --- the list style is a circle

di sc — the list style is a filled circle. This is the typical bullet list, and is the one
we're using for this example list

® squar e — the list style is a square

® deci mal —the listis numbered (1, 2, 3, 4, 5)

® | ower - al pha — the list is lower-case, alphabetized (a, b, c, d, €)

® | ower - r oman — the list style is lower roman numerals (i, ii, iii, iv, v, vi)

® upper - r oman — the list style is upper roman numerals (1, Il, lIl, IV, V, VI)

Sets the indent for a list output type, according to CSS quantities. Entering "10px"
will successively indent list heading levels by 10px. For example, h1l headings will
be indented 10px and h2 headings will be indented an additional 10px.

Only applies to the flat output type. Specifies the display style of the links. You can
enter any of the following values:

bracket s — Each item is enclosed by square brackets: [ ].

br aces — Each item is enclosed by braces: { }.

par ens — Each item is enclosed by parentheses: ().

pi pe — Each item is separated by a pipe:

anything — Each is separated by the value you enter. You can enter any text as
a separator, for example "***'_ If using a custom separator, be aware that text
displays exactly as entered, with no additional white space to further separate
the characters.

Select the largest heading level to start your TOC list. For example, 2 will list h2,
h3, and h4 headings, but will not include h1 headings.

Select the smallest heading level to include in the TOC. For example, 2 will list h1
and h2, but will not include h3 and below.

Filter the included headings according to specific criteria. You can use wildcard
characters. See Sun's Regex documentation for examples of constructing regular
expression strings.

Exclude headings according to specific criteria. You can use wildcard characters.
See Sun's Regex documentation for examples of constructing regular expression
strings.

By default, the TOC is set to print. If you clear this parameter, the TOC will not be

visible when you print the page.

If you have a custom TOC in your CSS style sheet, you can use this parameter to
output the TOC with the specified "class" attribute.
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The examples are based on a page with the following headings:

« Places
« Favourite Places
« Unknown Places
s Foods
« Favourite Foods
¢ Unknown Foods
e Things
« Favourite Foods
« Unknown Foods

Filtered Table of Contents

This example will filter all headings to include those that contain "Favorite", but will exclude any heading which
ends with the word "Things". The list is styled with upper-case Roman numerals.

Parameter Value
Output Type list
List Style upper - r oman

Include Headings @ Favourite.*

Exclude Headings . *Thi ngs

Screenshot: Filtered TOC zone' headings

|. Favourite Places
Il. Favourite Foods

Flat List

This example will filter all headings to render a flat list of "Unknowns" enclosed in square brackets.

Parameter Value
Output Type flat
Separator brackets

Max Heading Level @ 2

Include Headings = Unknown. *

Screenshot: Filtered TOC ‘zone' headings displayed as a flat list

[ Unknown Places ] [ Unknown Foods ] [ Unknown Foods ]

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.
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Macro name: t oc- zone

Macro body: Accepts rich text.

{toc-zone: printabl e=fal se| maxLevel =2| mi nLevel =2| | ocati on=t op| t ype=fl at | out | i ne=true| separ at or =pi pe}
Only headings within this block are included in the table of contents.
{toc-zone}

Notes

® Due to an outstanding issue in the Table of Content Zone macro (CONF-10619), the Macro Browser's Ref
resh function does not render any parameter modifications. Currently, the rendering of parameter value
modifications to the Table of Content Zone macro occurs only after the page is saved.

® Using HTML heading markup with the Table of Content Zone macro — The Table of Content Zone macro
cannot handle HTML heading markup on its own. Hence, if you used the HTML and HTML Include
macros to render HTML heading markup in a Confluence page, the Table of Content Zone macro will not
create a contents list out of these headings. (For more information on about this issue, please refer to TO
C-93))

However, if you insert an HTML anchor into each HTML heading on your page (based on the following
syntax), the Table of Content Zone macro will incorporate these headings into your contents list.

<h2><a nanme="pagenane- headi ngnane" ></ a>Headi ng Name</ h2>

The syntax for the anchor name is the page name and heading name separated by a hyphen. Remove
all spaces and convert all text to lower case. Convert all punctuation marks to their URL-encoded
equivalent.
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Task Report Macro

Use the Task Report macro to display a list of tasks on a page. Filter the

tasks by space, page, user, label, created date and more. On this page:
See Add, Assign, and View Tasks for more information on creating and * Using the Task
assigning tasks. You can also use the Task Report blueprint, which will Report macro
create a page and add this macro for you. * Parameters
Using the Task Report macro Related pages:

) ® Add, Assign, and
To add the Content Report Table macro to a page: View Tasks

1. From the editor toolbar, choose Insert © ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro
name, to see a list of suggested macros. In this example we're inserting the

cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit.
This will open the macro details, so you can edit the macro parameters.

Edit Remove

Task Report macro showing incomplete tasks, on pages with the label ‘meeting-notes".

Planning meeting actions
Description Due date - Assignee Task appears on
to finish creating the new project space by (7117 Jan 2018 17 Jan 2018 Cassie Owens Project plan
Schedule a follow up meeting on 130 Jan 2018 30 Jan 2018  Cassie Owens 2018-01-17
Meeting notes
Harvey Jennings distribute agenda for offsite (7108 Feb 2018 08 Feb 2018 Harvey Jennings  Project plan
Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter | Required Default Description

Space(s) No None Filter by the task location. The macro will only display tasks in
and Page the pages or spaces specified. You can enter a combination of
(s) spaces and pages.

(spaceAnd

Page)

Label(s) No None Filter by Label. The macro will only display tasks on pages with
(1 abel s) at least one of the specified labels (for example, 'label-a’ OR

'label-b"). Enter multiple labels, separated by a comma.
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Assigned No None Filter by Assignee. The macro will only display tasks assigned
to to the users specified.
(assi gnee
)
Created by ' No None Filter by Creator. The macro will only display tasks created by
(creator) the users specified.
Created No None Filter by created date. The macro will only display tasks created
after on or after the date specified. Date must be entered as dd- mm
(createdd YYVYY.
at eFron
Task Yes Incomplete = Show complete or incomplete tasks.
status
(status)
Number of  No 20 The number of tasks to display on each page of results in the
tasks to table. Choose from 10, 20 or 40.
display
(pagesSi ze
)
Display No description, | Columns to include in the table. Available columns include descr
columns duedate, iption, duedate, assignee, location, completedate and labels.
(col ums) assignee,

location
Sort by No Due date Sort tasks by due date, assignee or page title.
(sortBy)

Select the Reverse Sort check box to sort the table in reverse
order.

Wiki markup

Wiki markup is not available for this macro. You cannot add this macro via wiki markup.
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User List Macro

The User List macro displays a list of Confluence users, based on their group membership. The macro can also
indicate when users are online or offline.

(D The User List macro can be quite memory hungry in sites with lots of users. To prevent it causing out of
memory errors in your site, we don't show this macro if there are more than 10,000 people in the groups
specified. Your administrator can change this limit using the conf | uence. extra. userli ster.
I'imt system property.

Using the User List macro

To add the User List macro to a page:

1. From the editor toolbar, choose Insert = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter Default Description
Group(s) none Specify the group name. Specify multiple groups separated by a comma,
(groups) or use * to show all users in Confluence.

See this knowledge base page for more information about controlling
which users can see the details of other users.

Display Online All List online or offline users. Leave blank to show all users, irrespective of
[Offline Users registered status.
(online) users

Accepted values:
® Unspecified — The macro will show all registered users.

® true — The macro will show only online users.
* fal se —The macro will show only offline users.

Wiki markup example
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This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: userli ster
Macro body: None.

{userlister:groups=confl uence-users|online=fal se}
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User Profile Macro

The User Profile macro displays a short summary of a given Confluence user's profile. This is the same
summary that appears in a Hover Profile, which appears whenever you mouse over a user's name in the
Confluence interface.

Screenshot: Example of the User Profile macro

Leah Admin
sample@email.com.au

Updating Confluence documentation
Position:  Tech Writer

Department: Department of Awesome
Location:  Atlassian, Sydney

Using the User Profile macro

To add the User Profile macro to a page:

1. From the editor toolbar, choose Insert T ~ > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters
Parameters are options that you can set to control the content or format of the macro output. Where the

parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Default = Description

Username | none The username of the Confluence user whose profile summary you wish to show.
(user)

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in the
sidebar, header or footer of a space.

Macro name: profile
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Macro body: None.

{profile:user=adm n}
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View File Macro

The View File macros allow you to embed an Office or PDF document on a page. First attach the document to a
page and then use one of the View File macros to display the document's content.

When people view the page, they will see the content of the Office or PDF document. They do not need to have
Office installed in order to see the content of the file.

Displaying an Office or PDF Document in Confluence

To display an Office or PDF document in a page, use one of the following View File macros in the macro
browser:

Office Excel
Office PowerPoint
Office Word

PDF

To add one of the View File macros to a page:

1. From the editor toolbar, choose Insert = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the beginning of the macro name, to see a list of suggested

macros. In this example we're inserting the cheese macro.
{ che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro details, so
you can edit the macro parameters.

Edit Remove

Parameters for the Office and PDF macros

Parameters are options that you can set to control the content or format of the macro output. Where the
parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Macro = Parameter @ Default | Description

All Page Name The Enter a page name, if you wish to display a document which is attached
View page to another Confluence page.
File which
macros contains
the
macro
File Name | none The file name of the Office or PDF document to be displayed. The

document must be attached to a page on your Confluence site.

Office Show true Select to show grid lines around each cell of the Excel spreadsheet.
Excel Grid? Clear to hide these grid lines.
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Worksheet | Last
Name workshe
et
viewed
in the
spreadsh
eet

Last Row Last row

with
content
Last Last
Column column
with
content
Office Height
PowerP
oint Slide none
Number
Width

Editing a document

The name of the worksheet that you want displayed.

The number of the last row you want displayed, starting from '0' as the
first row.

The number of the last column you want displayed, starting from '0* as
the first column.

Hint for reducing the size of the spreadsheet: Use the Last Column
and Last Row parameters to reduce the size of the spreadsheet
displayed on the wiki page. This is especially useful to prevent the
display from showing empty cells. This will also help to prevent 'out of
memory' errors.

Specify the height of the display, in pixels (default) or as a percentage of
the window's height.

Specify the number of the slide that you want displayed on the
Confluence page, where the first slide is numbered zero. Instead of a
slide show, the page will display just the single slide, represented as a
JPEG image. If not specified, all slides display as a slideshow.

Specify the width of the display, in pixels (default) or as a percentage of
the window's width.

You can edit files embedded with the View File macro using your preferred desktop application, then save the
file back to Confluence automatically. Head to Edit files for instructions.

®* Word and Excel — choose the Edit button above the content.
® PowerPoint and PDF — choose the edit icon on the viewer.

Importing content from Word documents

If you want to use the contents of your Word document to create a Confluence page, see Import a Word

Document into Confluence.
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Widget Connector Macro

Embed online videos, slideshows, photostreams
and more directly into your page with the Widget
Connector macro.

On this page:

® Using the Widget Connector

The macro currently supports content from these ® Parameters
sites: * Examples
® YouTube

® YouTube ®* Vimeo

®* Vimeo ® Flickr

® Twitter * Twitter

¢ Google Calendar ® Google Calendar

® Google Docs * Troubleshooting

* Wufoo ® Some sites must be whitelisted

) ) ® Some content requires Flash

It can also display content from these sites, once * Wiki markup example
they have been added to the whitelist:

® Scribd

® Flickr (requires Flash)

® Slideshare (requires Flash)

[

Viddler (requires Flash)

Using the Widget Connector

To add the Widget Connector to a page:

1. From the editor toolbar, choose Insert + ~
> Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type { and the
beginning of the macro name, to see a list of
suggested macros. In this example we're inserting

the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro
placeholder and choose Edit. This will open the
macro details, so you can edit the macro
parameters.

Edit Remove

Parameters
Parameters are options that you can set to control the content or format of the macro output. Where the

parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro
browser, it will be listed below in brackets (exanpl e).

Parameter = Description
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Web Site's | This is the external site's URL. In some sites this will be the URL shown in the address bar
Widget of your browser, and in other sites you may need to click a Share or Link button to get the
URL URL.

(url)

Pixel The height of the display, in pixels.
Height

(value

Only)

(hei ght)

Pixel The width of the display, in pixels.
Width

(Value

Only)

(wi dt h)

Examples

Every site is a little different, so we've put together some info on what you'll need to do to embed each site's
content on a page.

YouTube

The fastest way to embed a YouTube video is to paste the URL into the editor. Confluence will autoconvert
the link and insert the macro for you, like magic. Autoconvert works with both long and short YouTube
URLs.

If you're pasting the URL into the Widget Connector macro URL field manually, you'll need to use the long
URL (from the address bar). Long URLSs look something like this ht t ps: / / www. yout ube. com wat ch?
v=k6l K5hl B1nQ

Atlassian Keynote in 7 minutes - Atlassian Summit 2014 <

¥ AtlassiansuMM|

e

W+ Watassiansummi
. +

® |f you're not able to see the video in some browsers, try using https rather than http in your
link.

® Links that contain a parameter to start a video at a particular time won't autoconvert or work in
the Widget Connector macro, like this link: ht t ps: / / www. yout ube. conf wat ch?t =15&v=L
hHKk odOPFo. Paste in the short sharing URL to be sure it works.
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Vimeo

The fastest way to embed a Vimeo video is to paste the URL into the editor. Confluence will autoconvert the
link and insert the macro for you.

You can use the URL from the address bar in your browser or the Share button in Vimeo.

Flickr

You can embed albums (formerly known as sets) and tags. You can't embed individual photos or user
photostreams.

You'll need to add the Widget Connector macro to the page first and then paste your link into the URL field.
Use the URL from the address bar in your browser.

The Widget Connector uses Flash to display this content. For security reasons, Flash is disabled in most
modern browsers.

fIiCI({‘f" « Atlassianexperience’s photostream

Twitter

To embed a single tweet you'll need to click the Copy link to tweet link on the tweet. The URL will look
something like htt ps: //twitter.com atl assi an/ st at us/ 346976521250037760.

Atlassian @ o

@ Atlassian

“Parents everywhere desire a better life for their children. It’s a
near constant. “ — John Wood #AtlassianFoundation
@RoomtoRead

3:50 AM - Dec 8, 2016

Q 12 2 See Atlassian's other Tweets

You can't currently embed a list of tweets, as Twitter has changed the way their widgets work.

A workaround for displaying a list of tweets is to enable the HTML Macro, and then use https://publish.twitter.
com/ to generate the embed code.

Google Calendar
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We don't autoconvert Google Calendars, so you'll need to add the Widget Connector macro to your page
first, and then paste the calendar address into the URL field.

You can only embed public calendars. To get your calendar's URL, in Google Calendar go to Calendar
Settings > Calendar Address and click the HTML button.

The URL will look something like this: ht t ps: / / www. googl e. conf cal endar/ enbed?sr c=en.
austral i an%®23hol i day%40gr oup. v. cal endar . googl e. com&ct z=Aust r al i a/ Sydney

Troubleshooting

If the Widget Connector can't display content from the external site, the macro will look like this:

We rely on the external website's APIs to display content in the Widget Connector macro. APIs do change
from time to time and this can cause the Widget Connector macro to stop rendering content.

If you experience problems, you can raise an issue about it to let us know.

Some sites must be whitelisted

The following sites need to be added to Confluence's whitelist before the macro can display any content.
This is due to the way we need to connect to that site.

Scribd
Flickr
Slideshare
Viddler

Some content requires Flash

The Widget Connector requires Flash for Flickr, Slideshare, and Viddler. This is blocked by most modern
browsers due to security concerns. We don't recommend you enable the Flash plugin in your browser.

Wiki markup example

This example is useful when you want to add a macro outside the editor, for example as custom content in
the sidebar, header or footer of a space.

Macro name: wi dget

Macro body: None.

{wi dget : hei ght =400| wi dt h=400] ur| =htt p: // yout ube. com wat ch?v=23pLByj _q5U}
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Your profile and settings

Confluence is very flexible — not only in the many ways you can create and

share content, but also in how you can tailor your own Confluence Related pages:

experience. Things like your profile picture, favorite spaces and pages, and * Watch Pages,
your personal space can say a lot about you, and can also make navigating Spaces and Blogs
Confluence much quicker and easier. Even a simple thing like adding * Create a Space
shortcut links to the sidebar of your personal space, can save you a lot of e Save for later

time in finding the things you use all the time.

Set up your personal space, and take a look at any of the pages below, to
start making Confluence feel like home.

Your User Profile

Change Your Password

Edit Your User Settings

Set Your Profile Picture

Choose Your Home Page

Save for later

View and Revoke OAuth Access Tokens



Your User Profile

Your user profile contains basic information about you, which other

Confluence users can see. It's also displayed to other users when they click

your name in the People Directory, if you haven't set up your personal space.

In your own profile, you can access account management features and
update information about yourself, like your name, email address, and pass .

word. You can also view other users' profiles.

Find your user profile

To find your user profile:

On this page:

Find your user
profile
Edit your user
profile
Notes

Related pages:

Choose your profile picture at top right of the screen, then choose Profile, or .
choose the Profile link in the sidebar of your personal space.

To find someone else's user profile:

Set Your Profile
Picture

Create a Personal
Space

Hover your mouse pointer over a user's linked name or profile picture and choose the user's linked name to
open their user profile. Alternatively, you can choose the Profile link in the sidebar of their personal space,

or go directly to this URL:

http://your.confluence.site/users/viewserprofile.action?user name=USERNAVE

Screenshot: User profile screen for the current user

Peaple

Cassie Owens

Profile Tasks Saved for later Watches Drafts Network Settings

Personal space

About Me

Hi there, I'm Cassie, Unfortunately | am
completley fictional. However, if | were a real live
person, | think I'd like to be a Tech Writer.

PROFILE

Picture

Activity
Pizza@2x.png
attached yesterday at 10:56 AM

E Teams In Space 2.0 - Stakeholder Update
updated yestarday at 10:08 AM « view change

B Get started in 5 steps
updated Jan 30, 2018 « view change

E Launch Pad Product Requirements

updated Jan 29, 2018 « view change
&) Cassie Owens

updated Jan 18, 2018

Cassie Owens

profile updated Jan 18, 2018

Personal
Full Name
Email
Phone
M

Website

Company

Position
Department

Location

Cassie Owens
cassie@email.com

+61 9811 2345

Tech Writer
Confluence Server

Sydney

# Edit profile

From your user profile, you can access the following:

Profile

® View and edit your personal details, such as your name and email address details and
optionally, your photograph and other personal information. Note that as a security
precaution, in order to change your email address, you will be required to re-enter your

password.
® Upload a profile picture (optional).
® Change your password.


https://confluence.atlassian.com/display/CONF74/Create+a+Space#CreateaSpace-personalspace
https://confluence.atlassian.com/display/CONF74/Create+a+Space#CreateaSpace-personalspace
https://confluence.atlassian.com/display/CONF74/Create+a+Space#CreateaSpace-personalspace
https://confluence.atlassian.com/display/DOCM/.Edit+Your+User+Profile+vOD-40
https://confluence.atlassian.com/display/DOCM/.Set+Your+Profile+Picture+vOD-40
https://confluence.atlassian.com/display/DOCM/Change+Your+Password
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Network
® View the recent activity of users that you are following via the Network view.
® Follow other users from this view.
Favorites
® View a list of your favorite spaces.
Watches
® View a list of the pages and spaces you are currently watching.
Drafts
® Retrieve any pages you were in the process of editing. See Working with Drafts.
Settings
® Edit your General Settings (homepage, language and timezone).
® Subscribe to email notifications.
* View and revoke your OAuth access tokens.
Edit your user profile

1. Choose your profile picture at top right of the screen, then choose Profile
Or, choose the Profile link in the sidebar of your personal space.

2. Choose Edit Profile.

3. Enter details about yourself in the form displayed.

4. Choose Save.

Fields in your user profile:

Detail

Full
Name

Email
Phone

IM

Websi
te

About
me

Positi
on

Depart
ment

Locati
on

Description

Your name as you'd like it to appear in your profile.

Your email address that will be used to send you mail notifications.

Your phone number.

Your Instant Messenger (IM) details.

@ To suit a variety of IM applications, this option accepts any string value. For example, you can
enter IM details in the form of an email address, or a user ID, like '123456789'.

Your website's URL.

Information about yourself that other users can view (such as your professional information,

hobbies, and other interests). You can use Confluence wiki markup in this field.

Your title or position within your organization.

The name of your department or team.

Your location. This can be your town, city, region or country.
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(® Handy Hint

Confluence administrators can configure Confluence to mask email addresses (e.g. 'example at
atlassian dot com'), protecting your email address from search engine spiders and the like.

Notes

The 'Administer User' link is visible to Confluence administrators only. The administrator can click this link to
go directly to the user management screen in the Administration Console.

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Change Your Password

There are two scenarios where you may want to change your Confluence
password:

® You're logged in, but you want or need to change your password
® You've forgotten your password and can't log in, so you need to reset

your password

From within Confluence

Change your password when you're logged in:

1.

e =@ Password

1.
2.

Choose your profile picture at top right of the screen, then choose Pr
ofile

On your Profile tab, click Password in the left-hand column

Enter your current password and your new password in the form
displayed

Click Submit

Creats

= 2 Confluence Sspaces v

Paople

People

Emma McRae

Profile Tasks Saved forlater Watches Drafts Network Settings

YOUR SETTINGS seﬁings
Site Homepage Site Default (Dashboard)
Email
Language Automatically detect browser settin.
Editor e " ¢

GADGETS

Find more language packs on the |l Atlassian Marketplace.

Time zone  Site Default ((GMT+1000) Sydney, Canberra, Melbourna)

View DAuth Access
Tokens

Text select Show option panel when text is selected

Edit

Location of Settings in the profile menu
Location of Password in the side bar

From the login page

Related Pages:

® Your User Profile
Set Your Profile
Picture

® Create a Personal
Space

Add personal space...
Recently viewad
Recently worked on
Profile

Tasks

Saved for later
Watches

Dirafts

Metwork

Settings o o

Atlassian Marketplace

Log Out

ts [does not apply to editor shartcuts). You can find a list of keyboard shortouts |

If you've forgotten your password and need to reset it, you can do so from the Confluence login page.
Choose the 'Forgot your password?' link and Confluence will step you through the process to reset your
password.

Don't see the Password option?

You may not be able to change your password directly in Confluence if your login credentials are coming
from another user directory, for example if Confluence is integrated with an LDAP directory or Jira for user
management.

Talk to your administrator about where you should change your password.
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Edit Your User Settings

If you want to make Confluence fit you, like a well-worn pair of sneakers,

you can set some preferences that will make you feel more at home:

Editor settings
Email settings for subscriptions to email reports.

user account.

General User Preferences

To edit your general user settings:

1. Choose your profile picture at top right of the screen, then choose S

ettings
2. Choose Edit and update the settings
3. Choose Submit

Setting Description
Site Homepage
Language Select your language. See below.

Time zone Select your time zone.

General preferences such as home page, language and time zone

OAuth access tokens that you have granted from your Confluence

On this page:

® General User
Preferences

®* More about
Language

® Editor Preferences

Related pages:

® Your User Profile

® Set Your Profile
Picture

® Create a Personal
Space

® Autocomplete for
links, files, macros
and mentions

Select the page that you would like to see whenever you log into Confluence.

Use Keyboard Shortcuts | Enable keyboard shortcuts, other than for the editor.

Text select Turn off the popup options panel when highlighting text.

Screenshot: Editing your user profile settings

! People

Emma McRae

Profile Tasks Saved forlater Watches Drafts Metwork Settings

YOUR SETTINGS SBttil'IgS
Password
Site Homepage | Site Default (Dashboard) H
Email
Editar Language = Automatically detect browser setti s
GADGETS Find more language packs on the [l Atlassian Marketplace

View OAuth Access

Tokans Time zone  Site Default ((GMT+1000) Sydney »

ard @ Enable
wortcuts Enabie

Text select Show option panel when text is selected

Submit  Cancel

More about Language

Setting your language preference in your user profile is described in the section above. This section gives
more information about that setting and other settings that affect the language Confluence will use.
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Individual users can choose the language that Confluence will use to display screen text and messages.
Note that the list of supported languages depends on the language packs installed on your Confluence site.

The language used for your session will depend on the settings below, in the following order of priority from
highest to lowest:

®* The language preference defined in your user profile. Note that you need to be logged in for this
setting to take effect.

®* The language that you choose by clicking an option at the bottom of the Confluence login screen.
Confluence stores this value in a cookie. When the cookie expires, the setting will expire too.

® The language set in your browser. The browser sends a header with a prioritized list of languages.
Confluence will use the first supported language in that list. Confluence administrators can disable
this option by setting the conf | uence. br owser . | anguage. enabl ed system property to f al se.

® The default language for your site, as defined by your Confluence site administrator.

Editor Preferences
You can set some options that determine the way the Confluence editor works. Note that these settings
affect only you. Other people using Confluence can enable or disable the settings on their user profiles
independently.
To change your editor preferences:

1. Choose your profile picture at top right of the screen, then choose Settings

2. Click Editor under "Your Settings' in the left-hand panel

3. Click Edit and make your changes
4. Click Submit

Setting Description

Disable Select to disable autocompletion when you press one of the trigger characters.
Autocomplete

Disable Select to disable autoformatting when you type wiki markup in the editor. Click ? on
Autoformatting the editor toolbar to learn more.

Screenshot: User settings for the editor

People

Emma McRae

Profile Tasks Saved for later Watches Draftz Metwork Settings

YOUR SETTINGS

Password

Editor Settings
Disable Autocomplete
Editar Disat

Email

lete in the Editor, whars it allows finks to be inserted with the trigger [ and images with the

GADGETS il
View OAuth Access Disable Autoformatting
Tokens

Submit Cancel
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Set Your Profile Picture

Your profile picture is used as the icon for your personal space, to represent
you in the People Directory, and to illustrate your comments. It also appears
in various other places next to your name, such as in the list of recent
updates on the dashboard.

Related pages:

® Your User Profile
® (Create a Personal

When you upload your profile picture, you can resize and reposition it to Space _
make sure it looks great. ® Your profile and
settings
@ This page is about Confluence Server and Data Center. If you use
Confluence Cloud head over here to see how to update your
personal profile.
Upload and adjust your profile picture:
1. Choose your profile picture at top right of the screen, then choose Pr
ofile
2. Choose Picture on the left
3. Choose Upload image > Upload an image
4. Locate and select the picture on your computer or file server
5. Adjust the size and position of your photo, then choose Save
Screenshot: Choosing a profile picture
People
Emma McRae
Profile Tasks Saved forlater Watches Drafts Network Settings
PROFILE
Picture Your profile picture is

Upload Image

used as the icon for
your personal space,
and to represent you
in Confluence.

Screenshot: Resize and position your profile picture
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Upload a profile picture

Upload an image

Cancel

You can't remove your own profile picture, but you can upload a new one any time. Alternatively you can
ask your admin to remove your profile picture for you.
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Choose Your Home Page

The dashboard is the default landing page when you log into Confluence. It
gives you easy access to what's happening in your site, and helps you get

back to pages you recently viewed and worked on.

You can choose to personalize your experience. and use an existing space

home page as your landing page.

To set your home page:

1.
ettings

Choose Edit

Choose an option from the Site Homepage drop down.
Only spaces you're allowed to view will appear.
Choose Submit.

Related pages:

® Your profile and
settings
® Your User Profile

Choose your profile picture at top right of the screen, then choose S

You'll be directed to your new home page the next time you log in. You can change your personal home

page at any time.

Alternatively, if your Confluence administrator has set a space home page as the landing page for the whole
site, you can choose Dashboard from the Site Homepage drop down to use the dashboard as your landing

page.

Screenshot: Profile Settings

People

Emma McRae

Profile Tasks Saved forlater Watches Drafts Metwork Settings

YOUR SETTINGS Settings
Password
Site Homepage Site Default (Dashboard) 5
Email
Editar Language = Automatically detect browser setti»
GADRETS nore language packs on the ) Atlassian Marketplace
\;r'c"::é:}s'*"'"" Accass Time zone  Site Default ((GMT+1000) Sydney &

Keyboard B Enable
teuts £ nA

Text select

Show option panel when text is selected

Submit  Cancel

@ You can access the dashboard at any time using the dashboard URL
/l'yoursite.conlw ki/dashboard. acti on.

. It'll look something like this: ht t ps:



Save for later

Saving pages for later helps you access them quickly from the dashboard or
from your profile.

No time to read that page now? No problem, hit Save for later and it'll be
waiting for you on the dashboard when you have more time. It's also a
great place to store those pages that you use on a day to day basis.

Save for later was previously called Favorites.

Save a page for later
To save a page for later, hit the Save for later button at the top of the page.

The star icon will change to dark grey to indicate the page is saved. Hit the
button again if you want to remove the page from the list.

Get back to your saved pages
To view your saved pages:

® Choose Saved for later on the dashboard sidebar.

On this page:

® Save a page for
later

® Get back to your
saved pages

® Choose your profile picture at top-right of the screen, then choose Saved for later — there's a list of

your saved pages, and the spaces that you've added to My spaces.

You can also use the Favorite Pages Macro to include a list of your saved pages on any page.

Screenshot: Viewing and removing saved pages from the dashboard

= & Confluence Spaces v People Create

E Recently worked on B Media assets

(® Recently visited
B Meet the SeeSpaceEZ Team

¢y Saved for later

MY SPACES ALL B Product Planning

W Devteam

DISCOVER —
Saved for later e

@ All updates

|~ Popular S

MY WORK B Team Sprint Calendar

E Teams in Space Finance Report

Remove
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View and Revoke OAuth Access Tokens

OAuth access tokens allow you to use a Confluence gadget on an external

web application or website (also known as the ‘consumer’) and grant this On this page:
gadget access to Confluence data which is restricted or privy to your
Confluence user account. * View your OAuth
Access Tokens
OAuth access tokens will only appear in your user profile if the following * Revoke your
conditions have been met: OAuth Access
Tokens
1. Your Confluence Administrator has established an OAuth
relationship between your Confluence site and the consumer. Related pages:
Confluence Administrators should refer to Configuring OAuth for
more information about establishing these OAuth relationships. ® Configuring OAuth
2. You have accessed a Confluence gadget on the consumer and have for Confluence
conducted the following tasks: Admins
a. Logged in to your Confluence user account via the gadget and
then,

b. Clicked the 'Approve Access' button to allow the gadget
access to data that is privy to your Confluence user account.
@ Confluence will then send the consumer an OAuth ‘access
token', which is specific to this gadget. You can view the
details of this access token from your Confluence site's user
account.

An OAuth access token acts as a type of 'key'. As long as the consumer is in possession of this access
token, the Confluence gadget on the consumer will be able to access Confluence data that is both publicly
available and privy to your Confluence user account. As a Confluence user, you can revoke this access
token at any time. Furthermore, all access tokens expire after seven days. Once the access token is revoked
or has expired, the Confluence gadget will only have access to publicly available Confluence data.

View your OAuth Access Tokens
To view all of your Confluence user account's OAuth access tokens:
1. Choose your profile picture at top right of the screen, then choose Settings
2. Click View OAuth Access Tokens. A view similar to screenshot below is displayed. Refer to OAuth

Access Token Details below for information on interpreting this table.
@ If no access tokens have been set, then 'None specified' is shown.

Screenshot: Viewing your OAuth Access Tokens

Authorised Applications
The following applications are using your account to access Confluence data

Consumer Consumer Description Issued on Actions
Atlassian JIRA  Atlassian JIRA at http://fjira.atlassian.com  Oct 30, 2017 expires in 1,730 days  Revoke Access

OAuth Access Token Details

Your list of OAuth access tokens is presented in a tabular format, with each access token presented in
separate rows and each property of these tokens presented in a separate columns:

Column Description
Name

Consumer = The name of the Confluence gadget that was added on the consumer.
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Consume
r
Description

Issued
On

Expires
On

Actions

A description of this consumer application. This information would have been obtained from
the consumer's own OAuth settings when an OAuth relationship was established between
Confluence and that consumer.

@ If the consumer is another Atlassian application, this information is obtained from the Consu
mer Info tab's 'Description’ field of the OAuth Administration settings. The application's
administrator can customize this Consumer Info detail.

The date on which the OAuth access token was issued to the consumer by Confluence. This
would have occurred immediately after you approved this gadget access to your Confluence
data (privy to your Confluence user account).

The date when the OAuth access token expires. This is seven days after the 'Issued On'
date. When this date is reached, the access token will be automatically removed from this list.

The functionality for revoking the access token.

Revoke your OAuth Access Tokens

To revoke one of your OAuth access tokens:

1. View your Confluence user account's OAuth access tokens (described above).

2. Locate the Confluence gadget whose OAuth access token you wish to revoke and click Revoke
OAuth Access Token next to it.
The gadget's access token is revoked and the Confluence gadget on the consumer will only have
access to publicly available Confluence data.

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Collaboration

Confluence is all about encouraging team collaboration to get the best
results, so we've built in a number of ways you can notify other people
about content that may be of interest to them.

You can:

® Work together with your team on a page or blog and see their
changes in real time

® Share a link to a page or blog post via email

® Mention a user when you write a page, blog post, comment, or add a
task

® | ike a page, blog post or comment

Whenever you mention another user, they'll receive an email notification; if
you like a page, blog post, or comment, the author will be notified that you like
the content.

Other users can also find out about changes to content in Confluence by wat
ching pages and spaces.

Another way to share Confluence content is by exporting it to other formats s
uch as XML, HTML, Microsoft Word and PDF.

Related pages:

® Pages and blogs

® \Watch Pages,
Spaces and Blogs

® Export Content to
Word, PDF, HTML
and XML



Network Overview

You can Create a network of users who are important to you, to make sure

you're always up-to-date with their Confluence activity. You might want to On this page:

follow your boss or teammates, to see what they're working on, or whoever

creates the most entertaining blog posts. * Follow another user
® Access your

When someone's part of your network, you'll be able to see when they: network view
* Notes

® Add or edit pages or blog posts

® Comment on a page or blog post or edit existing comments Related pages:

® Update their user profile

® Network Macro

® Subscribe to a
Network RSS Feed

Follow another user ® Email Notifications

You can follow another user by using either their Hover Profile or your
Network view.

To follow a user with their Hover Profile, hover your mouse over their
profile picture when it appears in a page and choose Follow.

To follow a user from your Network view:
1. Choose your profile picture at top right of the screen, then choose Network
Alternatively, choose More in the Network section of your profile sidebar.
2. Search for and select the user in the Following field
3. Choose Follow
If you now refresh or revisit your Network view, the profile picture(s) of the user(s) you just followed will

appear within the Following list on the right. Their tracked activities will also start appearing in the Recent
Activity list.

Access your network view
If you want to see what's been happening in your network, access your network view as described above.
You can access another user's Network view using the Hover Profile by choosing More > Network Page.

Screenshot: Example of the Network view

* People

Cassie Owens

Profile  Tasks Saved for later ‘Watches Drafts Network Settings

Recent activity of the users you are following '8 Following
Emma McRae People you're following
B Teams In Space 2.0 - Stakeholder Update updated Jan 31, 2018 » view wa ?
change Ser
Emad Abdi
Iser name Faollow
B Teams In Space 2.0 - Stakeholder Update updated Jan 31, 2078 - view
change
Emma McRae Followers
B 2018-01-18 Meeting notes updated Jan 31, 2018 + view change People following you
B} Team playbook update: customer interviews commented Jan 29, 2018 6

) Team playbook update: health monitor co

user-avatar profile picture updated Mov 23, 2017

pdl Emad Abdi
user-avatar profile picture updated MNov 23, 2017

Notes
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® RSS feeds: you can subscribe to any Confluence user's network RSS feed and receive summaries
on the activities of other users they're following in their network. See Subscribe to a Network RSS
Feed.

® Email notifications: you can request email notifications of any activity in your network. See Email
Notifications.
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Likes and Popular Content

Has someone written a good blog post or page on Confluence? Or made a
comment you agree with? Click the Like > button to them know.

When you like a page, blog post or comment, the author of the content

receives a natification. If enough people like the content, it'll appear on the P
opular tab of the dashboard.

Disabling the 'like' feature
The like functionality is provided by a system app called the 'Confluence

Like Plugin'. To remove the like functionality from your site, Disabling and
enabling apps.

Disabling notifications when your content is 'liked'
There are two ways to turn the 'someone likes your page' notifications off.
Do either of the following:

® Open an email notification of a like, and click Manage Notifications

® Goto<your confluence URL>/plugins/likes/view
notifications.action

On this page:

® Disabling the 'like’
feature

¢ Disabling
notifications when
your content is
'liked'

Related pages:

® The dashboard
® Email Notifications
® Network Overview
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Mentions

Mentions (often known as @mentions) are a useful way of drawing

someone's attention to a page or comment, or assigning a task to them. Related pages:

When you mention a user, they'll receive a notification by email and in their ® The Editor
workbox; if you mention them in a task, the task is assigned to them and * Autocomplete for
appears in their tasks list. links, files, macros

and mentions
There are two ways to mention someone: using autocomplete, or via the ® Keyboard shortcuts
Insert menu in the editor toolbar. e \Workbox

Notifications
Use autocomplete

To mention someone using autocomplete, type '@' in the editor then start typing their name. Choose the
person you want to mention from the list of suggestions.

Confluence will suggest people you've mentioned previously (after yourself, of course).

The best person to contact is @|

Cassie Owens

cassie

Harvey Jennings
harvey

Jessie Emmerson
jessie

Alana Grant
agrant

Emma McRae
emma

D & & o

It then continues to suggest matches as you type. If you've not mentioned the person recently, we'll also
include information about whether they've commented or contributed to the current page, to help you find the
right person, fast.

The best person to contact is @ Emm|

G’ Emma McRae
emma
Jessie Emmerson
jessie - Commenter

()
@ Emmett Paris

emmeatt

Emma MacDonald
emmmam

Use the Insert menu

If you'd rather use the Insert menu, choose Insert > User Mention then search for and select the user you
want to mention.
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Notes

Disable mentions — The functionality is provided by a plugin called the '‘Confluence Mentions Plugin'.
If you need to remove the user mention functionality from your site, you can disable the plugin. See Di
sabling or Enabling a Plugin.

Mentioning groups — You can only mention individual users who have the 'Can Use' Confluence
global permission. There's a feature request to allow mentions for groups:

] CONFSERVER-23015 - Extend 'Mentions' to work with groups as well FUTURE CONSIDERATION

Link to a user profile — You can use a square bracket '[' and a person's name to trigger Confluence
autocomplete and link to a person's user profile or personal space. Confluence will send the person a
notification just as if you had used @mention (unless the administrator has disabled the user mention
feature).

Mention notifications - A notification is sent to a person the first time you mention them in the
content of a page, but not for subsequent mentions. If you need to catch someone's attention, and
you've already mentioned them on the page, try mentioning them in a comment. A notification is sent
every time you mention someone in a page comment or inline comment, not just the first time.
Frequently mentioned people - Confluence relies on your browser's local storage to remember the
people you mention regularly. You may see different results if you switch devices, or don't allow local
storage. Confluence doesn't indicate whether someone is a creator, contributor or commenter when
they are also a recent mention (because we're grabbing them straight from your local storage, not the
page itself).

Changing the mention name - if you change the mention name in the editor (for example you
backspace to remove their surname, or edit the mention link to change their full name to their
preferred name) this will be treated as free text and won't be updated if the person changes their
name, or is deleted from Confluence.

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Share a Page or Blog Post

Use the Share button when viewing a page or blog post to email anyone a

link to that page or blog post. You can either grab the short URL from the

Related pages:

share dialog, or enter a Confluence user, group or email address.

To share a page or blog post by email:

ok

1. Go to the page or blog post you wish to share.
2.

3. Enter a username, group or email address, and select the
appropriate user, group or email address from the list of suggestions.
Repeat this process to add multiple recipients to the list (or use the

Choose Share.

trash icons to remove people from the list).
Enter an optional message.
Choose Share to send the link via email.

In addition to an email, Confluence users will also
receive a notification in their Confluence workbox.
See Workbox Notifications.

You can also share pages from inside the editor. Hit

the T button in the editor to invite people to edit
the page with you.

Notes:

The option to add people is only available if
your site has a mail server configured.
Sharing or inviting someone to edit a page or
blog post does not automatically grant any
permissions - they will still need the
appropriate Confluence permissions to
access Confluence and view or edit the

page.

®* \Workbox
Notifications

® Create and Edit
Pages

® Blog Posts

® Configuring a
Server for
Outgoing Mail

® Space Permissions
Overview

© Watching 2 Share see

Share this page

Share link

https://yoursite.com/x/w4BC Copy
Add people

) Alex Yakoviev W
g marketing [ ]

Include a message

I've made some edits to this page.
Could you please review?

Share Cancel
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Comment on pages and blog posts

Comments are a great way to bring others into the conversation about a
page or blog post. They allow you to remark on content, add important
information, ask questions, and generally drive collaboration and teamwork.

You can add a comment at the bottom of any page or blog post, or add an in
line comment by highlighting specific text on the page. °

Add a page or blog post comment

On this page:

Add a page or blog
post comment
Add an inline
comment

Resolve inline
comments

® Rich comments

1. Type your comment in the comment field at the bottom of the page ® Link to a comment
2. Optionally, choose Preview to see how your comment will appear ¢ Commept
3. By default, Watch this page is ticked (This means you'll start permissions
receiving notifications about the page. Uncheck it if you don't want to * Notes
watch the page.)
4. Choose Save (Ctrl+S or +S) Related pages:

[}
Other users can reply and/or like your comment, and you or a space

administrator can edit your comment(s).

Create and Edit
Pages

®* Blog Posts

® Share and

Add an inline comment

1. Highlight the text you want to comment on

2. Choose the add comment » button that appears above the highlighted text
3. Type your comment and choose Save (Ctrl+S or +S)

Comment on Files
Share a Page or
Blog Post

The selected text will appear with a yellow highlight indicating an inline comment; choose any highlighted

text on the page to display the related comment(s).

Just like page and blog post comments, others can reply to, or like, your inline comments, and you'll be

notified when they do.

with one click you can start X
omment is about. The page's
keep your project moving. Text

42 Giles Brunning

e comment and any replies. Hi Rachel,

of page comments in inline Can you check the wording on this
ed the JIRA issues macro. very important press release?

nd the conversation is stored It must go out, urgently!

any resolved comments if you .
Here's a link to the product page.

o the text you highlight rather

Resolve inline comments
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Hit Resolve to hide a set of inline comments once the conversation's finished. If you want to view resolved

comments, choose *** > Resolved comments; to reopen a resolved comment, choose Reopen at the
bottom left.

Rich comments

Inline and page comments might look simple, but they support rich text (like bold, underline, and italics), bull
eted and numbered lists, links, and @mentions. You can also drop images into any comment, to really
illustrate your point.

Link to a comment

You can link directly to a comment on a page. See Links for more information.

G} If you don't see a popup when you highlight text, check that Text Select is enabled in your profile
settings.

Comment permissions

® Add a comment — You need the 'Add Comments' permission in the space.
Edit a comment — You need the 'Add Comments' permission. Space administrators can edit all
comments within their space. The date on a comment always indicates the time the comment was last
edited.

® Delete acomment — You need the 'Remove Comments' permission. Deleted comments cannot be
restored. If you don't have the 'Remove Comments' permission, you can delete your own comments,
but only if there are no replies to your comment.

® Disable comments — If you don't want comments in a particular space, remove the '‘Add Comments'
permission from the 'confluence-users' or 'users' group, anonymous users and all other users and
groups. The option to add comments will no longer appear on pages or blog posts in that space.

See Space permissions for more information. There is no permission that controls comments across the
entire site.

Members of the Confluence-administrators group can add, edit and delete comments, even if you remove
their comment permissions in the Space permissions configuration.

Notes

® Choose Watch at the top-right of the page to receive an email notification whenever anyone edits or
adds a comment to the page.

® On blog posts only, an 'Author’ lozenge will appear on any comments made by the original author of
the post.
It's not possible to delete all comments on a page simultaneously, or change the order of comments.
Inline comments on text that is included on a page using the Include macro or Excerpt include macro
won't be visible. They are only visible on the original page.
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Watch Pages, Spaces and Blogs

You can 'watch' a Confluence page, blog post or space. Confluence will
then send you a notification email whenever anyone updates your watched
content.

You'll receive email notifications for:

® Page / blog post edits (unless the author clears the 'Notify watchers'
check box).

¢ Deletions.

® Attachments, including new versions or deletions of an existing
attachment.

® Comments, including new comments or deletions of existing
comments.

By default, Confluence will assign you as a watcher of any page or blog
post that you create or edit. This behavior is called '‘autowatch'.

There's no daily digest for email notifications. You'll receive immediate
emails for important notifications (like mentions and new pages), but when
lots of changes are being made at the same time, you'll only receive a
single email with all the changes (within a 10 minute window).

You will not receive email notifications for content changes due to the
output of a macro, because the page content itself hasn't been edited. We
also don't send a notification when a comment is edited.

You need 'View' permission for the page, blog post or space to receive
notifications.

Watching a page or blog post
To start watching a page or blog post:

1. Go to the page or blog post.
2. Choose Watch and select the relevant check box.

To stop watching the page or post, deselect the relevant check box.

Watching an entire space

You can choose to watch all the pages and blog posts in a particular space.

On this page:

Watching a page
or blog post
Watching an entire
space

Watch for new blog
posts in a space
Watch all spaces
on the site
Watching for all
new blog posts on
the site

Manage watches
from your user
profile

Manage watches
from the email
message
Autowatch and
other notification
options

Related pages:

Manage Watchers
Email Notifications
Your User Profile

The quickest way is to use the Watch option on a page or blog post, as described above.

To stop watching the space, deselect the relevant check box.

Alternatively, choose Pages in the space sidebar, then choose Watch this space at the top right.

Watch for new blog posts in a space

You can choose to receive a notification whenever someone adds a blog post in the space. You will not

receive notification when a blog post is updated, deleted or commented on.
To watch for new posts:

1. Go to a blog post in the space.

2. Choose Watch and select Watch for new blog posts in this space.

To stop watching for new blog posts, deselect the relevant check box. Alternatively, choose Blog in the

space sidebar, then choose Watch this blog at the top right.
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Watch all spaces on the site

You can receive natifications about changes to the content of pages, blog posts and comments from all
spaces on a Confluence site.

To start watching for content changes across the whole site:
1. Choose your profile picture at top right of the screen, then choose Settings
2. Choose Email.

3. Choose Edit then choose Subscribe to daily updates.
4. Choose Submit.

Watching for all new blog posts on the site

You can choose to watch for all new blog posts in all spaces on the Confluence site. You will not receive
notification of updates to or deletions of blog posts, nor of comments on the blog posts.

To start watching for all new blog posts:
1. Choose your profile picture at top right of the screen, then choose Settings
2. Choose Email.

3. Choose Edit then choose Subscribe to all blog posts.
4. Choose Submit.

Manage watches from your user profile
The 'Watches' page in your user profile displays a list of all pages and spaces you are currently watching.
To manage your watches:

1. Choose your profile picture at top right of the screen, then choose Watches.
2. Choose Stop Watching for any unwanted spaces or pages.

Manage watches from the email message

The email notifications that you receive from Confluence have some useful links at the bottom of the email
message. The links in each message vary, depending on the context. In general, the links allow you to view
the page online, reply to a comment, and so on.

In particular with respect to setting your notification preferences, you will see one or more of the following
links:

® Stop watching page — Click this link to stop watching the page that triggered the email notification.

® Stop watching space — Click this link to stop watching the space that triggered the email notification.

® Stop following this user — Click this link to stop following the user whose update triggered the email
notification.

® Manage Notifications — Click this link to go to the email settings page in your user profile.

Screenshot: Example email notification footer showing links

¢ Reply - ¢ Like

Stop watching space = Manage Motifications

Autowatch and other notification options
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By default, Confluence will assign you as a watcher of any page or blog post that you create or edit. This
behavior is called 'autowatch'. You can turn autowatch on or off, and set other notification options, in the
email settings section of your user profile. See Edit Your User Settings.
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Manage Watchers

As a space admin, you may want to control who's notified about changes

and updates to pages and posts within a space. You'll do this by managing Related pages:

the watchers of specific pages and posts, or of the entire space. * Watch Pages,
Spaces and Blogs

Take the example of a new member starting on your team, who should see ® Email Notifications

when changes are made in the team space — you can add them as a space

watcher so they get updates when any page or post in the space is ® Your profile and

changed. If someone no longer needs to be notified, you can remove them settings

as a watcher just as easily.

To manage the watchers of a page or blog post:

1. Go to the page or blog post for which you want to manage the watchers
2. Choose Watch > Manage Watchers
The left-hand column of the 'Manage Watchers' dialog shows the users watching the page or blog
post. The right-hand column shows the users watching the space.
3. Do either of the following:
® Add someone as a watcher of the page, post, or space — type their username in the relevant
search box and hit Add
® Remove an existing page, post, or space watcher — choose the trash icon next to their name

Manage Watchers Hely
Watching this page Watching this space
These people are notified when the page is changed. These people are notified when any content in the space is
changed.
Add
Add

i Gil Admin (gbrunning)

ﬁ Gil Admin (gbrunning]

)

Clost




Email Notifications

You can 'watch' a page, blog post or space. Confluence will then send you
a notification by email whenever anyone adds or updates content on that On this page:
page or space. You'll receive immediate emails for important notifications
(like mentions and new pages), but when lots of changes are being made at
the same time, you'll only receive a single email with all the changes within
a short window (usually 10 minutes).

® Subscribing to
email notifications
® Notes

You can also subscribe to daily email reports and other notifications of

various updates, as described below. Related pages:

® Watch Pages,

Ypu'll only receive notifications for content that you have pgrmission t_o Spaces and Blogs

view. Usgr_s th_at have been disabled by an administrator will not receive ® Subscribe to RSS

email notifications. Feeds within
Confluence

Subscribing to email notifications ® Your profile and
settings

You can subscribe to be notified when: ® Edit Your User
Settings

® A blog post is added or changed in a space that you have permission
to view.

® Someone you're following makes an update in a space that you have
permission to view.

® Someone follows you.

You can also subscribe to these summary reports:

® A daily report of the 30 most popular updates to all spaces that you
have permission to view.

® A daily or weekly report of recommended updates, in all spaces that
you have permission to view.

To edit your email notification settings:

1. Choose your profile picture at top right of the screen, then choose S
ettings

2. Click Email in the left-hand panel

3. Click Edit

Here's an explanation of all the email settings.

Setting = Description Content

Autowatch | Option: Do you want
Confluence to automatically ® Pages and blog posts that you create, edit or comment on.
add you as a watcher on
each page or blog post that
you add or update? If you
are a watcher of a page or
a post, you will receive
notification of future
changes.
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Subscrib
e to daily
updates

Subscrib
e to all
blog
posts

Subscrib
e to
network

Subscrib
e to new
follower
notificatio
ns

Notify on
my
actions

Receive daily email reports
showing changes to
content in all spaces that
you have permission to
view.

Note: Daily email reports
do not include information
about attachments on a
page or blog post that are
added, edited or deleted.
Up to 30 updates will be
included, sorted by
popularity.

Receive email notifications
for changes to blogs in your
Confluence installation that
you have permission to
view.

Receive email notifications
for changes to content by
all users that you are followi
ng, which you have
permission to view.

Receive an email message
when anyone chooses to
follow you.

Option: Do you want to
receive email notifications
for your own changes?

Note: If you have not
subscribed to any email
notifications and are not
watching any pages
/spaces, then selecting
'‘Notify on my actions' will
not do anything.

® Pages and blog posts that are added, edited or deleted.

® Comments on a page or blog post that are added, edited or
deleted.

® Updates by users who have changed their personal profile.

® Blog posts added, edited or deleted.

® Space is created.
® Page or blog post is created.

* All pages and spaces that you are watching.
® This affects all subscriptions set.
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Show
changed
content

Subscrib
eto
recomme
nded
updates

Notes

Option: Do you want your
notifications to include
details of the changes
made to the content?

® If you do not select this
option, your
notifications will include
only the title of the
page, and any
comment the author
made when updating
the page.

® |f you do select this
option, your
notifications will show
the differences between
the current and
previous versions of the
page. See Page History
and Page Comparison
Views.

Receive a daily or weekly
email message showing
the top content that is
relevant to you from spaces
that you have permission to
view.

How do you set the
frequency of the mail
message? A link in the
email message allows you
to choose daily or weekly
notifications.

How do you enable and
disable the notification?
You can turn off the
notification by clicking a link
in the email message. You
can also turn the
notification on or off by
setting the 'Subscribe to
recommended updates'
option in your user profile.

® Edits to pages and blog posts.

Confluence chooses the content to display, based on:

® Pages and blog posts that people have recently liked.

® Pages and blog posts that people have recently commented
on.

®* Pages and blog posts that have recently been created.

'Recent’ means any activity that occurred since the last
recommended updates message was sent to you.

The activities are listed in order of popularity, with the most
popular at the top. Likes, comments and content creations are
scored equally. Activity that involves people in your network rank
s higher than activity not involving your network. Content from
My spaces also ranks higher than content in other spaces. The
recommended updates summary does not include any content
that you created yourself, and it gives a lower ranking to content
that you have participated in, for example by adding a comment
or updating the page.

If there is no activity to report, Confluence will not send the
email message.

® Mail server: To enable Confluence to send email notifications, a System Administrator must configure
an email server. See Configuring a Server for Outgoing Mail.

® Batching window: System Administrators can change the batching window for changes and
comments on the same page or blog post in the Send batched notifications scheduled job. Increase
the time for fewer emails or reduce the time if more immediate notifications are essential in your site.

® Recommended updates email: Confluence Administrators can set the default options for
the recommended updates notification.

Choose the cog icon E then choose General Configuration

. Click Recommended Updates Email in the left-hand panel. See Configuring the Recommended
Updates Email Notification.
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®* Email threading: Confluence will attempt to group all the email notifications about changes to a
specific page together. Other notifications such as sharing a page, requesting access to a page, or
recommended updates emails are intentionally not grouped. Not all mail clients support email
threading, and different email clients use different methods for threading emails. We've tested
Confluence's email threading with Apple Mail 10.3, Outlook 2011, Outlook 2016, GMail, Google Inbox

and Outlook.com.

() Do more with Confluence

Take your Confluence notifications to the next level with these email notification apps on the Atlassia
n Marketplace:

® Notifications - ScriptRunner for Confluence: Manage Confluence notifications more easily,

with greater control and customization
®* No Email Storm - change the behaviour of the Notify Watchers checkbox in the editor
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Subscribe to RSS Feeds within Confluence

An RSS feed is a format for delivering summaries of regularly changing web
content. Subscribing to an RSS feed allows you to stay informed of the On this page:
latest content from sites that you are interested in.

RSS is not designed to be read in a regular web browser. Specialized RSS * Confluence RSS

newsreader programs can check RSS files every so often, and tell you N Esr?w?)ve an RSS
what's new on a site. Your reader may be on a website, a browser feed

extension, part of your email program, or a stand-alone program.
Confluence generates its own RSS feeds for tracking updates to content Related pages:
within Confluence. You will need an RSS reader which can grab the RSS * \Watch Pages,

feeds from Confluence and display them for you. Spaces and Blogs

. ® RSS Feed Macro
Confluence's RSS macro allows you to display the contents of an RSS feed

on a Confluence page. The feeds may come from a Confluence feed
generator or from external sites. In this way, Confluence can act as an RSS
reader.

Confluence RSS feeds

RSS feeds allow you to track updates to content within Confluence. You will need an RSS newsreader to
read a feed.

You can create a customized RSS feed using the RSS Feed Builder or subscribe to one of the pre-specified
feeds generated by Confluence.

What would you like to do?

® Create and subscribe to customized RSS feeds using the RSS Feed Builder — Create a customized
RSS feed. For example, you can filter your feed using a label, specify the number of items and days
to include in your feed, and so on. )

® Subscribe to pre-specified RSS feeds il — Generate an RSS feed automatically in a minimal number
of steps.

® Subscribe to a feed of any Confluence user's network — Track the activities of users the selected
person is following.

Remove an RSS feed
There is no need to try to delete or remove an RSS feed built by the Confluence RSS feed builder.

Explanation: The feeds generated by the RSS Feed Builder are dynamically generated via the parameters
included in the feed URL (address). For example, take a look at the following feed URL.:

http://confl uence. atl assi an. cont cr eat er ssf eed. acti on?t ypes=page&sor t =nodi fi ed&howCont ent =t r ue. . .

The above feed URL will generate a list of pages (‘types=page’), sorted by the modification date and
showing the page content. The feed is generated at the time when the URL is fetched and there is no RSS
feed information stored on the database. For that reason, there is no need to remove anything.



Subscribe to pre-specified RSS feeds

This page tells you how to get hold of an RSS feed which Confluence has

predefined for you. Related pages:

® The RSS Feed

To subscribe to predefined RSS feeds for a particular space: Builder
® RSS Feed Macro
1. Go to the space and choose Space tools > Content Tools from the ® Network Overview

bottom of the sidebar

2. Choose RSS Feeds

3. Copy and paste the link for one of the feeds into your RSS
newsreader

Feeds include:

® Pages ® Comments
* Blog ® Attachments
®* Mail ® All content

To subscribe to predefined RSS feeds for a particular page (where available):

Note that the word 'page' here means a part of the Confluence user interface, rather than a page that
contains Confluence content. For example, your Network view offers an RSS feed.

1. Go to the page

2. Locate the following icon, which is available in the top-right corner of certain pages: W
3. Copy and paste the icon's link into your RSS newsreader

Notes

The predefined RSS feed will return no more than 10 entries within the last 5 days, if you want to customize
your Confluence RSS feed (for example, use a label to filter your feed), use the RSS Feed builder instead of
the above instructions.



The RSS Feed Builder

Using the RSS feed builder, you can create customized RSS feeds to
subscribe to changes within Confluence.

Wondering what an RSS feed is? See more information about RSS Feeds.
On this page:

Build an RSS feed
® Build an RSS feed
Follow the steps below to build your feed, choosing the type of content and * Notes
the time period you want to monitor.
Related pages:

To create a customized RSS feed:
® Watch Pages,

- Spaces and Blogs
1. Choose the help icon at top right of the screen, then choose Fe . SEbscribe to RSgS
ed Builder _ Feeds within
2. Select the content types you want in your feed Confluence

Check Mail if you want to know when the email archive is updated.
(See the overview of mail archives in Confluence.)

3. Select one or more spaces from the list

4. Click Advanced Options to set the following:

Option = Description

Feed The default name is based on the name of your

Name Confluence installation. For example, 'Extranet RSS
Feed'.

With Enter one or more labels separated by spaces or

these commas. Confluence returns all content (of the selected
labels types) that matches one or more of the labels. See the h
int below about using labels to customize your feeds.

Exclud = Exclude specific spaces from those already selected.
e

these

spaces

Sorted @ Sort content by either the date or creation or the date
by they were last updated.

Limitto Specify the number of items returned in your feed.

Within Specify how old items returned can be.
the last

Include | Specify whether the entire page is displayed in the feed.
content

for

pages

5. Choose Create RSS Feed
6. Drag or copy the link into your RSS reader

Hints

® Separate feeds. Try building separate feeds, one for pages only and one that includes comments as
well. This allows you to monitor only pages if you are short of time, and to read the comments when
you have more time.
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® |abels to customize your feed. You can use the RSS feed builder to track updates to labeled pages

and comments on those pages. Here is an idea for customizing your RSS feed by using your own
personal label(s). This is useful if you want to track updates to specific pages or blog posts, and you
do not want to deal with emails. You can use this method as an alternative to watching pages.

® Build an RSS feed that returns pages, blog posts and comments labeled with a personal label,
such as 'my:feed".

® Each time you want to 'watch' a page, just label it with 'my:feed'.

® All updates and comments will automatically come through your RSS feed.

Notes

® Removing an RSS feed:

There is no need to try to delete or remove an RSS feed built by the Confluence RSS feed builder.

Explanation: The feeds generated by the RSS Feed Builder are dynamically generated via the
parameters included in the feed URL (address). For example, take a look at the following feed URL:

http://confluence. atl assi an. cont creat er ssf eed. acti on?t ypes=page&sort =nodi f i ed&howCont ent =t r ue. . .

The above feed URL will generate a list of pages (‘types=page’), sorted by the modification date and
showing the page content. The feed is generated at the time when the URL is fetched and there is no
RSS feed information stored on the database. For that reason, there is no need to remove anything.

Feed authentication options: Confluence can offer you the option of an anonymous feed or a feed
that requires authentication.
® An anonymous feed will show only the content that is visible to anonymous users. The feed
URL does not contain the &s_aut hType parameter mentioned below. This feed is useful
only if your Confluence site allows anonymous access. If a feed is anonymous, you only get
anonymously-viewable content in the feed regardless of whether you are a Confluence user or
not.
® An authenticated feed requires you to log in to Confluence before you can retrieve the
content. The feed URL contains the following parameter: &s_aut hType=basi c.
®* The option to choose between an anonymous and an authenticated feed is currently not
available on the feed builder screen. The feed builder offers only authenticated feeds. See CO
NF-21601 for details and a workaround.

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/
http://jira.atlassian.com/browse/CONF-21601
http://jira.atlassian.com/browse/CONF-21601

Subscribe to a Network RSS Feed

You can create an RSS Feed from any user's network view, allowing you to

receive summaries on the activities of users they are following in their On this page:
network. The types of activities tracked in these RSS feed summaries
include: ® Subscribe to a
user's network feed
® Additions or edits to pages or blog posts ® Customize your
* Comments added to a page or blog post or edits to existing network RSS feed
comments ®* Notes

® Updates to a user's profile
Related pages:

Subscribe to a user's network feed e Network Overview
® Subscribe to RSS
To subscribe to a user's network RSS feed: Feeds within
Confluence
1. Locate the RSS icon i, which is available from the top-right of: ¢ Your profile and
® The 'Recent activity of the users you are following' section of settings

your network page, or
® The 'Activity of followed users' section of another user's
network page.
2. Copy and paste the icon's link into your RSS newsreader

Customize your network RSS feed

Confluence does not provide a way of customizing a network RSS feed via the user interface. However, you
can modify the maximum number of results and type of content displayed in these feeds by directly editing
the RSS feed link in your RSS newsreader.

To modify the maximum number of results displayed in your RSS feed:

1. Edit the RSS feed link in your RSS newsreader.

2. Change the value of the max parameter from its default value of 40 to a value of your choice.
Example:
http://confluence.atlassian.com/feeds/network.action?
username=MYNAME&max=60&publicFeed=false&os_authType=basic&rssType=atom

3. Save the modified link in your RSS newsreader.

To modify the type of content displayed in your RSS feed:

1. Edit the RSS feed link in your RSS newsreader.
2. Append the parameter cont ent Type to the end of the link, followed by an equals sign (=) and then
add the appropriate content type value of your choice:

PAGE — restricts the RSS feed to page additions or updates.

BLOG— restricts the RSS feed to blog post additions or updates.
ATTACHVENT — restricts the RSS feed to attachment additions or updates.
COMMVENT — restricts the RSS feed to comment additions or updates.

Content type values are case-sensitive. Ensure that each parameter is separated from the other by an
ampersand (&).
Example:

http://confluence.atlassian.com/feeds/network.action?
username=ggaskell&max=40&publicFeed=false&os_authType=basic&rssType=atom&contentType=B
LOG

3. Save the madified link in your RSS newsreader.

Notes
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It is not possible to filter for more than one type of content by adding multiple values to the cont ent Type
parameter.
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Workbox Notifications

The Confluence workbox D displays all
notifications collected from Confluence page On this page:
watches, shares, mentions, and tasks. From your
workbox you can reply to comments, like a

® Manage your notifications
comment or page, watch a page, or open the ® Which notifications are included?
relevant page or blog post. ® Keyboard shortcuts
o ) o ® Manage natifications with Confluence
If your Confluence site is linked to a Jira application mobile
such as Jira Software or Jira Service Desk, you'll * Notes

also see notifications from your Jira application in

the workbox. Related pages:

Looking to manage your notification email ® Configuring Workbox Notifications
messages instead? See Email Notifications. ® Email Notifications

® \Watch Pages, Spaces and Blogs
Manage your notifications * Likes and Popular Content

1. Choose the workbox icon ﬂ in the header.
® A number will appear the workbox icon, to indicate the number of unread notifications waiting
for your attention.
® You can use the keyboard shortcut: Type g then n. (When in the Confluence editor, click
outside the editor before pressing the keyboard shortcut keys.)
2. Choose a notification from the list, to see the notification details. You can then:
® Open the related page, blog post, or comment.
® Like or Unlike the page, blog post, or comment.
® Watch or Stop Watching to receive notifications, or stop receiving notifications, about a page
or blog post.
® Reply a comment, without leaving the workbox.

Screenshot: Your Confluence notifications in the workbox
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Notifications
‘ (2 Emma McRae commented on Team playboo... >
'©] Alana Grant assigned a task on Where shoul... nut o »
(=] Emad Abdi shared Media assets sago  ?
= Ra a @ ¢ §f
=] Ra

¢{ Back to notifications

2 U

[&J

Team playbook update: customer interviews

(> 1 new comment on this page

Open - Stop Watching ' Like

E‘ Emma McRae commented on this
| think we should consider adding an example to the "craft an
interview script" section, to help people quickly understand

what we mean by open guestions.

just a moment ago - Cpen - Reply - Like

Which notifications are included?

The workbox displays a notification when someone does one of the following in Confluence:

® Shares a page or blog post with you.

® Mentions you in a page, blog post, comment or task.

® Comments on a page or blog post that you are watching.
® |ikes a page or blog post that you are watching.

The workbox does not show notifications triggered because you are watching a space. Only watches on
pages and blog posts are relevant here.

The notification in your workbox appears as ‘read' if you have already viewed the page or blog post.

If your Confluence site is linked to a Jira application, you will also see the following Jira notifications in your
workbox:

® Comments on issues that you are watching.
® Mentions.

® Shares of issues, filters and searches.

Keyboard shortcuts
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Shortcut = Action

gthenn Open the Confluence workbox.

j
k

Enter

Move down to the next entry in the notification list.

Move up to the previous entry in the notification list.

Move down to the next notification for a particular page or blog post.
Move up to the previous natification for a particular page or blog post.
Open the selected natification.

Return to the notification list after opening a particular notification.

Manage notifications with Confluence mobile

You can also view and respond to notifications on your phone or other mobile device. See Confluence Mobile
for more about mobile platforms.

Notes

Created in

Read notifications are automatically deleted after 2 weeks.

Unread notifications are automatically deleted after 4 weeks.

You cannot delete your notifications yourself.

If a new notification arrives while you have workbox open, the count appears on the workbox icon but
the notification is not added to the workbox. You need to close workbox and re-open it to see the new
notification.

The ability to receive notifications from Jira or another Confluence site is available in Confluence
4.3.3 and later. To receive Jira notifications, you need Jira 5.2 or later.

Administrators can enable and disable the workbox on your Confluence site. They can also connect a
Jira site or another Confluence site, so that notifications from those sites appear in your workbox too.
See Configuring Workbox Notifications.
The Confluence workbox is provided by a set of plugins. To remove the personal notifications and
tasks functionality from your site, you can disable the following plugins. See Disabling or Enabling a
Plugin for instructions. Disabling these plugins will disable the entire workbox . It is not possible to
disable only tasks or only notifications:

® Workbox - Common Plugin

® Workbox - Host Plugin

® Workbox - Confluence Provider Plugin
If you want to re-enable the plugins, do so in the following order: Common Plugin, Host Plugin,
Confluence Provider Plugin.
There is no option to disable the workbox for an individual user.
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Search

Confluence gives you a few ways to find what you're looking for. Here's an

overview of Confluence search, and a few tips to help you find things more On this page:
easily.

®* How Confluence
How Confluence search works search works

® Start a search
When you enter a search term, Confluence looks for content in all spaces ® Filter your search
(including personal spaces), pages, mail, personal profiles, and space results
descriptions. It also looks at the content of some attached file types (Word, ® Search for admin
Text, PowerPoint, Excel, PDF, and HTML). options

® Advanced search
Search results are based on your Confluence permissions, so you'll only ® Advanced search
see content you're allowed to view. syntax

Related pages:

® Confluence Search
Syntax

® Confluence Search
Fields

® Recently Viewed
Pages and Blog
Posts

® Search Results
Macro

® |Livesearch Macro

® Search the People
Directory

Start a search
To search Confluence:

1. Click the search field in the top-right of Confluence to open the search panel.
2. Start typing your search term.

Results will appear as you type — you don't need to hit enter.
We exclude comments from your search results unless you select the comment option from the type filter.

Screenshot: the search panel
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marketing strategy| x
FILTER BY 18 search results Search tips i o
Spaca 5 Strategy FY19

Product Marketing Jan 07, 2019
This page outlines the Product Marketing strategy for FY19,

& Contributor - 5 i WhEre ]
including the OKRs and strategic initiatives for each guarter. Wa've
1 Type 35 a Channel Marketing Budget.xisx
Product Marketing (... / Comms and marketing - strategic planning Q2 Ja._
Date %) Channel Marketing Budget Channel marketing budget Anticipated
sales total ($AUD) 750 200 500 1500 1200 1500 1500 1800 2000
Label v
ﬂ Marketing brand refresh - project overview.pptx
Space category Comms and Marketing / ... /| Brand guldelines and assets Jan 03, 2018
Brand refresh - project plan Brand and marketing team Last year,
Advanced search the marketing team launched a new project to refresh our brand

E Marketing assets
Product Marketing Jan 03, 2019
Find all the marketing assets you need. Download hi res logo files,
branded slide decks and lllustrations. Logo_color.png

& Comms and Marketing
Space
The Communications and Marketing team looks after our brand
guidelines, including logos, typefaces and other assets.

m How to create a successful marketing campaign
Product Marketing Jan 03, 2018
Marketing a new product or feature isn't easy. It involves lots of
time, energy and careful planning, especially because you want the

m Product Marketing Home
Product Marketing Jan 03, 2019
‘Welcome to the Product Marketing team home. Recent space
activity Space contributars favourite

1. Search filters — refine your results by space, contributor, type, date, label, or space category.
2. Advanced search — go the the advanced search page.
3. Search tips — get search help, and tips for refining your search.

@ Tip: Type / on your keyboard to quickly open the search panel.

Filter your search results

You can refine your search using interactive filters on the left-hand side of the search panel.

Search within a space

Use the space filter to find content within a particular space or list of spaces. The space you're currently in
will appear at the top of the list by default. Start typing the space name and choose from the list of suggested

spaces.

Click the toggle to search within archived spaces.

RECENT SPACES

#41 Pecple and Culture CURRENT
# T Knowledge Base

K Teamsin Space

&’ Comms and Marketing

- :
= Product Marketing

Search archived spaces

Search for content by a specific person
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Use the contributor filter to restrict your search to content modified (created, updated, or commented on) by
particular people. Start typing the person's username, or part of their name, and we'll show you a list of
possible matches. You can add as many people as you like.

@ Tip: To search for your own work, click the Contributor filter, then select your profile from the drop-
down menu. Your name appears here by default, so it's easy to find.

Filter by content type

Use the type filter to only show content of a certain type, such as pages, blog posts, comments or user
profiles.

Search within a specific time frame

Use the date filter to search for content last modified (created, updated, or commented on) within a particular
period of time.

To search within a specific date range:
1. Click Advanced Search on the left-side of the search panel.

2. In the Last modified section, choose Custom.
3. Select the date range from the drop-down date picker.

Search for content with a specific label

Use the label filter to search for content containing a specific label. Start typing the name of the label and
choose from the list of possible matches.

Search within a space category

Use the space category filter to search within a group of related spaces. Start typing the category name and
choose from the list of possible matches. You can browse existing categories from the Space directory.

@ Tip: Space admins can organize spaces into categories. You can create space categories for
departments, subject areas, office locations — whatever works for your team. Learn how to create a
space category

Search for admin options
As a Confluence admin, you can can quickly access admin options from the search panel.

Start typing what you want to do. We'll show the top three matching admin items at the top of your search
results. You'll only see options you have permission to perform.

If you apply a search filter, admin items will no longer appear in your results.

Advanced search

The advanced search page allows you to add more search filters, such as creator, title, date range or
ancestor page.

To use advanced search:
1. Click the search field at the top-right of Confluence.

2. Click Advanced search on the left-side of the search panel.
3. Type your keyword in the search field and hit enter.
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Adding afilter from the advanced search page
To add a search filter from the advanced search page:

1. Click Add a filter on the bottom left of the advanced search page.
2. From the drop-down menu, select the relevant filter.

Screenshot: advanced search page

& Confluence Spaces «

People Create = Feedback Search

Search marketing ® a
CONTRIBUTOR Page 1 of 1. Showing 5 results (0.044 seconds)
o] Marketmg brand refresh - project overview.pptx
N SPACE Brand refresh - project plan Brand and marketing team Last year, the marketing team launched
Comms and x & new project to refresh our brand and voice.
Marketing Comms and Marketing | ... { Brand guidelines and assets » yesterday at 8:54 PM
Bearliarchived Spaces O comms and Marketing

2 B

LAST MODIFIED
Any date

Last 24 hours

The Communications and Marketing team locks after our brand guidelines, including logos,
typefaces and other assets,

Comms and Marketing » yesterday at 10:03 PM

[3 Comms and Marketing Home

Last week Welcome to the comms and marketing home page. People.png Recent space activity Space
Last month contributors
Zommms and Marketing « yesterday at 9:47 PM
Last year
i B Marketing campaign briefs
— Comms and Marketing » yesterd LR
All content B Brand guidelines and assets
Pages Page owner Comms and Marketing division Last updated January 2012 Cur guidelines are
intended to lay the foundation for all cur marketing efforts, while giving ... templates, and logos -
Blog Posts as well as detsiled guidance on how and when to use each in your marketing campaign.
PR Comms and Marketing « yesterday at 3:54 PM
Spaces
Custom
CREATOR o

@ Emma McRae »

Add a filtar

1. Search filters — narrow your search by adding filters.
2. Add afilter — add more filters for even more precise search.

You can choose from these additional filters:

® Creator — Restrict your search to content created by a particular person. Start typing the person's
username or part of their name and Confluence will offer you a list of possible matches.

Label — Only search for content containing specific labels.

With parent — Only search for direct children of a specific parent page.

With ancestor — Only search for pages below a certain page in the hierarchy.

Created — Choose or enter a date to only show content created within a particular period of time.
Mentioning user — Only search for content that mentions a particular Confluence user.

With title — Only search within page or blog titles.

These filters are provided by Confluence Query Language (CQL).

Advanced search syntax

You can also refine your search using Confluence search syntax. These are words or symbols you enter into
the search field to help narrow down your results. Learn more about Confluence Search Syntax.
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Confluence Search Syntax

You can create an advanced search query using Confluence search syntax.
These are special words and symbols you enter into the search field to
narrow the focus of your search.

This page outlines the syntax supported by Confluence's search engine, Luc
ene.

How to use search syntax

To create a search query using Confluence syntax:

On this page:

How to use search
syntax

Search for an
exact match
Search using
wildcards

Exclude words
from your search
Combine search
terms

Search for nearby
words (proximity
search)

Search within an
alphabetical range
Search for words
spelled similarly
(fuzzy search)
Combining search
operators
Searching for
macros

Search specific
fields in Confluence
Confluence search
fields

Related pages:

® Search
® Confluence Search

Fields
Search the People
Directory

1. Click the search field at the top right of Confluence to open the expanded search panel.

2. Type your query using syntax supported by Confluence.
You can use multiple search words and operators in your query.

Screenshot: an example of a search query using Confluence search syntax

(connect®* AND VPN) AND spacekey:IKB

Q

FILTER &Y 1 search result
Space - E How to connect to our VPN
IT Knewledge Base Maov 01, 2018
Type L
Date Ly

« Label ~

Advanced search

Contributar - To connect to a VPN, head to Settings > Network & Internet > VPN
Click the “Add a VPN connection” buttan to set up a new VPN

Search tips
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Search for an exact match

Use double quotes around your search term to find a specific word or phrase. For example "product
roadmap" will search for content that contains the phrase 'product roadmap’, or a phrase where 'product' and
‘roadmap’ are the major words.

"product roadmap”

Limitations with exact match search
Phrases with stop words

Confluence ignores common words (stop words) — such as 'and’, 'the’, 'or', and 'it' — even if they are
included within double quotes.

For example, searching for "the IT budget" will only return pages containing 'budget’, because 'the' and 'it'
are stop words.

If you'd like to change this, vote on this improvement request:
] CONFSERVER-14910 - Provide ability to override Lucene tokenisation and stemming and search for
exact text (literal search) FUTURE CONSIDERATION

Phrases with special characters

Confluence ignores all symbols, such as hyphens or underscores, even if they are included within double
quotes.

For example, if you search for "'DOC-8510", you get all pages containing ‘doc' and '8510'.

(-:-*} Avoid using special characters, such as hyphens, in page or attachment names as they may not be
found by Confluence search.

Search using wildcards

Wildcards replace one or more characters in your search. They can help expand your search. For example,
the search below would find https://www.atlassian.com or http://www.atlassian.jp

http*. atl assi an. *

Confluence doesn't support leading wildcards. This means searching for * heese will not return cheese.

Wildcard Description Example

Multiple Use an asterisk (*) at the end of your word to | print* finds content containing 'printer’,
characters | replace multiple characters. ‘printing’, 'prints' and so on.

Multiple Use asterisks (*) to add more than one r*c* finds content containing 'react’,
wildcards multiple-character wildcard ‘recovery', 'refactor' and so on.

Single Use a question mark (?) to replace a single b?tter finds content containing 'butter’,
character character in your search. 'bitter', 'better’, 'batter' and so on.
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(® Leading wildcards
Lucene doesn't allow wildcards at the beginning of your search, but you can format your search as a
regular expression as a workaround. For example, you can't search for * hunt or ?hunt, as they

begin with a wildcard, but you can search for /.*hum.*/ and find things like hum, human, and
inhumane.

Exclude words from your search

Use NOT or minus (-) to exclude words from your search.

chal k NOT cheese

Operator = Description Example

NOT Use NOT (in capital letters) to exclude chalk NOT cheese finds content containing
a word from your search. ‘chalk’ but NOT 'cheese’

Minus (-) Put a minus sign (-) in front of words chalk butter -cheese finds content containing
you want to leave out. ‘chalk’ and 'butter' but not 'cheese'

Combine search terms

Operator =~ Description Example

OR Use OR (in capital letters) to search for content chalk OR cheese finds content
that contains one of the terms. containing either 'chalk’ or ‘cheese’

AND Use AND (in capital letters) to search for content chalk AND cheese finds content
that contains more than one search term. containing both 'chalk’ and 'cheese’

You can also combine search terms and operators, for example:

(cheese OR butter) AND chal k

Search for nearby words (proximity search)
Use a tilde (~) followed by a humber to find two words within a certain number of words of each other.
For example, the following search will return 'Octagon blog post', but not 'Octagon team blog post':

"octagon post"~1

The following search won't work, because you can't search for two words within zero words of each other. If
you think the words are next to each other, use the matched phrase search.

"octagon post"~0

Search within an alphabetical range

Use 'TO' (in capital letters) to search for names that fall alphabetically within a specified range. For example:
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[adam TO ben]

Note: You can't use the AND keyword inside this statement.

Search for words spelled similarly (fuzzy search)
Use a tilde (~) to find words spelled similarly, or to pick up misspellings.

For example, if you want to search for octagon, but you're not sure how it's been spelled, type the word
followed by a tilde:

oct ogan~

Combining search operators

You can also combine various search terms together:

o?tag* AND past~ AND ("bl og" AND "post")

Searching for macros

You can search Confluence pages to find where a macro is used. Start your search with macr oNane: and
type the macro name after the colon. For example, to search for all excerpt-include macros:

macr oNane: excer pt - i ncl ude*

Search specific fields in Confluence

Confluence data is stored in fields, for example title, label, type and so on. To search for content using a
specific field, type the name of that field into the search box followed by a colon (:), and then the term you're
looking for.

You can use multiple fields in the same query. For example, you could use the following query to find all blog
posts containing the Excerpt Include macro.

type: bl ogpost AND nmacr oNane: excer pt -i ncl ude*

Confluence will only look for the term directly after the colon. For example, the query below will search for
'some’ in the title field and 'title’ in the default fields:

title:sonme title

Use double quotes if you want to find multiple keywords:

title:"sone title"

Confluence search fields
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This table lists some common search fields, and shows examples of what to type into the search box. Fields

are case sensitive, so make sure you type the field name exactly as it appears in the table below.

Field

macro
Name

space
key

title

type

labelT
ext

Description

Searches for pages that contains a specific macro. Type the name of the
macro in lowercase. You can use a wildcard to make sure Confluence finds
the macro you're after.

Searches for content within a specific space, using the space key. Type the
name of the space key in capital letters.

You can add multiple spaces using brackets and commas.

Searches for content with specific words in the title.

Searches for content of a particular type. You can use the following content
types in your query:

page

blogpost

attachment

comment (only supported when using advanced search).

Searches for content containing a specific label. If the label has a hyphen,
include it within double quotes.

For more information about search fields, see Confluence Search Fields.

Examples

macr oName:
excer pt -
i ncl ude*

macr oNare:
jira*

spacekey:
MARKETI NG

spacekey:
(1T,
MARKETI NG

title:"
pr oduct
roadmap"

type:
att achnment

type:
bl ogpost

| abel Text :
r oadmap

| abel Text: "
pr oduct -
r oadmap"
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This page gives an overview of the Apache Lucene search fields used in
Confluence.

Filter with CQL

Before you dive into learning more about Lucene fields, you may want to
learn about the powerful search filtering offered by Confluence Query
Language (CQL).

CQL (Confluence Query Language) is a query language developed for
Confluence, which you can use in some macros and the Confluence
search. Confluence search and CQL-powered macros allow you to add
filters to build up a search query, adding as many filters as you need to
narrow down the search results.

Use the Add afilter link to add more filters to your query.
® For an OR search, specify multiple values in the same field.

So to show pages with 'label-a’, 'label-b* or both you'd put
'label-a’ and 'label-b' in the same Label field, like this:

Label *

label-a x |label-b x

® For an AND search, add more than one filter and specify a
single value in each.

To show only pages with label-a and label-b you'd put 'label-a’
in one label field, then add a second Label field to the macro,

and put 'label-b' in the second one, like this:

Label *

label-a x

Label [x)
label-b x

Put simply, OR values are entered in the same filter, AND
values are entered in different filter.

Only some filters support AND. If the filter doesn't support the

AND operator, you won't be able to add that filter more than
once.

® For a NOT search, enter a minus sign (-) before the label.
This'll exclude everything with that label.

You can use the following CQL filters to build your query:

Filter Description Operators
Label* | Include pages, blog posts or OR (multiple
attachments with these labels. values in the
same filter)
AND (multiple

Label filters)

On this page:

® Filter with CQL
® Searching for
content in specific

fields

® Confluence search

fields

® Notes

Personal
Information
Pages

Blog
Attachments
Mail items

Related pages:

® Search

® Confluence Search
Syntax

® Search the People
Directory
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With
ancest
or

Contri
butor**

Creator

Mentio
ning
user

With
parent

In
space**

Includi

ng
text**

With
title

of
type**

Include pages that are children of this
page.

This allows you to restrict the macro to
a single page tree.

Include pages or blog posts that were
created or edited by these people.

Include items created by these people.

Include pages and blog posts that
@mention these people.

Include only direct children of this
page (further sub-pages won't be
included)

Include items from these spaces.

Include items that contain this text.

Include items that contain this text in
the title.

Include only pages, blogs or
attachments.

* This field is required in CQL-powered macros.

OR (multiple
values in the
same filter)

OR (multiple
values in the
same filter)

OR (multiple
values in the
same filter)

OR (multiple
values in the
same filter)

EQUALS (one
page only)

OR (multiple
values in the
same filter)

CONTAINS
(single word or
phrase)

CONTAINS
(single word or
phrase)

OR (multiple
values in the
same filter)

** You can add these filters in CQL-powered macros but in search
they're part of the standard search filters, so they don't appear in the Add
a filter menu.

Searching for content in specific fields

Confluence data is stored in fields which can be specified in the search. To
search a specific field, type the name of the field followed by a colon "' and
then the term you are looking for. For example:

title:"Some Title"

| abel Text : chal k

The field specification applies only to the term directly preceding the colon.
For example, the query below will look for "Some" in the title field and will
search for "Heading" in the default fields.
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title: Sone Heading

To learn more about using Confluence search fields in an advanced search query, head to Confluence
Search Syntax.

Confluence search fields

Below are the fields which can be searched, listed by content type.

Personal Information

Name Indexed = Stored Tokenized Notes

handle true true false

type true true false

urlPath true true false

fullName true true true

title true true false

labelText true true true

modified true true false

created true true false

contentBody | true true true
Pages

Name Indexed = Stored Tokenized Notes

handle true true false

type true true false

urlPath true true false

title true true true

spacekey true true false

labelText true true true

modified true true false

created true true false

contentBody  true true true

macroName  true true false The name of a macro used on the page
Blog

Name Indexed = Stored Tokenized Notes

handle true true false

type true true false
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urlPath true true false
title true true true
spacekey true true false
labelText true true true
modified true true false
created true true false
contentBody | true true true
macroName  true true false The name of a macro used in the blog
Attachments
Name Indexed = Stored @ Tokenized Notes
handle true true false
type true true false
urlPath true true false
filename true true true
title true true false
comment true true true
spacekey true true false
modified true true false
created true true false
contentBody | true true true
Mail items
Name Indexed = Stored Tokenized Notes
handle true true false
type true true false
urlPath true true false
title true true true
spacekey true true false
messageid | true true false
inreplyto true true false
recipients true true true
labelText true true true
modified true true false
created true true false
contentBody | true true true
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Notes

To find out the version of Lucene Confluence is using go to <i nst al | ati on di rectory>/confl uence
/ VEEB- | NF/ | i b and locate the Lucene jar files. The Lucene version number will be part of the filename.
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Search the People Directory

The people directory displays a list of people who
are authorized to log in to your Confluence site
(they have the 'Can Use' global permission).

The people directory includes anybody who has
logged into Confluence or who has had a user
account created for them in Confluence.

The people directory does not include users who

can log into Confluence using external user
management if they have never yet logged in.

View the people directory

Choose People at the top of the screen.

Search for people

On this page:

View the people directory
Search for people

Follow people's activities
Notes

Related pages:

® Create a Personal Space
® Editing your User Profile
® Set Your Profile Picture

To search for a particular person, type their first name and/or last name into the search box and choose Sear

ch.

® To see everyone who uses your Confluence site, choose All People.
® To see just those people who have set up a personal space, choose People with Personal Spaces.

Follow people's activities

Confluence's network features allow you to follow' (that is, keep track of) other people's activities in your
Confluence site. For more information, please refer to Network Overview. You can use the hover profile
feature in the people directory to start following other people.

® To start following someone, move your mouse over their name or profile picture and choose Follow in

their profile popup.

® To stop following someone, move your mouse over their name or profile picture and choose Stop

Following in their profile popup.

Once you start following another person, their activities will start appearing in your network view.

Screenshot: The people directory

People Directory

All Pecple

All People

People with Personal

Spaces Josh User
sample@email.com.au
Sophie Staunton
sample@email.com.au

Search Clez

Ewan User
sample@email.com.au

ol Rach Admin
sample@email com au

Ml

Notes


https://confluence.atlassian.com/display/CONF74/Manage+Users
https://confluence.atlassian.com/display/CONF74/Manage+Users
https://confluence.atlassian.com/display/CONF74/Create+a+Space#CreateaSpace-personalspace
https://confluence.atlassian.com/display/CONF74/Create+a+Space#CreateaSpace-personalspace

Confluence 7.4 Documentation

® The people directory uses the hCard microformat for simple integration with a variety of microformat-
enabled tools. hCard is an open data format for representing people, companies, organizations, and
places. Read more about microformats and hCard.

® By default, deactivated users (disabled user accounts) are excluded from the people directory. You
can include them by adding the showDeact i vat edUser s parameter to the URL. For example:

http://ny. confl uence. conl dopeopl edi rect orysear ch. acti on?showbDeact i vat edUser s=t r ue

® Any user who does not have the 'Can Use' Confluence global permission won't appear in the People
directory (for example, Jira Service Desk customers who can view KB articles, but do not have a
Confluence license).

® By default, externally deleted users (for example, users deleted from an LDAP repository) are
excluded from the people directory. You can include them by adding the showExt er nal | yDel et edU
ser s parameter to the URL. For example:

http://ny.confl uence. conl dopeopl edi rect orysear ch. acti on?showExt er nal | yDel et edUser s=tr ue

® The Confluence administrator can hide the people directory. If it is hidden, you will not see the People
Directory option.
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Recently Viewed Pages and Blog Posts

The Recently Viewed list in Confluence keeps track of pages and blog

posts you've recently visited, and allows you to easily navigate back to them. Related pages:

® Create and Edit

To view your recently viewed content: Pages
. . ) ® Your profile and
1. Choose your profile picture at top right of the screen, then choose settings

Recently Viewed
2. Choose the title of the page you want to revisit

To filter the list, type part of a page title or user's name in the Filter field.

Your last ten recently viewed pages also appear when you click in Confluence's Search field before you
start typing a search query.

Recently Viewed Pages

Filter
TODAY
Status update - Josh User
(5 Josh User's Home - Josh User
(3 Angry Nerds Home - Angry Nerds
(5 Sophie User's Home - Sophie User

Blogs are a great way to communicate - Sophie User

(3 Test page 1 - Sophie User

OLDER
(S Test Space Home - Sample Space

(3 step 3 - share your favourite nerd - Angry Nerds
(3 step 2 - Play - Angry Nerds
(5 step 1 - download the game - Angry Nerds

Hint: type "g" and then "r" anywhere to quickly open this menu




Permissions and restrictions

As a tool for communication and collaboration, we
believe Confluence is at its best when everyone can
participate fully. Confluence keeps a history of all
changes to pages and other content, so it's easy to
see who has changed what, and reverse any
changes if you need to.

Confluence does, however, give you the choice to

make your site, spaces, and pages as open or
closed as you want to.

Levels of permission

There are three levels of permissions in Confluence:

® global permissions
® space permissions, and
® page restrictions.

Global permissions

On this page:

® | evels of permission
® Global permissions
® Space permissions
® Page restrictions
® How do permissions and restrictions
interact?
® Check who can view a page

Related pages:

Confluence Groups

Global Permissions Overview
Space Permissions Overview
Page Restrictions

Configuring Confluence Security

Global permissions are site-wide permissions, and are assigned by a Confluence administrator or system

administrator.

Global permissions cover things like whether a user can log in or create a space. They don't really interact

with space permissions or page restrictions.

For full details, check out the Global Permissions Overview.

Space permissions

Every space has its own independent set of permissions, managed by the space administrators, which
determine the access settings for different users and groups.

They can be used to grant or revoke permission to view, add, edit, and delete content within that space, and
can be applied to groups, users, and even to anonymous users (people who aren't logged in) if need be.

For full details, check out the Space Permissions Overview.

(-:-*} One thing to watch out for is where a user is a member of multiple groups. You may have revoked
permission for that individual user to add pages, for example, but if they're a member of a groups
that is allowed to add pages, they'll still be able to create new pages in the space.

If you can't get the result you want from space permissions, or you're not sure, check with one of
your Confluence administrators to determine what permissions you should apply to individuals and

groups.

Page restrictions

Page restrictions work a little differently to global and space permissions. Pages are open for viewing or
editing by default, but you can restrict either viewing or editing to certain users or groups if you need to.
Page restrictions can be applied to published or unpublished pages and blog posts (drafts).
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Don't forget, every page in Confluence lives within a space, and space permissions allow the space admin to
revoke permission to view content for the whole space. Even the ability to apply restrictions to pages is
controlled by the 'restrict pages' space permission.

For full details, check out Page Restrictions.

How do permissions and restrictions interact?

You can restrict viewing of a page or blog post to certain users or groups, so that even if someone has the
‘'view' permission for the space, they won't be able to view the content of the page or blog post.

If someone is a space admin and you've used page restrictions to prevent them viewing a page, they won't

be able to see the page when they navigate to it. As a space admin though, they can see a list of restricted
pages in the space and remove the restrictions.

Check who can view a page

To check who can view a page, go to *** > People who can view. This will show a list of people, including
administrators, who have space permission to see the space, and are not prevented by page restrictions
from seeing the page. See Check who can view a page for more information.

The diagram below shows the points at which someone could be prevented from viewing a page.

SITE SPACE PARENT CHILD
PAGES PAGE

O@.T

Site - they don't have permission to log in to Confluence.

Space - they don't have permission to view the space.

Parent page - the current page is inheriting a view restriction from another page higher up in the page
hierarchy, preventing them from viewing.

® Child page - the current page has a view restriction preventing them from viewing.

What about links?
Space permissions and page restrictions affect how links between Confluence pages are displayed.
® If someone doesn't have 'View' space permission, links to pages in that space will be visible, but
they'll get a "page not found" message. The space key is not revealed in the link URL.
® |f someone has the "View" space permission, but the page has view restrictions, the link will be visible
but they'll get an "access denied" message when they click the link.

Links to attachments are also affected. If the visitor doesn't have permission to view the page the attachment
lives on, the link won't be rendered.
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Confluence Groups

Grouping users in Confluence is a great way to cut
down the work required when managing On this page:
permissions and restrictions.

If you're a space admin, you can assign a set of spa ¢ Default Confluence groups

ce permissions to a group rather than to each ¢ Anonymous users

individual user. And as a page creator with 'Add ¢ Unlicensed users from linked applications
/Delete Restrictions' permission, you can also add

and remove page restrictions for groups. Related Pages:

Space Permissions Overview

Assign Space Permissions

Page Restrictions

Confluence Groups for Administrators

[ ]
Default Confluence groups .
[ ]
There are two default groups in every Confluence .
instance and, beyond that, Confluence
administrators are free to set up and edit groups in
any way they see fit.

The two default groups in Confluence are:

® confluence-users - this is the default group into which all new users are usually assigned. In most
sites this is the group that provides the permission to log in to Confluence.

® confluence-administrators — this super group grants the highest level of administrator
permissions. Members of this can view all pages, including restricted pages. While they can't edit
existing pages, they can add, delete, comment, restore page history, and administer the space. They
can also access the admin console and perform all administrative tasks.

G} Overlapping permissions

Space permissions are additive. If a user is granted permissions as an individual or as a member of
one or more groups, Confluence will combine these permissions together. This is sometimes known
as their effective permissions.

Sasha is a member of the conf | uence- user s group and the devel oper s group. The confl u
ence- user s group has 'export' permission, but does not have 'restrict' permission. The devel o
per s group has 'restrict' permission but does not have 'export' permission.

By being a member of these two groups, Sasha can restrict and export content. The permissions
do not conflict, they combine to determine what Sasha is allowed to do in this space.

Anonymous users

People who don't log in when they access Confluence are known as '‘anonymous' users. By default,
anonymous users don't have access to view or change any content in your Confluence site, but Confluence
admins can assign permissions to anonymous users if it's required.

Unlicensed users from linked applications

If you're using Confluence as a knowledge base for Jira Service Desk, your Jira Service
Desk administrator can choose to allow all active users and customers (that is logged in users who do not
have a Confluence license) to view specific spaces.

These users have very limited access, and cannot be granted permissions in the same way as an individual
or group. However, it's important to note that this permission overrides all existing space permissions, so any
logged in Confluence user will also be able to see the space (regardless of their group membership). This is
due to the way Confluence inherits permissions.
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Check who can view a page

Confluence is open by default, however because of the layers of space
permissions and page restrictions that can be applied, it isn't always
obvious who can see your page.

If you want to share a page with someone in a different team, for example,

it's useful to know whether they have adequate permissions to see it before
you share.

Check who can view a page
To check who can view a page:
1. Goto *** > People who can view.

2. Alist of all the people who can view the page will appear.
3. Start typing a hame to filter the list.

On this page:

® Check who can
view a page
® Why can
these
people
view?
® What should
| do if
someone
can't see my
page?
® Howdol
make my
page
completley
private?
® Disable the People
who can view
option

Related pages:

® Permissions and
restrictions

® Global Permissions
Overview

® Space Permissions
Overview

People who can view is available in both Confluence Server and Confluence Data Center.
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People who can view this page Filter users Q

5 people can view this page. Restrictions can affect who can view.

Full name Username

0 Rach Admin admin
Fran Perez fran

e Jane Rotanson jane
@ Jie Yang Song jie
@ Omar Darboe omar

Why can these people view?

Screenshot: the People who can view dialog showing a list of 5 people.

Why can these people view?
The list includes everyone who:

® s allowed to view the space, via space permissions, and
® is not prevented from viewing the page by page restrictions.

The list also includes members of the confluence-administrators super group, who can always see all spaces

and pages. This means that even if you restrict a page to yourself, it's possible that at least one other person
can see it.

What should | do if someone can't see my page?

If you want to share your page with a person, and they're not listed, you'll need to work out what is
preventing them from viewing the page.

If you restricted the page, add them to the page restrictions, and then check the People who can view list
again.

If they still aren't listed, it's likely they don't have permission to see the space. You'll need to contact a space
admin to help with this. Go to Space Tools > Overview for a list of space admins.

How do | make my page completley private?

The short answer is, you can't. Confluence is designed to be open. It's for sharing work with your team.
While you can restrict a page to yourself, it's important to note that:

® Space administrators always have the ability to remove page restrictions, even from pages they can't
see.
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® People with Confluence Administrator and System Administrator global permissions can't see your
pages by default, but they can grant themselves space administrator permission to the space.

* Members of the confluence-administrators super group can see all spaces and pages. This group
grants the highest possible permission in Confluence. Some organisations use this group heavily,

while others don't use this group at all.

Disable the People who can view option

People with Confluence Administrator or System Administrator permissions can disable the People who can
view option, if they don't want people to be able to see a list of user's names.

To disable the People who can view option:

1. Go to <base-url>/admin/plugins/gatekeeper-plugin/global/configuration.action
2. Deselect Show 'People who can view' option and save the change.
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Inspect permissions

() Inspect permissions is an advanced On this page:
permissions feature, and is only available in

Contluence Data’ Center. ® Troubleshoot permissions problems

® Inspect permissions via space

Confluence is open by default, but because of the administration _
layers of group, individual and anonymous ® Inspect permissions via the Global
permissions that can be applied, it can be administration
challenging to find out exactly who can do what. ® Inspect permissions for a group
® Permissions explanations
Inspect permissions helps you: ¢ Audit permissions
® Bulk apply permissions
* troubleshoot permissions problems ¢ Bulk apply permissions for a group
* audit who can do what in your site ¢ Bulk apply permissions for a user
* apply the permissions granted to a user or ® Troubleshooting and known issues
group in one space to multiple spaces. ® General cache problems
® Export options limited in Internet
It reveals a person's effective permissions, Explorer 11
combining everything we know about their ® Inspect permissions for a group only
permissions in a way that can be easily interpreted. shows direct permissions

® Excluding spaces with no
permissions can take a long time in
large sites

Related pages:

® Permissions and restrictions
® Global Permissions Overview
® Space Permissions Overview

Troubleshoot permissions problems

Often you will need to find out why someone can or can't do something in Confluence. By inspecting
permissions you can drill right down to the root of the problem.

For example, someone reports to you that a teammate can see a space they shouldn't be able see. By
inspecting permissions you can work out exactly what group memberships, for example, might be
contributing.

Inspect permissions via space administration

You need space admin permissions for the space you want to troubleshoot.

To find out why someone can or can't view this space:

Go to the space and choose Space tools > Permissions from the bottom of the sidebar
Go to the Inspect permissions tab

Enter the person’'s name or username.

Leave the Page field blank (unless you need to investigate a specific page in this space).
Choose Show.

agrwn e

A table showing the person's effective permissions in this space will appear. Click one of the icons to go to
the detail view, and find out exactly why they do or don't have that permission.

If you choose to specify a particular page, the permissions explanations will also include information about
any page restrictions. The icons will represent just that page, not the user's permissions for the entire space.
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Permissions Restricted Pages  Inspect Permissions
hooting
tin this space. Learn more
People
elected pag
Iways shov ous
Page
Enter page title, You can only search for one page at a time.
Refresh Export
All Pages Blog Comments Attachments Restrictions Mail Space
Name View Delete Own Add Delete Add Delete Add  Delate Add Delete Delate Export  Admin
Ji Rot
memnsn . 9 @ © O © © © 9 © © © © o0 ©
Jie ¥ 5
) s © 0 0 © © © © 9 © © © © © ©

Screenshot: Inspect permissions tab in Space Tools showing permissions for two users.

: Permissions Restricted Pages Inspect Permissions
Find out what permissions have been granted to people in this space. This is great for
EI troubleshooting permissions and restrictions problems, or if you need to audit who can do
what in this space. Learn more
»
People
Enter a name or username. Use * for a wildcard search.
Don't show disabled user accounts
Don't show users who have no permissions for selectad pages
Always show Anonymous
Page
Entar page title, You can only search for one page at a tima.
Show Export
o Powered by Atlessian Confluence 74.0-m{a HEDOTT & DL Atlassian News
»
A ATLASSIAN

Animation: Inspect permissions tab in Space tools showing permissions explanations for a user
Inspect permissions via the Global administration

You need Confluence Administrator or System Administrator global permission to do this. You don't need to
have permission to view the space itself.

To find out why someone can or can't view this space:

1. Goto E > General Configuration > Inspect permissions.
2. Enter the person's name or username.

3. Enter the spaces you want to view.

4. Choose Show.

A table showing the users and spaces you searched for will appear. Click the link to see the detailed view,
then click the icons to find out exactly why they do or don't have that permission.
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People Groups

People Jie Yang Song (jie) * Jane Rotanson (jans} %
Enter a name or username. Use * for a wildcard search
Don't show disabled user accounts
Don't show users who have no permissions for selected spaces
Always show Anonymous
Spaces *project %
Enter a space key or space name. Use * for a wildcard saarch.

Don't show spaces that have no permissions for selected users

BSP GATE VP
Name
Blue sky project Gatekeeper pr... VR project
e lJane Rotanson (%) Partial (¥) Partial € None
ane
Jie Yang Song Ve .
Full ) Partial None
® . © o

Screenshot: Inspect permissions in Global administration showing permissions for two users and three
spaces.

CONFIGURATION Inspect Permissions

General Configuration

Find out what permissions have bean granted to peaple in your site. Yau can

search by user or group, in combination with a space. This is great for

Backup Administration troulleshooting permission problems or it you need to audit who can do what to
which space in this site. Learn mare

Further Configuration

Languages

Shortcut Links Feople Groups

External Gadgets

Global Templates and

Blueprints People

Recommended Updates Enter a name of username. Use ® for a wildeard se
Email

Don't show disabled user accounts

Mail Servers

Don't show users who have no permissions tor
User Macros selected spaces
In-app Natifications Always show Anonymous
Spam Prevention
Spaces R
PDF Export Language
Support

Enter & spaca key or space nama. Use * for a wildecard search.
Configure Code Macro Don't show spaces that have no permissions for

Office Connector selected usars

WebDaVY Configuration

ATLASSIAN MARKETPLACE
Find new epps

Manage apps

Animation: Inspect permissions in Global administration showing searching for all spaces containing the
word "project" and then viewing permissions explanations for a user.

Inspect permissions for a group
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You can also inspect permissions for a specific group. This can only be done via the global administration.

To inspect permissions for a group:

Choose the Groups tab
Enter the group name.

aRNWNR

Choose Show.

Go to E > General Configuration > Inspect permissions.

Enter the spaces you want to view.

A table showing the groups and spaces you searched for will appear. Click the link to see the detailed view.

When inspecting permissions for a group, be aware:

®* We don't indicate when a group does not have the Can Use global permission, as we do for users.

* We don't show effective permissions for the group, as we do for users. We only show permissions
directly granted to that group (not granted via membership of a parent group. This is only an issue if
your external user directory has nested groups).

Using wildcards in your search

When searching for users, groups, or spaces, you can use * as a wildcard. For example if you wanted to
search for all spaces that contain the word project in their title, type * pr oj ect and select Search for
*project from the suggestions dropdown.

Permissions explanations

The detail view shows the effective permissions for a single user or group in a space. Click each icon to see
a detailed explanation, as shown here.

Fran Perez

All
Delete
Own

[X]

Pages

View Add

Q@— o

Can add and edit comments

Delete

© ©

Why

e ) Permission granted as a member of:
» developers
 staff

we Gatekeeper project
& gate

Blog Comments Attachments Restrictions Mail Space

Add

Add Add

Delete

[x]

Delete

o

Delete Delete

o N ©

Add/Delete

Q

Export

()

Good to know

Admin

[x}

—©O

Permission granted to anonymous users, which means everyone who is logged in will get

this permission by default.

1. Icons - icons indicate whether the user or group can or can't do this action.

2. Explanation - explains why the user can or can't do this action.

3. Good to know information - provides additional information that may become relevant, for example
that space administrators can grant themselves permissions they don't currently have.

Edit

The purpose of these explanations is to provide a simple reason why someone can or can't do something in
a space. The messages are designed to be short, and present the most relevant information first.

The table below contains a more detailed explanation of every message, including the conditions that trigger

the message.

Explanations about users

Explanation

Message appears when...
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Permission granted as an individual

Permission granted as a member of:

Permission granted as an individual
and as a member of:

Permission granted to anonymous us
ers, which means everyone will get
this permission by default, including
people who are not logged in.

Permission granted to anonymous us
ers, which means everyone who is
logged in will get this permission by
default.

No permission granted as an
individual or as a member of a group.

This person doesn't have the Can use
global permission, so they can't log
in to Confluence.

This person is a Confluence
administrator so could grant
themselves this permission.

This person is a space admin, so
could grant themselves this
permission.

This person is a space admin, so
can edit restrictions. They can also
remove all restrictions from pages
they don’t have permission to edit or
view.

This person has Delete own permissi
on so can delete their own pages,
blog posts, comments, and
attachments.

The user is listed in the space permissions for that space.

The user is a member of a group, that is listed in the space
permissions for that space. If the user is a member of multiple
groups that are listed in the space permissions, we will list all
of them.

The user is listed in the space permissions for that space,
and is also a member of a group that is listed in the space
permissions for that space.

The permission is granted to anonymous users in this space,
and your site is public (you have granted anonymous users
the Can use global permission).

Logged in users can't have fewer permissions than
anonymous users.

The permission is granted to anonymous users in this space,
but your site is not public (anonymous users do not have the
Can use global permission).

Logged in users can't have fewer permissions than
anonymous users. This is sometimes used as a shortcut way
to provide 'everyone' with space permission, without making
the site itself public.

The user isn't listed in the space permissions for that space,
they are not a member of a group that is listed in the space
permissions for that space, and anonymous has not been
granted any permissions.

This user exists in the user directory, but doesn't have a
Confluence license seat. They are not a member of
confluence-users or another group that has the 'Can use'
global permission.

The user, or a group they're user is a member of, has
Confluence Administrator global permission. This means they
can recover permissions for a space they don't have
permission to see, and then change the permissions for that
space. Unlike members of the confluence-administrators
super group, they can't see the space by default.

The user has space admin permissions in this space. This
means they can modify permissions for this space, and could
grant themselves any permissions they don't currently have.

The user has space admin permissions in the space. This
means they can always change page restrictions (even if they
don't have the Restrict permission), and can access a list of
all restricted pages in the space, and remove all restrictions
from these pages.

The user can delete pages, blog posts, comments, and
attached files that they have created. They can't delete
pages, blog posts, comments, and attached files created by
other users unless they also have Delete permission in the
space. For example the user can delete a page they created,
but they cannot delete a page their team mate created unless
they also have the Delete Page space permission.
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To add and delete restrictions this
person also needs the Add page per
mission.

This person is a member of the confl
uence-administrators super group.
This means they can view all pages,
including restricted pages. While they
can't edit existing pages, they can
add, delete, comment, restore page
history, and administer the space.

This person can't log in because their

account is disabled.

Restrictions on <page title> prevent
this person from viewing the page.

Restrictions on <page title> allow this
person to view, but prevent them
from editing the page.

Restrictions on <page title> allow this
person to view and edit the page.

Restrictions on <page title> allow this
person to view the page.

Explanations about groups

The user has Restrict permission, but does not have the Add
page permission. Applying a page restriction is considered
editing the page, so both permissions are required.

The user is a member of the confluence-administrators group.
This is a default group that has significant privileges in
Confluence, beyond that provided by the Confluence
Administrator or System Administrator global permission.

This user exists in the user directory, but their account has
been disabled. They don't have a Confluence license seat.
This is usually because the person has left the organisation.

A page restriction has been applied to the page. The user, or
a group they're a member of, are not listed in the page
restrictions dialog, so they have 'no access'.

This message only appears when you inspect permissions for
a specific page in a space.

A page restriction has been applied to the page. In the page
restrictions dialog, either everyone can view or the user or
group they're a member of can view, but only specific users
or groups can edit.

This message only appears when you inspect permissions for
a specific page in a space.

A page restriction has been applied to the page. The user, or
a group they're a member of, are listed in the page
restrictions dialog, and they have 'View and edit’ access.

A page restriction has been applied to the page. The user can
view the page, either because the page restriction allows
everyone to view, and only some people to edit, or the user,
or a group they're a member of, are listed in the page
restrictions dialog, and they have "View only" or 'View and
edit' access.

This message only appears when you inspect permissions for
a specific page in a space, and click on a permission that
doesn't require permission to edit the page, for example View,
or Add comment.

These messages appear when you select a group as the entity to inspect. You need to be a Confluence
Administrator to inspect permissions for groups.

Permission explanation Message appears when...

Permission granted to all
members of this group.

The group is listed in the space permissions for that space.
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Permission granted to anonymous
users, which means everyone will
get this permission by default,
including people who are not
logged in.

Permission granted to anonymous
users, which means everyone
who is logged in will get this
permission by default.

No permission granted to this
group.

This group doesn't have the Can
use global permission, so people
in this group may not be able to
log in to Confluence.

Members of this group are space
admins, so could grant
themselves this permission.

Members of this group are space
admins, so can edit restrictions.
They can also remove all
restrictions from pages they don't
have permission to edit or view.

Members of this group have Delet
€ own permission so can delete
their own pages, blog posts,
comments, and attachments.

confluence-administrators is a sup
er group. Members of this

group can view all pages,
including restricted pages. While
they can't edit existing pages, they
can add, delete, comment, restore
page history, and administer the
space.

To add and delete restrictions
people in this group also need the
Add page permission.

Delete own is only available to
members of this group who have
logged in.

The permission is granted to anonymous users in this space,
and your site is public (you have granted anonymous users the
Can use global permission).

Logged in users can't have fewer permissions than anonymous
users.

The permission is granted to anonymous users in this space, but
your site is not public (anonymous users do not have the Can
use global permission).

Logged in users can't have fewer permissions than anonymous
users. This is sometimes used as a shortcut way to provide
‘everyone' with space permission, without making the site itself
public.

The group isn't listed in the space permissions for that space,
and anonymous has not been granted any permissions.

This group exists but does not have the 'Can use' global
permission. This is very common. Often one group, such as
confluence-users is used to grant a Confluence license seat, and
additional groups used only to manage space permissions.

This is only an issue if a user is not a member of another group
that grant them Can use permission.

The group has space admin permissions in this space. This
means members of this group can modify permissions for this
space, and could grant themselves or this group any permissions
they don't currently have.

The group has space admin permissions in the space. This
means members of this group can always change page
restrictions (even if they don't have the Restrict permission), and
can access a list of all restricted pages in the space, and remove
all restrictions from these pages.

Members of this group can delete pages, blog posts, comments,
and attached files that they have created. They can't delete
pages, blog posts, comments, and attached files created by
other users unless they also have Delete permission in the
space. For example the user can delete a page they created,
but they cannot delete a page their team mate created unless
they also have the Delete Page space permission.

This is a default group that has significant privileges in
Confluence, beyond that provided by the Confluence
Administrator or System Administrator global permission.

The group has Restrict permission, but does not have the Add
page permission. Applying a page restriction is considered
editing the page, so both permissions are required.

This message appears when Delete Own permission is granted
to a group that doesn't have Can use global permission. It is just
a reminder that people must be able to log in to delete their own
content.
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This permission information may
be incomplete because this group
is @ member of one or more
parent groups. Permissions
granted to parent groups are not
shown here.

This message appears when the group is nested, that is, it's a
member of another group. This hierarchy of groups comes from
your external user directory.

We don't show any permissions that a group is inheriting from a
parent group. You'll need to inspect these parent groups

seperately.

Explanations about anonymous

These messages appear when you select Anonymous as the entity to inspect. Anonymous in this
instance means people who have not logged in to Confluence.

Permission explanation

Permission granted to anonymous
users.

No permission granted to anonymous
users

Anonymous users don't have Can use
global permission. People must log in
to use Confluence. All logged in users
will inherit this permission by default.

Although Delete own permission can
be granted to anonymous users, it has
no effect.

Restrictions on <page title> prevent
anonymous users from viewing the

page.

Restrictions on <page title> allow
anonymous users to view, but prevent
them from editing the page.

This permission can't be granted to ano
nymous users.

Anonymous access is enabled globally.

Message appears when...

Permission granted to the anonymous entity listed in the
space permissions for that space.

No permission granted to the anonymous entity listed in the
space permissions for that space.

The permission is granted to anonymous users in this
space, but your site is not public (anonymous users do not
have the Can use global permission).

Logged in users can't have fewer permissions than
anonymous users. This is sometimes used as a shortcut
way to provide 'everyone' with space permission, without
making the site itself public.

The Delete Own permission is assigned to anonymous
users. Because you need to be logged in for us to know
who you are, and what you have created, Delete Own is
never available to anonymous users, even when granted.

A page restriction has been applied to the page.
Anonymous users have 'no access'.

This message only appears when you inspect permissions
for a specific page in a space.

A page restriction has been applied to the page. In the page
restrictions dialog, everyone can view, but only specific
users or groups can edit.

This message only appears when you inspect permissions
for a specific page in a space.

This is a reminder that some permissions, such as Space
Admin, and Restrict are never available to anonymous
users.

This is a reminder that your site is public. Because you
have granted anonymous users the Can use global
permission, people do not need to log in to access
Confluence.

Audit permissions

If you need to regularly check who can do what in your site, for example for compliance or regulatory
reasons, you can inspect permissions to conduct an audit.
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To export permissions information for all users and all spaces in your site:

Go to E > General Configuration > Inspect permissions.

Choose your search criteria - you can search for particular users, groups, or spaces, include disabled
accounts, or exclude users who have no permissions.

Choose Show. This will give you an idea of how large your query is.

Choose Export.

Keep the default separator. Comma separated is great for opening in most spreadsheet applications.
Choose how you want spaces to be listed. This depends on how much information you want to
include. You can include just the space key, or the title and description too.

7. Choose Export.

N =

o0 h®

The CSV file will be immediatley downloaded in your browser. This can take a few minutes, depending on
the size of your query.

This file can be extremely large in sites with many users and spaces. You could use the wildcard search
feature to limit the number of users to be included in each export.

People Groups

Groups
Enter a group name. Use * for a wildcard search
Don't show groups that have no permissions for selected spaces
o ——)  SpACES *project
Enter a space key or space name. Use * for a wildcard search.
[0 Don't show spaces that have no permissions for selected groups
Refresh Export @ e
BSP GATE VP
Name
Blue sky project Gatekeeper pr... VR praoject

confluence-adminis... ° Full ° Full ° Full
confluence-users Partial € None Partial
developers a None Partial 6 None
staff € None Partial € None

1. Wildcard search - use a wildcard to narrow your search.
2. Export - export the results to CSV for auditing or further analysis.

This example shows the output for one user, and three spaces.

* A row will be created for each of the 14 space permissions that can be granted.

® A column will be created for each space in your query. These are identified by space key, but you
can choose to include the space name and description in the export if you require it.

®* T and F indicates whether the user has this permission (true) or they do not have this permission
(false)

Username  Display Name @ Permission SPACE1 SPACE2 @ SPACE3
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userl Sample User 1  view-space T T F
userl Sample User 1 ' remove-own T T F
userl Sample User 1  page-add T T F
userl Sample User 1 = page-remove T F F
userl Sample User 1  blog-add T F F
userl Sample User 1 blog-remove T F F
userl Sample User 1 = comment-add T T F
userl Sample User 1 = comment-remove T F F
userl Sample User 1 | attachment-add T T F
userl Sample User 1 = attachment-remove | T F F
userl Sample User 1 = mail-remove T F F
userl Sample User 1 = page-restrict T F F
userl Sample User 1  space-export T F F
userl Sample User 1  space-admin T F F

In this example Sample User 1:

® Can do everything, including administer Spacel
® Can view, add, and delete their own content in Space2
® Can't view Space 3 at all.

Bulk apply permissions
Bulk applying permissions is useful when:

® You create a new group, and want to give that group permissions to a number of existing spaces.

® You need to grant someone permissions as an individual for a number of existing spaces.

® You have just created several new spaces, and want to use permissions from an existing space as a
template.

We recommend using groups as an efficient way to manage permissions in your site. When someone new
starts on your team, we would recommend making them a member of appropriate groups, over using the
bulk add permission options to grant them permissions to all their spaces as an individual.

Bulk apply permissions for a group
You need Confluence Administrator or System Administrator global permissions to do this.

To give a group the same permissions in multiple spaces:

Goto E > General Configuration > Inspect permissions.

Go to the Groups tab.

Enter the name of the group.

Enter the name of the space that you want to use as a starting point.

Choose Show, then click to see the detailed view.

Choose Edit.

Make sure the correct permissions are selected. These are the permissions you'll be copying.
Enter the names of the spaces you want to copy these same permissions to. You can add as many
spaces as you like.

Choose Apply.

Check the confirmation dialog to make sure all spaces were successfully updated.

PN AN
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S ©
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developers e Gatekeeper project
developars N GATE
All Pages Blog Comments Attachments Restrictions Mail Space
Delete
View o Add Delete Add Delete Add Delete Add Delete Add/Delete Delete Export  Admin
-] ] ] a ] <]

Deselect Al

Apply to other spaces Blue sky project % Vit project *

Applying these permissions to other spaces will replace any existing individual permissions the person has in those spaces.

m it

Screenshot: detail view of permissions for a group and space, with several spaces listed in the 'Apply to
other spaces' field.

Bulk apply permissions for a user

Before you do this, we recommend you inspect permissions to find out what permissions the user already
has for the spaces you plan to update, paying particular attention to how the permissions are granted
(individually, or via a group). In many cases the best approach is to change the user's group membership, or
the space permissions granted to a group, rather than bulk applying changes to the individual.

You need Confluence Administrator or System Administrator global permissions to do this.

To give a user permissions in multiple spaces:

. Goto E > General Configuration > Inspect permissions.

Enter the name of the user.

Enter the name of the space that you want to use as a starting point.

. Choose Show, then click to see the detailed view.

. The user's effective permissions are shown. These permissions are a combination of any individual
and group permissions. Choose Edit.

6. Make sure the correct permissions are selected. These are the permissions you'll be copying.

7. Enter the names of the spaces you want to copy these same permissions to. You can add as many
spaces as you like.

. Choose Apply.

. Check the confirmation dialog to make sure all spaces were successfully updated.

AN WNR
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G} As a general rule, we recommend managing permissions using groups. If you do decide to bulk
apply permissions for a user, there are some things to be aware of:

® Permissions can only be granted to the user as an individual using this method.

® Any permissions the user has as a member of a group will be unchanged. For example if
they are a member of a group that has Export permission, and you bulk apply permissions
that do not have Export permission, they will still have Export permission. Changing their
individual permissions can't override their group permissions.

®* The checkboxes, when you click Edit, reflect the user's current effective permissions - that is
the combination of all the permissions they already have as an individual or member of a
group. When you click Apply, you'll apply these exact permissions as an individual. You may
actually be doubling up on permissions the user already has, as a member of a group.

Troubleshooting and known issues
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General cache problems

Confluence caches permissions information, which helps to make sure results are returned quickly when you
check who can view a page, or inspect permissions. We continually update the cache as people and
permissions change. However, we know of two scenarios where the cache is not correctly updated - when
you import a site, and when you add, disable, or change the order of your user directories.

If this happens, the best way to force Confluence to rebuild the cache is to disable the Inspect permissions
- gatekeeper plugin, then re-enable it. Alternatively, you can restart Confluence, as the cache is built on
startup.

Export options limited in Internet Explorer 11

There's a known issue with the export dialog in Internet Explorer 11. The dialog is known to intermittently
freeze if you select either of the dropdown menus. As a workaround, use the default values for the Separator
and List spaces by fields, or use another browser to complete the export.

Inspect permissions for a group only shows direct permissions

If your external directory has nested groups (a group is a member of another group), and you inspect
permissions for a group, you'll only see permissions granted directly to that group (not effectively granted by
being a member of a parent group). If you search for a user, we'll always show the effective permissions,
including those granted by parent groups.

Excluding spaces with no permissions can take a long time in large sites

In the global Inspect Permissions screen, if you select "Don't show spaces that have no permissions for
selected users" and don't specify any other filters (such as specifying users, groups, or spaces), the query
can take several minutes to return any results. This is particularly true in sites with a very large number of
users and spaces.
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Permissions best practices

There are several different strategies you can use
for managing permissions in your site. The larger
your site grows, the more important it is to make
sure that your permissions strategy can scale with
your organisation.

Granting permission to a space on an individual by
individual basis may work well for small teams, but
rapidly becomes unwieldy when your user base
grows to thousands of people.

On this page, we provide our recommendations for
the best ways to manage common permissions
scenarios. Most of the advice boils down to:

® Keep Confluence as open as possible, it's
designed to be open by default.

® Use groups over individual permissions
wherever possible, to avoid headaches in the
future.

Give people access

On this page:

® Give people access

| want everyone in my organisation
to be able to log into Confluence

| want everyone in my organisation
to be able to view a space

| want to give people in my team
access to our space

| want to give my team access to all
our project spaces

| want all the spaces in my site to
have the same permissions

| want to give external people
access to my space

® Lock things down

| want to check what a person can
access in Confluence

| need to prevent someone from
accessing Confluence

I need to prevent specific people
from viewing a space

| want to prevent people from
seeing my work in progress

| want to prevent people seeing part
of a space

| want share one page but keep the
rest of the space private

® Delegate administration tasks

| want to delegate space
administration to a specific group of
people

| want to control who can create
spaces

® The big questions

What permissions should | give
people?

What should | do when someone
leaves my team?

What should | do when someone
leaves my organisation?

Related pages:

Permissions and restrictions
Global Permissions Overview
Space Permissions Overview
Inspect permissions

| want everyone in my organisation to be able to log into Confluence

The best way to achieve this is to make everyone a member of a group that has permission to log in to
Confluence, such as the default confluence-users group.

See Adding or Removing Users in Groups for information on how to add people to groups.

When new people join your organisation, add them to this group to grant permission to use Confluence.


https://confluence.atlassian.com/display/CONF74/Global+Permissions+Overview
https://confluence.atlassian.com/display/CONF74/Adding+or+Removing+Users+in+Groups
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If you don't want to use an existing group, you can create a new one. The process is much the same, but
you will need to explicitly grant this group global permission to use Confluence.

To change the global permissions for a group:

Go to [’: > General Configuration > Global permissions.

Choose Edit Permissions.

Enter your new group name in the Grant browse permission to field.
Make sure the Can use checkbox is selected.

Save your changes.

O WNR

| want everyone in my organisation to be able to view a space

The best way to do this is to grant space permissions to a group that all users are a member of, such as the
default confluence-users group.

If your site is not public (anonymous users do not have the 'Can Use' global permission, everyone must log
in to use Confluence), you can also use the anonymous permission as an 'everyone' shortcut. This is useful
if your groups setup is complex, and there isn't a single group that everyone is a member of. If you plan to
make your site public in future however, it's best to avoid this workaround.

| want to give people in my team access to our space

Think about whether your space really needs to be private. If not, you can grant permission to a group that
all users are a member of, such as confluence-users.

If it does need to be private, and your team is only going to be using this one space, it might be appropriate
to grant permissions as individuals. That way you don't need to ask a Confluence Administrator to add
people to groups. See Assign Space Permissions.

However, if your team needs access to multiple spaces, using a group is definitely the way to go, as it will

save you a lot of time in future when people join or leave your team. See Adding or Removing Users in
Groups.

| want to give my team access to all our project spaces

The best way to do this is to create a group, and grant that group permissions in each project space. When
people join or leave your team, you only need to change the group membership, you don't need to edit the
space permissions for multiple spaces. See Adding or Removing Users in Groups for more information.

It might be more work to set up now, but it will help you in the long term.
I want all the spaces in my site to have the same permissions

First, you should change the default space permissions, so that when a new space is created, it
automatically gets your desired permissions.

To change the default space permissions:

1. Goto [’: > General Configuration > Space permissions.
2. Choose Edit permissions.
3. Add groups, and grant permissions in the usual way then save your changes.

Any new spaces created will get these permissions by default.

For existing spaces, it is a little more laborious. You'll need to go to the space permissions screen in each
space, and set your desired permissions manually.

If you have Confluence Data Center you can slightly speed up this process by applying the permissions from

one space to multiple spaces. This is done on a group by group or user by user basis. There is no way to
copy an entire set of permissions from one space to another. See Inspect permissions.
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| want to give external people access to my space

If you don't want to make your site public, but you need to give people outside your company, such as a
customer or contractor, access to your site, you will need to create user accounts for these people. We

recommend creating a group specifically for these people, so that it is easy to remove their access later
when it is no longer needed.

Your company is hosting a huge event, and you want to be able to collaborate with staff at Super Events,
an external events company, in Confluence, rather than relying on email.

Create a group called super - event s- st af f

Grant this group the Can use global permission.

Create a user account for each Super Events person you'll be working with.

Add these users to the super - event s- st af f group only. Remove them from conf | uence-
user s, and any other default group to make sure they don't see any spaces they shouldn't. They
should only be a member of super - event s-staff.

Create a space for the event, and set the permissions for your internal staff.

Give the super - event s- st af f group permission to add pages, comments, and attachments
only.

7. Send the space URL and usernames to your contacts at Super Events, and start collaborating.

AWNR
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By confining these users to a single group, they won't see any spaces, or other content that they don't
have permission to see, such as Confluence Questions. However, they will be able to see things like the
people directory.

Lock things down

| want to check what a person can access in Confluence

In Confluence Server there is no easy way to do this. You will need to find out which groups the user is a
member of, and then manually check the permissions for each space.

In Confluence Data Center you can Inspect Permissions to find out what a user can view.
I need to prevent someone from accessing Confluence

The best way to do this is to disable the person's user account. They will not be able to log in. See Delete or
Disable Users to find out how to do this.

I need to prevent specific people from viewing a space

If you have Confluence Data Center, Inspect permissions for the person and the space, to find out exactly
how they are being granted permission. If you have Confluence Server, you will need to see what groups
have permission, then manually check if the person is a member of that group.

If their permission was granted as an individual, simply go to the space permissions and change their
permissions. If their permission was granted via a group, you'll need to decide whether to remove them from
the group, or to change the whole group's permissions.

| want to prevent people from seeing my work in progress

First, check who can view your page. It may be that only you, or your team can see the page due to space
permissions.

If you do need to lock it down further, the simplest way to do this is restrict the page, so that only you, or your
team, can view it. See Page Restrictions to find out how to do this.

Once you're ready to share your work, remove the restrictions. A notification won't be sent when you remove
the restrictions. Notifications are only sent at the point you publish the page (this means that if you restrict a
page to yourself, and publish it, anyone who is watching the space for new pages won't ever get a
notification).
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| want to prevent people seeing part of a space

The simplest way to do this is to use Page Restrictions. This is particularly useful when the pages are a work
in progress, and will eventually be opened up for more people to view at a later date.

In this example, a user wants to keep all the pages relating to a sensitive new project private, until the
information can be shared with the whole organisation.

Here's what they would do:

1. Create a page called "Secret project" and restrict it to just the people working on the project.
2. Create or move any pages relating to the project to be a child of "Secret project”. The view
restriction will be inherited.

This approach is not foolproof. It requires people to remember to create future sensitive pages under the
restricted parent page, and to avoid moving pages to a parent that is unrestricted. If the content is sensitive,
and will always be restricted, consider moving it to a different space, and use space permissions to control
who can see the pages.

I want share one page but keep the rest of the space private

This can be tricky, and introduces complexity that may be a problem later, because you are forcing
Confluence to work in a way that is opposite to the way it is intended to be used.

Essentially you would need to organise your page hierarchy so that all pages are restricted, except the one
you want to share. You would then change the space permissions to open up the space. You can then check
who can view a page to make sure you've achieved the desired result.

In this example, a user wants to keep the work in their personal space private, but make their "What I'm
working on" page available for their manager and team to view.

Here's what they would do:

1. Create a page called "Private work" and restrict this page to themselves. Only they can see this
page.

2. Move all the pages in the space that should remain private to be a child of "Private work".

3. Create a page called "Open work". Move the "What I'm working on" page to be a child of this page.

4. Change the space permissions so that their manager and team can view the space.

Important things to note:

® This approach is not foolproof. It requires the user to remember to create future sensitive pages
under the restricted parent page, and to avoid moving pages to a parent that is unrestricted.

® Any blog posts or other non-page content created in the space would be visible, because the page
restrictions only apply to pages that are a child of "Private work".

Delegate administration tasks

| want to delegate space administration to a specific group of people

The best way to do this is to create a specific space administrators group. The benefit of using a group is
that you can easily add and remove members, without needing to touch the space permissions for the
spaces themselves.

If you need to create a sensitive space, that these people shouldn't be able to view or administer, simply edit
the space permissions for that space, and remove the group's permissions.

® Create a group, and give it a recognisable name like space-administrators.

® Add the people you want to be space admins as members of this group.

® Grant this group space admin permissions in the default space permissions, so all new spaces will
be created with this permission.

® Go to every existing space and manually grant this group space admin permissions. If you have
Confluence Data Center you can use Inspect permissions to speed up this step.
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| want to control who can create spaces
You can set which groups or individuals can create spaces in Global Permissions.

If you choose to limit who can create spaces, we recommend granting this permission to a group of
champions, who can handle requests, create the spaces, and work with stakeholders to set up their space
permissions in the most appropriate way for your organisation. These people don't need to be Confluence
Administrators, they just need the Create Space global permission.

The big questions

What permissions should | give people?

This is going to depend on your organisation, and the type of work you are doing in Confluence. If
collaboration is your goal, we recommend giving people full Add, Delete, and Restrict permissions, and
granting Space Admin permissions to a handful of people, who can act as champions in the space, to
perform tasks like creating templates, or customising the view.

In some industries you may need to prevent people from deleting or restricting content, for auditing or
compliance reasons. If this is the case for your organisation, consider updating the default space
permissions so that all new spaces are created with your ideal permissions.

The main use-case for your Confluence site also has an impact on how you will structure your permissions.
Find out about using confluence for Technical Documentation, Knowledge Base articles, your Intranet, or Sof
tware Teams.

What should | do when someone leaves my team?

If most spaces in your site are open, chances are you don't need to do anything. However it's good practice
to change the person's group memberships to match their new role. This might happen automatically, via
your external user directory, or you may need to search for the user, and change their group memberships
manually.

Once you've changed their group memberships, if you're a Confluence administrator and you have
Confluence Data Center you can Inspect permissions to check what spaces the person still has access
to, then edit their permissions for each space on the fly, to remove any individual permissions.

What should | do when someone leaves my organisation?

If someone leaves your organisation, usually you would disable their user account, either in Confluence, or
in your external user directory.

You may want to tidy up any individual permissions they've been granted (just to reduce the number of
people listed in your space permissions screens), but unfortunately there's no easy way to do this. If you're a
Confluence administrator, and you have Confluence Data Center, you can Inspect permissions to check
what spaces the person still has access to, then edit their permissions for each space on the fly, to remove
any individual permissions.
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Add-ons and integrations

Confluence has a wide range of features on its own, but you can also

extend those features with Marketplace apps, and by integrating Related pages:

Confluence with other applications. Integrating with Jira applications can * Use Jira

really take your Confluence experience to the next level by improving the applications and

way your teams track vital work, and plan and release new products. Confluence
together

If there's an extra piece of functionality you need, the Atlassian Marketplace

is the place to look for useful Confluence apps. Whether you need to create ® Use a WebDAV

diagrams, like the ones you can create with Gliffy, or you want to make Client to Work with

awesome mockups and wireframes with Balsamig, there are heaps of great Pages

apps in the marketplace. You may even find a really useful app you never ® Gadgets

knew you needed, but now can't live without. ® Request

Marketplace Apps
In this section:

Use Jira applications and Confluence together
Use Hipchat and Confluence together
Request Marketplace Apps

Use a WebDAV Client to Work with Pages
Mail Archives

Gadgets


https://marketplace.atlassian.com
https://marketplace.atlassian.com/home/confluence
https://marketplace.atlassian.com/plugins/com.gliffy.integration.confluence
https://marketplace.atlassian.com/plugins/com.balsamiq.confluence.plugins.mockups

Use Jira applications and Confluence together

Confluence and Jira are like bacon and eggs; coffee
and cake; Simon and Garfunkel. Separately, they're
great, but together, they're amazing!

On this page:

® For every project or team

If your Confluence and Jira sites are connected * Display issues on a page
Using Application LinkS, y0u can dISp|ay and Ccreate ® (Create reports and Charts
Jira issues and more from within Confluence. ® Create issues from inside
. ) Confluence
What you can do with Confluence and Jira depends * Move between Jira and Confluence
on the Jira application and version you have. Find ® For software teams
out about the required applications and versions * Define your requirements
later in this page. * Manage your sprints
® For service desk teams
For every project or team ¢ Provide self help resources for your
customers
Display issues on a page ® Create knowlgdge base articles
® Allow any active user to see
You can display Jira issues on a Confluence page . o knowledge base spaces
using the Jira Issues macro. Display a single issue, Jira applications required

a list of issues, or show the total number of issues.

The simplest way to add a Jira issue to Confluence
is to paste a Jira URL on a Confluence page.

® <yourjirasite.conp/ browse/ CONF-
1234 will insert the Jira Issues macro and
display a single issue.

® <yourjirasite.conp/issues/?
filter=56789 will insertthe Jira Issues
macro and display a list of issues
matching the saved filter.

® <yourjirasite.conp/issues/?
j gl =proj ect ¥%20%3D%20CONF will
insert the Jira Issues macro and display a
list of issues matching the Jira search.

Alternatively, you can add the Jira Issues Macro to the page and search for issues directly:

1. Inthe editor choose Insert > Jira Issue.
2. Follow the prompts in the macro browser to choose a project and search for an issue — you can even
use JIRA Query Language (JQL).

Once you've added the macro, you can customize how the issue or list of issues appears on the page,
including how much information to display, how many issues, and more.

T Heay Summary Status

o CONF-267T91 PDF Export Table RESOLVED
Hidden by Mangin

Ed CONF-35848 Roadmap time RESOLVED
period only

showing months

+| CONF-25846  Automaled row RESOLVED
numbering in
tabies

3issues " Refresh
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Create reports and charts

Reporting on information stored in Jira is simple in Confluence. In addition to the Jira Issues Macro, you can
use the Jira Report blueprint or Jira Chart macro to show information from your Jira application visually. It's
the best way to give your stakeholders a snapshot of your team or project's progress.

You can:

® Use the JIRA Report blueprint to create a Change Log or Status report.

® Use the Jira Chart Macro to display data as a chart, including pie charts, created vs resolved, and two
dimensional charts.

® Use JIRA Gadgets to display detailed Jira reports and charts on pages.

Create issues from inside Confluence

You can create issues while viewing a page or from the within the editor. This is really useful if you use
Confluence for planning and gathering requirements.

To create an issue when viewing a page:

1. Highlight some text on your page and choose the ¥ Create Jiraissue icon that appears above the
highlighted text.

2. Enter your server (if you have multiple Jira sites connected to Confluence), project, issue type and d
escription. Your highlighted text will populate the issue summary automatically.

3. Choose Create.

The issue will be created in Jira and added to your page. If your text is in a table, you'll have the option to
create multiple issues using text from the same column.

If you don't see a popup when you highlight text, check that Text Select is enabled in your profile settings.
To create an issue in the editor:

1. Inthe editor choose Insert > Jira Issue > Create new issue.

2. Enter your server (if you have multiple Jira sites connected to Confluence), project, issue type,
summary, and description.

3. Choose Insert.

The issue will be created in Jira and added to your page.

There are some limitations when creating Jira issues from Confluence. The Jira Issues macro or Create Jira
Issue dialog will notify you if it's unable to create an issue in the selected project. You can find out more in
the Jira Issues Macro page.

Move between Jira and Confluence

Whenever you add a link to JIRA issues in Confluence, or link to a Confluence page from your Jira
application, the Jira Links button appears at the top of the Confluence page. This makes it really easy to
jump from Confluence to Jira and vice versa, speeding up your workflow.

The number on the Jira Links button indicates the total number of issues, epics, and sprints connected to
that page, regardless of whether you have permission to view them. The dropdown, however, will only show
details of issues, epics, and sprints that you have Jira permissions to view.

The button doesn't detect links from issues displayed in the Jira Issues macro in table format.
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Pages / Mobile Development Team / Product requirements o % 6 JIRA links
Mobile Web Requirements
Cr Xy Mich Davis, last modified just a moment ago J I RA “nks
¥] Epics
Target release 10 MOT-18 and
Epic F| MDT-18 - Mobile optimized web app T Mabile optimized web app 3 is on
— ally by
Document status DRAET =] Issues itah
MDT-17 TODO
Document owner (=100 Ne -1 Twitter Integratior
" irch
Designer |Cassle Owens MDT-18 T0DO
API tErvies
Developers Harvey Jennings MDT-16 T0DO Lerviey
Post Usdates lenvie
QA | Kevin Campbell Dt hpewm
MDT-14 TODOD
Requirements Actvity Stream
MDT-13 TODO
#  Userstory User story description Fudatook negration Priori
title
1 Facebook A user wants to sign up via Facebook Must
Integration Have

For software teams

Here's some suggestions to help you get the most out of Confluence and Jira Software and unleash the
potential in your agile development team.

Define your requirements

Confluence is the perfect place to start defining your requirements. You can use the Product Requirements
Blueprint to capture your requirements, then create your Jira epic and other issues right from the
requirements page in Confluence.

Here's how it works:

1. Create a Confluence page using the Product Requirements Blueprint.

2. Choose the placeholder text 'Link to Jira epic or feature' and choose Create new issue to create your
epic in Jira.

3. Collaborate with your team to define your stories and save the page.

4. Highlight text on your requirements page and choose the Create Jira issue ¥ link to create stories

in Jira, and automatically link them to your epic.
5. Track the progress of the stories from the Confluence page or from within Jira.

Awesome new product requirements
Createc

Create |SSLIE Server: Atlassian J -
Targ

] Angry Nerds =
Epic i stories OPEN
8] Sto >
Doci - ks
Summary’
Doci
Require no work
Desi
Description
Dewvi
QA

Link to epic [f] ANERDS-4575
Goal Creste | Cancel

=« Reguire no work

The tight integration between Confluence and Jira Software means you can easily access issues from the
Confluence page and see their status at a glance, and from within Jira Software you can see links to related
Confluence pages. All the information you need is right there.
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Manage your sprints

There's often a lot of material in Confluence that provides useful context for your team during a sprint. These
might be requirements documents, designs, tech specs, customer research and more. By linking these
pages to epics, you make them easy for your team to find during the sprint.

Here's how you can use Confluence to support your sprint from within Jira Agile:

® |n Jira Software, create a Confluence page to plan your sprint. The page is created using the Meeting
Notes Blueprint — a handy template that helps capture the details you need — and is automatically
linked to the sprint.
In an epic, link to useful Confluence pages, including requirements, designs, and more.
Report on your progress to stakeholders using the JIRA Report blueprint in Confluence.
Use the Retrospective Blueprint in Confluence at the end of your sprint to take stock of what went well
and not so well.

For people who work mostly in Jira Software, the integration means that useful Confluence pages are only a
click away.

For service desk teams

Provide self help resources for your customers

If you use Jira Service Desk, you can help your customers resolve their issues without creating a request by
connecting your Service Desk project to a knowledge base in Confluence. You'll need Confluence 5.10 or
later.

If you use Jira Service Desk Cloud, you won't be able to connect your project to a knowledge base space on
a Confluence Server or Data Center site. You can only connect to a Confluence Cloud site. Read about how
to migrate from Confluence Server to Cloud.

In Service Desk, head to Project settings > Knowledge base to connect or create a Confluence space.

When Service Desk customers search in the Customer Portal, pages in the linked knowledge base space
will be suggested, allowing customers to help themselves.

print |
= Printer jam
(& Printer out of toner
[2 Printer out of paper
,[:'S Set up your remote office

Get assistance from IT on setting up your remote workstation (including
requesting new equipment for telecommuting)

Create knowledge base articles

The Knowledge Base space blueprint, along with templates for how-to and troubleshooting articles make
creating new knowledge base articles super simple for your Service Desk agents.

The templates used in the how-to and troubleshooting blueprints are completely customizable too. Set up
the template with all your standard information and let your agents take it from there.

Allow any active user to see knowledge base spaces

If your Confluence instance is not public, you can still make a knowledge base space available via the
customer portal.
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When you link your Jira Service Desk project to a Confluence space, you can choose to allow all active
users and customers to see pages in the linked space, even if they don't have a Confluence license. These
people get very limited Confluence access.

Unlicensed users can:

® View pages via the Jira Service Desk customer portal.
* Follow a URL to a page and then navigate within the linked space.

Unlicensed users can't:

® |ike, comment on or edit pages (or be granted permission to do this).
® See the dashboard, user profiles, the people directory or space directory.
® Search the whole site.

This permission can only be enabled via Jira Service Desk, but you can revoke access to the whole site or to
particular spaces via Confluence's global permissions or space permissions.

Allowing all active users and customers to view a space will override all existing space permissions, so
any logged in, licensed Confluence user will also be able to see the space (regardless of their group
membership). This is due to the way Confluence inherits permissions.

Jira applications required

As you've seen, Confluence has many integration points, some of which are only available in particular Jira
applications or versions.

This matrix outlines the specific Jira applications you'll need for each feature. We've also included the
minimum legacy Jira Server version (plus any add-ons) that you'll need if you're not using the latest Jira

applications.

Feature Jira Jira Jira Service Minimum legacy
Core Software Desk version

Display issues using Jira issues macro (/] (/] (/] Jira4.3

Display issue and project information (/] (/] (/] Jira 5.0

using Jira chart macro

Display issue and project information (/] (/] (/] Jira5.0

using the Jira Report blueprint

Create an issue from Jira issues macro (/] (/] (/] Jira4.3

Create issues by highlighting text on a (/] (/] (/] Jira6.3.1

Confluence page

Create issue by highlighting text on a (x] (V] (%] Jira 6.3.1 and

Confluence page and automatically link Jira Agile 6.3.5

issues to an epic

Link and create Confluence pages from [x] (/] (%] Jira 6.3.1 and

epics and sprints Jira Agile 6.3.5

View linked issues with the Jira links (/] (/] (/] Jira6.3.1

button in Confluence

Create a space using the Software [x] (/] [x] Jira Software 7.0

Project space blueprint

Use a Confluence space as a (x] (x] (V] Jira 5.2 and

knowledge base in the customer portal Jira Service Desk

1.0
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Allow Service Desk customers to view [x]
knowledge base articles without a
Confluence license

Search for an existing Confluence page (/]
within the Jira link dialog

Delegate user management to Jira (/]

Add a Jira gadget to a Confluence page (V]

o
o

o
o

Jira Service Desk
3.1

Jira 4.3

Jira 4.3

Jira 4.3

That's it? Time to jump into Confluence and give some of these great features a try with your team or
project.Want to find out more about how to connect your Jira application to Confluence? Check out Integratin

g Jira and Confluence.
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Use Hipchat and Confluence together

Hipchat is a group messaging and video chat app On this page:
for team communication. '
Connect a Confluence space to a Hipchat room to
get instant updates about changes in the space,
send realtime notifications to the room, and share
what you've been working on with your team.

Connect Confluence and Hipchat

Connect spaces to rooms

Send space notifications to Hipchat

Get Confluence in your Hipchat sidebar

Need to chat? See from Confluence if

someone's online on Hipchat

® Spice up your pages with Hipchat
emoticons

® Create Hipchat rooms from Confluence

® |nvite users to Hipchat from Confluence

I We ended support for the
Hipchat integration plugins in
Confluence 7.0
We have discontinued development on all
chat products. Hipchat Cloud services were
shut down in February 2019, and Hipchat
Data Center and Server will reach end of
life in 2019 and 2020 respectively.

Hipchat plugins are now disabled by default
for new installations. This will have no
impact on existing installations, and can be
easily enabled if required.

If you're not using Hipchat, you can reduce
clutter in your global and space
administration screens by disabling the
following plugins now:

® Atlassian Hipchat integration plugin

® Atlassian Hipchat integration plugin
core

® Confluence Hipchat emoticons plugin

® Confluence Hipchat integrations
plugin

® Confluence Hipchat plugin

Connect Confluence and Hipchat

You'll need to be a site admin with global
permissions for both Confluence and Hipchat to set
up the initial connection between Confluence and

your Hipchat group. Go to EI > General
Configuration > Hipchat Integration and choose C
onnect Hipchat.

Connect spaces to rooms
If you're a space admin, connect your space to a Hipchat room by going to Space Tools > Integration > Hip

chat and selecting which rooms you'd like to connect. A space can be connected to as many Hipchat rooms
as you like, and a Hipchat room can be connected to multiple spaces.

Send space notifications to Hipchat

When choosing which rooms to connect, you can also choose which notifications you'd like to send to each
room.
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HipChat  Application Links

HipChat integration @ Invite users ta HipChat
° Connect ° Choose Invite
Confluence is integrated with Awesome! Go ahead and sel up Invite your team fo collaboraie in
HipChat group Allasslan - testing. more rooms below. HipChat.
From space: Sample Spaca = | Select HipChat room - e o
Space Room
Sample Space -» Marketing Team Edit notificatons @
Sample Space -+ Sydney Social Done &
NOTIFY THIS ROOM WHEN
& Blog postis created & Page is created Page is updated & Question is asked & e

HIPCHAT CLIENT NOTIFICATIONS

Notify users in the rmom

1. Pick aroom: choose a Hipchat room to send notifications to.
2. Decide what to send: select the type of notifications to send to the room.

Notifications appear in realtime, and clicking on them takes you straight to Confluence.

You can choose different notification settings for each space-room connection. A design team working on a
specific project could choose to get updates from that project's space whenever a page is updated, so they
can keep close track of its progress. From their team space, though, they might choose to be notified only
when there’s a new a blog post, so they're up to date on important team news but don't get interrupted by
any other changes in that space.

Change the notification settings whenever you like by going to Space Tools > Integration > Hipchat, and
clicking on Edit Notifications next to the room name.

(¥) Permissions and restrictions

Want to keep something private? Don't worry, rooms are never notified about the creation or update
of any content with view restrictions on it.

Get Confluence in your Hipchat sidebar

Find content you've viewed or worked on in Confluence in your Hipchat sidebar, so you can easily resume,
share or discuss work with your team. Once a space has been linked to a room, you can find this in your
sidebar either under the space name or, if you have multiple spaces linked to your room, under the name of
your instance.

Select the name of your space or instance, then follow the prompts to authenticate your account. This will let
you open up a Confluence glance in your sidebar. Switch tabs to view either all Updates from the space
linked to that room, or My Work from across Confluence.

The My Work tab lets you filter all the content from Confluence that you've been Mentioned in, Recently
Worked on, Recently Visited or Saved for later. Now, when you want to share an important piece of
information with your team, ask them to review your work or collaborate with you, you can find and link them
to relevant content directly from Hipchat.

Need to chat? See from Confluence if someone's online on Hipchat
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Got questions about something someone else has worked on? Once your Confluence instance is linked to
your Hipchat group, you can hover over a user mention or a byline in Confluence to see if the user is
available in Hipchat. Green for available, yellow for away, or red for do not disturb.

Staff Mannian [Atlassian] @
snr@atlassian.com

Follow Maore: =

Spice up your pages with Hipchat emoticons

In the editor go to Insert > Emoticons to bring your pages to life with @ emoticons. You can also type
them right into the editor like this (success) L

Create Hipchat rooms from Confluence

Setting up a new team or project? Create a new Hipchat room at the same time, through Confluence. If

you're a space admin, go to Space Tools > Integration > Hipchat and instead of selecting an existing room
in the dropdown, type in the name of the new room you want to create and hit Add.

Invite users to Hipchat from Confluence

If you're a global admin for both Confluence and Hipchat, you can send users Hipchat invites directly from
Confluence. Go to E > General Configuration > Hipchat Integration > Invite users to Hipchat.

You'll need at least one space integrated with a room to see the Invite users link.
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Request Marketplace Apps

The Atlassian Marketplace website offers hundreds of apps that the administrator of your Atlassian application
can install to enhance and extend Confluence. If the app request feature is enabled for your Confluence
instance, you can submit requests for apps from the Marketplace to your Confluence administrator.

The 'Atlassian Marketplace for Confluence' page provides an integrated view of the Atlassian Marketplace from
within your Confluence instance. The page offers the same features as the Marketplace website, such as
searching and category filtering, but tailors the browsing experience to Confluence.

This in-product view of the Marketplace gives day-to-day users of the Atlassian applications, not just
administrators, an easy way to discover the apps that can help them work. When you find an app of interest,
you can submit a request with just a few clicks.

Submit an app request
To browse for add-ons in the Atlassian Marketplace, follow these steps:

1. Choose your profile picture at top right of the screen, then choose Atlassian Marketplace.

2. In the Atlassian Marketplace page, use the search box to find apps or use the category menus to browse
or filter by type, popularity, price or other criteria. You can see what your fellow users have requested by
choosing the Most Requested filter.

3. When you find an app that interests you, click Request to generate a request for your administrator.

4. Optionally, type a personal message to your administrators in the text box. This message is visible to
administrators in the details view for the app.

Reguest an Add-on

Confluence Source Editor

L by Allassian Labs

=

You can request that your syslem administrators install this add-on They wit get a
nolification inside the applicalion that you have made this request You can check back
nere o seg ifit has been instalied

Flease enter an opIoNE| MESSEJE WITh your request
This would really help me

Submit Reguest

5. When ready, click Submit Request.
6. Click Close to dismiss the 'Success!' message dialog box.

At this point, a notification appears in the interface your administrators use to administer apps. Also your request

message will appear in the app details view, visible from the administrator's 'Find New Apps' page. From there,
your administrator can purchase the app, try it out or dismiss requests.

Update an app request

After submitting the request, you can update your message at any time. Click the Update Request button next
to the listing in the Atlassian Marketplace page to modify the message to your administrator.

The administrator is not notified of the update. However, your updated message will appear as you have
modified it in the details view for the app immediately.
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Use a WebDAYV Client to Work with Pages

Create, move and delete pages and attachments in Confluence using a file manager like Finder (OS X),
Explorer (Windows) or Dolphin (Linux) or other WebDav compatible local client like CyberDuck.

For example, if you need to delete a lot of pages you can bulk delete them in your local file manager (like Finder
or Explorer), rather than one by one in your browser.

Access to Confluence through a native client is provided by the WebDav plugin. Your administrator may have
disabled the WebDav plugin, or may have restricted the actions that you can perform using a local client. See Co
nfiguring a WebDAV client for Confluence for more information on how to set it up.

Manage pages and files in a native client

Accessing Confluence through a native client is useful for performing bulk actions. Before you can start creating
and moving things around, it's useful to understand how the content is organized.

The hierarchy in the file system looks like this:

® Type of space (global or personal)
® Space (folder name is the spacekey)
®* Homepage (and other top level pages)
® Child pages (folder name is the name of the page)
® Attachments (filename of the attachment)

Essentially the file structure is the same as the page tree in your space. Here's how the Confluence
demonstration space looks in Finder.

@00 F default i
Ll ) (e B o (3% -] (@] [m~][ = | (@ Q
o - Mame i Date Modified Size Kind
"‘\‘ ﬂppiica[ions A 11§ odihied ze m
= ¥ | Global
o .| Desktop ov B ds
= Y =
[ Documents » [ @news
0 Downloads | © Demanstration Space.txt Pla
= > v | Welcome to Confluence
£ Movies i -
» L @exports Folde
—"j Music » ] @versions Folde
o TETPICTOTES ® » ] A quick look...or (step 2 of 9) Faoldes
= Confl » | Cet serious wi...e (step 5 of 9) Foldes
ey Diinenes » [ Lay out your page (step 6 of 9) def
lew) Macintosh HD » (] Learn the wo...rt (step 7 of 9) Foldel
DEVICES » [ Let's edit this page (step 3 of 9) Folder
: T » [ Share your pa...r (step 9 of 9) Foldes
) Remote Disc » [ Tell people w...nt (step 8 of 9) Falded

SHARED  Welcome to Confluence.txt
@ Welcome to Confluence.url
e L rachdoc.... = = e
» [ ] What is Confl...e? (step 1 of 9)
> & Ss

1. Space key
2. Pagetitle
3. Attached file

Here's some things you might choose to do in a local client, rather than in your browser:

® Move pages to another space
Select the page folders, and drag them into the other space's folder (drag them from Space A to Space B)
® Delete multiple pages
Select all the page folders you want to delete and delete them.
® Delete multiple attachments from a page
Navigate down to the page folder, select the attachments you want to delete and delete them.
® Upload multiple attachments
Navigate to the page folder, and drag the files into the folder (note you can attach multiple files through
the insert dialog as well).
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Mail Archives

Confluence allows you to collect and archive mail within each space. It's
useful for storing the email messages that relate to a particular project — you
can put them in the same Confluence space as the content for that project. * Spaces

® Add a Mail Account

Related pages:

You can download mail from one or more POP or IMAP accounts, or import
mail from an mbox file on your local system or on the Confluence server.

You need space administration permissions to manage the mail archives.

() Confluence mail archiving is an optional feature. This means that
the 'Mail' options may be disabled and will therefore not appear in
the Confluence user interface. Mail archiving features are contained
in a system app. To activate mail archiving features in Confluence,

enable the app — go to k24 > Manage apps then choose System in
the drop down, and enable the Confluence Mail Archiving Plugin.

To see archived mail:

® Go to a space and choose Space tools > Integrations > Mail
® Choose a message to see its contents, or choose Next, Previous
and other options to navigate around the mail archives.

Manage mail archives:

® Add a Mail Account
® Delete and Restore Mail
® Import Mail from an mbox

Screenshot: Viewing a message in the mail archive

Confluence Development / Browse Space / Mail Archive

Tom's on annual leave today (Monday)

Add ~
Mail Operations

. _ , _ o> Next By Date
From' Tom Davies <tomdavies@exemail com aus (find mare) ¢4 Previous By Dat

Date: Oct 22, 2006 16:12

Subject: Tom's on annual leave today (Monday) (find more)

iij Remove Mail
I'll see you all on Tuesday. = Mail Archive

Tom

Notes

® Only site spaces — not personal spaces — can store mail archives. See Spaces for information on site
and personal spaces.

® You can also search the mail messages and their attachments. See Search.

® Confluence mail archiving is an optional feature. This means that the '‘Mail' options may be disabled
and will therefore not appear in the Confluence user interface. Mail archiving features are contained in

a system app. To activate mail archiving features in Confluence, enable the app — go to k24 > Manage
apps then choose System in the drop down, and enable the Confluence Mail Archiving Plugin.



Add a Mail Account

When you add a mail account, you're configuring Confluence to download
mail from that account and archive it within the space.

You need space administration permissions to add a mail account. See Spa
ce Permissions Overview.

i. Note: Confluence will remove email messages from an email account
when it transfers them to the mail archive. You must therefore configure
Confluence to poll a clone email account rather than the actual account.
For example, to archive the actual account sal es@onpany. com to your
Confluence Sales space, you must first create a clone account such as con
f-sal es@onpany. com that contains the same email content.

Add a mail account

Step 1. Create a clone email account on the mail server

1. Add a new email account on the mail server with the clone email
address.

2. Copy all existing email messages from the actual account to the
clone account.

3. Set up the actual account to bcc sent email messages to the clone
account.

4. Set up the actual account to forward received email messages to the
clone account.

Step 2. Configure Confluence to archive the clone account

=

Choose Mail Accounts > Add mail account.
Enter configuration details for the account:

w N

Description: Provide a description for this account (optional).
Protocol: Choose from POP, IMAP, POPS or IMAPS.

® Password: Enter the account's password.
4. Choose Test Connection to verify the details
5. Choose Create to add the account to Confluence

On this page:

® Add a mail account
® Fetching Mail
®* Notes

Related pages:

® Mail Archives

®* How do | check
which spaces have
email accounts?

® How to disable
automatic mail
polling

Go to the space and choose Space tools > Integrations from the bottom of the sidebar.

Account Name: Enter a name for this account by which it will be known in Confluence.

Hostname: Enter the host name of the mail server on which the account resides.
Port: Don't edit this field. The mail server's port number will be displayed by default.
Username: Enter a username that has permission to retrieve mail from this account.
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Application Links  Mail Accounts = Mailbox Import  Mail

Configured accounts (including IMAP) will have
their mail downloaded and removed from the
server. For more information, please refer to our
online documentation.

Account Name  Gil's Mail

Description My Atlassian email

4k

Protocol IMAP

Hostname  imap.gmail.com

Port 143

Usermname  username@atlassian.com

Password ~ ssssesse

Create Test Connection | Cancel

For each mail account you add, you can perform these actions in the Mail Accounts tab:

® Edit: Change the configuration settings for the mail account.
® Remove: Remove the account permanently.
® Disable/Enable: Temporarily disable the account, or enable a disabled account.

Fetching Mail

Confluence automatically fetches mail from the server once every 30 minutes. You can manually retrieve
new mail from the configured mail accounts by selecting the Mail tab and choosing Fetch new mail.

@ You need to be a space administrator to manually retrieve mail. See Space Permissions.

Notes

® Only site spaces — not personal spaces — can store mail archives. See Spaces for information on site
and personal spaces.

® Confluence mail archiving is an optional feature. This means that the 'Mail' options may be disabled
and will therefore not appear in the Confluence user interface. Mail archiving features are contained in

a system app. To activate mail archiving features in Confluence, enable the app — go to E > Manage
apps then choose System in the drop down, and enable the Confluence Mail Archiving Plugin.
® Once mall is fetched it will be removed from the server.
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Delete and Restore Malil

To delete mail from a space, you need 'Delete Mail' permission.
Related pages:
@ Only a space administrator can delete all email messages in the space

: ® Mail Archives
simultaneously.

® Add a Mail Account

To delete mail from a space:

1. Go to a space and choose Space tools > Integrations > Mail
A list of email messages in the space is displayed in reverse
chronological order.

2. Do either of the following:

* Delete an individual email message by choosing the trash [
icon beside it.

® Delete all email messages within the space by choosing Delet
e All.

i. Email messages deleted using the 'Delete All' option can't be restored.
Space administrators can restore deleted email messages, provided they were deleted individually.
To restore deleted mail:
1. Go to the space and choose Space tools > Content Tools from the bottom of the sidebar
2. Choose Trash

You'll see a list of email messages and other content deleted from the space.
3. Choose Restore beside the email message you want to restore.



Import Mail from an mbox

Confluence allows you to import mail from mbox files located either on your
local system or in a specified location on the Confluence server. Confluence
will store the imported email messages in the space's mail archive. ® Mail Archives

® Add a Mail Account

Related pages:

You need to be a space administrator to import mail for a space. See Space
Permissions.

NB: You may need to enable the Confluence Mail Archiving Plugin as it
is disabled by default.

To import mail from an mbox file:

1. Go to the space and choose Space tools > Integrations from the bottom of the sidebar.
2. Choose Mailbox Import.
® To import from a location on your file system: Browse to the location of the mbox file, select the
file and then choose Import.
® To import from the Confluence server: Enter the location of the mbox file on the server, then
choose Import.

Notes

® Only site spaces can store mail archives. Personal spaces cannot. See Spaces for an explanation of
site spaces and personal spaces.

® Confluence mail archiving is an optional feature. This means that the 'Mail' options may be disabled
and will therefore not appear in the Confluence user interface. Mail archiving features are contained in

a system app. To activate mail archiving features in Confluence, enable the app — go to E > Manage
apps then choose System in the drop down, and enable the Confluence Mail Archiving Plugin.

® For security reasons mail can only be imported from a specified location in the Confluence server's
file system. We recommend administrators create a folder in their Confluence home directory, add
the system property conf | uence. nbox. di rect ory and specify the location for mailboxes to be
imported from . Mail cannot be imported from the server until this system property is set. See Configuri
ng System Properties.
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Gadgets

Gadgets allow you to add dynamic content to a Confluence page or Jira
application dashboard. Confluence can display gadgets that support the Op
enSocial specification, including third party gadgets.

On this page:

® Add a Confluence
gadget to a page

® Add a Jira gadget
to a page

® Add a Confluence
gadget to your Jira
application
dashboard

For more information about Atlassian gadgets, see the introduction to
Atlassian gadgets and the big list of Atlassian gadgets.

To see a list of available gadgets in your Confluence site go to Help > Avail
able Gadgets.

Add a Confluence gadget to a page

We ended support for the following Confluence gadgets in Confluence 7.0:
® Confluence Page Gadget
® Activity Stream Gadget

® Confluence QuickNav Gadget

These gadgets no longer appear in the macro browser and can't be added to a page. Any gadget already on
a page, or used in another application like Jira, will still work.

The Confluence News gadget was removed entirely in Confluence 7.0. This gadget displayed news from
Atlassian and hadn't been working for some time.

If you're wanting to display information within Confluence, we recommend using the following macros as an
alternative:

® Include Page macro

® Recently Updated macro
® Livesearch macro

Add a Jira gadget to a page

For displaying basic Jira information, such as issues and charts, we recommend using the Jira Issues Macro
and Jira Chart Macro as these macros have better performance and are easier to configure than gadgets.

If the Jira information you want to display is not available from either of these macros a gadget will likely do
the trick.

To add a Jira Gadget to a Confluence page:
® In the editor go to Insert > Other Macros.

® Select the gadget you wish to add, and use the preview area to configure the gadget.
® Choose Insert.

(¥ Ifyou don't see any Jira Gadgets in the macro browser, ask your Confluence administrator to add
the Jira Gadget urls to the list of authorized external gadgets in Confluence, and check that the
application link between Confluence and your Jira application is configured correctly.

Add a Confluence gadget to your Jira application dashboard

To add a Confluence gadget to your Jira dashboard:
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Go to the dashboard by selecting the Dashboard link in the header.

. On the dashboard, Click Add Gadget.
Use the gadget wizard to choose the gadgets you want to add.

wN R

@ If you don't see any Confluence gadgets in the Jira gadget directory, ask your Jira administrator to
add the gadget URLs as follows.

To add a Confluence gadget to your Jira application's gadget directory:

1. In Confluence, go to Help > Available Gadgets and copy the gadget URL for the gadget you

want to make available in Jira.
2. In Jira, go to the dashboard and choose Add Gadget.
3. Choose Manage Gadgets or Add Gadget to Directory (depending on your Jira application

and version)
4. Paste in the Confluence gadget URL and choose Add Gadget.

The gadget will now be available from the Jira Gadget Directory.

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

Activity Stream Gadget

I We ended support for this gadget in Confluence 7.0
The gadget no longer appears in the macro browser and can't be added to a page.
Any gadget already on a page, or used in another application like Jira, will still work.

The activity stream gadget is similar to the recently updated macro and shows a list of the most recently
changed content within your Confluence site.

In addition to showing a list of most recently changed content, the activity stream gadget also groups activities
by separate date, and provides an RSS feed link to its content in the top-right corner.

Activity Stream Gadget Properties

Properties are settings for Confluence gadgets that allow the user to control the content or presentation of data
retrieved by the gadget. These are similar to a Confluence macro's parameters. The table below lists relevant
properties for this gadget.

These properties are located in the preview panel in the macro browser.

Property Required?  Default = Description
Title Yes None Adds a title to the top of the Activity Stream.
Global No None Allows you to add filters to the gadget including:
filters

® space

® username

® update date

[ ]

Jira issue key (if your Confluence instance is integrated with a
Jira application)

Available Yes All If you have application links to other sites, Jira or another
streams Confluence site, you can choose to include activity from those
streams also.

Display No 10 Specify the maximum number of results to be displayed. A maximum
options: of 10 results will be displayed by default. The maximum value that
limit this property can accept is 100.

Display No Never Specify the time interval between each 'refresh' action undertaken by
options: [false the activity stream gadget. A refresh makes the activity stream
Refresh gadget reflect any new activity that has been conducted on the

Interval Confluence site.
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Confluence Page Gadget

I We ended support for this gadget in Confluence 7.0
The gadget no longer appears in the macro browser and can't be added to a page.
Any gadget already on a page, or used in another application like Jira, will still work.

The Confluence page gadget allows you to show

L On this page:
content from a page on your Confluence site in a
gadget. You can optionally configure the gadget to
Confluence site. The page gadget can also be * Working Macros

displayed in canvas view, so that it takes up all of
the space provided by your dashboard.

I Macros that work with the page gadget

Please note, not all macros work with the page gadget. Please refer to the Working Macros section
below for more information.

Screenshot: The Confluence page gadget displaying a sample page

Sample Page © View

Two penguins find themselves together on an ice floe, drifting
helplessly into warmer waters. The penguins are very fond of each
other. Suddenly cra-a-a-a-ck the ice flow splits in half, right between
the penguins. As they drift apart, one penguin sadly waves a flipper
and calls out "Chocolate milk!"

Confluence Page Gadget Properties

Properties are settings for Confluence gadgets that allow the user to control the content or presentation of
data retrieved by the gadget. These are similar to a Confluence macro's parameters. The table below lists
relevant properties for this gadget.

Property | Required? @ Default Description

Space No None Specify the space that your desired page is located in. Suggestions
will display in a dropdown when you start typing.
(Note, this property is only used to make searching for pages
easier. It is not required.)

Page Yes None Specify the page that you want to display in your gadget.
Suggestions will display in a dropdown when you start typing.

Show No Yes Select whether to display a link to view the page on your
View Link Confluence site. Clicking the link will open the page in Confluence.
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Show No No Select whether to display a link to edit the page on your Confluence

Edit Link site. Clicking the link will open the page for editing in Confluence.

Refresh No Never Specify the time interval between each 'refresh’ action undertaken

Interval [false by the page gadget. A refresh makes the activity stream gadget
reflect any new activity that has been conducted on the Confluence
site.

Working Macros

The Confluence page gadget will only render a subset of the macros that are used in Confluence correctly.
Refer to the table below for the list of macros that work and do not work with the page gadget and known
limitations.

@ Some of the issues with macros in the page gadget can be worked around, if you are comfortable
developing in Confluence. Please see Troubleshooting Macros in the Page Gadget for more
information.

Key:

@ Works with the page gadget

@ * Partially works with the page gadget
€ Does not work with the page gadget

Macro Works Limitations
with
page
gadget?
Activity [x] You cannot have another gadget embedded within the Confluence Page Gadget
Stream
Anchor (v Opens in a new page
(within a
page)
Attachments & N/A
Blog Posts @ N/A
Chart (/] N/A
Children (/] N/A
Display
Content (V] N/A
By Label
Content (/] N/A
By User
Excerpt (V] N/A
Gallery (/] N/A
Include (V] N/A
Page
Info (V] N/A
Labels List @ & N/A
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Livesearch
Note
Metadata

Metadata
Summary

Pagetree
Search

Pagetree
Panel
Quick Nav

Recently
Updated

RSS Feed

Section &
Column

Spaces
List

Table of
Contents

Team
Calendars
for
Confluence
Server

View File
(PDF or
PPT)

Widget
Connector
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N/A
N/A
N/A

N/A

N/A

N/A
N/A
You cannot have another gadget embedded within the Confluence Page Gadget

N/A

N/A

N/A

N/A

Works, however links will be opened in a new browser window when clicked.

See here for the Improvement Request:

L] CONFSERVER-51407 - Make Team Calendars display in a Confluence
Page Gadget, for use on a JIRA Dashboard GATHERING INTEREST

Works, but you may need to refresh the gadget the first time (see CONF-19932).

Only works for some content:

® Works: blip.tv, Episodic, Flickr, Google Calendar, presentations on Google
Docs, MySpace Video, Scribd, Skitch.com, SlideRocket, SlideShare,
Viddler, Vimeo, YouTube, Dailymotion, Metacafe, FriendFeed, Yahoo
Video, Wufoo HTML Form Builder

®* Does not work: FriendFeed, Google Gadgets, Google Video (consumer
service discontinued), Twitter, Widgetbox, DabbleDB, BackType
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Confluence QuickNav Gadget

I We ended support for this gadget in Confluence 7.0
The gadget no longer appears in the macro browser and can't be added to a page.
Any gadget already on a page, or used in another application like Jira, will still work.

The QuickNav Gadget allows you to add the quick navigation functionality to search your Confluence site.

To search Confluence using a QuickNav Gadget, type the name of a page, blog post, person, file, or space
into the search box, and choose from the list of results displayed.

If you don't immediately see what you need, hit Enter or choose the 'Search for' option at the bottom of the
search results to go to the advanced search page. Learn more about searching Confluence.

Screenshot: Using the QuickNav Gadget

Example]

|=] Example Fage

|=] Example Human Resources Page
=] Examples

|=] Example Sales Teamn Page

|=] Example Development Team Page
|=] Example Excel 2007 Document.xlsx
E Example POF Document.pdf

ﬁ_} Example Space

‘= Search for ‘Example’

(¥ You can also search for administrative options in the QuickNav Gadget. For example, type ‘general’
into the search field to go to the General Configuration screen.

More information about the QuickNav Gadget:

The QuickNav Gadget returns matches based on the title only, not the content of the page or file.
Matching items are grouped by type, so that you can quickly find the type you want. Confluence
shows a maximum of 3 admin options, 6 pages and/or blog posts, 2 attachments, 3 people and 2
spaces.

Items are ordered with the most recently updated first.

Permissions determine the admin options that appear in the search results. You'll only see the options
you have permission to perform.

Confluence QuickNav Gadget Properties

This gadget has no properties and cannot be customized.
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Confluence use-cases

This section describes some specific use cases for Confluence.

® Using Confluence for technical documentation

A technical communicator's guide to using Confluence — see Develop
Technical Documentation in Confluence.

® Setting up a knowledge base

A support engineer's guide to using Confluence as a knowledge
base — see Use Confluence as a Knowledge Base. You can also
check out our handy guides on writing how-to and troubleshooting
articles.

® Setting up an intranet

A quick guide to setting up an intranet — see Use Confluence as your
Intranet.

® Confluence for software teams
A series of blog posts to help your agile team get the most out of
Confluence. See Confluence for Software Teams.
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Develop Technical Documentation in Confluence

Confluence is a flexible platform with a range of features and Marketplace
apps that can help you capture, distribute, and update your technical
documentation. Below are some tips to help you get your technical

On this page:

Create your

documentation site started, and to save you time and effort managing your Documentation
documentation's life cycle. Space

. ® Save time by re-
For another great overview of how you can use Confluence for using content

documentation check out Rock the Docs from our solution partner, K15t. * Use page templates

Draft your work
Create your Documentation Space ® Use links and
anchors
¢ Useful macros

Creating spaces in Confluence is quick and easy. All you need to do to get
Keep track of page

your documentation started is choose Spaces > Create space from the

Confluence header. To make things even easier, choose the updates
'Documentation Space' option in the create space dialog; it'll give you a ¢ Customize PDF
custom home page with a search box (the livesearch macro) to search just export
your documentation space, a recently updated macro, and a few other ¢ Other useful tools
goodies. and apps

¢ Documentation
Give your space a name, and Confluence will automatically create the theme

home page and space key for it (change the space key if you're not happy (discontinued)

with the one Confluence chooses for you). Feel free to customize the home

page at any time; what it looks like is completely up to you! Related pages:

® Spaces

Save time by re-using content

If there's something you're going to use multiple times in your
documentation space — whether it's a word, sentence or paragraph; an
image; a product version number; or anything else — you can create it once
and include it on as many pages as you like (or use it in the header and/or
footer). Inclusions not only save you typing the same thing many times, they
also make it easier when things change — it's much better to update the info
in one place, than 47!

There are 3 macros that allow you to re-use content:

® The Excerpt macro to define a re-usable section, or 'excerpt’, on a page — add content inside this
macro, and you can reuse it on as many pages as you like.

® The ExcerptInclude macro (excer pt-i ncl ude) to include the contents of an excerpt on another
page.

® The Include Page macro (i ncl ude) to include the entire content of a page on another page.

For example, let's say you create release notes for each major release of your product, and you want to
include the intro from each release notes page on a 'what's new' page. Place each release notes intro in an E
xcerpt macro, then add an Excerpt Include macro for each set of release notes to the what's new

page. Your intros will magically appear on the what's new page, and if you update the release notes it'll
automatically update the what's new.
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S Pages / Technical Doco &
lechnical Doco

What's new?

Created by Gil Admin, last modified less than a minute ago

PAGE TREE

» What's new?

Version 1

» Release notes 1 = e
"—.

X = Version 1 of our product is so amazing!
» Release notes 2 :

» Release notes 3

Version 2

Version 2 is even better than version 1!

1. Excerpts: the intros to these pages are in excerpt macros.
2. Excerpt include: these are excerpt include macros.

Another example is one of the ways we use the Include Page macro. Whenever the ellipsis (***) appears
in our documentation — for example, go to *** > Copy —it's actually an Include Page macro. We have a
page with just that image on it, so we can include it whenever we need an ellipsis.

Why do we do use an Include Page macro for one tiny image? Well, just in case that Ul element is ever
changed. If we attach the image to every page, there might be 50 pages we need to update when things
change; if we use an Include Page macro, we update once and it's changed everywhere. Doing it this way
also allows us to know how many pages we're using the image on. By going to *** > Page Information, we
can see how many incoming links there are to this page, and that tells us how many pages use the image.

Create an inclusions library (optional)

You can include content from any Confluence page, but you may want to create an 'inclusions library' to hold
content that's specifically for re-use. The inclusions library isn't a specific feature of Confluence; the pages in
the inclusions library are just like any other Confluence page. This is just a technique you can use if you
want a place to store content that's specifically for re-use.

To create your inclusions library:

1. Choose Create and create a new page in your space

2. Enter a suitable title. We use '_Confluencelnclusions' (the underscore before the title helps to let
people know this page is special)

3. Enter some content and save the page
We enter text explaining the purpose of the inclusions library and how to re-use the content

4. Choose Space tools > Reorder pages and drag your new page above the space homepage

5. Go to your new inclusions page and choose Create to add child pages containing your re-usable
content

Because you've moved the pages to the root of the space, they won't appear in the page tree in the

sidebar. The pages will be picked up by other searches though, as they're normal Confluence pages.

Templates Reorder Pages Orphaned Pages Undefined Pages  Attac

o——- » [2) _Confluencelnclusions

» [#) Confluence Documentation Home

1. Inclusions library location: drag your inclusions library here, above the rest of your documentation.
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Use page templates

Creating one or more page templates can be a real time-saver if you're creating a lot of pages with the same
layout. If you're constantly adding the same macros, like panels and table of contents, save yourself from
RSI and put them into a template — you can start with one, but make as many as you need to maximize your
efficiency.

To create a page template that's available in all spaces:

1. Goto E > General Configuration

2. Select Global Templates and Blueprints from the list on the left
3. Choose the Add global page template button at the top-right

4. Create your template page and choose Save

For detailed info on page templates, see Create a Template.

@. To get to Global Templates and Blueprints , or any other admin page quickly, hit/ on your
keyboard and start typing the name of the admin page you're looking for.

Draft your work

When you're creating a new page in your documentation, you'll likely want to do it over time, saving as you
go, and have a select few people review it to provide feedback. A loose description of this workflow is 'draft,
review, publish'.

You don't want any half-finished pages being seen by your users, and most documentation needs to be
reviewed before it's finalized, so here's a technique for drafting pages and allowing for review:

1. Create a page and restrict its permissions
For example, you might restrict viewing to a group of people such as your team, or a few select
individuals. On a public site, you might restrict viewing to staff members, so that the general public
can't see the page.
2. Write your page content
3. Share the page with your reviewers and ask them for feedback (make sure you haven't restricted
them from seeing the page!)
The reviewers can add comments to the bottom of the page or highlight text to add a comment inline.
If you give them permission, they can also edit the page content directly.
4. Publish the page when ready, by doing the following:
a. Delete any comments on the page
b. Remove page restrictions so that your audience can see it

You've now published your page. The space permissions and site permissions now determine who can see
and/or update the page.

Use links and anchors
Add links
In any documentation site, it's essential to be able to link from one page to another, and often to specific

sections on a page. You can add any URL to a Confluence page and Confluence will automatically detect
it and turn it into a link.

Created in 2020 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

Confluence 7.4 Documentation

If you paste the URL for another page in your Confluence site, Confluence will display the link text as the
page name and turn it into a relative link, meaning if the name of the page changes, Confluence will adjust
the link so it doesn't break.

Add and link to anchors

The anchor macro allows you to create anchors in your documentation, which can be linked to from
anywhere. I've added an anchor at the top of this page so you can click to go back to the top.

To add a macro and link to it from the same page:

1. Type {anchor in the editor, select the anchor macro and give your anchor a name (t op in my

example)

2. Select the text that'll link to the macro and hit Ct r | +K (Windows) or Cnd+K (Mac) (this opens the link
dialog)

3. Choose Advanced from the options on the left and type # followed by your anchor name (#t op in my
example)

Check out our documentation for links and anchors to get the full rundown on linking to anchors on other
pages and other anchor goodness.

Useful macros

Confluence ships with a great range of macros, and there are a few that are particularly useful in technical
documentation. Here's a few:

Table of contents macro

The Table of Contents macro helps people navigate lengthy pages by summarizing the content structure and
providing links to headings used on the page. The best part is, you don't need to do anything except add the
macro; once you've added it, it'll automatically detect headings and add them to the table of contents.

Tip, Note, Info, Warning, and Panel macros

Often when creating documentation, there are elements of a page that you want to highlight or draw the the
viewers' attention to. Confluence ships with the Tip, Info, Warning, Note and Panel macros, which will help
you focus a viewer's attention on a particular part of your content.

(® Tip of the day

Use the tip macro to give your readers handy hints!

Keep track of page updates

In Confluence, it's quite usual for a number of different people to update a single page. Technical writers
need to know what happens to our documents, both during review and after publication.

Watch pages or the space

So that you know when changes are made, it's a good idea to watch pages or even the entire space. That
way, when changes are made to pages you're watching, or someone comments on them, you'll get an email
notification letting you know who changed what.

Whenever you're on a page in your documentation space, choose the Watch button at the top-right of the
page. From there, you can choose to watch just that page, or all pages in the space.
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View page history

Confluence creates a new version of the page every time someone edits the page. The page history shows
all the versions, with date, author, and any comments made on the update.

To view page history, go to the page and choose *** > Page History
On the page history view, you can:

* View the content of a specific version of the page.

® Revert to (restore) a specific version.

® Select any two versions and ask for a comparison, to see what has changed between those two
versions.

Take a look at Page History and Page Comparison Views for a detailed explanation.
Show a list of contributors

If you want to see at a glance who's updated a page or pages, you can add the contributors macro. This
macro displays a customizable list of people who've contributed by creating, editing, or, optionally,
commenting on the page.

Customize PDF export

If you're planning to provide a PDF version of your documentation — whether it be for email, download, print,
or any other form of delivery — you can customize the look of the PDF by adding a title page, header, and
footer.

The process you take depends on whether you're trying to customize the PDF export for one space or for
your whole site, so, if you're keen to make these changes, take a look at our page on Customize Exports to
PDF for more detailed instructions.

Other useful tools and apps

Confluence is already a great tool for technical documentation, but you can still add to it depending on your
documentation and workflow needs. Here are some useful apps available on the Atlassian Marketplace, most
of which we use ourselves, which can extend the functionality of Confluence.

New apps are hitting the marketplace all the time. This is by no means an exhaustive list!
Scroll Versions (supported by vendor)

Scroll Versions, by K15t, allows you to tie versions of your documentation to versions of your product, so that
when a new version of your product ships you can publish that version of your documentation. Create as
many versions of your documentation as you like, make the changes you need to, and keep them up your
sleeve until release time. You can even publish different variations of your documentation — like if you have
versions of your documentation for different operating systems — to different spaces or Confluence instances.

Copy Space (unsupported)

The Copy Space add-on, by Atlassian Labs, does what its name suggests; it allows a space administrator to
copy a space, including the pages within the space. Great for when you want a space template that you can
copy to create other spaces.

This app is also useful when you need to archive a copy of a current space at a particular point in time, like

when you're moving from one version of your product to the next — copy the space, give it a new nhame, and
keep it wherever you like, all without losing the existing space.
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@ At this point this plugin won't copy page history, blog posts and email.
Scroll PDF Exporter (supported by vendor)

If you're going to produce a PDF of your documentation space, wouldn't you like it to be professionally
formatted? The Scroll PDF Exporter, by K15t, lets you style single pages or whole spaces for export, using
handy PDF templates.

Gliffy (supported by vendor)

Create diagrams, wireframes, flowcharts and more with Gliffy. Gliffy features a highly intuitive drag-and-drop
interface, and allows you to export your diagrams in multiple formats, including: JPEG, PNG and SVG. Add
Gliffy flowcharts, Ul wireframes, and network diagrams directly to your Confluence pages to communicate
your ideas visually, making them easy to understand and faster to spread through your team.

Lucidchart (supported by vendor)

Lucidchart is available in versions for Cloud and Server, and allows you to create and insert diagrams within
your Confluence Cloud environment. Quickly draw flowcharts, wireframes, UML diagrams, mind maps, and
more inside our feature-rich editor.

The server version also comes with a free Visio viewer, so you can view Microsoft Visio (.vsd) files, Visio
stencils (.vss) and it also supports exporting back to Visio.

Documentation theme (discontinued)

Confluence historically provided a theme specifically for documentation. This theme was removed in Conflue
nce 6.0.

A number of the original Documentation theme features, such as headers, footers and the ability to add

custom content to the sidebar, are available in Confluence's more modern default theme, which make it a
great choice for your documentation space.
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Use Confluence as a Knowledge Base

A knowledge base is a repository for how-to and troubleshooting information. Knowledge Bases are
commonly used by IT Support teams, but can be useful for procedural and troubleshooting information in
any organization or team.
Learn more about how a knowledge base helps your team work smarter
What do people want out of a knowledge base? Using an IT Support team as an example:
® Customers want fast access to a solution, and relevant search results.

Help desk staff want to be able to create new articles quickly.

Help Desk team leads wants the space to be self curating, and do not want to spend a lot of time

manually organizing content.

® Everyone wants a way to be notified when articles they are interested in have been updated or
important notices are added.

Create a knowledge base space

i. You'll need the Create Space global permission to do this.

To create your knowledge base space:
1. Choose Spaces > Create space > Knowledge base space
2. Choose Space Tools > Permissions to set permissions for the space, including anonymous access
3. Choose Create > How-to or Troubleshooting and follow the prompts to create your first knowledge

base article

The knowledge base space blueprint includes everything you need to get started, including article templates,
and a pre-configured homepage with Livesearch and Content By Label macros.

Page labels are essential in knowledge base spaces. These are used to add topics to your articles, and
allows your knowledge base to become self-organizing over time.

Users will generally find articles by searching, and using the topic navigation on the homepage and end of
each article, rather than navigating through a tree-like page hierarchy.

When starting off your knowledge base space, it's a good idea to brainstorm a few topics to get started.
Customize your knowledge base space

G} You'll need Space Admin permissions to do this.

To make it easy for your users to create knowledge base articles, such as your help desk or support team,
we recommend customizing the how-to and troubleshooting article templates to make them relevant for your
organization. The more guidance and structure you can put in your template, the faster it will be for your
team to create great articles.

To edit the article templates:
1. Goto Space Admin > Content Tools > Templates.
2. Edit the How-to or Troubleshooting article templates.
3. Add headings and instructional text (choose Template > Instructional Text).

You can also add additional templates, such as a policy or procedure page templates.

We also recommend customizing the look and feel of your space. Simple changes like a space logo and
welcome message can make a huge difference.

To change the look and feel:
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Confluence 7.4 Documentation

® Add a space logo and useful shortcuts to the sidebar (choose Space Tools > Configure Sidebar)
® Edit the homepage to add a custom welcome message.
® Edit the color scheme (choose Space Tools > Look and Feel > Color Scheme).

Provide communication and notification options

Channels of communication with your audience, internal or external, are essential in a good knowledge
base. Here are some out-of-the-box options:

® Blog - blog updates and important notices, and encourage people to watch for new blogs in your
space.

® Watch - encourage people to watch pages that interest them, or watch the entire space.

® Comments - allow logged in users (or even anonymous users) to comment on knowledge base
articles. This is a simple way to connect with your end users.

® RSS - create an RSS feed and add the link to your knowledge base homepage (choose Help > Feed
Builder). Alternatively encourage users to create their own feed - useful if they want to keep up with
particular topics (labels), rather than receive notifications for the whole space.

Integrating your knowledge base with other Atlassian products

If your Confluence site is connected to another Atlassian product (via an application link), you can make use
of these great integration features:

® |f you use any Jira application - add a JIRA Issues macro to your troubleshooting article to provide
quick access to known issues. This has the added advantage of automatically updating when an
issue is resolved or its status changes. One simple way to do this would be to add some labels to Jira
to indicate the issue should appear in the knowledge base (for example 'printer-kb'), and then add a
Jira Issues macro with a query like 'label = 'printer-kb and status <> resolved" on all articles with the
printer topic.

® If you use Jira Service Desk - link a Confluence space to be used as a knowledge base. Users
(including those without a Confluence license) can search your knowledge base directly from within
the Service Desk customer portal. You can connect Jira Service Desk with Confluence 5.10 or later.

® |f you use Questions for Confluence Server - add a Questions list macro to troubleshooting
articles, to highlight the top questions with the same topic as the article, and an Ask a Question button
to the knowledge base homepage.

Extending your knowledge base with Marketplace apps

The Atlassian Marketplace has a large number of apps for Confluence. A common addition to Knowledge
Base spaces is a survey or form tool, which enables you to get feedback on the usefulness or usability of
your knowledge base articles.

Search for 'knowledge base' on Marketplace and see if there is an app that's right for your knowledge base.
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Use Confluence as your Intranet

Your intranet is the hub of your organization. When choosing your intranet platform, you need to ensure that
the system is simple enough for non-technical users, information and content can be shared easily, and
access is restricted to those within your organization.

Confluence has a host of great out-of-the-box features that allow you to share and collaborate with your
colleagues, while keeping your information secure. Share things like procedures, specifications and
important files — or organize company events and functions — and get your teams working together. It's one
place to share, find, and collaborate to get work done.

Create your community

It's quick and easy to add users to your Confluence site. Allow people to add themselves as users of the site;
invite people to sign up by sending them an invitation link; add new users manually; or use an existing
directory — like an LDAP directory — for authentication and to manage users and groups.

Whichever way you choose, you can quickly build a community of Confluence users and give them access
to your intranet; you'll also have a ready-made people directory.

Match your company branding

Upload your company logo, and Confluence's auto look and feel will change the color scheme to match. It'll
make your intranet feel more familiar to your colleagues, and help with adoption.

A space for everything, and everything in its space
A Confluence space is essentially a container for a group of pages and blog posts with related content.

When you're starting out with Confluence, the easiest way to organize things is to create a space for each
team or department within your organization. Each team's space is then a place for them to create and share
pages, blog posts, meeting notes, files, and much more — and becomes the place to go for team members to
get the information they need.

Just choose Spaces > Create space from the header, and Confluence provides a list of space blueprints to
help get you started.

Create Team Space

About Team Spaces

" Tach Writing

Share knowladge and collaborate an

™ 6l N N b i

W projects, processes and procedures with

your team. They will be notifled about this

B Gil Admin x| [ Josh User space and all updates. Team members wil
be granted permissions and added as

Description | Welcome to the Technical Writing space! Find watchers of the space

out aboul our projects, meat the team
members, check out our calendar, and watch
our blog.

Back Create

Each space can have its own color scheme and has a customizable home page, which you can edit to suit
your purpose — like displaying and tracking team goals and displaying a list of team members. Use the built-
in "'Team Space' template to automatically add all members of the team to the homepage, to help everyone
get to know each other.

You can set permissions for each space, so if there's sensitive information that should only been seen by
certain users or groups, it's easy to secure it with Confluence.
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Don't feel restricted to creating spaces for teams though; you can also create spaces for projects (large or
small), events, and anything else where you want to collect information under a common heading or
permissions structure.

Once you have some spaces set up, create some pages and blog posts to give your colleagues an example
of how Confluence can be used, then invite them to create their own pages and blogs.

Add a personal space

Every Confluence user, including you, can also create their own personal space; it can be a place to keep
your own work, add shortcuts to your most used content, and you even get your own blog for sharing your
ideas and opinions with the rest of your organization (or just those that you want to see them).

Create pages, meeting notes and more

You can create pages for anything you want in Confluence - meeting notes, project plans, decisions, and
more. Pages are editable so others can contribute and keep them up to date after you create them. Choose
Create from the Confluence header and choose a blank page, or use a template to get you started.

Type your page, change its layout, add images and links, and do it all without any specialist skills or training.
You can also attach files — allowing everyone in a team access to assets that are critical to the project — like
mockups and requirements. You and your colleagues can like the page, and comment on it to start a
conversation about the content.

Confluence also offers a series of useful built-in page blueprints, which help you with the content and

formatting of the page. The meeting notes and decisions blueprints are two that can be really useful when
others need to be in-the-know about what happened, and why it happened.

Avoid the reply-all and blog about it

Each space you create in Confluence has its own blog, where you and your teams can share news and
events, discuss important projects and developments, or congratulate a teammate for a special effort;
blogging is a great way to foster company culture and celebrate achievements across your organization.

You can watch any blog to make sure you get updated when there's a new post. Blog posts are
automatically organized by date, and grouped by year and month, so they're also easy to find.

Share stuff that matters

If you need to be sure that the right people see a page or blog post, Confluence offers a range of ways to
make sure you can get their attention. Type the @ symbol and the name of a Confluence user to mention the
m in a page, blog post, or comment. They'll get an email notification that you've mentioned them, with a link
to the page, post or comment.

There's also a Share button at the top right of every page. Type the name or email address of a user or
group and send them a short message with a link to the content you're sharing.

Watch and learn

Don't miss out on important updates. Watching spaces, pages, and blogs is a great way to stay up-to-date
with what's happening in your own team, or any other team or person you need to keep up with. When you
watch something, you'll get email updates when changes are made or a comment is added.

The Confluence dashboard also has a recent activity feed, which allows you and your team to see what's
trending throughout the company or in your network.

Let team collaboration take on a life of its own
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If you want to communicate in-the-moment, Hipchat — our private service for chat, video, and screen sharing
— is built for teams. Share ideas and files in persistent group chat rooms, or chat 1-1 for that personal touch.
Hipchat integrates with Confluence, so you can get real-time notifications in Hipchat whenever new
information is shared in Confluence pages and blogs.

Got a question (that's not rhetorical)? Why not ask your team? Questions for Confluence is an add—on for
Confluence that gives you knowledge sharing with your own Q&A service. Run company-wide polls to gauge
reaction to a new marketing initiative, or let people vote on the venue for the Christmas party. Ask questions,
get answers, and identify experts.

You can also try Team Calendars for Confluence for organizing and sharing team events, leave, and other
important appointments. Embed each team's calendar on their home page so that everyone knows what's
happening, and when.

= XUConfluence sSpaces ~ People Calendars | Create ==

Calendars ] AddEvent  dh Add Galendar
Today 4 > August 2013 Month  Week @ List = Timeline ; ; b
Mon Tue Wed Thu Fri Sat Sun
1 2 3 4

& Sprint 1

Deav Team -
I ® Travel
g. Mitch Davis, Max Taylor, Harvey l & Birthdays
Jennings e
. g I [Fl Versions
':,I Leave Plans
1 I ) Events
Alana, Harvey, Will: Team Offsite Sydney =
7 : Sprints
: 31 Jul, 08:00 - 09:00, 02 Aug b: Long Weekend in NYC IQ‘ prm
e Ul : I ® Leave
rols on ; I Edit - Delete i
booking | & JRAIssues

page lo
handle groups prowid
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Confluence for Software Teams

Welcome to the Software Team's guide to using Confluence.

Check out the articles in this collection:

How to write product How to build arelease Creating insightful customer
requirements planning page interview pages
®
ol A O
O
Create sprint retrospective How to make better decisions How to document releases
and demo pages (like a BOSS) as a development team and share release notes
[y
Use blogs to share your development How to create technical and
team’'s progress onboarding documentation

Like what you see? Start creating these pages and more in
Confluencel!

Try it for free
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